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Welcome. 
1 

Welcome to THINK C. This chapter tells you what's in your THINK C package, 
what equipment you need, and what you need to know to write C programs 
on your Macintosh. 

If you don't read manuals 
Read this chapter, the next chapter, and one of the tutorials. Be sure to keep 
this manual nearby to answer any questions that come up as you work. 

If you're an experienced THINK C user 
Read Chapter 2, "Installing TInNK C 5.0," before installing the new version. 
Read Appendix A, "What's New," in this manual for information on the new 
THINK C 5.0 features, including the global optimizer and 100% ANSI-confor­
mant compiler. If you read nothing else, read "Porting to THINK C 5.0" on 
page 458 to learn how to port your old code. 

If you're learning the C language 
Read Chapter 3, "Tutorial: Hello World," to learn how to run simple pro­
grams in THINK C. If you need a book on C, see "Learning C" on page 10. If 
you're learning C from a book written for UNIX or MS-DOS computers, look 
at these chapters in the Standard Libraries Reference to learn how to port 
example programs to THINK C: Chapter 2, "Using the Standard Libraries" 
(especially the section "Using Files and Streams"), and Chapter 3, "Using 
Console Windows." 

Contents 
What is THINK C? . 5 
What You Need. . . . . . 5 

Which Macintosh models? . 5 
How much disk space? . 6 
Which System/Finder? . 6 

What's in the Package. . . 6 
What's in the Manual. . . . 6 

Conventions in the manual 9 
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What is THINK C? • 
What is THINK C? 
THINK C is a unique development environment for the Macintosh. It fea­
tures a very fast compiler, a faster linker, a time-saving optimizer, an integrat­
ed debugger, a text editor, an auto-make facility, and a project organizer that 
holds all the pieces together. Because the editor, the compiler, and the linker 
are all components of the same application, THINK C knows when edited 
source files need to be recompiled. And if you edit a header file, the auto­
make facility recompiles all the source files that depend on it for declara­
tions. 

With THINK C you can build Macintosh applications, desk accessories, de­
vice drivers, and any kind of code resource. The standard C libraries include 
all the functions specified in the ANSI C standard, as well as some additional 
Unix operating system functions. 

You can run your program from TI-IINK C as you work on it Your program 
runs exactly as if you had opened it from the Finder, not under a simulated 
environment. And if you use MultiFinder or System 7, your program runs in 
its own partition while TlllNK C remains active, so you can examine and 
edit your source files as you watch your program run. 

The THINK C development environment includes a source-level debugger 
that lets you debug your code exactly as you wrote it. No more translating 
assembly language back into C. The debugger lets you set breakpoints, step 
through your code, debug objects, examine variables, and change their val­
ues while your program is running. And because the debugger works along 
with THINK C, you can edit your source files while you're debugging. 

What You Need 
THINK C requires a hard drive and at least 1 Mb (megabyte) of RAM. With 
only 1Mb you won't be able to take advantage of MultiFinder or System 7.0, 
and you won't be able to use the debugger. With 2Mb, you can run small 
programs under MultiFinder and System 7.0. With 4 Mb, you can run com­
fortably under MultiFinder or System 7.0. 

Which Macintosh models? 
You can run THINK C on a Macintosh Classic, LC, Plus, Portable, the Macin­
tosh SE series, or the Macintosh II series. You can run THINK C on a Macin­
tosh 512Ke if you've upgraded it to at least 1Mb of RAM. 

You can run THINK C without the debugger on any Macintosh computer 
with at least 1Mb of RAM. To use the debugger, you need at least 2Mb of 
RAM. 
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How much disk space? 
The complete mINK C system takes up about 5.75 megabytes on your disk, 
not including your own files. The actual size of your system may be smaller, 
depending on the kinds of programs you work on. 

Which System/Finder? 
Use the latest System and Finder provided by Apple. mINK C requires at 
least System 6.0.5. 

1HINK C is designed to work best under MultiFinder or System 7. If you're 
using a Macintosh with 1Mb RAM, however, you're better off using the latest 
version of System 6 recommended for you machine with MultiFinder turned 
off. 

What's in the Package 
Your mINK C package consists of four double-sided floppies, this manual, 
the Standard Libraries Reference, and the Object-Oriented Programming 
Manual 

What's in the Manual 
This manual is organized in six sections: Getting Started, Learning TI-IINK C, 
Using THINK C, Reference, and the Appendices. Each chapter begins with 
an introduction that describes what's in the chapter followed by a list of the 
major topics covered in the chapter. 

Getting Started 

This is the section you're reading. It contains this chapter and the installation 
instructions .. Even if you don't read manuals, be sure to read the installation 
instructions in Chapter 2. 

Learning TIIINK C 

This section contains three tutorials. 

This chapter 
Tutorial: Hello World 

Tutorial: MiniEdit 

describeS ••. 
How to write a minimal program that uses 
the standard C libraries and introduces 
you to the basics of using mINK C. 

How to build a Macintosh application. 
This tutorial is based on the Sample pro­
gram in Inside Macintosh. It shows you 
how to fIx bugs, how to use resource files, 
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Tutorial: Bullseye 

Using11lINKC 

What's in the Manual 

and how to build a double-dickable appli­
cation. 

How to use TfllNK C's source level de­
bugger. 

• 

This section contains nine chapters that describe the different components 
ofTHINKC. 

This chapter 
Overview 

The Project 

The Editor 

Files and Folders 

The Compiler 

Toolbox Routines 

describes ..• 
How THINK C works. 

The four different kinds of projects. It 
gives you the details of building applica­
tions, desk accessories, device drivers, 
and code resources. This chapter contains 
several code examples to make writing 
your program easier. 

The THINK C integrated text editor. The 
editor'has several features to make editing 
C source files easier and a sophisticated 
searching facility: 

The best way to arrange your TfllNK C 
files. This chapter describes how THINK C 
looks for files on your disk and how it 
names files. . 

How THINK C compiles your source files. 
It also tells you how to compile ANSI-con­
formant code, use the global optimizer, 
generate code for the 68881 floating point 
coprocessor, use strict type enforcement, 
and port code. 

How to call the Macintosh Toolbox rou­
tines from your programs. It also tells you 
how to write Pascal callback routines and 
use some THINK C extensions that help 
you write programs for the Macintosh. 
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The Debugger 

Assembly Language 

Libraries 

Reference 

The source-level debugger. This chapter 
tells you how to control execution, how to 
set breakpoints, and how to examine and 
modify your variables as you debug. 

TInNK C's inline assembler. This chapter 
also explains C and Pascal calling conven­
tions so your assembly language routines 
will integrate smoothly with both your C 
functions and the Macintosh Toolbox rou­
tines. 

How to build and use libraries in your 
TInNK C programs, and how to convert 
object code from other compilers and as­
semblers into THINK C libraries. 

This section contains three reference chapters. 

This chapter 
THINK C Menus 

Debugger Menus 

Language Reference 

Utilities 

describes ... 
The THINK C menu commands. 

The source-level debugger's menu COffi- . 

mands. 

TInNK C's implementation of the C lan­
guage. Its sections are keyed to the ANSI 
standard. 

This section describes three utilities that help you program with THINK C. 

This chapter 
The Pro filer 

oConv 

describes ... 
How to analyze the way your program 
runs. You can time your functions, and 
trace your program. 

How to convert object files from other de­
velopment environments to THINK C's 
format 
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Resource utilities 
This section describes two utilities to help you create and examine resource 
files. 

ThJs chapter describes .•• 
Resource Description Files How to write text files that you 

compile with SARez to produce 
resource files 

Using SARez 

Using SADeRez 

Note 

How to use SARez to create re­
source files from resource de­
scription files. 

How to use SADeRez to create re­
source description files from re­
source files. 

TI-llNK C also includes ResEdit, which helps you edit re­
source files. It's described in the book ResEdtt 2.1 Refer­
ence(Addison-Wesley) by Apple Computer, Inc. 

Appendices 

The appendices contain information on THINK C 5.0's new features, trou­
bleshooting, error messages, and this manual's terms. 

ThJs appendix 
What's New 

Troubleshooting 

Error Messages 

Glossary 

describes .•• 
The new features in THINK C 5.0. 

How to troubleshoot your program. 

The error messages that THINK C gener­
ates. Many descriptions include examples 
and tips on solving. 

Defmitions for many of the terms used in 
this manual. 

Conventions in the manual 
The names of menus and commands are in bold face. When a technical 
term or key word is introduced, it also appears in bold face. 

Names of files, code fragments, resource names, function names, and vari­
ables appear in "typewriter face." 
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All numbers are decimal. Hexadecimal numbers are written in C notation: 
Ox3EFA instead of Pascal notation ($3EFA). 

In this manual, the term Toolbox routine means any routine described in 
Instde Macintosh. The Macintosh ROM actually consists of two different 
kinds of routines: Operating System routines and Toolbox routines. Operat­
ing System routines deal with low-level aspects of the machine like the file 
manager, the event posting mechanism, interrupts, device management, etc. 
The Toolbox deals with high-level aspects like the drawing environment, the 
window mechanism, menus, dialogs, etc. 

What You Should Know 
This manual assumes you already know, or are at least learning, how to pro­
gram in C. If you're just getting started in C, THINK C is a great platform. 

If you're planning to write Macintosh applications, you should be familiar 
with the Macintosh Toolbox as described in Inside Macintosh, the official 
reference that describes the more than 1,000 Macintosh Toolbox routines. 
The Toolbox is the set of operating system and user interface routines that 
make a Macintosh a Macintosh. It's beyond the scope of this manual to show 
you how the different parts of the Toolbox work together. 

Learning C 
As the popularity of C grows, more and more introductory level books ap­
pear on the shelves. Some books assume that you're just learning how to 
program, and others assume that you already know how to program in an­
other language. Some books spend time telling you how to use the develop­
ment environment: the editor, the linker, the make facility. These things are 
done very differently in THINK C, so when you choose a book, choose one 
that doesn't dwell too much on these aspects of programming. 

If you're learning C from a book, or if you're using THINK C to do course 
work, be sure to do the fIrst tutorial. It shows you how to set things up to 
write and run C programs that use the standard C libraries. 

The standard references for the C programming language are Kernighan & 
Ritchie's The C Programming Language, Second Edition (prentice Hall) and 
Harbison & Steele's C: A Reference Manual (prentice Hall). The C Program­
ming Language, Second Edition is an update to The C Programming lan­
guage that incorporates what was then the latest draft of the ANSI standard. 
These books assume that you're already an experienced programmer. 
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Standard C(Microsoft Press) by P. J. Plauger and Jim Brodie is a guide to 
writing C programs that conform to the ANSI C standard. Both of the authors 
were officers of the committee that drafted the ANSI standard. 

Software Engineering in C(Springer-Vedag) by Peter Darnell and Philip 
Margolis is an excellent introduction to the C programming language. This 
book is ideal for new C programmers who have programmed in other lan­
guages. 

C Traps and Pitfalls (Addison-Wesley) by Andrew Koenig is a good book for 
intermediate and advanced C programmers. It contains a detailed discussion 
of common C programming problems. 

Numerical Rectpes in C(Cambridge University Press) by Press, Flannery, 
Teukolsky and Vetterling is a detailed technical description of numerical 
methods with implementation examples in C. 

Portability and the C Language (Hayden Books) by Rex Jaeschke is a good 
book on writing portable C programs for advanced C programmers. It gives 
you guidelines on how to write programs that can be compiled with differ­
ent compilers and run on multiple platforms. It points out changes intro­
duced with ANSI C. You'll find it useful if you port code from one platform 
to another or from an old (pre-ANSI) version of THINK C to THINK C 5.0. 

Portable C Software (Prentice Hall) by Mark R. Horton is also about writing 
portable C programs, but emphasizes porting among C compilers for UNIX 
and MS-DoS. 

The document describing the ANSI standard is American National Standard 
for Information Systems-Programming Language-C X3.159-1989. Cost 
is $50, plus $5 for shipping and handling. To order a copy, write or call: 

American National Standards Institute (ANSI) 
Sales Dept. 
1430 Broadway 
New York, NY 10018 
(212) 642-4900 

Learning to write Macintosh programs 
If you're new to programming the Madntosh, you might find yourself over­
whelmed by the complexity of the Madntosh Toolbox and unfamiliar pro­
gramming techniques. When the Madntosh was introduced in 1984, there 
was very little technical information available to casual programmers, and 
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even commercial developers had a hard time figuring out how to get things 
to work correctly. 

The Macintosh is even more complex today than it was in 1984, but now 
there are more places you can go for information. Several good books intro­
duce programming the Macintosh and teach some of the finer points of us­
ing the Macintosh Toolbox. No matter which books you choose to get 
started, Inside Macintosh is indispensable. 

Inside Macintosh Volumes 1-VI(Addison-Wesley) is the official reference that 
describes the more than 1,000 Macintosh Toolbox routines. You might be 
able to get by without it for a while, but if you're planning to write serious 
applications, you just can't do without it. At six volumes, it represents a hefty 
investment. The first three volumes cover the fundamentals. Volumes IV and 
V cover the additions and changes made with the introduction of the Mac 
Plus, Macintosh SE, and Macintosh II. Volume VI covers the changes intro­
duced with System 7. 

In addition to Inside MaCintosh, Apple also publishes these books through 
Addison-Wesley: 

• Human Interface GUidelines 
• Technical Introduction to the Macintosh Family 
• Programmers Introduction to the Macintosh Family 
• Guide to the Macintosh Family Hardware, Second Edition 
• Apple Numerics Manual, Second Edition 
• LaserWriter Reference 
• Inside AppleTalk 
• Designing Cards and Drivers for the MaCintosh Family, Second 

Edition 

You won't need all these books when you get started. Some of the books, 
like Human Interface Guidelines, are useful for all Macintosh programmers. 
Other books, like Inside AppleTalk, are meant for programmers working on 
specific kinds of applications. These books are available from APDA (see 
page 14), technical bookstores and computer stores, and in some general 
bookstores. 

TIllNK Reference, published by Symantec, is a hypertext program that gives 
you instant access to the critical system information that you need to pro­
gram the Macintosh. It describes nearly all of the Macintosh Toolbox rou­
tines from Inside MaCintosh J- V, including information from the technical 
notes, code examples, and Symantec programmer tips. The information is 
cross-referenced, so you can look up related Toolbox routines quickly. It in-
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cludes customizable bookmarks and templates that let you copy Toolbox 
calls right into your own program. 

• 
The Macintosh C Programming Primer: Inside the Toolbox Using mINK C, 
Volumes I and o (Addison-Wesley) are a good introduction to Macintosh 
programming for those already familiar with C. Volume I, by Dave Mark and 
Cartwright Reed, explains how to use the Toolbox, handle resources, and 
write a Macintosh application. Also, the examples use some of the newer 
parts of the Macintosh system, such as the Notification Manager and Hyper­
Card XCMDs and XFCNs. Volume II, by Dave Mark, covers more advanced 
topics like Color QuickDraw and code resources. 

Stephen Chernicoffs four volume set, Macintosh Revealed (Hayden Books), 
is another step-by-step introduction to Macintosh programming. Chernicoff 
shows you how to build a working application and points out the parts of 
Inside Macintosh you really need to know as opposed to the parts you just 
need to be aware of. The programs in the books are written in MPW Pascal, 
but they're not too difficult to translate to TI-lINK Pascal or to TI-IINK C. 

Scott Knaster is the author of two books on Macintosh programming. The 
first, How to Write Macintosh Software (Hayden Books), teaches you what 
goes on inside the Toolbox. This book contains some valuable tips about de­
bugging Macintosh programs. The second book, Macintosh Programming 
Secrets (Addison-Wesley), deals with some of the conventions and tech­
niques that have become standard in Macintosh programs. It also contains 
information about the Macintosh II and the Macintosh SE. These books are 
more technical than Macintosh Revealed and are loaded with pictures, dia­
grams, and examples. 

If you frequently use ResEdit to create and edit resource files, you may want 
the ResEdtt 2.1 Reference (Addison-Wesley) by Apple Computer, Inc. It ex­
plains how to edit standard resource types and how to extend ResEdit by 
adding your own resource pickers and editors. 

Finally, Mac Tutor is the leading technical journal for Macintosh program­
ming. The articles range from tutorial examples to advanced techniques. 
MacTutor covers several languages, not just C and Pascal, and most of the 
examples are written in TI-lINK C and TI-lINK Pascal. (All of the programs 
described in the magazine are available on disk.) 

Apple Computer, Inc. 
Apple Computer is naturally one of the best places for information about 
Macintosh programming. Apple administers the Apple Partner and Apple 
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Associate program for commercial and non-commercial software develop­
ers. For more information, contact Apple: 

Apple Computer, Inc. 
20525 Mariani Avenue, MS 75-2C 
Cupertino, CA 95014 

(408) 974-4897 

Apple Programmer's and Developer's Association (APDA) 
The Apple Programmer's and Developer's Association (APDA) is Apple's in­
house membership organization that distributes technical information to 
programmers and developers. APDA is a great source for Technical Notes, 
programming utilities, reference books, and information about announced 
(but unreleased) products. For information about membership and prod­
ucts, contact APDA directly: 

Apple Programmer's and Developers Association (APDA) 
Apple Computer, Inc. 
20525 Mariani Avenue, MS 33G 
Cupertino, CA 95014-6299 

(BOO) 282~2732 (USA) 
(BOO) 637-0029 (Canada) 
(408) 562-3910 (Other) 
(408) 562-3971 (Fax) 

CompuServe 
Symantec has a forum on CompuServe specifically for its customers. Simply 
type GO SYMANTEC at any! prompt. You'll find discussions here about 
programming in general and mINK C and mINK Pascal in particular. The 
data libraries contain utilities as well as sources for many programs. 

CompuServe also has an Apple developers forum. Just type GO MACDEV at 
any ! prompt. This forum is a good place to get in touch with the Macintosh 
programming community. 

Sy~antec PrQgramming Languages Association (SPLAsh) 
The Symantec Programming Languages Association (SPLAsh) is a user group 
for anyone who uses the Symantec programming languages mINK C and 
1HINK Pascal. SPLAsh is an independent organization endorsed by, but not 
affiliated with, ~ymantec Corporation. 
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SPLAsh offers its members the following: 

• mINKin' CaP, a 100-page quarterly that includes technical arti­
cles with source code, help for beginners, tips from Symantec 
Technical Support, insights on the TIIINK Class Library, and re­
views of the latest tools and conferences. 

• A quarterly disk containing all the source code from mINKin' 
CaP, programming utilities, and the latest patches for mINK C 
and TIIINK Pascal 

• Meetings at major Macintosh conferences, including seminars on 
topics of interest and presentations from Symantec and SPLAsh 
members. 

• A SPLAsh forum on America Online. 

• 

Yearly membership is $30 for USA residents, $40 for Canada and Mexico res­
idents, and $60 for residents of other countries. For more information, write 
to this address: 

SPLAsh Resources 
1678 Shattuck Ave., #302 
Berkeley, CA 94709 
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Installing 
THINK C 5.0. 

2 
Installing TIllNK C S.O takes just a few minutes and some mouse clicks. The 

installation programs know where to place the files so you don't have to. 

This chapter explains how to install TI-llNK C 5.0 on your hard drive. If 
you're installing THINK C 5.0 for the first time, be sure to read the whole 
chapter. If you need to restore a few things from the original disks, read 
"What's in the Archives" on page 22. 

Note 
You must have a hard disk to use THINK C 5.0. 

Contents 
Summary. . . 19 

Before You Start.... . 19 

Instructions. . . . 20 

What's in the Archives . 22 
Headers & Libs.sea . 22 
DAlcdev Tools.sea . . . 23 
THINK C 5.0 Demos.sea . . 23 
THINK Class Library 1. 1. sea . 23 
TCL 1.1 Demos.sea . . . . 23 
Resource Utilities.sea . . . 23 
THINK C Utilities. sea . . . 23 

About the Self-Extracting Archives . 24 
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Summary • 
Summary 
This chapter tells you how to set up THINK C on your hard disk. This setup 
ensures that THINK C will know where to find all the files it needs to com­
pile your programs. To learn more about why the files are organized this 
way, see Chapter 9, "Files & Folders." 

Your THINK C 5.0 disks contain a total of seven self-extracting archives, ap­
plications that contain compressed files which they decompress and install 
on your hard disk. You'll create a folder on your hard drive and then run 
each self-extracting archive and let them install their files in that folder. Then 
you'll move the THINK C 5. 0 application and the THINK C Debugger 
5.0 into the newly created THINK C 5.0 Folder. If you want to install 
only some parts of THINK C 5.0, read "What's in the Archives" on page 22 to 
find out which archives you need to run. 

Before You Start ... 
Before you install TI-llNK C 5.0, you'll want to take care of these steps: 

• If there is a file named READ ME on the disk THINK C 1, read 
it before proceeding. It contains information that didn't make it 
into the THINK C manuals. It's a text file that you can read with 
any word processor, including TeachText. 

• Make a copy of you THINK C 5.0 disks. If something goes wrong 
during the installation, you'll be able to make another copy and 
continue. 

• Fill out and send in your registration card. You'll find it in the 
Customer Service Plan envelope. If you want technical support, 
information about upgrades, or news about special promotions, 
you must become a registered user. 

• Make sure you have at least five megabytes (5Mb) of disk space 
free. If you don't have enough room, either clean up your hard 
disk, or read "What's in the Archives" on page 22 and install only 
the parts of THINK C 5.0 that you need. 

Note 
Some anti-viral software, like Symantec AntiVirus for the 
Macintosh (SAM), may warn you when the archive installs 
an application. If this happens, let the archive continue its 
operation. On SAM, click Allow.) You may want to turn off 
your anti-viral software before you install TIDNK C 5.0. 
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Instructions 
Here's how to install TIUNK C 5.0: 

1. In the Finder, create a new folder and name it Development. 

2. Insert the disk THINK C 2, and double-click on Headers & 

Libs.sea. 

3. A standard file dialog, like Figure 2-1, appears. Move to your 
Development folder and click Extract. 

Select Destination Folder: 

151 Deuelopment I 
Q CJAkbar 

( I:j.~~;1 ) 
( Driue ) 

n E"tract iJJ 
0 [ Cancel ) 

Figure 2-1 Placing files in your Development folder 
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4. The archive decompresses its files and places them on your hard 
disk. It displays its progress in the dialog in Figure 2-1. The ar­
chive quits when it's done. 

5. Repeat steps 2-4 for the each of the other archives on THINK C 
2, THINK C 3, and THINK C 4. 

6. Insert THINK C 1, and move THINK C 5. 0 and THINK C 
Debugger 5.0 into the THINK C 5.0 Folder in your 
Development folder. 



Instructions 

RutoEHtractor™ 

EHtracting: Files.h 

Files remaining to be eHtracted: 91 (Cancel] 

Compacted by Compact Pro 1M AutoExtr actor © 1 991 8m Goodman 

Figure 2-2 Watching the archive install your files 

When you're done, the Development folder contains these folders, as 
shown in Figure 2-1: 

• THINK C 5.0 Folder 
• THINK C 5.0 utilities 
• THINK C 5.0 Demos 
• TCL 1. 1 Demos 

Deuelopment 
4 n.ms 31 ,032K in disk 1S,933K ~vailablt 

0 THINK [ 5.0 Folder 

• 

~L --- LJ 10 items 31 ,032K in disk 1 S, 933K av ailab 1. 

THINK C 5.0 utilitits ~ [IJ 
LJ LJ THINK C 5.0 

TCl 1.1 Demos THINK C 5.0 Demos 

LJ ~ LJ 
oops l ibr aries THINK C Debugger 5.0 TH INK Class Library 1.1 

LJ ~ LJ 
DA stuff DA sh.n cd.v stuff 

LJ LJ LJ 
C libraries Mac -includes Mac l ibr aries 10 

¢I I¢ Q] 

Figure 2-3 The THINK C 5.0 Folder 
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2 • Installing THINK C 5.0 

What's in the Archives 
You don't need to install everything included in your mINK C 5.0 package. 
This table describes which archives you should run to get what you need. 

If you want the ••• 
Basic mINK C system 

TIDNK Class Library 

cdev and DA support 

Tutorials and 
example programs 

Resource utilities, like 
ResEdit and SARez 

Other utility programs, 
like oConv 

Run these archives ••• 
Headers & Libs. sea on THINK C 2 
and copy THINK C 5. 0 and THINK C 
Debugger 5.0 into your THINK C 5.0 
Folder from THINK C 1. 

THINK Class Library 1.1.seaand 
TCL 1. 1 Demos. sea on THINK C 3. 
(Even if you've used the lliINK Class Li­
brary before, you'll need the demos for 
examples of the new features.) 

DA/ cdev Tools. sea on THINK C 2. 

THINK C 5.0 Demos.sea 
on THINK C 2. 

Resource Utilities. sea 
on THINK C 4. 

THINK C Utilities. sea 
on THINK C 4. 

The rest of this section describes what's in each archive. 

Headers & Ubs.sea 
This archive places these folders in the THINK C 5.0 Folder: 

• oops Libraries 
• C Libraries folder, which includes the ANSI, ANSI -A4, 

ANSI-small, and unix libraries 
• Mac =If:includes folder, which includes MacHeaders andMac 

=If:includes.c 
• Mac Libraries folder, which includes MacTraps and 

MacTraps2 
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What's in the Archives 

DA/cdev Tools.sea 
This archive places these files in the THINK C 5.0 Folder: 

• cdev stuff folder 
• DA stuff folder 
• DA shell application 

THINK C S.O Demos.sea 
This archive places these folders in the THINK C 5. 0 Demos folder: 

• Hex Dump DA folder 
• MiniEdit Folder 
• Sample cdev folder 
• Bullseye Folder 
• OOP Demos folder, which includes the Object Bullseye 

folder and LearnOOP Folder 

THINK Class Library 1.1.sea 
This archive places the TI-llNK Class Library in the THINK Class 
Library 1.1 folder. 

Tel 1.1 Demos.sea 
This archive places these folders in the TCL 1.1 Demos folder: 

• NewClassDemo Folder 
• Starter Folder 
• TinyEdit Folder 
• Art Class Folder 

Resource Utilities. sea 
This archive places these files in the THINK C 5. 0 Utili ties folder: 

• ResEdit 2.1 
• Rez Utilities folder, which includes SARez and SADeRez 

THINK C Utilities.sea 
This archive places these files in the THINK C 5.0 Utili ties folder: 

• Compare 
• oConv 
• Prototype Helper 

• 
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2 Installing THINK C 5.0 . ----------~-----------------------------------------------
About the Self-Extracting Archives 
The self-extracting archives included with mINK C 5.0 are created with the 
shareware program Compact Pro. You can open a self-extracting archive 
with Compact Pro to examine its contents or install files one by one. You can 
download Compact Pro from most on-line services, including CompuServe, 
or write the author for ordering information: 
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Bill Goodman 
109 Davis Avenue 
Brookline,~ 02146 
USA 
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Learning THINK C 

Part Two 
3 Tutorial: Hello World 
4 Tutorial: MiniEdit 
5 Tutorial: Bullseye 

THINK C User Manual 25 



· --------------------------------------------------------

26 THINK C User Manual 



Tutorial: 
Hello World + 

3 
HllO World shows you how to put together an application with THINK C. The 

idea here is not to write a fancy program, but to show you how to build an 
application in mINK C. The program writes the words "hello world" in a 
window on the screen. 

Before you begin 
Be sure you followed the instructions in Chapter 2, "Installing mINK C 5.0," 
to install TIIINK C on your disk. 

What you should know 
You should know how to use the standard file dialog boxes to move around 
to different folders. If you don't know how to do this, read the user's manual 
that came with your Macintosh. 

Contents 
Creating the Project . 29 

Creating the Source File . . 32 

Compiling the Source File . 33 
Did you get an error? . 34 

Adding the Library. . . . 35 

Running the Project . . . 37 

Creating the Application. . 39 

Where to Go Next. . . . 40 

THINK C User Manual 27 



3 Tutorial: Hello World · ----------------------------------------------------
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Creating the Project 

Creating the Proje,ct • 
First, you need to create a folder for your project in the Development fold­
er. This is the folder you'll use for all your development work. 

Create a folder in the Development folder and call it Hello Folder. 
Do this now, before you start 1HINK C. You can use a different name if you 
like, but remember that your dialog boxes won't match the pictures in this 
chapter. 

Generally speaking, you'll have a folder for each project you work on. The 
folder should contain your source files, your #inc1ude files, and the applica­
tion's resource file. 

When you've created the Hello Folder, open the THINK C 5.0 
Folder (the one that contains the 1HINK C application) and double click 
on the 1HINK C icon. 

You'll see a dialog box that asks you to open a project. 

I CSl TH I NK C Folder I 
D C Libraries ~ 
CJ Mac #includes 
CJ Mac Libraries 
CJ oops 

Figure 3-1 Opening a project 

E::) Moose 

( ) 

( Driue ) 

U Open n 
( New~ 
( Cancel~ 

Since you're creating a new project, click on the New button. You'll see an­
other dialog box, one that lets you create projects. 

Move back to the Hello Folder you just created. 
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3 Tutorial: Hello World . ------------------------------------------------------------

Warning 
It's very important that you move to the Hello Folder. 

Name the project hello project, and click on the Create button. 

I a Hello Folder I 
Q G::=l Moose 

( [j.~e1 ) 
( Driue ) 

{) 

n create) Name new project: 
~ I hello project ( Cancel J 

Figure 3-2 Creating your new project 
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Creating the Project • 
THINK C creates a new project document on disk and displays a project 
window: 

hello project 
. Name obj sizeo 

~ 

r§ 
Q] 

Figure 3-3 The project window for a new project file 

The Name column shows the names of all the source files and libraries in 
your project, and the obj size column displays their sizes in bytes. 
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3 Tutorial: Hello World 

Creating the Source File 
Now you're ready to create your source file. Choose New from the Flle 
menu to bring up an empty editing window. 

et File Edit Search Project Source Windows Ill" 
hello proJect 

.. · . · . 
. . · . 

~~ ~~!~~i~~~!~~~!~!~~~~~~~~~~~~~~!~~~JI~ 
Figure 3-4 An empty editing window 

Type this program into the editor window (you don't need to type in the 
comments if you're in a hurry): 
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/***** 
* hello.c 
* * The hello world program for THINK C 
* 
*****/ 

#include <stdio.h> 

main () 
{ 

printf("hello world\n"); 



For more information about 
the THINK C text editor, see 
Chapter 8, "The Editor. II 

Compiling the Source File • 
The 1HINK C text editor works like most other text editors on the Macin­
tosh. You can drag to select a range of text or double click to select words. 
You can also triple click to select an entire line. If you have a keyboard with 
arrow keys, you can use them to move around your me. 

The text editor does not wrap text back to the left edge of the window when 
you type past the right edge of the window. Use the horizontal scroll bar at 
the bottom of the window to see any text that goes past the right edge. 

When you've typed in the program, select Save As ••• from the Flle menu to 
save it. You'll get a dialog box like the one below. Name the file hello. c, 
and click on the Save button. 

la Hello Folderl 

~ c::l Moose 

( I:j.~~~1 ) 

( Driue ) 

p 
Saue file as: n Saue ;JJ 

( cancel] 

Figure 3-5 Saving a new file 

THINK C will compile only files that end in . c, but you can edit any text file 
with the TIIINK C editor. 

Compiling the Source File 
Using the Compile com- Now you're ready to compile your source file. Select Complle from the 
mand in THINK C is like us- Source menu. TIIINK C displays a dialog box that shows how many lines 
ing the cc command in have been compiled. 
UNIX, except that THINK C 
adds the object code to 
your project, instead of cre-
ating a separate object file. 
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II 

Tutorial: Hello World 

When THINK C compiles a source file, it adds its name and size to the proj­
ect window. Your project window should now look like this: 

Figure 3-6 The project window with one file 

TIllNK C keeps all the object code for your source files in the project docu­
ment 

Did you get an error? 
If you made a mistake typing the program, THINK C will display an error 
message in a dialog box. The message may say "syntax error." In this small 
program, about the only syntax error you can make is forgetting a quote, a 
parenthesis, or a semicolon. 

Click anywhere in the dialog box to get rid of it. THINK C puts the insertion 
point in the line with the error. Look over your program to make sure every­
thing is correct. Then select Complle from the Source menu. 

If you get an error message that says "can't open file" like this one: 

can't open #include'd file 

II 
Figure 3-7 An error message 
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To learn more about the 
routines in the ANSI li­
brary, see the Standard li­
braries Reference. 

Adding the Library • 
it means that TIlINK C wasn't able to find the #include file stdio. h. TI-ITNK 
C can't find the #include files if you didn't move the Libraries folder into 
the THINK C Folder. The best thing to do now is to start over from the 
beginning. 

Quit TIlINK C and move the Hello Folder to the Trash. Then look in 
Chapter 2, "Installing TIlINK C 5.0," to make sure you installed TIlINK C 
correctly. Once you're sure everything is OK, start again from the beginning 
of this chapter. 

Warning 
Throw the Hello Folder into the Trash only if you're 
starting all over. If you didn't get the "can't open file" error 
message, go on. 

Adding the library 
If you tried to run your program now, you'd get linking errors because the 
project doesn't know where the printf () function is defmed. 

Next, you need to add the ANSI library to your project. It defines the routine 
printf () and all the standard C library routines. To add the ANSI library, 
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3 • Tutorial: Hello World 

choose Add .•• from the Source menu. You'll see a dialog like the one in Fig­
ure 3-8. 

16) C Libraries I 
D RNSI ~ 
D RNSI-R4 
D RNS I-small 
D headers 
D profile 
D sources 
D uniH 

c::::::J Moo s e 

( ) 

( Driue ) 

( [l(lrl(~ ) 

( Cancel) 

€ Rdd J\ ) 
( Add All ) 
( H(~rnOl~(~ ) 

Figure 3-8 The Add ... dialog. 

, 
The top list displays the source files and libraries in the folder you're current-
ly in. The bottom list shows the fIles THINK C will add to your project when 
you click Done. The Add and Add All buttons move fIles into the bottom list. 
The Remove button removes files from the bottom list. 

Move to the folder called C Libraries. This folder contains all the librar­
ies for ANSI and UNIX compatibility, including the ANS I library. Select 
ANSI, and click on the Add button. The file moves to the bottom list. Now 
click on the Done button 
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Using the Run command in 
THINK C is like doing all 
this in most other compil­
ers: compiling your project's 
files, linking it, and run­
ning it. However, Run 
doesn't save a copy of your 
application to disk before 
running it. To save it, use 
Build Application"" de­
scribed below. 

Running the Project • 
TIllNK C adds the name ANSI to the project window. Your project window 
should look like this: 

hello pr 

Figure 3-9 The hello project window with both its files 

The object size for the ANSI library is zero since TIlINK doesn't load a li­
brary's code until you need it. This lets you add several libraries without 
waiting for them to load. 

TI-llNK C loads a library automatically when you run the project. Another 
way to load a library is to click on its name in the project window, and then 
choose Load library from the Source menu. For this example, let TIUNK C 
load it for you. 

Running the Project 
Everything is all set to run the project. The source file is in the project win­
dow along with the libraries you'll be using. Now select Run from the 
Project menu. 
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3 Tutorial: Hello World • 

For more information on 
console windows, see the 
Standard Libraries Refer­
ence, Chapter 3, "Using 
Console Windows." 

TIllNK t notices that the library needs to be loaded, so it puts up a dialog 
box asking you if you want to bring the project up to date: 

Lt Bring the project up to date? 

K )] Yes ( No ) 
( Malee ) ( Cancel ) 

Figure 3- lOA dialog box asking if you want to update your project 

Click on the Yes button. mINK C goes to disk to load the code for the ANS I 
library. It may take mINK C a little time to load it. Once it's loaded into the 
project, though, mINK C doesn't need to load it again. 

Any time you choose to run your project and mINK C notices that you've 
made changes (added libraries or source files or edited source files) it will 
ask you if you want to update the project. !fyou say yes, it will compile the 
new or changed files and load the new libraries. 

Since this program uses the ANSI library, everything printf () writes goes 
to a console window. A console window a Macintosh window that behaves 
like a simple display terminal, the kind of terminal that many MS-DOS and 
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,. • File Edit 

Creating the Application • 
UNIX computers use. You'll see the "hello world" string at the bottom of this 
window. 

., 
............................................................................................................................... .. .. .. .. .. .. .. .. .. .. ...... .. .. .. .... .. .. .. .... .. .. .... .. .... .. .. .... .. ............ .. .. .... .. .. .. .. .. .. .. .... .. .. .. .. ...... .. .. .. 

press «return» to eHit 
lit 

hello world! 

............................................................................................................................. .:,. 
Figure 3-11 Your program running in a console window 

To exit the program, press the Return key or choose Quit from the Flle 
menu. 

Creating the Application 
As you develop a large application, you make changes to your source files. 
Each time you run your project, mINK C will recompile only those files that 
have changed. When you're ready to turn your project into a stand-alone 
double-clickable application, select Build Application .•• from the Project 
menu. 
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• 3 Tutorial: Hello World 

You'll see a dialog box asking you to name your application. Name it 
hello appl. Leave the Smart Link box checked. This option tells mINK C 
to make your application as small as possible 

I a Hello Folder I 
D h(~Uo Jlro j(~( t 
r.) tH~UO,( 

Saue application as: 

I hello appl 

l8J Smart Link 

Figure 3-12 Building your application 

c:JMoose 

( 1:j.~.~1 ) 
( Driue ) 

U Salle kJ 
( cancel) 

1HINK C puts up a dialog box telling you it's linking your application. When 
it's finished, the application will be in the folder you chose. 

If you're running without MultiFinder or System Software 7.0, quit mINK C 
to run your application. Use the Quit command in the Fne menu. If you're 
using MultiFinder or System Software 7.0, you don't need to quit first. Just 
bring up the window with the folder your application is in. Double click on 
your application and watch it run. That's all there is to it. 

Where to Go Next 
The tutorial in the next chapter is a more elaborate example of building an 
application with mINK c. It describes how mINK C reports errors when 
you compile and link, and it will show you some advanced features of the 
1HINK C editor. 

If you would rather explore on your own, read the chapters of the "Using 
1HINK C" section that interest you. Or if you want to learn how to use 
1HINK C's source level debugger, now, go to Chapter 5, "Tutorial: Bullseye," 
and follow the tutorial there. 
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Tutorial: 
MiniEdit. 

4 
M.niEdit shows you how to use the more advanced features ofTIflNK C. 

You'll build a small text editor based on the sample application described in 
Chapter 1 of /nstde Mactntosb I. One of the source files has a small, inten­
tional bug to show you how 1HINK C makes it easy to fix mistakes. 

You'll learn how to create a project, how to fIx mistakes, how to run a 
project, how to build an application, and how to use a resource fIle. 

Before you begin 
If you didn't follow the "hello world" example in the last chapter, read it now 
to get an idea of how 1HINK C works in general. 

Make sure the MiniEdit Folder is on your hard disk, since it contains 
all the fIles you need to follow this example. If you followed the directions 
in Chapter 2, "Installing 1HINK C 5.0," it should be inside the THINK C 

5.0 Demos folder inside your Development folder. To install it, run the 
self-extracting archive THINK C 5.0 Demos. sea on THINK C 2, and 
select your Development folder as the destination folder. 

What you should know 
You should know how to use the standard fIle dialog boxes to move around 
to different folders. If you don't know how to do this, read the documenta­
tion that came with your Macintosh. 

You will need to know which folder contains the fIle MacTraps. 

Contents 
Creating the Project .43 

Adding the Source Files and Libraries . 45 

Compiling and Running the Project . 49 

Fixing a Bug. . . . . . 50 

Running the Project Again . 53 
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• 4 Tutorial: MiniEdit 

Building the Application 

Using a Resource File 

Finishing Up . . 

Where to Go Next . 
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Creating the Project 

Creating the Project • 
Make sure the MiniEdit Folder is on your hard disk, since it contains 
all the files you need to follow this example. If you followed the directions 
in Chapter 2, "Installing THINK C 5.0," it should be inside the THINK C 
5.0 Demos folder inside your Development folder. To install it, run the 
self-extracting archive THINK C 5.0 Demos. sea on THINK C 2, and 
select your Development folder as the destination folder. 

Generally speaking, you'll have a folder for each project you work on. The 
folder should contain your source files, your header files, and the applica­
tion's resource file. 

Open the THINK C 5.0 folder, and double click on the THINK C icon 
to begin. You'll see a dialog box that asks you to open a project, as in Figure 
4-1. 

151 THINK C Folder I 
D C Libraries :B 
CJ Mac #includes 
CJ Mac libraries 
CJ oops 

Figure 4-1 Opening a project 

( 
( 

c::lTess 

) 

Driue ) 

Open 

New 

Cancel 

Since you're creating a new project, click on the New button. 

When you get the next dialog box, move to the MiniEdi t Folder, and 
name your project MiniEdi t . x. Project names don't have to end in . x, 
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4 Tutorial: MiniEdit . ------------------------------------------------------------

though it's a good idea. For this example, it is important that you name your 
project MiniEdi t . x, as in Figure 4-2. (To make a x, type Option-p.) 

I a MiniEdit Folder I 
r.~ HU~j~j~j[d~ t,c: ~ c:::::::JTess 

r.~ rnin~, nl(~,( 
( ] r) rn~n~,J~~·~n1 ,( I l:.j.~~~1 

D rnini,n~indon~~ .. 1: ( nril~(~ ) 
[) ~~n~[di t 11 ,r~n~ 

D ~ini[dit,h K) 

Name new project: n Create B 
I MiniEdit.l1 I ( Cancel ) 

Figure 4-2 Creating a new project 

Warning 
It's very important to move back to the MiniEdit 
Folder. 
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Adding the Source Files and Libraries • 
Click on the Create button. TIIINK C creates a project document on disk, 
and displays an empty project window, like Figure 4-3. 

MiniEdit.1t 
Name obj size 

Q 

Q 
Q] 

Figure 4-3 The project window for a new project file 

Adding the Source Files and libraries 
Now you're ready to add the source files and the MacTraps library to your 
project. All the source files for MiniEdi t .1t are in the MiniEdi t 
Folder. 
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4 Tutorial: MiniEdit . --------------------------------------------------------------

Select Add ••• from the Source menu. You'll see the dialog in Figure 4-4. 

I a MiniEdit Folder I 
D BuggyEdit.c ~ 
D mini.file.c 
D mini.print.c 
CJ mini.windows.c 
D pleasewait.c 

Figure 4-4 The Add ... dialog. 

( [j~~.~1 ) 

( Driue ) 
............................................ 
( [l(~r~(~ ) 

( Cancel] 

I Rdd D 
( Rdd RII~ 

( H(~rnOl~(~ ) 

The top list displays the source files and libraries in the folder you're current­
ly in. The bottom list shows the fIles mINK C will add to your project when 
you click Done. The Add and Add All buttons move files into the bottom list. 
The Remove button removes files from the bottom list. 
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Adding the Source Files and Libraries • 
Click on the Add All button. TIIINK C moves all the source files in the 
MiniEdi t Folder into the bottom list. The dialog should look like Fig­
ure 4-5. 

I a MiniEdit Folder I 
E:::J Tess 

( [j~~~~1 ) 
( Driue ) 

............................................ 

( Done ) 
( Cancel ) 

........................................................................................................................................................................ 
BuggyEdit.c 
mini. file.c 
mini.print.c 
mini.windows.c 
pleasewait.c 

Figure 4-5 Adding the MiniEdit source files. 

~ 
( 
( 

Hdd J 
Add All ) 
HHrnOt~(~ ) 
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4 Tutorial: MiniEdit . ---------------------------------------------------------

Don't click on the Done button yet. You still need to add a library. Move to 
the Mac Libraries folder, and add the MacTraps library by selecting it 
and clicking the Add button, as in Figure 4-6. 

la Mac Libraries I 
[) RppleEuents 
[) RppleTal1< 
[) CommToolBoH 
[) Graf3D 
[) MacTraps 
[) nRppleTalk 
[) PrGlue 
[) SRNE 

BuggyEdit.c 
mini. file.c 
mini.print.c 
mini.windows.c 
pleasewait.c 

Figure 4-6 Adding MacTraps to your project 
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( I:j.~{~1 ) 

( Driue ) 
............................................ 

( Done) 

( Cancel) 

€ Rdd ~ II 
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Compiling and Running the Project • 
All the files you need for this project are now in the project window. Click 
on the Cancel button now. Your project window should look like Figure 4-7. 

MiniEdit.l1 

o 
o 
o 

Figure 4-7 The MiniEdit.1t project window with all its files 

The obj size column displays the object size in bytes for each file. The sizes 
are all zero because you haven't compiled any files or loaded the MacTraps 
library. 

Compiling and Running the, Project 
Before you can run your project, you need to compile the source files and 
load the MacTraps library. You can use the Compile and Load Library 
commands in the Source menu, or you can let mINK C take care of every­
thing for you. 

THINK C uses the project document to keep track of which files need to be 
compiled, so you can go ahead and run your project. Choose the Run com­
mand from the Project menu. 
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• 4 Tutorial: MiniEdit 

None of the files in the project have been compiled, so TIllNK C asks you if 
you want to bring the project up to date, like Figure 4-8. 

Lh Bring the project up to date? 

[ Yes J ( No ) 
( Make ) ( Cancel ) 

Figure 4-8 A dialog box asking if you want to update your project 

Click on the Yes button. 

TI-llNK C starts compiling the first me in the project. It displays a dialog box 
that shows how many lines have been compiled. (TI-IINK C adds the num­
ber of lines in #includes files in the line count.) 

In this example, TI-llNK C doesn't get very far because BuggyEdi t . c has a 
small intentional bug. 

Fixing a Bug 
When mINK C finds an error in your source file, it opens the file that con­
tains the error and displays an error message in a dialog box. mINK C se-
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Fixing a Bug • 
lects the line the line that contains the error. In Figure 4-9, TIIINK C 
complains that a variable hasn't been defmed. 

r " File Edit Search .:rnIfiIil. Source Windows III" 
'my Window' has not been declared 

int OoMou»QOown (int windowPart, '-lindowPtr whichl-lindow, EventR.cord ... ...,e:v.n 

switch (windowPart) { 
case inGoAway: 

If (TrackGoAway(my'-llndow, myEvent->where» 
OoFi le(fmClose); 

break; 

case inMenuBar: 
return(DoCommand(MenuSelect(myEvent->where»); 

case inSys'-lindow: 
SystemClick(myEvent, which'-lindow); 
break; 

case inDrag: 
if (ours(which~indow» 

Orag~indow(which~indow, myEvent->wher., &dra9Rect); 
break' 

Figure 4-9 THINK C displays an error message. 

10 
... 

To get rid of the dialog box, click anywhere in it or press the Return or Enter 
key. 

Scroll toward the beginning of the file, and you'll see that the declaration for 
my Window is commented out, like Figure 4-10. 

BuggyEd~.C 

-include "MiniEdit.h" 

~indowRecord 
1* ~indowPtr 
TEHandle 
int 
Rect 

wRecord; 
my~indow;"'1 1* This is the «bugN *1 

TEH' 
I i n~s I nF 0 I der; 
dragRect = { 0, 0, 1024, 1024 }; 

Figure 4- lOA declaration that was commented out 

Remove the comments surrounding the declaration of my Window . 
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4 Tutorial: MiniEdit . ---------------------------------------------------------------

Now, compile the file BuggyEdi t . c. Choose the Compne command from 
the Source menu. THINK C will compile the source file without errors this 
time. Note that you don't have to save a file to recompile it. 

Before you run the project again, save the changes you've made to 
BuggyEdi t . c. Since the file no longer contains a bug, save it with a differ­
ent name. Choose the Save As ••• command from the Fne menu, and save 
the corrected file as MiniEdi t. c, as in Figure 4-11. (Make sure you're in 
the MiniEdi t Folder.) 

I f5l MiniEdit Folder I 
r.~ Hu~j~j~j[d~ t,(~ 2 E:JTess 

D rnini, nJ(~,( 
[ D rr~~r~~,'~~ir~1,( I 

[j.~(~1 ) 
D rnini,H~ indo U~i-,e [ Uril~(~ ) 
D ~inH:(Ht 11 
:'" ~ini[di t 11 ,ri-n~ K7 l .. : 

Saue file as: n Saue B 
I MiniEdit.c I ( Cancel ) 

Figure 4-11 Saving a file with a new name 

Now click on the project window. When you use the Save As ••• command 
on a me that is already in the project, THINK C changes the file's name in the 
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To save a file with a differ­
ent name without affecting 
the project, use the Save A 
Copy As ••• command. 

Running the Project Again • 
project window as well. The file's object code is now associated with the 
new name, as in Figure 4-12. 

MiniEdit.n 

Figure 4-12 The MiniEdit.7t project window with the new file name 

Now that you've fIxed the bug, you can try running the project again. 

Running the Project Again 
Choose Run from the Project menu. When TIIINK C asks you if you want 
to bring the project up to date, click on the Yes button. 

TIllNK C loads the MacTraps library, then it compiles all the files in the 
project. Since you already compiled MiniEdi t . c, TIIINK C doesn't recom­
pile it 
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4 Tutorial: MiniEdit • 
r • File Edit 

_D 

-include "MiniE I 

1-1 I ndowRecord 
I-lindowptr 
TEHandle 
int 
Rect 
MenuHandle 
ControlHandle 
Cursor 
Cursor 
char 

extern Str255 

-define ours(w 

main() 
{ 

int myRsrc; 

~I 

Once mINK C compiles the whole project, it launches it as if you had 
opened it from the Finder, like Figure 4-13. 

J ~~~~r, it."'" 
Untitled obj size-

~ 13060 ~ 
1370 
626 

1238 
1486 

8 

I 
..............••. ..•............. _ ..... 

~ 

K} 
Q] 

ro 
10 

Figure 4-13 Running MiniEdit with the THINK C environment 

If you're using MultiFinder or System Software 7, mINK C launches your 
project in its own partition, so you can shift from your project back to 
1HINK C. If you're not using MultiFinder or System Software 7, mINK C 
launches your project as if you had started it from the Finder. When you quit 
running your project, mINK C starts up again automatically. 

Play with the MiniEdit application for a while if you like. You might want to 
make some changes. When you're satisfied with how the project runs, 
you're ready to turn it into a double-clickable application. 
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@ Rpplication 

Building the Application 

Building the Application • 
Turning your TIIINK C project into an application is easy. Choose the Set 
Project Type ••• command from the Project menu. You'll see the dialog box 
in Figure 4-14: 

o Desk Rccessory 

File Type I RPPL 

Creator 11111 o Oeuice Oriuer 

o Code Resource 

Partition (K) ~ 

SIZE Flags ~ 10080 I 

OK )] 

o Far CODE 

o Far DRTR 

o Separate STRS 

( cancel) 

Figure 4-14 The Set Project Type ... dialog 

Set the creator to CEM8. This will ensure that your application will have the 
right icon when you build it. 

CEM8 doesn't stand for 
anything. It's just unlikely 
that any other application 
on your disk has that signa-
ture. Set the partition size to 128K. Since MiniEdit is such as small program, it 

doesn't need the default 384K partition size. The Macintosh uses the parti­
tion size to determine how much memory to give to your application. 

THINK C User Manual 55 



4 Tutorial: MiniEdit . -------------------------------------------------------
When the dialog box looks like Figure 4-15, click on the OK button: 

@ Rpplication 

o Desk Rccessory 

o Deuice Driuer 

o Code Resource 

Partition (K) ~ 

SIZE Flags ~ 10080 I 

[( OKW 

File Type I RPPL 

Creator I CEM8 

D Far CODE 

D Far DRTA 

D Separate STRS 

( cancel) 

Figure 4-15 Setting the project type for MiniEdit 
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Using a Resource File • 
Choose Build Application ••• from the Project menu. You'll see the dialog 
box in Figure 4-16. 

Ie MiniEdit Folder I 
r.~ HU~j~j~jl:di t,.~ 2 c:JTess 

r.~ rnini, n)(~,( 
[ ) 

r.~ rnini,pl·.n1,( I 
I:jt~.~1 

D rnini,H~indoH~i>,~~ ( nrh.~(~ ) 
D Minil:lii t, 11 

D MinH:di t, 11 ,ri>n~ 0 

n saue;J Saue application as: 

I MiniEdit I [ Cancel ) 
[8] Smart Link 

Figure 4-16 Building the MiniEdit application 

Name the application MiniEdi t. Leave the Smart Link box checked. This 
option tells THINK C to make the application as small as possible. 

As it's building the application, THINK C gives you status messages. First it 
links all the object code. Then it copies the resource file for the project into 
the application. (The next section tells you how to use a resource me with a 
project.) When it's finished, you'll have a new application in the MiniEdi t 
Folder. 

MiniEdit 
Figure 4-17 The MiniEdit icon 

Using a Resource File 
The MiniEdit Folder you copied from disk THINK C 4 contains a 
file called MiniEdit.1t. rsrc. This file contains the resources that the 
MiniEdit project uses. 
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4 Tutorial: MiniEdit • 
For more information on 
SARez, see Chapter 78, 
"Using SARez. " For more 
information on resource 
files, see Chapter 77, "Re­
source Description Files. " 

When THINK C runs your project, it looks for a file named 
projectnameo rsrc. (1bat is, the name of your project plus the characters 

o r s rc appended to it) This file should contain the resources (menus, 
alerts, dialogs, etc.) that your project uses. 

To create a resource file, you can use Apple's SARez or ResEdit utilities 
(they're included in your THINK C package). MiniEdi t oX 0 rsrc was cre­
ated with ResEdit, so there's no resource description file for it. 

Finishing Up 
When you're ftnished working on a project, you can either close the project 
or quit TI-IINK C. To close the project, use the Close Project command in 
the Project menu. When you close a project, 1HINK C displays a dialog box 
that lets you open or create projects. 

To quit TIIINK C, choose Quit from the File menu. 

Where to Go Next 
The tutorial in the next chapter shows you how to use THINK C's source lev­
el debugger. It shows you how to activate the debugger, how to trace 
through your code, and how to examine and change the values of your vari­
ables. 

If you feel comfortable with what you know so far, you might want to start 
creating your own applications right away. Use the next part of the manual, 
"Using TIIINK C", when you need help on a particular topic. You'll probably 
find Chapter 8, "The Editor," useful now. 
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Tutorial: 
Bullseye + 

5 
BUllseye shows you how to use WINK C's source level debugger. Bullseye is 

a simple application that draws a series of concentric circles in a small win­
dow. Its Width menu lets you select how wide each of the rings is. 

Before you begin 
Make sure you're using System Software 7 or running MultiFinder under Sys­
tem 6.0.x on a Macintosh with at least 2Mb of memory. 

Make sure the Bullseye Folder is on your hard disk, since it contains 
all the files you need to follow this example. If you followed the directions 
in Chapter 2, "Installing mINK C 5.0," it should be inside the THINK C 
5.0 Demos folder inside your Development folder. To install it, run the 
self-extracting archive THINK C 5.0 Demos. sea on THINK C 2, and 
select your Development folder as the destination folder. 

Make sure that the file THINK C Debugger is in the same folder as 
TI-nNK C (the THINK C 5.0 folder). This file must be named THINK 
C Debugger. 

What you should know 
Before you try this example, you should know how THINK C works. You 
should know how to open a project, how to edit source files, and how to run 
a project. If you're not familiar with any of these operations, go back and 
read (or try) the examples in the last two chapters. 

Contents 
Opening the Bullseye Project . 61 

Turning the Debugger On . . 61 
Generating the debugging tables . 62 
Running the project. . . 62 

Watching the Program Run. . . . 62 
The Source window . 63 
Stepping through statements . . 64 
Stepping into functions . 65 
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5 Tutorial: Bullseye • 
Stepping out of functions 65 
Tracing every statement . 66 
Setting a breakpoint . . 67 
Letting the program run . 69 
Stopping the program 69 
Viewing other ftles 70 

Examining and Setting Variables 70 
The Data window. . . . 71 
Examining variables . . . . 71 
Changing the value of a variable 74 

Examining structs and arrays. . . 75 

Expressions and Contexts. . . . . . . . . . . . . 80 
How and when the source debugger evaluates expressions 81 
Display formats 81 

Quitting the Debugger. . . . . . . . . . . . . . 82 
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three source files E 
the MacTraps library ~ 

Opening the Bullseye Project • 

Opening the Bullseye Project 
If you're at the Finder, double click on the Bullseye.1t project in the 
Bullseye Folder. If you're already in THINK C, use the Open Project ••. 
command in the Project menu to open the Bullseye.1t project. 

Bullseye consists of three source files and the MacTraps library shown in 
Figure 5-1. 

bullseye 11 
Name obj size 
bullMenus .c 0 Q 
bullseye.c 0 
bullYindo'W .c 0 

... ~~~!..~.~.p..~ ........................................... 0 ....................... 

Q 
--'--

Q] 
Figure 5-1 The bullseye.1t project window 

Note that none of the files have been compiled, and that the MacTraps li­
brary hasn't been loaded. 

Turning the Debugger On 
THINK C ordinarily runs your project without the debugger. Choose the Use 
Debugger command from the Project menu. 
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The "bug" column 

When the source debugger is on, TIIINK C adds a "bug" column in the 
project window to the left of the Name column. 

Figure 5-2 The bullseye.1t project window with the debugger turned on 

Generating the debugging tables 
The gray diamonds in the "bug" column let you know that nHNK C will 
generate special debugging tables for a source file. These tables go into your 
project document along with the source files' object code. TIIINK C never 
generates additional code when you run the debugger. 

Running the project 
Choose Run from the Project menu to let TfllNK C compile and load all the 
files in your project. TIIINK C will generate debugging tables for all the files 
as well. 

Watching the Program Run 
Instead of running your project, TIIINK C launches the source debugger, 
which controls the execution of your program. The debugger displays two 
windows at the bottom of your screen. If you're using two screens, the de­
bugger windows are on the second screen instead. 

The window on the left is the Source window. It contains the source text of 
your program. The window on the right is the Data window. You use this 
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Watching the Program Run • 
window to examine and set the values of your variables as you debug your 
program. 

Data 

iii[:::~:~:::::::milic::::~~:~~::::::::m:::::::~~::::]C:::::o:~t 
I main<) 

I { 
0+ 
ol 
o! 

I 

I 
• 

I n i tHae intosh ( ) ; 
Se tupHenus ( ) ; 
Se tup,", I ndow ( ) ; 

for (;;) 

main 

Figure 5-3 The THINK C debugger 

The Source window 
The Source window shows you the source of your program. The title of the 
window is the name of the source file you're looking at. 

bullseye.c 

status panel ~ 11!i:::::::~~:::::::IIIIII[::::~!~~:::::::IlI::::::):~:::::::IiI:::::::€~!:::::::ll[::::f~~~~::::]lllliiI:~~~~:::~:::ml 
i. rna in() 

current statement ---t-~ 
arrow It { 

~ 

I <>., c: <>1 
statement markers~ <>1 

InitMacintosh(); 
Se tUpMenus ( ) ; 
SetUpW i ndow( ); 

for (;;) 

current function --I-'" ..... t----.. main ..,.. 

Figure 5-4 The source window of the THINK C debugger 

The Source window shows the source text of your program. When you 
start the debugger, this window shows the file that contains the main ( ) 
routine of your application 

The top of the Source window has a six bu tton status panel. These buttons 
control the execution of your program. The names of these buttons match 
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the commands in the debugger's Debug menu. Right now, the Stop button 
is lit to show you that your program is stopped. 

The black arrow to the left of the first line of the program is the current 
statement arrow. This indicator shows you the current statement, the 
one that the debugger is about to execute. 

The column of diamonds running along the left side of the source text are 
statement markers. Every line of your program that generates code gets a 
statement marker. Later, you'll use the statement markers to set breakpoints. 

The source debugger uses the space at the lower left of the source window 
for the name of the current function. When you click here and hold the 
mouse button down, the debugger displays a pop-up menu that shows the 
call chain-the names of the functions that were called to get to the current 
function. 

Stepping through statements 
Click on the Step button in the status panel, like in Figure 5-5 

bullseye.c 

Ili[::::~~:::::::lillli[::::~!~~::]i[:::~~:::::::!iI::::::~~~:::::::li[::::~~~~~::::::I!!!!I[~::~!~~::~:::1l!1 
main() 

{ 
<>1 
<>~ 

OJ 

<>1 

• 

I n i tMac intosh ( ); 
Se tUpMenus ( ) ; 
Se tUpW i ndow ( ) ; 

for (;;) 
HandleEvent(); 

main 

Figure 5-5 Stepping through the program 

Kr 

I 
The Step button lights up for a moment, the current statement arrow moves 
to the second statement, and the program stops again. 

The Step button lets you execute your program line by line. You can use the 
Step command in the Debug menu or type Command-S to do the same 
thing. 
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Instead of pressing the In 
button, you can also choose 
the Step In command in the 
Debug menu or type 
Command-I. 

Instead of pressing the Out 
button, you can also choose 
the Step Out command in 
the Debug menu or type 
Command- O. 

Watching the Program Run • 
Press the Step button (or type Conunand-S) one more time so the current 
statement arrow points to the call to SetUpWindow () . This function cre­
ates the window that Bullseye uses. 

Stepping into functions 
To see how SetUpWindow () works, press the In button on the status pan­
el. 

Now the current statement arrow points to the first line of the 
SetUpWindow () function. This function is in the file bullWindow . c, so 
the title of the window changes to let you know what file it's displaying. 

buliWindow.c 0 

111[:::~:~::::]llli[::::~:~~~::::::::IICE:J[:::€~~:::::::1ii::::::~~~~~::::::::lillliII:~~~~:::~]111 
I SetUpWindow() 

~ 

i 1 { 

<>~ 
<>~ 
<>1 
<>1 } 

drcgRect = screenBits.bounds; I 
bul IseyeWindow = NewWindow(OL J &windowBoundsJmm 
SetPort(bul IseyeWindow); ~ 

K7 
• SetUpYindoy to [ ]lmmmmmmmmmmm~mmmmmmmm~mmm119121 

Figure 5-6 Inside SetUpWindowO 

Note 
The current statement arrow doesn't have to be right before 
a function call for the In button to work. The Step In com­
mand executes every statement until the program counter 
is no longer in the current function. Another way to think of 
the Step In command is: "Keep going until you fall into a 
function. n (Step In also stops execution if you fall out of 
the current function.) 

Stepping out of functions 
You can see the entire SetUpWindow () function in the source window. It's 
a pretty straightforward function, and you can rest assured it works. 

Click on the Out button to leave the SetUpWindow () function. 
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Instead of pressing the Trace 
button, you can also choose 
the Trace command in the 
Debug menu or type 
Comman d-T. 

The Source window now shows that the debugger is ready to execute the 
function HandleEvent () in the bullseye. c file. 

<>i 

01 
<>~ 
<>i } 

SetUpMenus(); 
SetUpWindow(); 

for (;;) 

bullseye.c 0-

Hand I eEven t ( ); 

I 1* end main *1 

• main 

Figure 5-7 Outside SetUpWindowQ 

The Out button steps through each statement in the current function until 
the current statement arrow leaves the function. 

Tracing every statement 
Now click on the Trace button. 

The current statement arrow now points to the first statement of the 
HandleEvent () function. 

mr=::::G:~:::::::jlllltr:::::s:t:~~::::::::jtr:::::I:~::::::iir:::::o:~t:::::::jlr=::::T~~:~~:::::~::llllm:::~:::s:t~~::~:::jili 

I:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::""-'::::::::::::::::::::::::::::::::: 

{ ~ 

o~ :~:~:::::::o:~~Event; ~ 
<>1 SystemTask (); 1* Handle desk accessorie 

<>! ok = GetNextEvent (everyEvent J &theEvent); mm 
<>1 if (ok) K} 
• H dl E t 11'1[ 1:1'101'1':-;'1'101'1'1'1'1'101'1':'1':'1';0:';':'1'1':':':'1':';':':';1 r\ rh 

an e yen I,,", Jimmmmmmmmmmmmmmmmmmmmmmml '"V t:..J 

Figure 5-Slnside HandleEventQ 
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Watching the Program Run • 
Tracing takes you to the next statement even if it has to step into a function. 
If you were to continue tracing, you'd stop at every statement. Stepping, on 
the other hand, never dives into a function. 

Note 
The In button actually does a Trace until the current state­
ment arrow leaves the current function. 

Setting a breakpoint 
Since the SetUpWindow () function opened a new window, the program 
will get an activate event the first time through the event loop. In Bullseye, 
all the program does on activate events is call InvalRect () on the whole 
window, so the second time through the event loop it gets an update event. 

You could Step or Trace to verify that this is what really happens. A faster 
way is to set a breakpoint at the function that redraws the window. 

Scroll down in the source window until you get to the code that handles up­
date events. Click on the statement marker to the left of the 
DrawBullseye () function. 

bullseye.c 

111[::::~:~:::::::IIIIII[::::~:~:~~::::::::I11:::::::':~:::::::li[::::~:~~:::::::II[::::T.:~;:~~:::::]IIIII[~::~:~:~~:::~]III 

• 

break; ~ 

case updateEvt: mm 
BeginUpdate(bullseyeWindow); .mm 
DrawBu I I seye( «W i ndowPeek) bu I I seyeW I Him 
EndUpdate(bul I seyeWindow); ~ 
break; 

case activateEvt: 

HandleEvent 

Figure 5-9 Setting a breakpoint 

The hollow diamond turns black to indicate that you've set a breakpoint. 
You can set as many breakpoints as you like this way. When your program is 
about to execute a statement that has a breakpoint, it will stop. To remove a 
breakpoint, just click in the filled diamond. 
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To start your program running, press the Go button. The program runs for a 
few moments and then stops. The current statement arrow is at your break­
point. 

Press the In button to step into the DrawBullseye () function. (This func­
tion is in the bullWindow. c file, so that's the file you see in the source 
window now.) 

buliWindow.c 

Ili[::::~~:::::::Iiiiii[::::€!:~~:::::::Il!::::::!~::::J[::::~~!:::::::IiI:::::::~~~:~~:::::::lillll[~:~:!~~:::~:::11II 
short active; {} 

{ 
Rect myRect; 

<>~ i nt co I or = true; I 
<>i SetPort(bullseyeWindow); 
<>l EraseRect(&circleStart); ~ 
<>i myRect = circleStart; K7 
• Dr ayBullsey e to l JHHmmmmmmmmmmmmmHWmWmmmwmn 0 l2:J 

Figure 5-10 Inside DrawBuilseyeO 

Click on the Step button to watch how the program draws a bullseye in the 
window. If you get bored, press the Out button. Whether you Step or Step 
Out, you'll eventually end back at the call to DrawBullseye (). 

bullseye.c 0 
IIlr::::G:~:::::::illllir:::::s:t:~~::::::::ilr:::::,:~:::::::IIi:::::::o:~t::::~::lir:::::T:~~:~~:::::::ii1IIIr:~:::S:t:~~:::E:::i!l1 

:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: "".::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

<>i +»­
<>i 
<>~ 

I 
• 

break; fO 
case updateEvt: I 

8eginUpdate(bullseyeWindow); .mm 
DrawBu I I seye ( ( (W i ndowPeek) bu I I seyeW I 111111 
EndUpdate(bullseyeWindow); ~ 
break; 

case activateEvt: 

HandleEvent 

Figure 5-11 Outside DrawBuilseyeO 
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Watching the Program Run • 
Note that the current statement arrow is hollow. This means that there are 
still some instructions left to execute in the statement. You'll see hollow ar­
rows when the statement is making an assignment or cleaning up the stack 
after stepping out of a function. 

Before you go on, clear the breakpoint. Just click on the fIlled diamond. 

Letting the program run 
Press the Go button to let the program run. You can set and clear break­
points while your program is running. 

When you click in the Source window to set breakpoints, your application 
will go to the background, and the debugger comes to the foreground. If 
you press the Go button when your program is running, the debugger brings 
it to the foreground. 

Stopping the program 
To stop your program, click on the Stop button or, if the debugger is the 
front-most application, press Command-Period. Your program will stop as 
it's coming out of one of the event-fetching routines (GetNextEvent () or 
wai tNextEvent ()). 

If your program is stuck in a loop or if you want to stop it without waiting for 
control to return to the event loop, you can use the panic button, Com­
mand-Shift-Period, to stop your program. Be careful when you do this, 
though, because the debugger will stop execution no matter what it's doing. 
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1,2 
___ bullseye TI' 

Viewing other files 
The Source window usually shows the file that contains the current state­
ment To look at another file in the Source window (to set breakpoints in it, 
for example) you tell TIIINK C to send the text to the debugger: 

1. Click on the TIIINK C project window 
2. Click on the name of the me you want to look at 
3. Select Debug from TIIINK C's Source menu. 
4. The file that you chose appears in the Source window. 

4 . 

, 
fldd 

'1 <id. " 
flerrullIe 
Get Info 

_I', , 
~ • The window !"OUtl".. for the Bull • ...,. . ..... , 

ctUH k Sunf em ill'Y 
f')'(~fll'(I( .~s~ 

[JI~ns~.~mblp. 

IIlndowPtr bull.eo"eIIlndow; 
flee t drogF\ec t; 

Pre(olll!)IIp. ... 
COrrlJlile ')('K 
1.01ul lIbr<l11J 
I'-Hlke ... >J«\ 

Browser XJ 

Figure 5-12 Viewing another file in the source window 

Now you can examine the me and set breakpoints in it. To get back to the 
current me, dick on the current function indicator at the lower left of the 
Source window or press the Enter key. 

Examining and Setting Variables 
Tracing your program's execution lets you see what your program is doing. 
But to really ftx bugs, you need to be able to examine your variables. That's 
what the Data window is for. 

If you've quit the Bullseye program, start it up again. Select Run from the 
Project menu, and when you see the debugger window, press the Go but­
ton in the status panel. 
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entry field 

The Data window 

Examining and Setting Variables • 
The Data window appears to the right of the Source window. The best way 
to think about this window is to treat it as a spreadsheet. 

Data 

enter button -t---------jH-----' 

deselect button -f----------li--------' 

expression column -f--~ 

value column -f--------H--.. 

Figure 5-13 The data window of the THINK C debugger 

Expressions you type into the entry field appear in the left column when 
you press the enter button (check mark) or when you press the Return or 
Enter key. Pressing the Enter key leaves the expression selected. Pressing 
the Return key leaves the entry field empty so you can type in the next ex­
pression. The ente~ button works just like the Enter key. 

If you change your mind and don't want to enter an expression, press the 
deselect button ex mark). The expressions you enter appear in the left col­
umn and their values are displayed in the right column. 

You can drag the center bar to make a column wider. 

To clear an expression in the Data window, select it and choose Clear from 
the Edit menu or press the Clear key. 

Examining variables 
Suppose you want to watch the value of the menuID variable in the 
HandleMenu () function. First, make sure the bullMenus. c file is dis­
played in the source window. If it's not, bring the project window to the 
front, click on the name bullMenus . c, and select Debug from the Source 
menu. 
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Next, scroll down until you see the HandleMenu () function, and set a 
breakpoint at the swi tch statement. Remember that you can set break­
points even while your program is running. 

After you set the breakpoint, click once on the line that contains the switch 
statement to select it 

buliMenus.c 
mr':~:::G:~::~~::'lllllr:::::s:t:;~::::::::IlI:::::::':~:::::::IIi:::::::o:~t:::::::'Ir:::::T:~~:~~::::::::'1111Ii:::::::s:t:~~::::::::1II1 

::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

int 
Str255 
GrafPtr 
WindowPeek 

{ 

menultem = LoWord(mSelect); 
name; 
savePort; 
frontWindow; 

case applelD: 
GetPort(&savePort); 

Figure 5-14 Selecting the context for the debugger 

Em 
10 

You select a line to give the debugger a context for evaluating menuID. In 
this case, you're saying that you want to know the value of menuID right be­
fore the switch statement. 

Expressions in the Data window have either local scope or global scope. 
An expression has local scope if it refers to variables with dynamic storage; 
in other words if it refers to non-static variables local to a function. All other 
expressions have global scope. 

Click in the Data window. You'll see the insertion point blinking in the entry 
field. Type menuID in the entry field and press the Return key. 
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The debugger compiles the expression (it takes about a second) in the con­
text of the selected line. Right now, the Data window doesn't show a value 
for menuID because the program isn't stopped there. 

Data 0 

I 10(g] 
menulD ~ 

~ i--'"-

12l 
Figure 5-15 Entering menulD into the data window 

Now, go back to the Bullseye program. Click on the Bullseye window, click 
on the Go push button (or type Command-G) to bring Bullseye to the fore­
ground. 

Next, select 7 from the Width menu. Your program stops at the breakpoint 
when you release the mouse button, and the value ofmenuID appears in 
the value column. 

Data 0 

II 10(g] 
menulD 4 ~ 

Q 
l2J 

Figure 5-16 Examining the value of menulD 
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Any time your program stops, the source debugger displays the values of ex­
pressions that have global scope. Then it displays the values of expressions 
with local scope whose context is the same as the current function. Finally, 
the debugger clears the values of local expressions whose context is not the 
current function. 

Changing the value of a variable 
Click in the Data window again, and type menultem. This variable contains 
the item number of the selected menu item. When you press the Return key, 
the source debugger shows you its value. 

Data 0 

I 10[8] 
~-IO menulD 4 

menultem 7 ~ 

~ 
I2J 

Figure 5-17 Entering menultem in the data window 

To change the value of a variable, click on its value and type a new one in 
the entry field. When you click on the enter button, the value of the variable 
changes. Here's an example. 
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Click on the value of menultem (the right column) to select it. Its value ap­
pears in the entry field as well. Now type 8 as a new value for it. Click on the 
enter button to assign the new value to the variable. 

Data 0 

Ie 
menulD 4 

1~[8] 
:JO 

menultem 

~ 
I2J 

Figure 5-18 Changing the value of menultem 

When you click on the Go button, the Bullseye program behaves as if you 
had chosen 8 from the Width menu. 

To remove an expression from the Data window, select it and choose Clear 
from the Edit menu or press the Clear key. 

Note 
You can enter the same expression more than once in the 
Data window. You might want to do this to lock one of the 
expressions so you can compare it to the same expression 
later in the program. See "How and when the source de­
bugger evaluates expressions" on page 81. 

N ow choose the Clear All Breakpoints command in the Source menu to 
make sure there aren't any breakpoints set before you go on to the next sec­
tion. Then click on the Go button to start the program running again. 

Examining structs and arrays 
The data window lets you examine and modify structs and arrays, not just 
simple variables. When you display a struct or union in the data window, its 
value appears as struct OxOOOOOO or union OxOOOOOO. Arrays ap­
pear as [] OxO 0 0 a a o. (The real address appears instead of ax a a a a a 0, of 
course.) 
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When you double click on one of these values, the debugger displays anoth­
er window for the struct or array. 

Note 
Anything you read here about structs applies to unions as 
well. 

To see how this works, make sure the Bullseye program is still running. Dis­
play the file bullseye. c in the Source window, and set a breakpoint on 
the line right after the call to GetNextEvent () in the function 
HandleEvent () . 

bullseye.c 

111[:~:::~:~::~::1II1II!:::::::~:~:~~:::::]I!:::::::':~:::::::!11:::::::?:~~:::::::!11:::::::~:~~:~~::::::::!IIIII[::::~:~:~~::::::::!III 
01 
01 
oi 
+1 ¢! ~ 

H iii teMenu (0 ) ; 
SystemTask (); 

Kt 
. mill 1* Hand I e desk accessor I e 1=1=1= 

(everyEvent, &theEvent); ~ ok = GetNextEvent 
if <ok) 

switch (theEvent.what) 
{ 
case mouseOown: 

Figure 5-19 Setting a breakpoint in HandleEventO 
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Now click in the Bullseye window. The program will stop at the breakpoint. 
When it does, type theEvent in the entry field of the Data window, and 
press the Return key. 

Data 0 

I 10[g] 
menulO ~ menu I tern 
theEvent struct Ox098760 

~ 

~ 
l2:J 

Figure 5-20 Entering theEvent in the data window 

The debugger displays the word struct and the address of the struct. If 
you can't see the entire value, click on the center separator bar and drag it to 
the left. Or you can make the window bigger. 

Note 
If you don't select a line to give a variable a context, the de­
bugger uses the current statement. 
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Double-click on the value of theEvent. The debugger displays a window. 
The names on the left are the fields of the struct. 

~D- theEuent -0~ 

[8] 
what 8 Q message 577164 
when 1066595 
where struct oxo~ 
modifiers 129 

It 
~ 
'2:J 

Figure 5-21 Entering theEvent in the data window 

You can edit the values of the fields, but you can't edit the names. 

The what field indicates that you're looking at an activate event 
(activateEvt = 8). In activate events, the message field points to the 
window record that gets the activate event. 

Double-click on the message field. The debugger enters a new expression 
in the main Data window: theEvent. message. 

Note 
Double-clicking on the left column of any Data window 
creates a new entry in the main Data window. 
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Edit the expression so it reads * (WindowPtr) theEvent. message so 
you can look at the WindowPtr. 

Data 

_mo_-I strlllct Ox08CE8C 
theEvent str~~t Ox09S760 

Figure 5-22 Entering *(WindowPtr)theEvent.message 

Double-click on the value of the new expression. The debugger displays an­
other struet window. 

=0= *(Win(~wPtr)the §0§ ,,. 

[8] 
device 0 Q portBits struct Ox08CE8E 
portRect struct Ox08CE9C 

I visRgn Ox099A94 
cl ipRgn OxOA5DEA 
bkPat [ ] Ox08CEAC 
fi IIPat [ ] Ox08CEB4 
pnLoc struct Ox08CEBC ill 

pnSize struct Ox08CECO' ~ pnMode 8 

Figure 5-23 Examining the fields of *(WindowPtr)theEvent.message 
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Scroll down to the pnPat field, and double-click. You'll see an array win­
dow. 

=0= (*(WindornPtr)th. ~BJE 

I ~0[g] 
0 OxFF 0 
1 OxFF 

I 
2 OxFF 
3 OxFF 
4 OxFF 
5 OxFF 
6 OxFF 
7 OxFF 
8 OxOO ~ 
9 OxOO '2J 

Figure 5-24 The array *(WindowPtr)theEvent.message.pnPat 

Because C compilers don't enforce array bounds, array windows have "infi­
nite" scroll bars. Unlike structs, you can select an index in the left column 
and change it. When you do so, the window shows the array from the index 
you entered 

When you double click on the value of a pointer variable, the debugger in­
serts a dereferenced expression in the Data window and displays its value. 
To see a pointer as an array, change its format to Address. 

To get rid of a struct or array window, you can click on its close box, press 
the Clear key, or select Clear from the Edit menu. When you use the Clear 
key or the Clear command, the debugger removes the expression associat­
ed with the window from the main Data window. If you click on the win­
dow's close box, only the window goes away; the expression in the main 
Data window remains. 

Expressions and Contexts 
You can enter any expression that does not have a potential side effect. That 
means you cannot enter assignment statements, function calls, or expres­
sions involving ++, --, +=, etc. 

Every expression you type in the entry field is compiled in a context. The 
context is the selected line of the Source window. If no line is selected, the 
context is the line that the current statement arrow points to. 
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To see the context of an expression, click on the expression in the left col­
umn of the Data window, and select Show Context from the Data menu. 
The source debugger will display the context in the source window. 

To change the context of an expression, click in the source window at the 
line you want to use as a context. Then select an expression in the Data win­
dow and choose Set Context from the Data menu. A shortcut is to hold 
down the Option key as you click on the enter button. 

If you edit an expression, its context will be the context of the original ex­
pression. You can change its context by holding down the Option key as 
you click on the enter button as described above. 

How and when the source debugger evaluates expressions 
Expressions in the Data window have either local scope or global scope. An 
expression has local scope if it refers to variables with dynamic storage; in 
other words, if it refers to non-static variables local to a function. All other 
expressions have global scope. 

Every time your program stops, the debugger evaluates the expressions in 
the Data window. It displays the values for expressions with global scope 
and the values of expressions with local scope. The values of expressions 
that don't have a global or local context are cleared to make the window less 
cluttered. 

If you want to make sure that the debugger doesn't redisplay a value, select 
it and choose Lock from the Data menu. A small lock icon appears next to 
the expression. This command is useful if you want to compare the value of 
the same expression at different times. You can also lock expressions to 
keep their values from being cleared when they go out of scope. 

Display formats 
The way the debugger displays expressions depends on their type. You can 
change the format with the formatting commands in the Data menu. To 
change a format, select an expression from the Data window. Then choose 
the format from the debugger's Data menu. 
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Not all formats are available for all types. Defaults are in italics: 

Type 
integers 
unsigned 
pointers 
arrays 
structs 
unions 
functions 
floats 

Formats Available 
decima4 hex, char 
hex, decimal, char 
pointer, address, hex, C string, Pascal string 
address, C string, Pascal string 
address 
address 
address 
floating point 

This is what the display formats look like: 

Format 
decimal 
hex 
char 
Cstring 
Pascal string 
pointer 
address 
floating point 

Example 
4523345,-23576 
OxA09E1487 
'c', 'TEXT' 
"abcdef\nghi\33" 
"\pabcdef\nghi\33" 
Ox7A7000 
[] Ox09FE44,struct Ox08FC14 
1961.0102 

The C string and Pascal string formats display non-printing characters in 
backslash form. Whenever it can, the debugger uses the built-in escape 
characters (\n, \r, \a)j otherwise, it uses \nn, where is an octal value. 

Of course, you can use type casting to use formats that aren't normally avail­
able. For example, if you really wanted to see the integer i as a C string, you 
would type this expression: ( cha r *) i. 

To see any pointer as an array, just change its format to Address. This way, 
when you double-click on its value, you'll see an array window instead of 
the value of what the pointer points to. 

Quitting the Debugger 
The best way to quit the debugger is to quit your application. You should 
use the ExitToShell command in the debugger's Debug menu only when 
you can't use your application's Quit command. 
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Overview + 
6 

Tt,is chapter describes the 1HINK C environment and how to write a program 
in TIDNK C. The rest of the chapters in this part of the manual discuss specif­
ic aspects of the components of the mINK C environment. 

Contents 
The mINK C Environment. . 87 

The Project . . . . . . . 87 

Writing a Program in mINK C . . 87 
Creating source files . . 87 
Adding libraries . . . . 88 
Compiling the program . 88 
Running the program . . 88 
Debugging the program . 88 
Building the application . 88 

Using mINK C . . . . . . 89 
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The THINK C Environment 
THINK C is a complete integrated development environment, not just a C 
compiler for the Macintosh. Traditional development environments consist 
of three separate applications: the editor, the compiler, and the linker. It is 
up to you create your source files with a text editor, run each file through the 
compiler, and finally link all your object files. 

In TIlINK C, the three components work together as parts of the same appli­
cation. This way, the TIlINK C compiler knows when you've edited a file. 
The compiler produces object code that the linker can put together in an in­
stant. Then TIlINK C can launch your program. And because TIlINK C is still 
running, it can launch the source level debugger so you can debug your pro­
gram. 

The Project 
The project is at the heart of the TIlINK C development environment. What 
you see on the screen is a project window. It contains a list of all the files 
that comprise your program. Next to each file name is the size of that file's 
object code. 

Rather than producing a separate binary object code file, TIlINK C keeps all 
the object code in the project document in ready-to-link form. 

Because the project document knows all the files that make up your pro­
gram (including header files), it can keep track of changes. When you edit a 
source file, the project manager marks it for re-compilation. When you edit 
an #include file, the project manager marks all the files that use it. 

Writing a Program in THINK C 
Writing a program in TIlINK C is like writing a program in any other devel­
opment environment. You create your source files, compile them, then link 
the object code to create an executable file. The difference is that in TIlINK 
C, you use the same application to do all of this. 

Creating source files 
When you write a program in TIlINK C, you create a project document. Usu­
ally, the project document is in a folder for all the files related to your pro­
gram. Next you create your source files and add your libraries. TIlINK C 
source files are standard text files, so you can use existing source files. The 
THINK C editor provides some features that help you edit C source code. Its 
search facilities include a pattern matching option based on Grep, and a 
multi-file search that looks for strings in any file in your project. 
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Adding libraries 
Virtually every program you write will need to access the Macintosh Tool­
box. You can call any Macintosh Toolbox routine exactly as it's described in 
Inside Macintosh. The code for Toolbox routines marked [Not In ROM] as 
well as the glue code needed to call some of the other Toolbox routines is in 
the MacTraps and MacTraps2 libraries. MacTraps handles the functions 
in Inside Macintosh I-V and the Gestalt Manager. MacTraps2 handles Inside 
Macintosh VI 

Your mINK C package also includes several other libraries you can use in 
your programs. The ANSI library contains the standard ANSI functions de­
fined in the ANSI standard. The unix library contains UNIX system func­
tions including memory calls. You can use these libraries when you port 
code from other systems. You can also create your own libraries in mINK C. 

Compiling the program 
The mINK C project manager knows when files need to be recompiled. If 
you edit a source file, the project manager marks it. If you edit an #include 
file, the project manager marks all the files that depend on it. You can ask 
1HINK C to bring your project up to date, or you can rely on the Auto-Make 
facility to do it for you when you run the program. 

Running the program 
1HINK C lets you run your program from mINK c. The project manager 
recompiles all the marked source files and loads any unloaded libraries. 
Then the mINK C linker links all your code together instantly. 

1HINK C launches your program as if you had double-clicked on it from the 
Finder. This way, you know exactly how your program will behave in actual 
conditions. If you're running under MultiFinder, mINK C launches your 
program in its own partition. Since mINK C is still running, you can look at 
your source files while your program is running. 

Debugging the program 
To help you get your program working correctly, you can use mINK C's 
source level debugger. The debugger lets you step through your code, set 
breakpoints, and examine and modify variables. You can set conditional 
breakpOints that stop execution only when certain conditions are true. 

Building the application 
Finally, when you're ready to put together the fmal application, THINK C's 
smart linker examines the object code in your project to make the final file as 
small as possible. 
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Using THINK C • 
The best way to learn TIUNK C is to follow one of the tutorials in Part Two 
of this manual. The rest of the chapters in this part of the manual describe 
the components of TIIINK C in detail. This summary shows you the basic 
steps you'll take when you write a program in TIIINK C. 

,. Create a project folder. Use the Finder's New Folder com­
mand in the File menu to create a folder for your project. This 
folder will contain the project and all the source files your project 
needs. 

2. Start THINK. C. Double click on the TIIINK C icon from the 
Finder. 

3. Create a new project. When TIIINK C starts, it will ask you 
(with a standard flle dialog) to open an existing project or to cre­
ate a new one. Click on the New button. A second standard file 
dialog will appear. Move to the folder you created for your proj­
ect, name your project, and click on the Create button. 

4. Create source flies. Use the New command in the File menu to 
get an empty edit window. To open existing source files, use the 
Open •.. command in the File menu. 

5. Save source flies. Use the Save command in the File menu to 
save source files. Source files must end in . c for TIIINK C to use 
them in a project. 

6. Add source flies. Use the Compile command in the Source 
menu to compile the active source file and add it to the project 
window automatically. If you want to add a source file without 
compiling it, use the Add command in the Source menu to add 
the front-most source file. Use the Add ... command to add 
source files you haven't opened with the TIIINK C editor. 

7. Add libraries. Use the Add ... command in the Source menu to 
add libraries to the project window. A dialog appears with two 
lists. The top one lists the contents of the current folder. The bot­
tom one lists the flles that TIIINK C will add to your project. You 
move files Add flles to the bottom list with the Add and Add All 
buttons. When you're done, click the Done button. 

8. Run project. Use the Run command in the Project menu to run 
your project. If there are un-compelled or changed source flles or 
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libraries that need to be loaded, mINK C will ask you if you 
want to bring the project up to date. Click on the Yes button. If 
you want to use the source level debugger, choose the Use De­
bugger command before running your program to turn it on. 

9. Build application. Use the Build Application ..• command to 
turn your project into a stand-alone application. A standard file 
dialog will prompt you for the name of your application. 
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You can write applications, desk accessories, device drivers, and any kind of 
code resource in mINK C. This chapter tells you how to build these four 
types of projects. The first section is about projects in genera1. It describes 
some of the internal components of projects, how to use resource files with 
projects, and the different types of projects. The second section tells you 
how to break up your project into segments. The remaining sections de­
scribe the four project types. 

What you should know 
You should know howTI-lINK C works. If you haven't done so, run through 
Chapter 4, "Tutorial: MiniEdit." That chapter takes you step by step through 
building an application in TIIINK C and gives you the practical background 
you need. This chapter deals with the more technical aspects of projects. 

This chapter shows you how to use TIIINK C to build programs, but it won't 
give you step-by-step instructions that teach you how to put them together. 

Contents 
Anatomy of a Project . 

The project types 
Components of a project . 
How mINK C puts projects together 
Using resource files with projects . 

Segmentation . . . . . . 
Moving files into segments 
Moving entire segments . 
Deleting a segment. . . 

Building Applications. . . . . . . . . 
Setting the application me type and creator 
Using a larger jump table with Far CODE. 
Using more global data with Far DATA . 
How Far CODE and Far DATA work .. . 
Mixing Near CODE and DATA with Far CODE and DATA 
Using a separate STRS component. . . . . . . 
Setting the partition size and SIZE resource flags . . 
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Running the project . . . . . . 104 

Building Desk Accessories and Device Drivers. 104 
Setting the project type . . . 105 
How drivers work. . . . . . . 107 
How to write mainO for a driver .. .. 108 
Getting the event record pointer from paramBlock 108 
Global data in drivers . . . . . . . . . . . . 108 
Using driver globals in callback and trap intercept routines 109 
Using libraries in drivers. . . . . 110 
Setting the fields of a driver's header 111 
Opening an open driver. . 112 
How to return from a driver 113 
The jIODone problem 113 
Multi-Segment drivers 114 

Building Code Resources . 115 
Setting the project type . . . . . . 116 
How to write mainO for a code resource 118 
Global data in code resources. . 118 
Using libraries in code resources . 119 
Locking code resources. . . . 120 
Code resource headers . . . . 121 
Merging code resources into files . 123 
Multi-segment code resources. 123 
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To learn about File Types 
and Creators (also called 
signatures), see Inside 
Macintosh III, Chapter 1, 
"The Rnder Interface" or 
Inside Macintosh VI, 
Chapter 9, "The Finder In­
terface. " 

Anatomy of a Project 

Anatomy of a Project • 
The project is at the heart of the TIIINK C development environment. It 
takes over the functions of several other files in traditional development en­
vironments. The project holds the object code of all your compiled source 
files and maintains the dependencies and connections among them. It keeps 
track of files that need to be recompiled or that depend on an edited header 
file. And if you're using the source level debugger, the project keeps the ta­
bles that the debugger needs. 

Warning 
You cannot put aliases in a project. However, you can use 
an alias of a project. See "Using Aliases" on page 155. 

The project types 
THINK C lets you build four kinds of projects: applications, desk accesso­
ries, device drivers, and code resources. To set the project type, use the Set 
Project Type ••• command in the Project menu. This command displays a 
dialog box that lets you set type-specific attributes for your project. For every 
project you can set the type and creator of the final file. 

@ Application 

a Desk Accessory 

a Deuice Driuer 

a Code Resource 

File Type I RPPL I 
Creator I_I 

Figure 7-' The file type and creator in the Set Project Type ... dialog 

The best time to set the project type is when you create a new project. You 
can change project types as you wish, but you have to recompile everything 
if you do so. There is a section in this chapter for each project type. Each 
section describes the type-specific settings. 

The File Type and Creator of a file let the Finder know what icon to display. 
The Finder treats some types, like RDEV, INIT, and cdev, specially. 

When you set the project type to something other than Application, the 
name of the Build Application ... command in the Project menu changes 
accordingly. For example, if you set the project type to Desk Accessory, the 
menu reads Build Desk Accessory .... 
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Changing the type of a project changes the way a project is built, not the 
way a program behaves. You can't turn an application into a desk accessory 
merely by changing the project type. Desk accessories are structurally differ­
ent from applications. The same applies for the other types. 

When you choose one of the Build •.. commands (Build Application ... , 
Build Desk Accessory~ •• , etc.) from the Project menu, TIUNK C creates a 
file and creates the CODE resources for applications, a DRVR resource for 
desk accessories and drivets, or the type of resource you specify for your 
code resource. mINK C also creates the resources it uses to manage global 
data and inter-segment calls. 

Components of a project 
Each source file or library in a project has up to four object components: 
(Not all project types use all four components.) 

ThJs component ... 
CODE 
DATA 
STRS 

JUMP 

Contains ... 
The executable code for the project. 
The global and static variables. 
String literals, in applications that have the 
"Separate STRS" option on. 
The jump table, which multi-segment 
projects use to determine the address of a 
routine. 

To examine the size (in bytes) of each component, select a source file in the 
project window a~d choose Get Info ... in the Source menu. The display 
also shows the segment and project totals. (For some components there is a 
small amount of overhead per segment or per project.) 

MiniEdit.c 

CODE DRTA STRS JUMP 

File 1698 380 0 72 

Segment 2 15360 1094 0 4272 

Project 16104 1094 0 4384 

(NeHt) (Preu) File [( OK J P~.~Ht]( Pn~u] Segment 

Figure 7-2 The Get Info •.. dialog 
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Depending on the kind of project you build, there are different limits on the 
sizes of these components: 

If project is a(n) ..• 
Application 

Single-segment 
desk accessory or 
device driver 

Multi-segment 
desk accessory or 
device driver 

Single-segment 
code resource 

Multi-segment 
code resource 

The limits are ••• 
CODE: 32K per segment 
DATA: unlimited per project, 32K per me, 

with Far DATA 
C32K per project, without Far DATA) 

JUMP: 2S6K per project, 32K per file, 
with Far CODE 
C32K per project without Far CODE) 

STRS: unlimited per project, 32K per file, 
if "Separate STRS" is on 
(No STRS if "Separate STRS" is of 0 

CODE: 32K per project 
DATA: 32K,per project 
JUMP is not used for single segment drivers 

CODE: 32K per segment 
DATA + JUMP: 32K per project 

CODE + DATA: 32K per project 
JUMP is not used for single segment code re­
sources 

Segment with main () : 
CODE for segment + 
DATA for project + 
JUMP for project: 32K 

Other segments: 
CODE: 32K 

If you exceed any of these limits, you'll see an error at link time. 

TIDNK C generates an 8 byte JUMP table entry for each function that is not 
declared static and for each function used in a non-call context (Le. 
whose address is taken). The jump table built by the Build ••• command 
may be smaller. The entry for each function that is only referenced within a 
single segment is removed. 
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To learn more about librar­
ies in THINK C see Chapter 
14, "Libraries." 

SARez is described in Chap­
ter 18, "Using SA Rez.II 
Res Edit is described in the 
book ResEdit 2.1 Refer­
ence (Addison/Wesley) by 
Apple Computer, Inc. 

How THINK C puts projects together 
When you choose a Build ••• command from the Project menu, TI-IINK C 
puts all the pieces of your project together as compactly as possible. THINK 
C uses a technique called smart linking to extract only the CODE elements 
it needs to build your application, desk accessory, device driver, or code re­
source. 

TIllNK C searches the project for files or libraries whose code is never refer­
enced and ignores them during the link. If you use a project as a library, 
TIllNK C takes only the code it needs from the project. If you use a library 
that you converted from a . reI file or one that you built with the Build U­
brary ... command, all of its code is included in the final me. 

Smart linking yields smaller code, but it takes several seconds longer to pro­
duce the final file. You can choose not to use smart linking; your mes are 
larger, but they come out faster. 

Note 
For desk accessories, code resources, and applications, 
TIllNK C checks the components' size limits (described 
above) after smart-linking. 

To turn smart linking off, choose your Bund .•• command from the Project 
menu as you normally do, then click on the Smart Link check box to clear 
the option. at's on by default.) See Figure 7-3 

After TI-IINK C finishes linking the object code, it produces the application, 
desk accessory, device driver, or code resource file. Finally, it copies any re­
sources you put in the project resource file into the final me. 

Using resource files with projects 
Most Macintosh applications use resources for menus, window templates, 
dialogs, etc. TI-IINK C makes it easy to use resources with your applications. 

Use ResEdit or SARez to create a file that contains the resources your pro­
gram needs. Save the resource file with the same name as your project plus 
. rsrc. For instance, if the name of your project is MyProject, name your 
resource file MyProject. rsrc. If your project is named 
SuperWizzy .project, THINK C looks for the project's resources in Su­
perWizzy.project.rsrc. 
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If you're building a code re­
source and the Merge op­
tion is on, the project's 
resource file isn't copied. 
See "Merging code resourc­
es into files" on page 123. 

Segmentation • 
Ie MiniEdit Folder I 

D HU~HHJI:~H t~; ~Tess 

D rnini, nl(~,( 
D rnini,p~'in1 ,( ( 1:j.~l;1 

D rnini,u~indou~i-,~~ ( nrh~(~ 
D ~lni[di t, 11 

D ~lnl[di t, 11 ,r~re 

Saue application as: n Saue 

I~ ( Cancel 

[8] Smart Link 

Figure 7-3 The Smart Link check box in a Build ... dialog 

Note 
Make sure the resource file is in the same folder as your 
project so TIIINK C can fmd it. 

) 
) 

D 
) 

When you choose Run from the Project menu, TIIINK C opens the re­
source file automatically, so your program can access its resources. 

When you choose one of the Build ••• commands from the Project menu 
(Build Application .•. , Build Desk Accessory ... , etc.) TIDNK C copies the 
resource file into the finished application. 

Warning 
TIDNK C does not support aliases. If you use an alias as 
your project's resource file, TIIINK C will not resolve the 
alias, but will use the alias file's alis resource as your 
project's sole resource. 

Segmentation 
Most Macintosh programs are made up of several segments. Segments are 
units of object code that can be swapped in and out of memory as needed. 
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To learn more about seg­
ments, see Inside Macin­
tosh II, Chapter 2, "The 
Segment Loader. " 

The Macintosh Operating System limits segments to 32K, so if you're writing 
a large program, you must segment your code. 

TIIINK C lets you segment not only applications, but also desk accessories, 
device drivers, and code resources as well. Applications can have up to 254 
segments. Desk accessories, device drivers, and code resources can have up 
to 30 segments. 

Moving files into segments 
Dotted lines separate segments, and the current segment has gray hatching 
running along the left edge. When you add files to your project, they're add­
ed to the current segment. 

MiniEdit.11 

MacTraps 
mini _ file _c 
mini _print_c 

Figure 7-4 A project with one segment 

To move a source file into another segment, click on its name in the project 
window and drag it below the dotted line. 

MiniEdit.11 

Figure 7-5 Moving a file to a new segment 
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Source files appear in alphabetical order within segments, so even if your 
program is small enough to fit in one or two large segments, you might want 
to break it down into smaller segments for cleaner organization. 

Moving entire segments 
If you want to rearrange whole segments at a time, hold down the Option 
key as you click and drag on any file name in the segment. The entire seg­
ment is placed before the segment where the drag ends. Moving segments 
affects only the project window display. 

Deleting a segment 
To delete a segment, move all the files from it into other segments. THINK C 
automatically gets rid of a segment when you move the last file out of it. 
When you use the Add ••• command, new files are placed in the current seg­
ment. 

Building Applications 
THINK C is set up to build applications by default. The Set Project Type ••• 
dialog gives you an opportunity to set some application attributes. Choose 
Set Project Type ••• from the Project menu, and you see the dialog in Fig­
ure 7-6: 

o Desk Rccessory 

File Type I RPPl 

Creator I 1111 o Deuice Driuer 

o Code Resource 

Partition (K) ~ 

SIZE FI ~ 10080 I ags r3 

OK )] 

D Far CODE 

D Far DRTR 

D Separate STRS 

( cancel) 

Figure 7-6 The Set Project Type ... dialog for applications 
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To learn about File Types 
and Creators (also called 
signatures), see Inside 
Macintosh III, Chapter 7, 
"The Finder Interface" or 
Inside Macintosh VI, 
Chapter 9, "The Finder In­
terface. " 

Setting the application file type and creator 
When you're building an application, the default file type is APPL. (For ap­
plications to work with the Finder, applications must be of type APPL.) Set 
the Creator to whatever you want your application's signature to be. The 
Finder uses the file's creator to link icons with specific applications (See In­
side MaCintosh III, Chapter 1, "The Finder Interface" to learn more about ap­
plications and icons.) 

Using a larger jump table with Far CODE 
If you're building a large application, especially one that uses the THINK 
Class Library, its jump table can grow large quickly. The jump table contains 
entries for the following: 

• Two entries for each virtual method 
• One entry for each routine called by a routine in another segment 
• One entry for each routine that you take the address of 

If you need a large jump table, check the "Far CODE" option. It allows a 
jump table as large as 256K, since it uses 32-bit absolute addresses instead of 
16-bit relative addresses. Your application will be about 6% larger because of 
the longer addresses. If the" Far CODE" option is off, your jump table can be 
only 32K. 

Note 
If the "Far CODE" option is on, each of your project's files 
can contribute only 4095 jump table entries (or 32K). 

Using more global data with Far DATA 
If you use a lot of global data, check the "Far DATA" option. It allows you to 
have an unlimited amount of global variables, since it uses 32-bit absolute 
addresses instead of 16-bit relative addresses. Your application will be about 
SO/o larger because of the longer addresses. If the "Far DATA" option is off, 
your project can contain only 32K of global variables. 

Note 
If the "Far DATA" option is on, each of your project's file 
can contribute only 32K of global data. This limit means, for 
example, that you can't use an array that's over 32K. 

How Far CODE and Far DATA work 
Far CODE and Far DATA both work similarly. You can have larger applica­
tions with more space for your jump table and global variables since THINK 
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C handles addresses into these areas differently. When these options are off, 
addresses into these areas are given as offsets from AS. In the Mc68000 fam­
ily, register-relative offsets must be 16-bits long, so these areas can contain 
only 32K. When the option is on, addresses to these areas are absolute ad­
dresses and can be 32-bits long. 1HINK C includes code in your application 
that adds the value of AS to these absolute addresses before your code runs. 

Mixing Near CODE and DATA with Far CODE and DATA 
If the "Far CODE" or "Far DATA" option is on and your application contains 
libraries that were compiled with those options off, put those libraries to­
gether in their own segment (or segments). 1HINK C places the jump table 
entries for those libraries in first 32K of the jump table. If the libraries are 
grouped together, 1HINK C won't waste space in the first 32K by placing in 
it entries that can be elsewhere. Also, if one of those libraries calls a function 
in one of your files, put that file in the same segment as those libraries. 

Using a separate STRS component 
THINK C normally places string literals in the DATA component of a project. 
When you check "Separate STRS" option, 1HINK C uses a separate STRS 
component to store string literals. 

When this option is off (the default), 1HINK C uses a 2 byte offset from reg­
ister AS to access the string literals. Not only is the code smaller but there's 
no need to do run-time address fix-ups. When the "Separate STRS" option is 
on, 1HINK C uses a 4 byte absolute address to access the string literals. 

The "Separate STRS" option is useful only if you need a library compiled 
with a previous version of 1HINK C. If your project contains a library that 
was compiled with the "Separate STRS" option on, you must turn on the 
"Separate STRS" option in your project, too. If you need more space for glo­
bal data, use the "Far DATA" option, described in "Using more global data 
with Far DATA" on page 100. 

Setting the partition size and SIZE resource flags 
THINK C uses the values you set in the Partition and SIZE Flags fields to 
build the SIZE resource your application needs to run under MultiFinder or 
System 7.0. 

The partition size determines how much memory your application gets. 
The default partition size is 384K, which is more than enough for moderate 
size applications. You'll want to use a higher value for larger applications or 
a lower value for small applications when memory is tight. 
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See" Apple Programmer's 
and Developer's Associa­
tion (APDA) " on page 74 
for more information 
about APDA. 

The SIZE Flags field sets the flags that tell MultiFinder and System 7.0 how 
compatible your application is and which features it uses. To learn how to 
write an application for the MultiFinder under System 5.0 or 6.0, order the 
Programmer's Guide to MulttFtnder from APDA. To learn how to write ap­
plication for System 7.0, see Inside Mactntosh VI For more information on 
the SIZE resource, see the chapter "The Event Manager" in Inside Mactn­
tosh VI 

You can type in the value of the flag (in hexadecimal) in the field, or you can 
set the bits from the pop-up menu next to the field. The pop-up menu is in 
Figure 7-7. 

Backgroun . 
Suspend & Resume Euents 

.............................................................................................................. 

Background Only 
Get FrontCUcks 
Rccept ChiidDiedEuents 
. . .................................................................................................................... 

32-Bit Compatible 
Hi 9 h L eu e I Eu e n t - Aware 
Accept Remote HlghLeuelEuents 
Statione -Aware 

Figure 7-7 The SIZE Flags menu 

The bits fall into three categories: basic MultiFinder support, extra MultiFind­
er features, and System 7.0 fealures. The first three bits describe how com­
patible your application is with MultiFinder and System 7.0: 

• If the MultiFinder-Aware bit is set, the Finder expects you to con­
form to the guidelines for shifting from the foreground to the 
background layers. Your application gets suspend/resume events 
as your application shifts from foreground to background but not 
activate/deactivate events. If MultiFinder Aware is checked, Sus­
pend & Resume events should be checked as well. 
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• If the Background Null Events bit is set, your application gets reg­

ular null events when your application is in the background. Oth­
erwise, your application gel$ only update events. 

• If the Suspend & Resume Events bit is set, your application gets 
these events as it shifts from 'the foreground to the background 
layers in addition to the activate/deactivate events you normally 
receive. 

Note 
If you're using the TI-llNK Class Library, be sure you check 
MultiFinder-Aware and Suspend & Resume Events. 

The next three bits explain which of the extra features of MultiFinder and 
System 7.0 your application uses. 

• If the Background Only bit is set, your application runs only in 
the background. Set this bit if your application has no user inter­
face and cannot run in the foreground. 

• If the Get FrontClicks bit is set, your application receives the 
mouse-down and mouse-up events that bring your application to 
the foreground. 

• If the Accept ChildDiedEvents bit is set, your application is noti­
fied when an application it launched quit or crashed. 

The last four bits tell the Finder which of the~ new System 7.0 features your 
application supports': 32-bit memory, Applef;vents, and stationery docu­
ments. 

• If the 32-bit Compatible bit is set, your application runs under the 
32-bit version of Memory Manager. Don't set this flag unless 
you've tested your application on a 32-bit system, like a Macin­
tosh IIci running System 7 in 32-bit mode or a Macintosh running 
AlUX. 

• If the HighLevelEvent-Aware bit is set, your application receives 
all high-level events, including AppleEvents, when it calls wai t­
N'extEvent. There is no way to mask out the types of high-level 
events your application can't handle. If this bit isn't set, your ap-
plication receives no high-level events. . 
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For more information on 
the debugger, see Chapter 
72, "The Debugger. /I 

• If the Accept Remote HighLevelEvents bit is set, your application 
receives high-level events, including AppleEvents, from your 
computer and other computers on your network. If this flag isn't 
set, your application receives high-level events from your com­
puter only. 

• If the Stationery-Aware bit is set, the Finder expects your applica­
tion to handle stationery documents. If this bit isn't set, the Finder 
handles stationery documents for you, by duplicating the docu­
ment and asking the user for a name for the duplicate. 

Running the proJect 
The Run command in the Project menu lets you run your application proj­
ect as you work on it. When you choose the Run command, TIDNK C 
launches your application as if you had opened it from the Finder. If you're 
using MultiFinder or System 7.0, your application runs in its own partition. 

Under MultiFinder or System 7.0, you can watch your application run, exam­
ine your source code, and use the nnNK C debugger at the same time. You 
can switch back and forth between your application, nUNK C, and the de­
bugger to edit your source files and examine your variables. When you quit 
your application, you're be back in THINK C, and the auto-make facility is 
ready to recompile your changed files. While your application is running, 
the Run command changes to Resume. Choosing Resume brings your a p­
plication to the foreground. 

When you're running under MultiFinder or System 7.0, you have to be a little 
more careful about stray pointers and much more conscientious about back­
ups. A pointer to random memory may be pointing into another applica­
tion's partition. A stray pointer to TI-lINK C's data structures may damage 
your project, and the damage is copied out to disk. Be careful with stray 
pointers. If this happens to you, delete the damaged project, and start over 
with your backup and bring it up to date with the Use Disk button in the 
Make ••• dialog. 

Building Desk Accessories and Device Drivers 
Desk accessories and drivers are structurally identical; they're both drivers. 
According to Inside Macintosh, drivers don't behave much like applications 
and have a different internal structure. In this section, the word drlverby it­
self means either a device driver or a desk accessory. 

This section won'~ teach you how to write a desk accessory or a device driv­
er from scratch. To learn how to write them, read Inside Macintosh I, Chap-
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ter 14, "The Desk Manager," Inside Macintosh II, Chapter 6, "The Device 
Manager," and Inside Macintosh V, Chapter 23, "The Device Manager." 

Note 
For System 7.0, Apple recommends that you write small ap­
plications instead of desk accessories. 

Setting the project type 
Set the project type before you start working on a driver. If you set the proj­
ect type after you've started compiling code, you must recompile your 
source files and reload your libraries. 
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Choose Set Project Type ••• from the Project menu. When the project type 
dialog appears, click on either the Desk Accessory button or the Device 
Driver button. 

o Rpplication 

@ Desk Rccessory 

o Deuice Driuer 

o Code Resource 

File Type IDFIL 

Creator IDMOU 

o Multi-Segment 

Name L;...II __________ ---I 

Type 10RUR 

(_(_lK----...;) 

o Rpplication 

o Desk Rccessory 

@ Deuice Driuer 

o Code Resource 

101 '--1_2 _--' 

K [oncel ~ 

File Type 11111 

Creator 11111 

o Multi-Segment 

Name 1 L;...I __________ ---I 

Type 10RUR ID 

( __ (_IK----...;) [ [oncel ~ 

Figure 7-8 The Set Project Type ••• dialogs for desk accessories and drivers 

The dialog boxes are the same, except for the default settings of some fields. 
The Desk Accessory dialog presets the File Type and Creator so the resulting 
file is a FontiDA Mover file. The ID is set to 12. The FontiDA Mover renum­
bers it when you install it in your System. You shouldn)t need to change the 
ID number. All that's left to do is to name the desk accessory and write the 
code. By convention, desk accessory names begin with a null. lliINK C pro­
vides the null for you automatically. 
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In System 7.0, you don't need the Font/DA Mover, since the 
Finder lets you install fonts and desk accessories. 

The Device Driver dialog leaves all the options empty for you to set. Device 
driver names begin with a period. !fyou don't provide one in the Name 
field, THINK C automatically provides one for you. 

The default settings in the project type dialogs aren't the only difference be­
tween desk accessories and device drivers. See "Setting the fields of a driv­
er's header" below to learn about the internal differences between desk 
accessories and device drivers. 

Both device drivers and desk accessories can have more than one segment, 
just like applications. Just click on the Multi-Segment check box. You can 
learn more about multi-segment drivers below, but read how a driver works 
first. 

Note 
To use objects in a driver, you must turn on the Multi-Seg­
ment option, even if your driver has only one segment. 

How drivers work 
The Device Manager expects drivers to have five entry points and to be writ­
ten in assembly language. When the Device Manager calls a driver written in 
THINK C, a short assembly-language stub (or glue routine) translates the De­
vice Manager's request into a call to the C function main ( ) . TIUNK C auto­
matically places the driver glue at the beginning of your driver. 

THINK C does two things to make writing a driver easier. First, it sets up a 
data area so that your driver can have its own global variables. Second, it fig­
ures out the proper way to return control to the Device Manager automati­
cally. These services are discussed later in this section. 
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MacHeaders indudes the 
files Files.h and 
Devices.h by default. 

How to write malnO for a driver 
The driver's main () function takes three arguments. The function returns a 
short int and is not declared pascal. A typical driver skeleton looks 
like this: 

short main (CntrlParam *paramBlock, 
DCtlPtr devCtlEnt, short n) 

switch (n) { 

case 0 II Open 
case 1 II Prime 
case 2 II Control 
case 3 II Status 
case 4 II Close 

ParamBlock, defined in Files. h, is a pointer to an I/O parameter block. 
This is the value that is passed in address register AO to the assembly-lan­
guage entry point of the driver. 

DevCtlEnt, defined in Devices. h, is a pointer to the driver's device con­
trol entry. This is the value that is passed in address register Al to the assem­
bly-language entry point of the driver. 

N is a selector that specifies which entry point actually received the call. Use 
the value of n to dispatch control to the appropriate routine. 

Getting the event record pointer from paramBlock 
According to Inside Macintosh I, Chapter 14, "The Desk Manager", the 
csCode field of the paramBlock passed to your driver specifies what kind 
of action your driver should take. 

When paramBlock->csCode == accEvent, the csParam field of 
paramBlock contains a pointer to an EventRecord Since csParam is 
defined as an array of ints, this is how you cast the field to get a pointer to 
the event record (assume that eventptr is declared EventRecord *): 

eventPtr=(*(EventRecord **) paramBlock->csParam) 

Global data in drivers 
You can declare global and static variables in drivers. The THINK C driver 
glue allocates the space for the globals in the heap before it calls main () to 
implement the Open entry. The glue releases the memory when the driver 
returns from a Close call. (There is a way to keep the global data area allo­
cated after a Close; see "Returning from a driver" below.) 
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In drivers, string literals are stored the same way as global 
variables. 

Macintosh applications use register AS to access their globals. Since drivers 
co-exist with running applications, they can't use register AS to access their 
globals. Instead, drivers use register A4. 

The TIIINK C driver glue stores a handle to the dynamically allocated data 
area in the dCtlStbrage field of the driver'S device control entry. This 
handle is dereferenced into address register A4 and locked before each call 
to main ( ) . Your Open routine must check whether the data area was allo­
cated successfully. If it was not, the dCtlStorage field is 0, and your driv­
er should display some error message (without using any globalsO and close 
itself. 

The data area remains locked between calls to your driver. If you like, you 
can unlock it yourself before returning. If you unlock the data area, though, 
make sure that you don't rely on the address of any data item staying the 
same between calls. Also, make sure that the data area doesn't contain any 
objects, such as windows, that the Toolbox assumes do not move. 

Using driver globals in callback and trap Intercept routines 
The TIIINK C driver glue sets up register A4 for you whenever it's called 
from main ( ) . If your driver defines callback routines, trap intercept rou­
tines, or other functions that might be called when the value of A4 is in 
doubt, you have to save A4 where your routines can find it. 

The header file SetUpA4. h defines a set of macros that take care of saving, 
setting, and restoring A4 for you. 

Suppose your driver calls ModalDialog () with a filterProc. Since 
you're not sure if the value of A4 is correct when ModalDialog () calls 
your filterProc, you need to save it Your filterProc needs to setA4 
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to the saved value and then restore it before it exits. Your call to 
ModalDialog () would look like this: 

engage in dialog() 
{ --

extern pascal Boolean myFilter(); 
int item; 

RememberA4 () ; 
ModalDialog(myFilter, &item)i 

Your filterProc would look like this: 

pascal Boolean myFilter(DialogPtr dp, 
EventRecord eventp, 
short *itemp) 

Boolean result; 

SetUpA4()i 

RestoreA4 () i 
return(result); 

The calls to RememberA4 () and SetUpA4 () must appear in the same 
source file. 

Note 
If your routine uses an aggregate initilaizer for a local vari­
ables, that variables must be declared static or it will 
have the wrong value. 

Use the same technique for trap intercept routines that need access to a driv­
er's globals. Of course, if your callback or trap intercept routine doesn't use 
driver globals, you don't need to set up and restore A4. 

Using libraries in drivers 
You can use libraries in drivers as long as the libraries don't reference global 
variables accessed through register AS. 

The MacTraps and MacTraps2 libraries don't reference any globals, so 
you can use them in your drivers. MacTraps does define the QuickDraw 
globals, though. If you access these globals from a driver, you'll find that 
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they aren't the real QuickDraw globals but simply the driver's own variables 
that QuickDraw knows nothing about. 

You can access the real QuickDraw globals from a driver by observing that 
o (AS) holds the address of the las~ of the QuickDraw globals, thePort. 
The remaining QuickDraw globals ~re at descending addresses from 
thePortj refer to Inside M(lCintosb 1, Chapter 6, "QuickDraw" for more in­
formation. The value of AS is stored in the low-memory global CurrentA5. 
you might want to use the inline assembler to get to the QuickDraw globals. 
See Chapter 12 for details. . 

Other libraries supplied with TI-llNK C reference their globals from register 
AS, so you must modify them. To make a library use register A4 for its glo­
bals, first make a copy of the libqlry. Then change the project type of the li­
brary to anything butf\pplication, and recompile and rebuild the library. See 
Chapter 13 to learn how to build libraries. 

Setting the fields of a driver's hea~er 
A driver begins with a header containing several flags and other data items 
(some of whiCh apply only to desk accessories). When the driver is opened, 
the Device Manager copies these fields to the device control entry before the 
Open entry point is called. After that, the device header is not used. The 
fields in the driv~r are used only to initialize the fields in the device control 
entry. 

TI-llNK C p~esets these fields to reasonable default values. If your device 
driver or desk accessory requires different settings for these fields, modify 
them on the fly in the device control entry. 

These are the default settings for desk accessories: 

Field 
dCtlFlags 

dCtlDelay 
dCtlEMask 

dCtlMenu 

Value 
dReadEnable 0 
dWritEnable 0 
dCtlEnable 1 
dStatEnable 0 
dNeedGoodbye 0 
dNeedTime 0 
dNeedLock 0 
N/A because dNeedTime = 0 
OxO 16A (mouseDown, keyDown, 
autoKey, update, activate) 
o 
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These are the default settings for device drivers: 

Field 
dCtlFlags 

dCtlDelay 
dCtlEMask" 
dCtlMenu 

Value 
dReadEnable 1 
dWritEnable 1 
dCtlEnable 1 
dStatEnable 1 
dNeedGoodbye 0 
dNeedTime 0 
dNeedLock 1 
N/A because dNeedTime 0 
NI A (desk accessories only) 
NI A (desk accessories only) 

Suppose you want a desk accessory to remain locked between calls and to 
be called once per second (every 60 ticks). Just include this code in the driv­
er's Open routine. (devCtlEnt is the second argument to main ( ) , the 
pointer to the device control entry.) 

devCtlEnt->dCtlFlags 1= dNeedLockldNeedTime; 
devCtlEnt->dCtlDelay = 60;' 

Opening an open driver 
The Open entry point of a driver (main () 's third argument == 0) may be 
called even if the driver is already open. This happens, for example, when 
the user selects the name of a desk accessory that's already on the screen. 
The driver should check to see if it is already open to avoid repeating its ini­
tialization sequence. 

You can set the fields of the device control entry directly as shown above, 
but the Device Manager copies the dCtlFlags, dCtlMenu, dCtlDelay, 
and dCtlEMask fields of the driver's header to the corresponding fields of 
the device control entry every time the Open routine is called, even if the 
driver is already open. So you need to set these fields to their proper values 
each time. Your Open routine might look something like this: 

doOpen () 
{ 

devCtlEnt->dCtlFlagsl= dNeedLock; II or 

if (already open) 
return; -

already_open = 1; 

II whatever 
II already open is a 
II driver global 
II one-time 
II initialization. 
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How to return from a driver 
If your Open routine was successful, return O. If the Open routine fails, re­
turn a negative result and the driver isn't be opened. 

Return 0 from Close if it was successful. If your Close routine returns 
closeErr (-24) the driver won't be closed. If you return a 1, the THINK C 
driver glue preserves the dCtlStorage field of the device control entry. 
This way you can keep your driver globals around until your driver is re­
opened. (1be driver glue makes it seem as though your Close routine re­
turned 0, meaning the Close was successful.). 

Warning 
Returning negative values from Open and Close to pre­
vent opening or closing works only on 128K and later 
ROMs. 

Return 1 from asynchronous calls to Prime, Control, and Status rou­
tines if the request could not be completed right away. This result code is 
stored in the ioResul t field of the I/O parameter block, but 0 (no error) is 
returned to the Device Manager. 

The jlODone problem 
THINK C always returns from a driver correctly. In other development sys­
tems, it's not so easy. Read this section if you want to learn about this prob­
lem. Since you don't have to worry about it, you might want to skip this 
section. 

One of the trickiest aspects of returning from a driver is deciding whether to 
return directly to the Device Manager (via an RTS instruction) or whether to 
jump to j rODone. This is a complex issue, and many existing desk accesso­
ries do it wrong (though, fortuitously, they manage to work anyway). 

Associated with each driver is an I/O queue, which is a list of I/O parameter 
blocks waiting for service from the driver. Calls made to a driver fall into one 
of two categories: queued, meaning that the I/O parameter block passed as 
an argument to the call is in the driver's queue; and immediate, meaning that 
it is not In the immediate case, the queue may even be (and in fact usually 
is) empty. 

All Open and Close calls are immediate. All Control calls made to desk 
accessories are immediate, except for the "good-bye kiss" (csCode=-l) is­
sued to desk accessories that have requested to be notified when the current 
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7 The Project • 
application exits out from under them. Other calIs may be queued or imme­
diate. 

The rules for returning from a driver are: The driver should return directly to 
the Device Manager from all immediate calls. It should also return directly to 
the Device Manager from queued calls requesting asynchronous I/O that 
could not be completed right away. Finally, it should jump to j IODone 
from queued calIs if the driver completed the request (or if there was an er­
ror). 

It is incorrect to violate these rules; in particular, it is incorrect to jump to 
j IODone to return from an immediate call. j IODone attempts to examine 
the driver's I/O queue, and since the queue is usually empty it ends up ex­
amining low-memory locations beginning at OxO 000. Apparently, these 
locations somehow look enough like an I/O parameter block to satisfy the 
Device Manager, but this is clearly an unsafe situation. 

Just to make things difficult, when returning from Prime, Control, and 
Status calls, it is jIODone that unlocks the driver's code and its device 
control entry so they won't form islands in the heap between calls to the 
driver (unless, of course, the driver has requested that they remain locked). 
So the author of a desk accessory, for instance, has to make a difficult deci­
sion - to return directly to the Device Manager, leaving the driver's code 
and its device control entry locked and potentially interfering with the host 
application; or to violate the rules and jump to j IODone. Most desk acces­
sories seem to take the latter route. 

TInNK C avoids this dilemma. When a driver written in TIIINK C returns 
from main () , the decision whether to call j IODone is made automatically 
(and correctly). For Prime, Control, and Status calls, if the decision is 
made to return directly to the Device Manager, and the driver has not re­
quested that its code and device control entry remain locked, they are un­
locked. 

Multi-Segment drivers 
If the Multi-Segment option is on, drivers can contain multiple segments. As 
with applications, segments are loaded automatically as they are called. In 
addition, all loaded segments are unloaded automatically upon return to the 
Device Manager after each call, unless the dNeedLock bit is set in the driv­
er's device control entry. 

You can unload driver segments manually with this function: 

void UnloadA4Seg(ProcPtr); 
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This function works just like UnloadSeg () does in applications. 

Warning 
Do not use UnloadSeg () instead ofUnloadA4 Seg () by 
mistake! 

When mINK C creates a multi-segment driver, it puts the code segment that 
contains the main () function in a DRVR resource. This is called the owning 
resource. You set its ID in the Set Project Type ••• dialog, which must be 63 
or lower. mINK C puts the other code segments in DeaD resources and 
numbers them from 0 to 31. These are called owned resources. 

Read the Segmentation section above to learn how to break up a project into 
different segments. 

Building Code Resources 
You can use mINK C to write pure code resources. Code resources don't 
have the complex structure of drivers; they simply contain code to be called 
at the entry point, main ( ) . 

You might want to write code resources for several reasons. You might want 
to write a window definition function that you can use in several other pro­
grams, or you might want to write an INIT to run at start-up. You may de­
fine your own code resource types to make a function you've written in 
THINK C available to a program written in another language. The "client" 
program simply loads the resource and calls it at its beginning. It's up to you 
whether you use C or Pascal calling conventions. (For more information 
about calling conventions, see Chapter 12.) 
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7 The Project • 
This section tells you how to build code resources in TIIINK C. The specific 
formats and calling sequences for code resources are given in the various 
volumes and chapters of Inside Macintosh. This list helps you get started. 

To build a. .. 
ADBS resource 

CDEF resource 
cdev resource 
FKEY resource 
INIT resource 

LDEF resource 

MBDF resource 
MDEF resource 

WDEF resource 
XCMD resource 

XFCN resource 

Setting the project type 

Read Inside Macintosb ... 
Vol. V, Chap. 20, "The Apple Desktop 
Bus" 
Vol. I, Chap. 10, "The Control Manager" 
Vol. V, Chap. 18, "The Control Panel" 
Technical Note 3 (also see below) 
Vol. IV, Chap. 29, "The System Resource 
File" 
Vol. V, Chap. 19, "The Start Manager" 
Vol. IV, Chap. 30, "The List Manager Pack­
age" 
Vol. V, Chap. 13, "The Menu Manager" 
Vol. I, Chap. 11, "The Menu Manager" 
Vol. V, Chap. 13, "The Menu Manager" 
Vol. I, Chap. 9, "The Window Manager" 
Appendix A, HyperCard Script Language 
Guide 
Appendix A, HyperCard Script Language 
Guide 

Set the project type before you start working on a code resource. If you set 
the project type after you've started compiling code, you must recompile 
your source files and reload your libraries. 
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Building Code Resources • 
Choose Set Project Type ••• from the Project menu. When the project type 
dialog appears, click on the Code Resource check box. 

o Desk Recessory 

File Type 11111 

Creator 11111 o Deuice Driuer 

@ Code Resource o Multi-Segment 

Name 

Type 10 

o Custom Header Rttrs ~ ~ 

(, __ (_~K __ ) [( Cancel )] 

Figure 7-9 The Set Project Type ... dialog for code resources 

Fill in the Type and ID of the code resource you're building. If you like, you 
can give your code resource a name. Use the "Attrs" (attributes) pop-up 
menu to set the resource attributes for your code resource. If you prefer, you 
can enter a hex value in the Attrs field. To learn about resource attributes, 
see Inside Macintosh 1, Chapter 5, "The Resource Manager." 

Code resources can have more than one segment. If your code resource has 
multiple segments, select the Multi-Segment option. Read the section "Multi­
segment code resources" for more information. 

Warning 
To use objects in a code resource, you must turn on the 
Multi-Segment option, even if your code resource has only 
one segment. 

THINK C User Manual 117 
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How to write main() for a code resource 
The way you write your main () routine depends on the kind of resource 
you're writing. The main point to remember is that if your code resource is 
going to be called from a Pascal program or as a callback routine, it must be 
declared pascal. 

An FKEY resource, for example, is called by the Event Manager. It doesn't 
have any arguments. You would define main () like this: 

main () 
{ 

A WDEF resource is a custom window definition. The Window Manager 
calls main () with several arguments and expects the window definition 
function to return a long. This is how you would write main () for a WDEF: 

pascal long main (short varCode, 
Windowptr theWindow, 
short message, long param) 

Global data in code resources 
Code resources, like applications and drivers, can have global and static 
variables.When you build a single-segment code resource, the DATA com­
ponent is appended to the CODE component, so CODE and DATA together 
must be less than 32K. When you build a multi-segment code resource, the 
DATA and JUMP components from all the segments are appended to the 
CODE component of the segment that contains main ( ) , so all the DATA 
and JUMP information and the CODE component for the main segment must 
be less than 32K. 

Code resource globals are addressed as offset from A4. Unlike drivers, how­
ever, A4 isn't set up automatically for you when your main () routine is 
called. You have to do this yourself. 

Note 
If your main () routine uses an aggregate initilaizer for a 
local variable, that variables must be declared static or it 
will have the wrong value. 
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Building Code Resources • 
In multi-segment code resources, THINK C treats string lit-
erals the same way as globals. If you're using literals and 
constants but not globals, you still need to set up A4. In sin­
gle-segment code resources, string literals are not treated 
the same way as globals. 

When main () is called, AO points to your code resource. This is the same 
value that your cQde resource expects A4 to have to find your globals. 

The header file SetUpA4 . h contains a set of macros that help you set up 
the A4 register. Immediately after you enter main () , call RememberAO () . 
This macro saves the value of AO where another macro, SetUpA4 () , can 
find it. You must call RestoreA4 () before you return from main () . For 
example: 

main () 
{ 

RememberAO(); II To access resource globals 
SetUpA4 () ; 

RestoreA4 () ; 

Warning . 
This technique works onlY when you use the default code 
resource header. If you use a custom header, you must set 
up A4 another way. See "Code resource headers" below to 
learn how to do this. 

Using libraries in code resources 
You can use libraries in code resources as long as the libraries don't refer­
ence global variables accessed through register AS. 

The MacTraps and MacTraps2libraries do not access any globals, so you 
can use them in your code resources. MacTraps does define the Quick­
Draw globals, though. If you access these globals from a code resource, 
you'll find that they aren't the real QuickDraw globals but simply the re­
source's own variables that QuickDraw knows nothing about. 

You can access the real QuickDraw globals from a code resource by observ­
ing that 0 (AS) holds the address of the last of the QuickDraw globals, 
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thePort. The remaining QuickDraw globals are at descending addresses 
from thePort; refer to InstdeMactntosb I, Chapter 6, "QuickDraw" for 
more information. The value of AS is stored in the low-memory global Cur­
rentAS. You might want to use the inline assembler to get to the Quick­
Draw globals. See Chapter 12 for details. 

The other libraries supplied with mINK C reference their globals from regis­
ter AS, so you must modify them. To make a library that uses register A4 for 
its globals, first make a copy of the library. Then change the project type of 
the library to anything but Application, and recompile and rebuild the li­
brary. To learn more about libraries, see Chapter 13. 

Locking code resources 
The Macintosh Toolbox takes care of locking and unlocking the standard 
code resources like WDEFS. When you write your own code resources, you 
can either let the caller take responsibility for locking and unlocking them, 
or you can have the code resource do it itself. 

When main () is entered, register AO contains a pointer to your code re­
source. If you need to lock it, you would write main like this: 

#include <SetUpA4.h> 

main () 
{ 

Handle h; 

RememberAO () ; 
SetUpA4 () ; 

asm { 
RecoverHandle 

move. 1 aO, h 
} 
HLock(h); 

HUnlock (h) ; 
RestoreA4 () ; 

II To access resource 
II globals 

II aO already points 
II to resource 
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Building Code Resources • 
This technique works only when you use the standard code 
resource header. If you use a custom header, you must get 
the address of your code resource another way. See "Code 
resource headers" below. 

If your code resource can be called reentrantly, it should not unconditionally 
be unlocked each time it returns. Instead, it should be restored to the same 
state of locked-ness it had on entry. 

Code resource headers 
If the Custom Header option is off, THINK C creates a code resource with a 
standard header: 

Offset 
o 
2 
4 

8 
10 (OxA) 
12 (Oxe) 
14 (OxE) 

Contents 
BRA. S . +Ox10 (branch to header code) 
OxOOOO (unused) 
, TYP E' (resource type) 
OxOOOA (resource ID) 
OxOOOO (unused) 
OxOOOO (unused) 
OxOOOO (unused) 

The standard header code puts the address of your code resource in register 
AO and then branches to your main () routine, but the file containing 
main () is not guaranteed to be the first file in the code resource. You can 
do anything you like with the unused words. 

Note 
Older versions of THINK C put the address of your code re­
source in the low memory global ToolScratch. The stan­
dard code resource header does not do this. Use inline 
assembly if you need to reference AO directly. 

If the Custom Header option is checked, THINK C does not generate the 
standard header. Instead, your code resource starts with the first function in 
the file where main () is defined. The routine main () doesn't have to be 
the first function in the file, so your resource can begin any way you like. (In 
fact, main () may never be called.) This option is useful for certain types of 
code resources that must begin with a table of some kind, rather than with 
code. 
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When you use a custom resource header, AO does not contain the address of 
your code resource. This means that you can't use the RememberAO () mac­
ro to set up register A4 to use your code resource globals until you set up AO 
to point to your code resource. 

The following code shows one way to set up your code resource globals 
when you use a custom resource header. 

Warning 
SetUpA4. h generates code, so if you include it at the top 
of your file, the internal function defined in SetUpA4 . his 
your header. This is not what you want. 

/* iincludes, globals, declarations */ 

/* declare main() so we can JMP to it */ 
extern main(); 

header() /* First function in file */ 
{ 

asm { 
DC.L 0 /* header information */ 
... 
/* end of header */ 

/* put address of code resource in aO */ 
LEA header, aO 
JMP main 
} 

/* SetUpA4.h generates code, so don't put it */ 
/* at the top of the file with the other */ 
/* headers */ 
iinclude <SetUpA4.h> 

main () 
{ 

RemernberAO () ; 
SetUpA4 () ; 

RestoreA4(); 
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Building Code Resources • 
Unlike other project types, you can build code resources into already exist­
ing meso In the Bulld Code Resource ••• dialog, check the Merge option, 
and type the name of the file you want your code resource placed into. 

Ie myCDEU folderl 

[) ( ~h~u, 11 Q ~Moose 

D ( d.~u,~: 
[ ) D ~ni1.. n [j.~~:1 

r.~ inli'( [ Driue ) 
D rn~jCn[U 

{} 

Saue code resource as: n Saue D 
ImycDEu ( Cancel ) 
[8l Smart Link [8l Merge 

Figure 7-10 The Merge check box in the Build Code Resource ... dialog 

You might want to do this when you're building a library ofxCMDs or build­
ing a combination cdev and INIT. However, when you check the Merge 
option, the project's resource file is not be copied into the file, so you should 
make sure that any resources needed by your code resource are already 
present in the file. 

Multi-segment code resources 
If the Multi-Segment option is checked in the Set Project Type ••• dialog, 
code resources can contain multiple segments. As with the other project 
types, segments are loaded automatically as they are called. However, unlike 
the other project types, you must unload the segments yourself when the 
code resource exits. You can unload individual segments with this function: 

void UnloadA4Seg(ProcPtr); 

This function works just like UnloadSeg () does in applications. To unload 
all segments at once, call UnloadA4 Seg () with a null pointer; that is, Un­
loadA4Seg(OL) . 
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Warning 
Do not use UnloadSeg () instead ofUnloadA4 Seg () by 
mistake! 

In a multi-segment code resource, the code segment that contains the 
main () function is called owning resource. The other segments are called 
owned resources. When TI-IINK C builds your resource, it uses the Type and 
ID number from the Set Project Type ••• dialog for the owning resource. 
The ID must be 63 or lower. TI-IINK C puts the owned code segments in 
CCOD resources and numbers them from 0 to 31. 

In code resources, the owning segment is special. The DATA and JUMP com­
ponents for all the segments is appended to the CODE component of the 
owning segment. So all the DATA and JUMP information and the CODE 
component of the main segment must be under 32K. 

Read the Segmentation section above to learn how to break up a project into 
different segments. 
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8 

E ruting and creating files in an integral part of programming. This chapter de­
scribes the features of the built-in TI-llNK C editor. The editor uses standard 
Macintosh editing techniques so you're familiar with its basic operation. Al­
though you can use it to edit any text file, the editor has some features that 
make editing your source and header files easier. 

Contents 
Creating and Opening Files. 

Creating a new file . . 
Opening a text file . -. . 
Opening a source me . 
Opening header files . . . 
Opening the current selection 

Editing a File. . . . . . . . 
Typing text . . . . . . 
Undoing changes to a file. . 
Scrolling to the insertion point . 
Using the arrow and function keys. 
Moving to a specific line . . . . 
Selecting lines . . . . . . . 
Indenting . . . . . . . . . . . . 
Shifting blocks right and left. . . . . . 
Balancing parentheses, brackets, and braces 
Changing font and tab settings . 

Using Markers . . . . . . . . 

Using MPW Projector with mINK C . 

Printing Files. . . . . 

Closing and Saving Files. 
Closing a me . . . 
Saving a file . . . . 
Saving a file with a different name 
Saving and closing all open files 
Saving files automatically '. . . 

127 
127 
127 
127 
128 
129 

129 
129 
129 
130 
130 
132 
132 
132 
132 
133 
133 

134 

136 

138 

138 
138 
138 
138 
138 
139 
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Searching and Replacing 

Finding a string . 
Search options. . 
Replacing a string. . . . . . . 
Setting things up for searching later . 
Finding non-printing characters . 
Searching through multiple files . . 
Disabling multi-file search . . . 
Finding the defInition of a symbol 

Searching for a Pattern (Grep) . 
Patterns . . . 
Simple patterns 
Complex Patterns. . 
Sub-patterns 
Constraining patterns . 
Replacing with Grep . 
Grep Examples. . . 
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Creating arid Opening Files • 
Creating and Opening Files 
To create or open a file, you must have a project window open. You can 
open as many files as the memory in your Macintosh allows, and each me 
appears in its own edit window. Although you usually use the THINK C edi­
tor to create and open source or header files, it can open any text me. 

Creating a new file 
To create a new file, choose New from the Flle menu. An untitled edit win­
dow appears, ready for you to start typing into it. 

" File Edit Search. Project Source Windows 
~ I hello project 

Untitled 

-

. 0 
... 

Figure 8-1 An new editing window 

Opening a text file . . 
The Open ••• command in the Flle menu opens any text file. A standard me 
dialog box displays the· na~es of all text files in the current folder, even if 
they weren't created with THINK C. The file you open appears in its edit 
window. 

Opening a source file 
To open a source file that's already in your project window, double-click on 
its name in the project window. if the file is already open, double-clicking 
on its name brings the file's edit window to the front. 
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Holding down the Com­
mand key while dicking in 
a title bar brings up a menu 
of markers, described on 
page 134. 

You can select a file by typing the first few characters of its name when the 
project window is the active window. You can then open it by pressing Re­
turn or Enter. Since the files in the project window are in alphabetical order, 
the selected file is the first file in the project that matches the characters 
typed so far. If what you type doesn't match any name in the project win­
dow, any selected file is deselected. When what you type matches more 
than one file name, you can use the Tab key to cycle among all the names 
that match. The up- and down-arrow cursor keys also change the selection 
in the project window. 

Note 
In the project window, you can use Backspace to mean up­
arrow, and Shift-Backspace to mean down-arrow. 

Opening header flies 
Sometimes when you're working on a source file, you want to look at the 
header files associated with it. Naturally, you can use the Open ••• command 
in the File menu to open header files, but THINK C gives you a way to open 
these files quickly. 

To get a pop-up menu of all the flles included in a source file, like in Figure 
8-2, hold down the Option key as you click in the title bar of its window. To 
open a header file in its own edit window, choose its name. If the file is al­
ready open, mINK C brings its window forward. 

mini.file.c 

I"''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' ~ m in i. fil e.h to"'''''''''''''''''''''''''''''''''''''''''''''''' ~ 
.. . mini.print.h r-

ftllnl.flle.c .. . d h ~ 
mlnl.WIn ows. HiW 

fi Ie functions for MiniEdit.h mm 

"''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''"'''''''''''''''''''''''' 111111 

~ [ ]mmm~mmmmmmmmmmmmmmm~mmmmmmmmmmm~mmmmmmm~mmmmmmmmmmmH~mH!~~~~~lmmli ~ I2J 
Figure 8-2 The list of a file's header files 
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To learn more about 
precompiled headers see 
"Precompiled Headers" on 
page 764." 

To learn about the project 
and THINK C trees, see 
Chapter 9, "HIes & Fold­
ers. /I 

Editing a File • 
Holding down the Option key as you click in the title bar of the project win­
dow brings up a pop-up menu containing the names of all the header files 
used in the project. 

THINK C builds the pop-up menus only for compiled source files. Any head­
er files that are part of a precompiled header don't appear in the pop up 
menus. 

To open a header file that you've added to a source file since the last compi­
lation, or to open a header file for a file you haven't compiled yet, use the 
Open Selection command described below. 

Opening the current selection 
The Open Selection command in the File menu lets you open a header file 
by selecting its name in the current source file (double clicking on the name 
works here). You don't have to select the . h extension. The selection is au­
tomatically extended to include it as long as you've selected the first part of 
the me name. 

Open Selection can deal with path names. If the character following the se­
lection is . (period) or : (colon), the selection is extended to the end of the 
next word following, and this process is repeated. A partial path name is 
searched for as though it appeared in an # incl ude " ... " statement in 
the file being edited. (Open Selection is not smart enough to look for angle 
brackets.) If the editing window is untitled, only the project and THINK C 
trees are searched. 

Editing a File 
The editor uses all the standard Macintosh editing techniques as well as 
some designed for editing C programs. Double-clicking on a word selects 
the entire word. Triple-clicking anywhere in a line selects the entire line. 
Cut, Copy, Paste, and Undo all work the way they do in other Macintosh 
applications. 

Typing text 
The THINK C text editor does not have the word wrap feature you might be 
used to in other editors. If you type past the right edge of the window, use 
the horizontal scroll bar at the bottom of the window to see past the right 
edge. 

Undoing changes to a file 
If you make an unintentional change to your file, use the Undo command in 
the Edit menu. Undo remembers only the last thing you did. You can also 
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use Undo to redo what you undid. The wording of the Undo command al­
ways reflects what it will undo. For instance, if you cut a range of lines, the 
Undo command reads Undo Cut. If you choose Undo, the command now 
says Redo Cut. You can undo the most recent replace (see "Searching and 
Replacing" on page 139), but you can't undo a Replace All command. 

If you've made numerous changes to your file, and you want to undo all of 
them, or if you want to undo a Replace All, use the Revert command in the 
File menu. Revert discards all of the changes you've made since you last 
saved (or opened) the file. 

Scrolling to the insertion point 
The TI-IINK C editor lets you examine an area of your file, then instantly 
jump back to where you were. To see the current insertion point or the start 
of the current selection, press the Enter key. Since scrolling in any direction 
does not affect the insertion point or the current selection, pressing Enter 
takes you back to your previous position in the file. 

If the start of the selection is already visible, pressing the Enter key makes 
the end of the selection visible, so you can toggle between the two ends of 
the current selection. This shortcut is particularly useful after using the Bal­
ance command (see "Balancing parentheses, brackets, and braces" on page 
133). 

Using the arrow and function keys 
The arrow keys move the insertion point up, down, left, and right. At the 
end of a line, the left (or right) arrow wraps around to the end of the previ­
ous line (or beginning of the next line). Pressing the Option key with any ar­
row key moves the insertion point as far up, down, left, or right as possible. 
Shift-arrows and Shift-Option-arrows extend the current selection. 
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This table summarizes how the arrow and editing keys move the insertion 
point. 

Press this •.. 
Up-arrow 
Down-arrow 
Left-arrow 
Right-arrow 
Command-Left-arrow 
Command-Right-arrow 
Option-Up-arrow 
Option-Down-arrow 
Option-Left-arrow 
Option-Right-arrow 

Note 

To move the insertion point. .. 
Up one line. 
Down one line. 
Left one character. 
Right one character. 
Left one word. 
Right one word. 
To the beginning of the file. 
To the end of the file. 
To the beginning of the line. 
To the end of the line. 

If you're using a Macintosh Plus keyboard, the editor treats 
the +, *, /, and = keys on the numeric keypad like Shift-ar­
row keys. For example, the + key on the keypad is treated 
as a Shift-Left-arrow. On other keyboards, the +, *, /, and = 
keys work correctly. 

If you have an Apple Extended Keyboard, you can use the keys above the 
arrow keys. This table describes what they do: 

Press this key ••• 
Forward Delete (00) 
Home 
End 
Page Up 
Page Down 
Option-Page-U p 
Option-Page-Down 
Option-Home 
Option-End 

Note 

To do this action ... 
Delete the next character. 
Scroll to the beginning of the me. 
Scroll to the end of the file. 
Scroll to the previous screen. 
Scroll to the next screen. 
Scroll to the left. 
Scroll to the right. 
Scroll all the way to the left 
Scroll all the way to the right 

The Home, End, Page Up, and Page Down keys do not 
move the insertion point. They just scroll the file. 
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Moving to a specific line 
The Go To Line ••• command in the Edit menu lets you move to a specific 
line in your file. Lines are numbered consecutively, with the first line in the 
file being number 1. 

When you choose Go To Line .•• , you'll see the dialog in Figure 8-3. 

( Cancel) 

Go To Line: I L.-2_3 __ --' 

K OK ] 

Figure 8-3 The Go To Line ... dialog 

When the dialog appears, the line number specified is the line that contains 
the insertion point. To go to a particular line, type its number and click OK. 
If you change your mind, click Cancel. The editor moves the insertion point 
to the beginning of the line you entered. 

Selecting lines 
To select a line, triple click anywhere on the line. To select a range of lines, 
drag the mouse after you triple click. 

Indenting 
When you press Return to start a new line, the editor indents the new line 
with the same number of leading tabs and spaces as the previous line has. 

To change the indentation, backspace over it. To keep the editor from auto­
indenting a line, hold down the Option key when you press Return. 

Shifting blocks right and left 
To change the indentation level for a range of lines, use the Shift Left and 
Shift Right commands in the Edit menu. Shift Left deletes the leading tab 
from each selected line. Shift Right inserts a tab at the beginning of each se­
lected line. Both Shift Left and Shift Right extend the current selection to 
include entire lines. 

132 THINK C User Manual 



Editing a File • 
Warning 

Do not type anything while doing Shift Left or Shift Right 
on a selected region. Typing replaces the selected text with 
what you typed. 

Balancing parentheses, brackets, and braces 
The Balance command in the Edit menu extends the current selection in 
both directions until it encloses the smallest block of text enclosed in paren­
theses (), brackets [], or braces { } . Successive invocations select larger se­
quences of text 

Note 
The Balance command looks for any parentheses, brackets 
and braces. It doesn't ignore text in strings or comments. 

You can use Balance to check whether all the parentheses, brackets, and 
braces in your file are properly balanced. Go to the beginning of your file 
and search for the first left brace ( {). Use Balance and Find Again repeat­
edly until you get to the end of your file. 

Changing font and tab settings 
When you open a new edit window with the New command, the font is 
9-point Monaco, and there's a tab stop every four spaces. You can change 
these settings with the Set Tabs & Font. •• command in the Edit menu. 
When you choose this command, you'll see the dialog in Figure 8-4: 

Tabs: - ~ OK , ( Cancel ) 

Font: Monaco 
It II 9 

The quick brown fox jumps: over the lazy dog. 

Figure 8-4 The Set Tabs & Font ... dialog. 

Type a number to set the number of spaces per tab. To change the font, click 
on the font name. You'll see a pop-up menu with the names of the fonts in 
your System file. Click on the font size to see a pop up menu of the sizes for 
the font 
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THINK C recognizes the 
markers that MPW puts in 
files, and MPW recognizes 
the markers that THINK C 
puts in files. 

If you are using a proportionally spaced font like New York or Geneva, the 
TIllNK C editor uses the width of the non-breaking space Caption-Space) to 
figure out the width of a tab. 

When you change the font or tab settings, the editor adds EFNT and ETAB 
resources to your text files to record the new settings. Other text editors use 
these resourceS as well. 

Note 
To change the default font and tab settings, use Res Edit to 
modify the CNFG 0 resource in the mINK C application. 
The second, third, and fourth words of this resource specify 
the font number, font size, and tab width, respectively, 
used for newly created Untitled windows. 

Using Markers 
Markers are like bookmarks in a book. They help get to a certain point in 
your program quickly. You can place markers at the beginning of each rou­
tine, or anywhere else in your program. 

To put a marker in a file, place the insertion point in the line you want to 
mark or select some text in that line. Choose the Mark. .. command in the 
Search menu. You'll see the dialog in Figure 8-5. 

Marker name: 

I HahdleEuent 

n OK n ( Cancel) 

Figure 8-5 The Mark ... dialog 

If you selected text, the editor uses that text as the default name. If you don't 
select text, the editor uses the word nearest the insertion point as the default 
name. Edit the default name, if you want, and click OK. If you don't want to 
insert a marker after all, click Cancel. 
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Holding down the Option 
key while dicking in a title 
bar brings up a menu of the 
file's header files, described 
on page 728. 

Note 

Using Markers • 
Make sure that your marker has a unique name. lliINK C 
doesn't check whether the name is already used. If several 
markers have the same name, that name is listed several 
times in the marker pop-up menu. 

To go to a marker in a file, hold down the Command key and click in the title 
bar of the file's editing window. A pop-up menu of the file's markers ap­
pears, sorted alphabetically, like Figure 8-6. Choose the marker you want to 
go to, and the editor scrolls to that marker. If you marked a text selection, the 
editor selects that text. If you marked an insertion point, the editor move the 
insertion point there. 

o 
1***** 
* bullseye.c 
* * A simple demon~ 
* 
* *****1 

bullseye.c 
"" HandleEuent 

HandleMouseDown 
How does this code work? 
I nitMacintosh 
main 

-include "buIIHenus.h" 
-include "buIIWindow.h" 

extern WindowPlr 
extern Recl 

bu I I seyeW i ndow; 
dragRect; 

void InilMacinlosh(void); 
void HandleHouseDown (EvenlRecord * lheEven l ) ; 

Figure 8-6 The marker pop-up men\-! 

ebugger 

THINK C User Manual 135 



8 The Editor • 

To learn how to use the Op­
tlons ... dialog, see "Using 
the Options ... Dialog" on 
page 779. 

To delete a marker, choose the Remove Marker ••• command in the Search 
menu. You'll see the dialog in Figure 8-7. 

Remoue selected markers: 

HandleEuent 
HandleMouseDown 

InitMacintosh 
main 

n OK D Cancel 

Figure 8-7 The Remove Marker ... dialog 

Select the markers you want to delete and click OK. If you change your 
mind, click Cancel. The next time you see the marker pop-up menu, you'll 
notice that the deleted markers are gone. 

Using MPW Projector with THINK C 
You can work on a large project with people who use MPW Projector. If the 
"Projector-aware" option is on in the Preferences section of the Options ••• 
dialog, TI-IINK C checks for a Projector resource CeKrD resource) every time 
it opens a source file. The "Projector-aware" option is one by default. TI-IINK 
C displays an icon in the lower left corner of the editing window that tells 
you whether Projector marked the file as read-only. If the file is a read-only 
file, its window has a crossed-out pencil icon. If it's not a read-only me, its 
window has a regular icon. If it's a modified read-only file, its window has a 
pencil icon with a dotted cross-out. 

136 THINK C User Manual 



A file without 
a projector resource 

A file that's 
"read-only" 

Using MPW Projector with THINK C • 
For example, let's say you opened the files in Figure 8-8 with this option on. 
FileA. c doesn't have a Projector resource. FileB. c isn't read-only. 
FileC. c is read-only. FileD. c is modified read-only. 

~D§ FileR.c §0§ 

1*************** 
* Fi Ie A 

1*************** 
* Fi Ie C 

#include <stdio. 

A file that's 
not "read_only" 

A file that's 
"modified 
read-only" 

~D§ FileB.c §0~ 

1*************** 
* Fi Ie B 

1*************** 
* Fi Ie D 

#include <stdio. 

Figure 8-8 Editing files marked with MPW Projector 

You can't edit a file marked read-only when the "Projector-aware" option is 
on. THINK C lets you select and copy text, but ignores your typing and dis­
ables the Cut and Paste commands. If you want to edit a file marked read­
only, you have two choices: 

• You can make a copy of.it. Choose Save As ••• and enter a new 
file name in the standard file dialog. THINK C copies the file's 
text, but not its Projector resource (or anything else in the re­
source fork, for that matter). 

• You can make it a modified read-only me. Choose Modify Read­
only in the File menu. Its icon changes to a pencil with a dotted 
cross-out, and you can edit it. 
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Printing Files 
Use the Print. •• command in the Flle menu to print the file in the frontmost 
edit window. You'll see the standard print dialog for your printer. 

The Flle menu also contains a standard Page Setup ••• command that lets 
you set the page size and other options before you print. 

Closing and Saving Files 
It's a good idea to save your work every fifteen minutes or so just in case 
something horrible happens. Power failures and strange machine crashes 
occur at the most inopportune times. 

Closing a file 
To close a file, click on its edit window's close box. If you've made changes, 
and haven't saved the file, the editor asks you if you want to save it before 
closing. You can also use the Close command in the Edit menu to close a 
file. 

Saving a file 
To save a file without closing it, use the Save command from the Flle menu. 
If you've never saved the file before (that is, if its edit window is Untitled), 
you'll get a standard file dialog asking you to name the file. 

Saving a file with a different name 
The mINK C editor gives you two ways of saving a file under a different 
name. The Save As ••• command asks you to name a new file and then saves 
the contents of the edit window under that name. If the file is part of your 
project (it's in your project window), its name changes there, too. 

The Save a Copy As ••• is similar to the Save As ••• command except that it 
doesn't change the name of the file. This command saves the contents of the 
current edit window under a new name, but lets you continue editing the 
original file under its original name. The project window remains un­
changed. This is a good way to make backup copies without mistakenly ed­
iting the backup. 

Saving and closing all open files 
To save all the open files, use the Save All command in the Windows 
menu. Using this command is the same as using the Save command on each 
window. 

The Close All command closes all the open files. If a file hasn't been saved, 
the editor asks you if you want to save it. 
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For more information on 
the Options ... command, 
see "Using the Options ... 
Dialog" on page 779. 

Search for: 

Saving flies automatically 

Searching and Replacing • 
THINK C saves files for you automatically when you close them if you 
uncheck the "Confirm saves" check box in the Preferences page of the 
Options •.• command. 

Searching and Replacing 
The TI-IINK C editor offers a wide range of search and replace capabilities. 
You can: 

• find a string in a me 
• replace one string with another 
• find a string in any file in your project 
• find the defmition of a symbol 
• find strings that match a pattern (grep) 

Finding a string 
Use the Find •.• command in the Search menu when you want to fmd a 
string. You'll see the dialog box in Figure 8-9. 

Replace with: 

1~I_M_C_F ___ ln_it ______________ ~11 ~ ____________________ ~ 
D Whole Words Only DGrep D Multi-File Search 

D Wrap Rround [e~~~~~~ 
1811 gnore Case f Find Ji Don't Find J ( Cancel ) 

Figure 8-9 The Find ... dialog 

Type the string you're looking for in the "Search for" field and click the Find 
button. If the string is in the me you're editing, the editor scrolls to where it is 
and highlights it. If it's not, the editor just beeps. 

Since the string you've found is highlighted, you can replace it just by typing 
in a replacement string. 

To find the next instance of the string, use the Find Again command in the 
Edit menu. 
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For more information on 
the Options ... command, 
see "Using the Options ... 
Dialog" on page 779. 

Search options 
The three check boxes on the left side of the Find •.• dialog let you specify 
how the editor looks for your string. 

If you check the "Whole Words Only" option, the editor matches only whole 
words. This option is useful when you're looking for a one-letter variable 
name or a word that commonly appears inside other words, like handle. 

The editor usually searches from the insertion point to the end of the file. If 
you check the "Wrap around" option, it searches the entire me for your 
string. The search begins from the insertion point (or the end of the selec­
tion). If the editor doesn't find your string by the time it reaches the end of 
the me, it searches from the beginning to the insertion point. 

When the "Ignore case" option is checked, the editor matches the search 
string regardless of case. If this option is off, the case of the strings must 
match exactly. 

You can set the defaults for these options in the Preferences page of the Op­
tions .•. dialog in the Edit menu. When you set the options in the Find ... di­
alog, they apply only to the current session. When you set the options in the 
Options .•. dialog, they are the permanent defaults for the current project or 
for all new projects . 

.. Search Options ................................................................................. ... 

D Whole words only 

D Wrap around 

[8l1 gnore case 

Figure 8-10 The Search Options in the Options ... dialog 

Replacing a string 
If you want to replace some but not all instances of the search string, enter a 
replacement string in the Replace with field of the Find ... dialog box. When 
the editor finds the first occurrence, use one of these commands: 

• Find Again to go on to the next instance 
• Replace to replace it with the replacement string 
• Replace and Find Again to replace the current instance and 

then immediately go on to the next one. 
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Replace All replaces every instance of the search string in the file with the 
replacement string. If you don't type in a replacement string, it deletes every 
instance of the search string (that is, it replaces it with nothing). 

Setting things up for searching later 
In addition to the Find button ("Go ahead with the search") and the Cancel 
button ("Pretend I never invoked this command"), there is a Don't Find but­
ton. Clicking on this button sets up the search and replace strings and the 
option settings without doing the search. To go ahead with the search later, 
use the Find Again command 

You might use this button when you realize that the insertion point is not 
where it should be to start the search. Click on the Don't Find button, move 
the insertion point to the proper place, then use Find Again to find your 
string. 

Note 
The Find Again command looks for the string you've en­
tered in the search string. 

Finding non-printing characters 
To look for tab and return characters, hold down the Command key as you 
type them into the Search for and Replace with fields. To insert other non­
printing characters, use the Copy command to copy them into the Clip­
board, then Paste them into the Search for and Replace with fields. 

A return signifies the end or beginning of a line in a string search. 

Searching through multiple files 
The Multi-File Search option lets you look for a string in more than one file 
in your project. This feature is useful when you're tracking down undefmed 
or multiply defined symbols, or if you change the number of parameters to a 
function, and you need to fix up all the references to it 

THINK C User Manual 141 



8 The Editor • 
To look for a string in more than one file, check the Multi-File Search check 
box in the Find ••• dialog box. When you check this box, another dialog box 
displays all the text files associated with the project. 

Source files to search: 2 

I nelude files to search: 0 
cq( [ancel ) 

( Check All ) 

( Check nil .c ) 

( ChH( k nu .h ) 

( Check None) 

""bullM.nus.c 
bulls.y •. c 

""bullYindoY.c 

Figure 8-11 The Multi-File Search dialog 

Scroll through the list and click on individual flIes to select them. A small 
check mark appears next to the flIe name.If a file is already selected, clicking 
on its name removes the check mark.You can use the buttons in the dialog 
box to Check All, Check None, Check All .c, or Check All .h flIes. You can 
also use these Command-keys instead of the button: 

Button 
Search All 
Search All .c 
Search All .h 
Search None 

Command-key equivalent 
Command-A 
Command-S 
Command-H 
Command-N 

When you've checked the files you want to search, click OK to return to the 
Find ••• dialog box., then click Find to start the search. If you didn't select 
any files, the Multi-File Search option isn't checked. 

TIITNK C looks for the search string in each of the checked files, starting 
with the first one checked. When it finds a file that contains the search string, 
it opens the file and selects the search string. At this point, you can edit the 
file, or, if you' want to search further in the current flIe, you can use the 
Find ••• , Find Again, Replace, and Replace All commands to work within 
the current file. When you're ready to go on to the next file, use the Find in 
Next Fqe command. . 

142 THINK C User Manual 



Note 

Searching and Replacing • 
Multi-file search finds the first ~stance of the search string 
in each file. To find more instances of the search string in 
the me, use the Find Again command. Once you issue a 
Find in Next File command, THINK C looks in the next 
file you checked, even if there are additional instances of 
the search string in the current me. 

Here's another example of when you'd want to use the Don't Find button. 
Suppose that in a multi-file search, you decide that you really want to set the 
Match Words option. Open the Find dialog, and change the option. If you 
were to click on the Find button, ~e search would go on to the next file. So 
you click on the Don't Find button, and continue using the Find Again and 
Find in Next File commands. 

Disabling multi-file search 
Entering a new search string cancels a multi-file search. To enter a new 
search string without cancelling a multi-file search, bring up the Find •.. dia­
log. Click on the Multi-File Search check box. The list of all the text fIles ap­
pears. Click OK to accept all the checked files, and then enter the search 
string in the "Search for" field. 

To cancel a multi-file search without going through the multi-file selection 
dialog, hold down the Option or Command key as you click the Multi-File 
Search check box. 

Finding the definition of a symbol 
There's a shortcut for finding the definition of a function, class, or global 
variable used in a source file. While holding down the Option or Command 
key, double-clic~ on the name of function, class, or global variable. TIIINK 
C opens the file that defmes it and moves the defmition. If it doesn't exist or 
is defined in a library, TIIINK C beeps. 

Note 
If TIIINK C doesn't bring you to the definition of the sym­
bol, use the Find Again command until you find it. 

You can use this shortcut to find a method, too. Just Option-double-click (or 
Command-double-click) on a method name. If more than one class defines a 
method for that message, TIIINK C displays the Class Browser and high­
lights the clas~s that define a method for that message. Double-click on the 
class you want. TIIINK C opens the file that defines it and moves to the defi-
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nition. For more information on the Browser, see Object-Oriented Program­
ming Manual, Chapter 6, "The Browser." 

Searching for a Pattern (Grep) 
In addition to the search and replace functions described in the previous 
section, the TIIINK C editor also provides a powerful pattern search capabil­
ity called Grep. The Grep search option in mINK C is based on the Grep 
utility on Unix systems. If you're familiar with this kind of pattern matching 
you'll fmd an old friend here. If pattern searching is new to you, experiment 
with this feature before you use it on a real file. 

Warning 
The editor looks for patterns only when the Grep option is 
on. 

Patterns 
A pattern is a description of a set of strings rather than a specific string. For 
example, you can build a pattern that means "any word that begins with P." 
Or a pattern that means "any function call with & even t as an argument." 

Patterns can't span lines. So you can't write a pattern that means "three con­
secutive lines that begin with a, b, and c." 

Simple patterns 
The simplest patterns match a single character. 

1 . Any character, with the exceptions noted below, is a pattern that 
matches itself. 

For example, the pattern 2 matches a character 2. If you've checked Ignore 
Case in the Find •.. dialog box, any letter matches both its upper- and lower­
case equivalent. So, either a or A matches both a and A. 

2. The character. is a pattern that matches any character. 

3. The character \ followed by any character except ( ) < > or 
one of the digits 1-9 is a pattern that matches that character. 

For example, \. matches a . and \ \ matches a \. 

4. A string of characters s surrounded by [ and] is a pattern [s] 
that matches anyone of the characters in the string s. The pattern 
[" s] matches any character that is not in the string s. If s is 
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string of three characters in the form a-b, this represents all of 
the characters from a to b inclusive. All other characters in 5 are 
taken literally. To include the character] in 5, you must use it as 
the first character. To include the character - in 5, you must use it 
at the beginning or at the end of 5. 

For example, the pattern [A-Za-zO-9] matches any alphanumeric char­
acter. The pattern ["! --] matches any non-printing ASCII character. The 
Ignore Case option has no effect on what's between brackets. 

Complex Patterns 
To match strings, not just individual characters, you need patterns that match 
consecutive sequences of characters. One way of doing this is to append a * 
to the end of one of the simple patterns. 

1. A pattern x followed by a * is a pattern x * that matches zero or 
more consecutive occurrences of characters matched by x. 

For example, the pattern @ * matches a string containing any number of at­
signs. If the string does not begin with an at-sign, or if it contains no at-signs 
at all, then the pattern matches the empty string at the beginning of the string 
to be matched. You'll see later on why this is useful. 

You can put patterns together to form more complex patterns: 

2. A pattern x followed by a pattern y forms a pattern xy that 
matches any string ab, where a matches x and b matches y. 

For example, the pattern P. matches any two-letter string consisting of P 
and any other character. 

3. You can concatenate the compound pattern xy with another pat­
tern z, forming the pattern xyz. 

To put all of this together, consider the pattern (. *) . This pattern matches 
any string enclosed in parentheses. This includes the string (), since the 
sub-pattern . * matches the empty string between the ( and the ). 

Does this pattern match the string ( () ) ? Since the sub-pattern . * matches 
any number of occurrences of all characters, won't the pattern match just the 
( () and not the very last) ? The answer is any sub-pattern of the form x * in 
a pattern x*y matches the largest number of occurrences of whatever x 
matches that still allows a match to y. In matching ( () ) against the pattern 
( . *) , only the inner pair of parentheses matches the sub-pattern . *, so the 
pattern matches ( () ) . 
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Sub-patterns 
Grep has a way of remembering sub-patterns so you can use them again as 
part of even more complex patterns. Things get a little complicated here. 

1 . A pattern surrounded by \ ( and \) matches whatever the sub­
pattern matches. 

For example, \ (a [b-y] z\) matches the same thing as a [b-y] z. 

2. A \ followed by n, where n is one of the digits 1-9, matches 
whatever the nth \ ( \) sub-pattern matched. You can add a * 
to a \n pattern to form a pattern \n* that matches zero or more 
occurrences of whatever \n matched. 

For example, to find two repeated words Oike "the the") you might use a 
pattern like this: \ ( [a - z] [a - z] * \ ) \ 1. This pattern matches a space, 
any sequence of letters, a space, and the same sequence of letters. Note that 
\ 1 is not a reapplication of the pattern. Instead it becomes whatever the first 
\ ( \ ) pair matched. 

Constraining patterns 
Finally, you can constrain patterns to match only if they meet certain condi­
tions in the context outside the string. 

1. A pattern surrounded by \ < and \ > matches whatever the pat­
tern matches, provided that the first and last characters of the 
matched string match [A-Za-zO-9_] and that the characters 
immediately surrounding the matched string don't match 
[A-Za-zO-9 _] . In other words, the pattern matches only if the 
string begins and ends on a word boundary. If you've checked 
Match Words in the Find ••• dialog box, the entire pattern you en­
ter is treated as though it were surrounded by \ < and \ >. 

For example, to find occurrences of repeated words even if they're not sur­
rounded by spaces, you would use the pattern 
\ (\< [a-z] [a-z] *\>\) ["'a-z] *\1 

2. A pattern x preceded by a '" forms a pattern "'x. If AX is not pre­
ceded by any other pattern, it matches whatever x matches as 
long as the first character x matches occurs at the beginning of a 
line. 

3. A pattern x followed by a $ forms a pattern x$. If the pattern x$ 
is not followed by any other pattern, it matches whatever x 
matches as long as the last character that x matches is at the end 
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of a line. If the pattern x $ is followed by another pattern, then 
the $ is taken literally. 

These last two items constrain pattern matches to begin or end at line 
boundaries, and can be combined to constrain a pattern to match an entire 
line only. 

Replacing with Grep 
You can use Grep not only to search for strings, but also to replace them. 
The following special characters let you alter the replacement string. 

1. Each occurrence of the character & is replaced with whatever the 
entire pattern matched. 

For example, if you wanted to add a P to the beginning of every word that 
ended with pt r, you would search for \ < . * pt r \ > and replace it with p &. 

2. Each occurrence of \n, where n is one of the digits 1-9, is re­
placed by whatever the nth occurrence of \ ( matched 

For example, to change all strings like :itdefine Faa 1 to Faa 1, 
search for: 

:itdefine \ (\<[A-Za-zO-9] [A-Za-zO-9]*\>\) 
\(\<.*\>\) 

and replace it with 

\1 = \2 

3. Each occurrence of a string \x, where x is not one of the digits 
1-9, is replaced by x. 

Grep Examples 
Grep is not easy to learn. To give you a hand, here are some typical exam­
ples. 

Suppose that you've written a Macintosh application, and you've forgotten 
to put a \p at the beginning of your strings to signal to the compiler to make 
them Pascal strings rather than C strings. You can change all your C strings to 
Pascal strings by specifying 

n\ (["I'] *\) n 
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as the search pattern and 

"\\p\l" 

as the replacement string. 

To convert 

symbol equ (expression+4); a comment 

to 

#define symbol (expression+4)/* 

search for 

a comment */ 

\ (\<. *\>\) [space tab] *\<equ\>\ ([";] *\) \ (. *\) 

and replace with 

#define \1 \2 /* \3 */ 

Explanation: 

• \ < . * \ > matches a symbol. 
• The surrounding \ ( and \) lets you use the symbol in the re­

placement string as \ 1. 
• The [space tab] * matches any number of spaces or tabs be­

tween the symbol and the key word equ. (1be words space and 
tab stand for the characters here because you can't see them on 
paper. To enter a Tab, type Command-Tab in the dialog box.) 

• \ <equ \ > matches the word equ. It des not match equ if it is part 
of another word, for example equal. \ <equ \ > is not surrounded 
by \ ( and \) because it's thrown away in the replacement string. 

• [ " ; ] * matches an expression formed by any number of charac­
ters up to but not including a ; (semi-colon). 

• The surrounding \ ( and \) lets you use the expression in the re-
placement string as \ 2. 

• The . * matches the comment which is the rest of the line. 
• The surrounding \ ( and \) stores the comment as \ 3. 
• If there was no ; (semicolon) in the line, then \ 2 consists of ev­

erything after the equ to the end of the line and \ 3 is an empty 
string. 

To convert $HHHH to OxHHHH, where H is a hexadecimal digit, Grep search 
for 
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$\ ( [O-9A-Fa-f] [O-9A-Fa-f] *\) 

and replace with 

Ox\l 

Explanation: 

• $ matches a $. [0 - 9A - Fa - f ] matches one hex digit. 
• [O-9A-Fa-f] [O-9A-Fa-f] * matches one or more hex digits. 

(The pattern [O-9A-Fa-f] * matches zero or more hex digits.) 
• The surrounding \ ( and \) lest you remember the hex digits in 

the replacement string as \ 1. 

Note 
Save complicated Grep search and replace strings in a file 
so you can copy and paste them into the Find .•• dialog 
box. 
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Files & Folders * 
9 

Organizing your files and folders correctly helps mINK C work faster. This 
chapter tells you how to set up your files and folders, how TI-lINK C looks 
for #inc1ude files, and what happens when you move your files from one 
folder to another or from one machine to another. 

Before you begin 
Make sure that you followed the installation instructions in Chapter 2, "In­
stalling TIIINK C 5.0. n If you didn't, go back now, and check to make sure 
that your disk is set up correctly. This chapter explains why your disk should 
be set up this way. 

Contents 
The TI-IINK C and Project Trees 

How THINK C Names Files. . 

How THINK C Looks for Header Files 

Once-only Headers 

Shielded Folders . 

Project Specific Folders 

U sing Aliases 

Using the Trees. . . . . . . . . . . . 
Don't put project folders in the THINK C Tree 
Avoid duplicate file names in trees . 

Organizing Your Files. . .' 

Moving Files Within a Project 
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Moving other files .. 
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A full pathname describes 
exactly where on a disk a 
file is. For example, the 
name Hard Disk: 
Folder l:Folder 2: 
MyF ile . c says the file 
MyFile. c is in the folder 
called Folder 2 which is 
in the folder Folder 1 on 
the disk called Hard 
Disk. 

The THINK C and Project Trees • 
The THINK C and Project Trees 
THINK C works with many mes at the same time. Most programs have sever­
al source files and header files, and virtually every Macintosh application 
needs to use the MacTraps library and some of the standard #include files. 
THINK C needs to be able to keep track of where these files are on your 
disk. At the same time, you have to be able to organize the files in your 
project in a way that makes sense to you. 

Instead of using full pathnames to keep track of where a file is, TIHNK C 
looks for your files either within the folder that contains the THINK C appli­
cation or within the folder that your project is in. 

TIDNK C treats all the files in all the folders within the THINK C Folder 
as if they were in the same flat folder. The THINK C Folder and all the 
subfolders in it are called the THINK C Tree. 

TIDNK C treats all the files in your project folder as if they were all in the 
same folder. The folder and subfolders your project is in is called the 
project tree. 

This organization lets you move files in and out of folders and even rename 
folders without having to let TI-IINK C know exactly where the files are. 
TIDNK C notes which tree a file belongs to when you add it to your project. 
If you move files later on, TI-IINK C looks in the appropriate tree to find it. 

How THINK C Names Files 
When TI-IINK C displays a file name in an edit window's title or in a Get 
Info ..• dialog, it uses these naming conventions to let you know which tree 
the me is in: 

If the name looks like •.• 
<filename> 
filename 

It's in this tree 
TI-IINK C Tree 
project tree 

If a file isn't in the TI-IINK C Tree or in the project tree, TI-IINK C displays an 
absolute name for it: 

vol: filename 
vol:folder:filename 
vol: ... : folder: filename 
vol:?:filename 

top level folder 
subfolder of top level folder 
deeper subfolder 
subfolder on unmounted volume 
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How THINK C Looks for Header Files 
These are the rules TlllNK C uses to ftnd header fIles: 

#include statement 11IINK C looks here 
<filename. h> TI-IINK C looks only in the TIUNK C Tree 
"filename. h" TI-IINK Cloaks ftrst in the referencing 

folder, then in the project tree, and ftnally 
in the mINK C Tree. 

The referencing folder is the folder that contains the file that has the 
=It incl ude preprocessor directive. For example, if a source fIle references a 
header file MyUtils. h, and that fIle in turn has the line =ltinclude 
"MyUtil Types. h", mINK C will look for Myutil Types. h in the folder 
that contains MyUtils. h ftrst. 

Once-only Headers 
You may want to create a header file that you want included in several plac­
es but which should define its symbols only once in a project. You can use 
the =ltpragrna once directive to do this. 

If you have the directive 

=ltpragrna once 

in your header file, mINK C will include that file only once. If another file 
tries to include that header file, TI-IINK C knows that the symbols in that fIle 
have already been defined, so it doesn't process the file again. 

Note 
TlllNK C 4.0 used a similar mechanism. It would not in­
clude a header file if the symbol _ HJname was deftned, 
where fname was the name of the file (in lowercase, with­
out the . h). In fact, the =ltpragrna once directive does ex­
actly the same thing. The =ltpragma once directive has the 
advantage that you can rename the header file without 
changing the directive. 

Shielded Folders 
To shield a folder from either search tree, enclose its name in parentheses. 
For example, you might have a folder in the project folder named (Back­
ups) . mINK C ignores all the files and sub-folders in shielded folders. You 
can use shielded folders to store old versions of source or header files or to 
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keep TI-IINK C from wasting time looking in folders that contain other kinds 
of documents like development notes. 

Project Specific Folders 
There is one exception to the shielding rule. If the folder your project is in 
contains a folder that has exactly the same name as your project surrounded 
by parentheses, TIIINK C will search that folder. 

You can use this feature if you're working on two projects that share meso 
For instance, suppose you're working on two projects, INITProject and 
cdevProject, that share some source files and are in the same folder. You 
create two folders, (INITProject) and (cdevProject), that both con­
tain versions of the header file con f ig . h tailored to control conditional 
compilation of the common source files. 

Note 
In mINK C 5.0, a better way of accomplishing the same 
thing is to use the Prefix page of the Options ... menu. 

Using Aliases 
THINK C lets you work with the alias of a project file. The project tree begins 
where the original project is. However, mINK C does not support aliases in 
these cases: 

• Putting aliases in a project 
• Including aliases in an # incl ude statement 
• Using an alias as a project's resource (. rsrc) file 
• Inserting an alias of a folder in your TIIINK C tree or project tree. 

Using the Trees 
The way THINK C keeps track of your files lets you organize your files just 
the way you like without having to specify full path names. There are a few 
points you should remember about using the THINK C and project trees. 

Don't put project folders in the THINK C Tree 
This is the most common mistake. It seems natural to put all your THINK C 
files in one folder and then toss your project folders in there as well. If you 
set up your disk like this, THINK C will search allyour other project trees ev­
ery time it searches the THINK C Tree. Setting up your project folders this 
way not only increases search times, it also makes it more likely that you'll 
duplicate names within trees. 
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Avoid duplicate file names In trees 
Just as you can't have two files with the same name in the same folder, you 
shouldn't have duplicate me names in different folders within the project or 
TI-llNK C Tree. If you do, TIIINK C won't know which file to use. Duplicate 
file names won't lead to any explicit errors, but you may end up using the 
wrong file. 

It's OK to have the same file name in both the project and mINK C trees. 
TI-llNK C resolves the conflict deterministically by search order. 

Warning 
The Save As ••• command copies files, so if you use it to 
save a copy in another folder, be sure to remove or rename 
the original file. See section "Moving Files Within a Project" 
on page 157. 

Organizing Your Files 
When you're working on a small program, it makes sense to keep all the 
source files and all the header files in the same folder like this: 

0 Small Rpplication t!J 
8 items 48 1603K in disk 1 Ol362K av ailab le 

[i ~ 
~ 

Small Application.l1 Sma 11 Application .11.rsrc 

~ ~ ~ 
Smal1App.c Drawing.c WindowHandler .c 

I ~ ~ 
Smal1App.h Drawing.h MenuHandler .c {} 

¢I I~ Q] 

Figure 9-1 Organizing files for a small application 
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0 
9 items 

~ 
larger Application.'71 

~ 
larger App.c 

LJ 
Common Headers 

~l 

Moving Files Within a Project • 
In the project in Figure 9-1, TInNK C looks for all the project files in the fold­
er called Small Application. 

As your application grows, you might want to distribute your source and 
header files among several folders like this: 

Larger Rpplication ~I= Table Lookup Routines 
49,903K in disk 9,062K available 

49,903K in disk 9,062K availa 5 items 

LJ ~ 
[Q 

~ ~ (Old Files) larger Application.'71.rsrc 
Tab lelookup.c Hashing.c 

LJ LJ LJ Drawing Routines Dr awing Window 
Tab le lookup Headers 

1IIIIIIl!l!l!ll LJ ~ ~ Tab le lookup Routines Scaling Commands 5 TableTest.c TableTest.'71 

I¢ Q] 

Figure 9-2 Organizing files for a larger application 

In Figure 9-2 most of the source and header files are in folders. Since TIIINK 
C treats all the files and folders within the Larger Application folder 
as if they were in the same folder, you can put your header files where they 
make the most sense. The folder called (Old Files) is a shielded folder, 
so TIIINK C will never look for source or header files there. You can use 
shielded folder this way to store old versions of files. 

Moving Files Within a Project 
You can move files freely within a tree. IfTInNK C can't find a file that's al­
ready in your project, it assumes that you've just moved it somewhere within 
the tree, and tries to find it there. 

Moving a source file 
To move a file from one tree to the other tree, it's best to use the Save As ••• 
command in the File menu. This command takes care of updating the refer­
ences to the file in your project document without losing the object code, so 
you won't have to recompile it. 
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This is how you move a file from one tree to the other: 

1. Open the file you want to move. Double clicking on its name in 
the project window is the fastest way. 

2. Choose Save As ••• from the File menu. When the standard file 
dialog box appears, go to the folder within the tree you want to 
save the file in, and click on Save. 

3. Make sure you delete the file from the original tree. Since Save 
As ••• makes a copy, the original file is still in the old tree. 

Moving a library 
Moving a library is a little trickier since you can't open libraries with the edi­
tor. 

1 . Move the library to a folder in the other tree. Use the Finder or a 
file-moving desk accessory. 

2. Choose Remove from the Project menu to remove references to 
it from the project. 

3. Use the Add ••• command in the Source menu to put it back into 
the project. 

Moving other files 
From time to time your project may refer to files and libraries outside the 
n-nNK C or project trees. To move these files, use the same procedure as for 
libraries above. 

Moving files to another machine 
When you move a project to another Macintosh, use the Use Disk button in 
the Make ••• dialog to let TIIINK C find all the files. Files don't need to be in 
exactly the same place on the two machines as long as they're within the 
project or THINK C Trees. Files outside either tree must have the same abso­
lute pathname on the two machines. 

A note about search times 
Searching the trees after you've moved files around can take a little time. 
Once TIIINK C finds a file, though, it remembers where it is and looks there 
first the next time. So if the compiler seems slower than usual, don't worry. 
Once TIIINK C learns where your files are, it will speed up again. 
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Disk layout Diagram 

Disk Layout Diagram • 
This diagram shows the recommended disk layout. You don't have to set up 
your disk this way, but the important thing to remember is that your project 
folders should not be in the THINK C folder. 

c:::J 
Hard D;sk 

I 
LJ 

Deve lopment 

LJ LJ 
THINK C Folder Bullseye Folder Other Project Folder 

~ [i] 
THINK C THINK C Debugger bullseye 11 

LJ I 
Mac #;nc ludes bullseye.c 

LJ LJ I 
Mac L ;br ar;es C L;brar;es bullMenus .c 

LJ LJ I 
oops L ;br aries TH INK Class L ;br ary bullW;ndow.c 

Figure 9-3 Recommended disk layout for THINK C 
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10 

Different compilers implement C differently. even if they conform to the ANSI 
standard. This chapter explains the unique features of THINK C: how to 
compile source files, how to use precompiled headers, and how to set op­
tions that affect the way TI-IINK C compiles your source files. This also chap­
ter lightly touches on how TI-IINK C complies with the ANSI standard for the 
C language. For more detailed information, Chapter 22, "Language Refer­
ence." 

Contents 
Compiling Source Files . . . . . 

Compiling files not in the project . 
Compiling files already in the project 
Checking files without compiling 
Fixing errors in source files 

Precompiled Headers. . . . . . 
Editing the MacHeaders file . . . . . 
Creating your own precompiled headers . 

THINK C Reports . . . . . . . 
Viewing the preprocessor output 
Disassembling your code. . . 
Generating a link map. . . . 

How TI-IINK C Implements C . . . 
Identifier length and capitalization 
Using register variables 
Integer representation. . . 
Floating point representation 

THINK C Extensions . 
Disabling trigraphs 
enums of any size 
Inline assembly . 
pascal keyword . 
C++ style comments 
short double type . . . . . 
Comments after #else and #endif 
Inline function definitions. . . 
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Low memory global definitions 
Mc68881 unary inline functions 
Function prototypes with (. .. ) . 
Dimensionless arrays. . . . . 
Using void • with function pointers 
The TIIINK_ C predefined symbol 

Using the Options ... Dialog. . . 

Using the Project Prefix . . . . 

Compiling ANSI-Conformant Code. 

Using the Global Optimizer. . . 
Induction variable elimination . 
CSE elimination 
Code motion . 
Register coloring 

Using Other Optimizations . . 
Defer & combine stack adjusts 
Suppress redundant loads 

Type Checking . . . . . 
Checking pointer types . 
Enforcing prototype use. 

Writing Processor-Specific Code. . 
Writing code for the Mc68020 . 
Writing code for the Mc68881 . 

Porting Code to THINK C. . . . . 
Porting code from other compilers . . . 
Porting code from other versions of THINK C 

Using #pragma Directives. . . . . 
The pragma once directive. . . 
The pragma parameter directive . 
The pragma nooptimize directive 

Accessing Option Settings in Your Code. 
Internal compiler options . 
Set Project Type ... options . 
Type options . . . . . 
Language extension options 
Enumerated type option. . . . . 
Pascal string option . . . . . . 
Object-oriented programming options 
Type-checking options . . . . . . . 
Generating processor-specific code options 
Debugging options . . . . . . . . 
Global optimizer options . . . . . . 
Other optimization options. . ',' . . 
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Compiling Source Files 

Compiling Source Files • 
Unlike traditional compilers, TIDNK C doesn't generate separate object 
flIes from your source flIes. Instead, TI-IINK C puts all the object code into 
the project document. Although you can compile flles yourself, most of the 
time you'll be using the Auto-Make facility to compile your meso 

Note 
Source files are your program files. Object code is the ma­
chine language that the TIDNK C compiler generates from 
your source files. 

Compiling files not in the project 
You can add a source file to your project and compile it in one step. First, 
create your source file with the TI-IINK C editor. Save your flle in the same 
folder as the project document. Make sure that the file name ends in . c. 
TIDNK C will only compile files that end in . c. 

Next, choose Compile from the Source menu. A dialog box shows you 
how many lines TIDNK C has compiled. If there were no errors in the source 
file, TI-IINK C adds the file and its object code to the project. 

Compiling files already in the project 
If you want to compile a file that is already in the project, just click on its 
name in the project window and choose Compile from the Source menu. 
Once a file is in the project, you don't need to open it to compile it. 

Checking files without compiling 
Sometimes you just want to make sure that your source file will compile 
without actually compiling it. The Check Syntax command in the Source 
menu checks the syntax of the contents of the frontmost edit window with­
out generating code or adding the file to the project window. In fact, you 
don't even have to save the file first. 

Fixing errors in source files 
When TI-IINK C detects an error in your source file, it opens the source file 
and displays a bug alert. 

'theEuent' has not been declared 

Figure 10-1 A bug alert 
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To get rid of this alert box, click anywhere in it or press the Return or Enter 
key. 

The source file that contains the error will be in an editor window with the 
line that contains the error highlighted. 

Precompiled Headers 
TIIINK C lets you precomplle header (#include) fIles. Precompiled headers 
contain only declarations and preprocessor symbols. Since precompiled 
headers are in a format mINK C can use readily, they load faster than text 
header files. 

Note 
If you're using the source level debugger, you should use 
precompiled headers. Precompiled headers help make the 
debugger tables smaller. 

THINK C comes with one precompiled header fIle, MacHeaders, which 
contains the most common declarations you use for writing Macintosh pro­
grams. If you #include MacHeaders in the project preftx, mINK C auto­
matically includes MacHeaders in all the mes in your project, so you never 
have to explicitly #include common header files like QuickDraw. h. (It 
doesn't hurt if you do.) To edit the project preftx, go to the Preftx page of the 
Options ..• dialog, described on page 181. 

Note 
The project prefIX contains the line =It incl ude 
<MacHeaders> by default. 

The MacHeaders me contains these mes: 

Controls.h 
Devices.h 
Disklnit.h 
Events.h 
Fonts.h 
Memory.h 
Notification.h 
OSUtils.h 
Quickdraw.h 
Scrap.h 

Desk.h 
Dialogs.h 
Errors.h 
Files.h 
Lists.h 
Menus.h 
OSEvents.h 
Processes.h 
Resources.h 
SegLoad.h 
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StandardFile.h 
Timer.h 
Types.h 
pascal.h 
LoMem.h 

Precompiled Headers • 
TextEdit.h 
ToolUtils.h 
Windows.h 
asm.h 
THINK.h 

These mes aren't used as often, so they're not included in MacHeaders. 
You'll have to include them yourself. 

ADSP.h 
Aliases.h 
AppleTalk.h 
CommResources.h 
ConnectionTools.h 
CTBUtilities.h 
DeskBus.h 
Editions.h 
EPPC.h 
FileTrasferTools.h 
FixMath.h 
GestaltEqu.h 
HyperXCmd.h 
Language.h 
Packages.h 
Picker.h 
Power.h 
Printing.h 
QDOffScreen.h 
ROMDefs.h 
Script.h 
Serial.h 
Slots.h 
SoundInput.h 
SysEqu.h 
TerminalTools.h 
Video.h 

AIFF.h 
AppleEvents.h 
Balloons.h 
Connections.h 
CRMSerialDevices.h 
DatabaseAccess.h 
Disks.h 
ENET.h 
FileTransers.h 
Finder.h 
Folders.h 
Graf3D.h 
Icons.h 
MIDI.h 
Palettes.h 
pictUtil.h 
PPCToolBox.h 
PrintTraps.h 
Retrace.h 
SANE.h 
SCSI.h 
ShutDown.h 
Sound.h 
Start.h 
Terminals. h 
Values.h 
Traps.h 

Usually, you'll just use the built-in MacHeaders. You can, however, edit the 
default MacHeaders file or make your own precompiled headers. 

Editing the MacHeaders file 
You might find that in the kinds of program you write, you frequently refer 
to a header file that is not already in MacHeaders. Or, MacHeaders might 
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include some files you never use. You can edit the MacHeaders file to suit 
the kinds of programs you write. 

1. Find the me, Mac iincludes. c in the Mac iincludes 
folder. DU~licate it and give it a new name, such as My 
iincl udes. c. Open the duplicate with TIIINK C. 

2. If you want to change the compile options, edit the ipragrna 
options directive. Otherwise, it uses the settings in the Op­
tions ... dialog and uses different options depending on the proj­
ect that's open. For more information, see" Accessing Option 
Settings in Your Code" on page 195. 

3. Search for the files you want to add or remove. All the 
i incl ude statements are enclosed in conditional compilation 
directives. To add a file, change the iif 0 directive to iif 1. 
To remove a file, change the i i f 1 directive to i i f O. Some 
files can't be used together. For more information, see the list be­
low. 

4. Choose Precompile ... from the Source menu. After TIIINK C 
precompiles the file, save it as MacHeaders. (Precompiled files 
don't go into the project.) The best place for MacHeaders is in 
the Mac i incl udes folder, but you can save it anywhere in 
the TIIINK C tree. 

The auto-make facility marks the files in the current project for recompila­
tion if you charige MacHeaders. To let other projects know that 
MacHeaders changed, use the Make .•. command in the Source menu. 
Click on the Use Disk button to mark all the files affected, then click on the 
Make button to recompile them. 

When you add and remove files from MacHeaders, keep these dependen­
cies in mind: 

• You carmot #include both Printing. hand Print Traps. h. 
• You cannot #iriclude both LoMem. hand SysEqu. h. 
• If you #include both asm. h and Traps. h, you must #include 

asm. h before Traps. h. IfYOli #include Traps. h, do notprefix 
traps with underscores in inline assembly. 
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Creating your own precompiled headers 
If you want to use your own precompiled headers, follow these steps: 

1. Remove the line #include <MacHeaders> from the project 
preflX, described on page 181. 

2. Create a file containing the desired series of #include state­
ments. You can #include MacHeaders or any other precompiled 
header in the first line of your prc:!compiled header. 

3. If you need to change the compile options, use the #pragma 
options directive. Otherwise, it u~es the settings in the Op­
tions ... dialog and uses c4fTerent options depending on the proj­
ect that's open. For more information, see "Accessing Option 
Settings in Your Code" on page 195. 

4. Choose the Precomplle ... command from the Source menu. 
When TIUNK C is through precompiling, it asks you to name the 
file. 

You use a precompiled header the same way you use any other header file. 
Use the #include statement to ~oad!t into your source file. The #include 
statement must be the first non-comment line of your source file. You can 
use only one precompiled header per source file. (If you #include 
MacHeaders in the project prefix, you can't explicitly include any other 
precompiled header.) 

If you don't #include any precompiled headers in the project preflX, you can 
use several different precompiled headers for different parts of your pro­
gram, and you can still explicitly include MacHeaders if you want to use it 
in certain files. 

Note 
You can use only one precompiled header per source file. 

THIN~ C Reports 
TI-ITNK C lets you look at your source code and finished applications in 
three different ways. You can see the preprocessor output of a source file, 
the assembly code a source file produces, and a link map of a finished appli­
cation. 
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Viewing the preprocessor output 
If you think you have a bug in one of your macros, use the Preprocess 
command in the Source menu. It runs the code in the frontmost window 
through the TIllNK C preprocessor and displays the result in a new window. 
The preprocessor expands your macro, includes the contents of your #in­
clude files, and evaluates your #ifdef statements. You can save and print 
the contents of this window like you would any other file. 

Disassembling your code 
Looking at the assembly code that the compiler produces helps you debug 
your code and figure out how efficient it is. The Disassemble command in 
the Source menu disassembles the code in the front-most window and dis­
plays the result in a new window. You can save and print the contents of this 
window like you would any other file 

Note 
The Disassemble command shows all references to global 
variables and subroutine calls as being at OxO 000 (AS) . 

This value is merely a place holder for the disassembler. 
When lliINK C compiles your program it uses the correct 
offset. 

Generating a link map 
TIllNK C can write a link map for your application. The link map lists all 
your project's segments, including one for global data. For each function (or 
global variable) in a segment, the map lists its name, its position in the seg­
ment, and the file it's defined in. To generate a link map, turn on the "Gener­
ate link map" option in the Preferences page of the Options •.• dialog. 

TIllNK C creates the link map only when you use the Bund .•• command. 
The name of the map is the name of the project with 0 map appended. For 
example, the link map for the Bullseye o1t project is Bullseye o1t 0 map. 
TIllNK C places the link map in the project folder and erases any link map 
that was there. 
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This is an excerpt from the global data section of a link map: 

Segment "%GlobalData" size=$00084E 
appleMenu -$00084E(AS) file="bullMenus.c" 
fileMenu -$00084A(AS) 
editMenu -$000846(AS) 
widthMenu -$000842(AS) 
windowBounds -$0007A8(AS) file="bullWindow.c" 
circleStart -$0007AO(AS) 

Here is how to read it: 

• The top line gives the segment's name and size. This segment is 
named %GlobalData and is Ox00084E bytes large. 

• Each of the other lines lists a variable and its address as a negative 
offset from AS. The variable appleMenu is at Ox00084E offset 
from AS. 

• At the far right is the name of the file that defines the variable. 
The variables appleMenu, fileMenu, edi tMenu, and 
widthMenu are in the file bullMenus. c. The variables 
windowBounds and circleStart are in bullWindows. c. 

And this is an excerpt from a code segment: 

size=$0004FC rsrcid=2 Segment "Seg2" 
SetUpMenus 
AdjustMenus 
HandleMenu 
InitMacintosh 
HandleMouseDown 
HandleEvent 
main 

Here is how to read it: 

$000004 file="bullMenus.c" 
$000092 
$000186 
$000282 
$0002A6 
$00036E 

file="bullseye.c" 

$000414 JT=$000072 (AS) 

• The top line gives the segment's name, size, and resource ID. The 
segment Seg2 is OxO 0 0 4FC bytes large and is in code resource 
2. 

• Each of the other lines lists a function name and its offset within 
the segment. The function SetUpMenus () is at offset 
Ox000004. 

• If a function has a jump table entry, the address of the entry is list­
ed as an offset from AS. The function main () has a jump table 
entry at Ox000072 offset from AS. 

• At the far right is the name of the file that defines the function. 
The functions SetUpMenus (), AdjustMenus () , and 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 795 and 
"Other optimization op­
tions" on page 202. 

HandleMenus () are in the file bullMenus. c. The functions 
InitMacintosh() , HandleMouseDown() , 
HandleEvent () , and main () are in bullWindows. c. 

How THINK C Implements C 
This section describes how mINK C implements certain parts of the C lan­
guage, including how it assigns variables to registers and how it represents 
integers and floating-point numbers 

Identifier length and capitalization 
In mINK C, every character in an identifier and its case is significant. For ex­
ternal identifiers, the number of significant characters is 255. For all other 
identifiers, all characters are significant. 

Using register variables 
In mINK C, you can decide which variables are placed into registers or let 
THINK C decide for you. The "Automatic Register Assignment" option in the 
Code Optimization page of the Options ..• menu controls what happens. If 
that option is on, mINK C automatically assigns variables to registers to 
make your code as small as possible. If that option is off, mINK C puts only 
those variables declared register into registers. 

r· r8J Automatic Register Assignment ···································1 

I D Honor 'register' first I 
, ........................................................................................................................ : 
Figure 10-2 The "Automatic Register Assignment" option 

If you select this option, the "Honor 'register' first" option below appears. 
This table explains what that option does: 

If "Honor register 
first is" ••• 
On 

Off 

TIIINK C ••• 
Puts the variables declared register in 
registers and puts the variables it wants in 
the remaining registers. 
Ignores your register declarations and 
puts the variables it wants in registers 
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How THINK C Implements C • 
When you ask Tl-llNK C to honor your register declarations, the following 
registers are available for register allocation: 

Registers 
A2-A4 
D3-D7 

FP4-FP7 

Note 

Used for 
Pointer types 
Integral types, pointer types, and floats if 
"Generate 68881 instructions" is on 
12-byte floating-point types if "Generate 
68881 instructions" is on 

If you're building a desk accessory, device driver, or code 
resource, register A4 is not available for register variables. 
These project types use A4 to access their globals. 

You should not rely on the order in which TI-lINK C allocates variables to 
registers. Tl-llNK C never places a struct or a union in a register, even if it 
would fit into one. 

When you ask Tl-llNK C to choose variables to place in registers, TmNK C 

tries to make your code as small as possible. Notice that it doesn't try to save 
time. For example, it will not make a special effort to place a variable incre­
mented in a loop in a register. 

This list explains which option is best for your project: 

• If you're porting old code with many register declarations, 
turn on "Automatic Register Assignment" and turn off "Honor 
'register' first." TI-lINK C will ignore the declarations and will pro­
duce the smallest code possible. 

• If you're writing new code, turn on both "Automatic Register As­
signment" and "Honor 'register' first." As you write, don't use 
'register' declarations unless you're sure you want to override 
Tl-llNK C's assignments. For example, you may want to put a 
variable incremented in a loop in a register. Since this option op­
timizes for space and not speed, TI-lINK C may not put that vari­
able in a register. You must declare it register to ensure that it 
is. 

• If you need to be absolutely sure what's in each register, turn off 
"Automatic Register Assignment." 
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You can test and change the 
settings of this option from 
your code. See "Accessing 
Option Settings in Your 
Code" on page 795 and 
"Type options" on page 
797. 

Note 
When mINK C compiles a function that contains in-line as­
sembly, it ignores this option's setting and does not auto­
matically assign variables to registers. 

Integer representation 
This section describes how TI-llNK C implements integers. The limits for the 
integer types are declared in the header file <limits. h> and documented 
in the Standard Libraries Reference. 

Integers are represented as 2's complement binary numbers. These are the 
sizes of integer types: 

Type Bytes 
char 1 
short 2 
long 4 
int 2 or4 

You choose the size of int with the "4-byte int" option in the Compiler Set­
tings page of the Options ... dialog. If the option is ofT, in ts are two bytes 
long. If it's on, ints are four bytes long. 

Use four byte ints if you're porting code from a compiler that uses four 
byte integers, like MPW C, or you're porting code that assumes integers and 
pointers are the same size. Otherwise, use two byte integers, since the 
Mc68000 family handles them more efficiently. 

Note 
If you turn on the "4-byte int" option, you must recompile 
the AN S I library if your project uses it. 

Floating point representation 
This section describes how TI-IINK C implements floating-point numbers. 
The limits for the floating-point types are declared in the header file 
<float. h> and documented in the Standard Libraries Reference. 
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These formats are docu­
mented in detail in the Ap­
ple Numerics Manual, 
Second Edition (Addison­
Wesley) by Apple Computer. 

exponent 1 exponent 

How THINK C Implements C • 
TIDNK C gives you these three types of floating-paint numbers. 

• long double is the fastest floating-point type. Use this type 
most of the time. 

• float is smaller than double, but also slower. Use this type 
when you need to save space and can sacrifice some speed and 
accuracy. 

• short double is the medium sized float but, strangely 
enough, is the slowest floating point type. You'll rarely need to 
use this type. 

The TI-lINK C type double is usually the same size as a long double. 
However, if the "8-byte doubles" option is on, double uses the same repre­
sentation of short double. This option is described in "Porting code 
from other compilers" on page 193. 

Note 
The short double type is a TI-lINK C extension and is 
not part of the ANSI standard. 

TIDNK C uses these five different representations for floating point values: 

• 4 byte IEEE single precision 
• 8 byte IEEE double precision 
• 10 byte SANE extended precision 
• 12 byte Mc68881 extended precision 
• 12 byte universal extended precision 

mantissa 12 byte 
THINK C Universal 

12 byte 
MC68881 Extended 

exponent I always zero I mantissa 

exponent mantissa 10 byte 
SANE Extended 

exponent ---+-1." mantissa 8 byte IEEE 

exponent mantissa 4 byte IEEE 

Figure 10-3 Floating-point formats 

The Universal format is a TI-lINK C extension that lets TI-lINK C use the same 
format whether the program uses Mc68881 code generation or SANE. The 
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For more information on the 
Options ..• dialog, see "Us­
ing the Options ... Dialog" 
on page 179. 

You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 795, "Type 
options" on page 7 97, and 
"Generating processor-spe­
dtic code options" on page 
200 

If you're writing ANSI-con­
formant code, you must dis­
able all the THINK C 
extensions. For more infor­
mation, see "Compiling 
ANSI-Conformant Code" on 
page 782. 

universal format is the same as the Mc68881 extended format, but it dupli­
cates the exponent part in the second word. 

The types float and short double always use the same representa­
tion: float uses the 4-byte IEEE representation, and short double use 
the 8-byte IEEE representation. However, the representation for long 
double depends on your option settings. 

To choose a format for long double, use these two options in the Com­
piler Settings page of the Options ..• dialog: "Native floating-point format" 
and "Generate 68881 instructions." If "Native floating-point format" is off, 
THINK C uses the Universal format. If "Native floating-point format" is on, 
THINK C chooses a format according to the setting of "Generate 68881 in­
structions. " This table shows which format mINK C uses: 

If Native Float- and Generate Then doubles use 
lng-point is 68881 is this format ..• 
Off On or Off Universal 
On Off SANE Extended 
On On Mc68881 Extended 

If your project contains any libraries or projects that were compiled with the 
Universal format, use the Universal format. These mINK C libraries use the 
Universal format: 

• ANSI 
• profile 

If you're writing a library for general use, use the Universal format. Projects 
can use your library no matter how they set the "Generate 68881 instruc­
tions" option, as long as they turn off the "Native floating-point format" op­
tion. 

If you want the fastest code possible and use no libraries compiled in the 
Universal format, use the native floating-point format. The conversions to 
and from the Universal format are eliminated. 

THINK C Extensions 
THINK C defmes several extensions to the C language that make program­
ming on the Macintosh easier and let you take advantage of object-oriented 
programming. 

Most of the extensions are controlled with the "Language Extensions" option 
in the Language Settings page of the Options ... dialog. When you turn that 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 795 and 
"Language extension op­
tions" on page 798. 

THINK C Extensions 

option on, you can choose between two sets of extensions: "THINK C" or 
"THINK C + Objects." 

! .. ·181 Language Extensions ·· ................................ ·· .................. ·1 

i @THINK C I 
! 0 THINK C + Objects I 
i ................................................................................................................... j 

Figure 10-4 The "Language Extensions" option 

The "TIllNK C" setting enables these extensions, which are described be­
low: 

• Inline assembly 
• pascal keyword 
• C++ style comm~nts 
• short double type 
• Comments after #else and #endif 
• Inline function definitions 
• Low memory global definitions 
• Mc68881 unary inl~ne functions 
• Function prototypes with ( ... ) 
• Dimensionless arrays 
• Using void * wi~ function pointers 
• The THINK _ C predefined symbol 

• 

The "THINK C + Objects" ~etting enables all the extensions above plus it lets 
you write object-oriented code. The object extensions are described in Ob­
ject-Oriented Programming, Chapter 4, "Using Objects in THINK C." If you 
use the object extensions, these words become keywords, and you can't use 
them as identifiers: 

class 
new 

delete 
virtual 

These words are interpreted specially in context. They are not keywords, 
but you should avoid using them: 

direct 
operator 
public 

indirect 
private 
this 

inherited 
protected 
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You can test and change the 
settings of this option from 
your code. See "Accessing 
Option Settings in Your 
Code" on page 795 and 
"Language extension op­
tions" on page 798. 

You can test and change the 
settings of this option from 
your code. See "Accessing 
Option Settings in Your 
Code" on page 795 and 
"Enumerated type option" 
on page 799. 

Two other extensions have their own option settings in the Language Set­
tings page of the Options .•• dialog. 

This extension .•• 
Disabling trigraphs 
enums of any size 

is controlled by this option .•• 
Recognize trigraphs 
enums are always ints 

.... ANSI Conformance ......................................................................... ... 

o #define _STDC_ 

[8J Recognize trigraphs 

r8l enums are always ints 

o Check pOinter types 

Figure 10-5 Two more THINK C extensions 

Disabling trigraphs 
Trigraphs are sequences of three letters that are treated as one. The se­
quence contains?? and an additional character. Trigraphs let computers 
without such characters as braces ( {, }), tilde ( ""), and caret (II.) use C. How­
ever, many Macintosh programs use character literals that resemble tri­
graphs. For example, the file type '????' is interpreted as '?". If you 
don't want THINK C to recognize trigraphs, turn off the "Recognize tri­
graphs" option in the Language Settings page of the Options ... dialog. 

Note 
To write the file type '????' with the "Recognize tri­
graphs" option on, use '??? \ ? ' . 

enums of any size 
In THINK C, enumeration types can be the same size as a char, short 
int, int, or long into 

THINK C makes an enumeration type as small as possible or as large as nec­
essary. For example, this type will only be as large as a char: 

enum { red=l, yellow, green }; 

And this type will be as large as a long int: 

enum { million=1000000, billion=1000000000 }; 
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The rest of the extensions in 
this section are available 
when you turn on the "Lan­
guage Extensions" option in 
the Language Settings page 
of the Options ... dialog 

THINK C Extensions • 
If you want enumeration types to be any size, turn off the "enums are always 
ints" option in the Language Settings page of the Options ..• dialog. If you 
are writing ANSI-conformant code, turn the option on. 

Inline assembly 
The identifier asm is reserved for the inline assembler. For more information 
about the inline assembler, see Chapter 13, "Assembly Language." 

pascal keyword 
The identifier pascal is reserved to define functions that follow Pascal call­
ing conventions. 

c++ style comments 
Two slashes (/ /) introduce a comment. The comment ends at the new-line 
character. 

short double type 
The type short double is allowed. It is an 8-byte IEEE floating point 
number. 

Comments after #else and #endif 
An identifier after an #endif or #else preprocessing directive is ignored. 

#ifdef DEBUG 
printf( "oops!\n"); 

#endif DEBUG 

Inline function definitions 
You can define inline functions using this form: 

ret urn Type !unctionName (arguments) 
{ instrl, i nstr2, ... }; 

TI-llNK C replaces a call to the functionjunctionNamewith the machine in­
structions instrl, instr2, ... instead of generating a function call. For exam­
ple, the function P rOpen () is defined like this: 

pascal void PrOpen(void) 
= {Ox2F3C,OxC800,OxOOOO,OxA8FD}; 

When you call P rOpenP age () TIlINK C generates these instructions: 

move.l #Oxl0000808, -(SP) 
PrGlue 
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For a detailed description of You can use the #"pragma parameter directive be used to assign registers 
the #pragma parameter di- to parameters: 
rective see page 194. 

#"pragma parameter AO NewHandleClear( DO) 
pascal Handle NewHandleClear(Size byteCount) 

= OxA322; 

Most of the Macintosh Toolbox routines are defined in the header files as in­
line functions. 

Low memory global definitions 
Global variables may be defined to refer to absolute memory addresses. 

extern short MemErr : Ox220; 

This construct is only legal in global scope. The extern storage-class speci­
fier is optional. It was required in earlier versions of TIIINK C. 

~IIC68881 unary inline functions 
When the "Generate 68881 instructions" option is on, you can declare unary 
inline functions for the MC68881 like this: 

returnType !unctionName (argument) : instr; 

where instris the low seven bits of the second word of the desired Mc68881 
instruction. This syntax works with unary functions-functions with only 
one argument. 

For example, this is the inline function definition for atanh () : 

double atanh (double) : OxOD; 

The header file <rna th . h> defines some unary functions in this way. You 
may want to define others yourself. 

Function prototypes with ( ... ) 
The parameter list ( ... ) is allowed in a function prototype. 

Dimensionless arrays 
Dimensionless arrays are allowed as the last member of st ruct definitions. 
The member does not contribute to the size of the struct. For example: 

struct { 
short count; 
char data[]; 

} CountData; /* sizeof(CountData) is 2 */ 
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@This Project 

~ I Preferences 

Using void * with function pointers 

Using the Options ... Dialog • 
You can use the type void * with function pointers, in addition to data 
pointers. 

The THINK_C predefined symbol 
TIllNK C predefines a preprocessor symbol, THINK _ C, so you can test for 
TIllNK C and for the version when doing conditional compilation. In this 
version of mINK C, it is set to 5. In mINK C 4.0, it's set to 1. In previous 
versions, it's not defined. 

Using the Options ... Dialog 
The Options .•• dialog in the Edit menu gives you a great deal of control 
over how the mINK C environment behaves and how the mINK C compil­
er compiles your code. 

» Copy» o New Projects 

r·· Search Options ................................................................................. ~ 

I 0 Whole words only I 
~ Confirm project updates 

~ Confirm saues 

i 0 Wrap around i 
L ... ~ ... ~.~.~.~.~~ ... ~.~.~.~ ............................................................ _ .... ..1 

o Always compact projects 

o Generate link map 

~ Projector-aware 

: ................................................................................................................................................................................................. -............................................. ~ 
I This is the Options dialog. Click on any button to find out more about that I 
! option. Use the pop-up menu to go to a specific page ,or use the arrow button to i 
i move the next or previous pages. ! 
t .............................................................................................................................................................................................................................................. .1 

( Factory settings) [~( iiiiiiiiiiiiiiiOiiiiiiiiiiiK ~)) ( cancel) 

Figure 10-6 The Options ... dialog 

The help box is near the bottom of dialog, just above the buttons. It displays 
information about an option when you click on the option. To get help on 
an option without changing its setting, click on it without releasing the 
mouse button, move the mouse off the option, and then release the mouse 
button. 
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The Options ..• dialog has six pages. To go to a certain page, click on the 
pop-up menu in the upper left corner and select the page name. You can 
also scroll through the different pages with the arrow keys or the arrow but­
tons to the left of the pop-up menu. an the Preftx page, you have to press 
the Command key with the arrow keys.) 

../ Preferences 
Language Settings 
Compiler Settings 
Code Optimization 

Figure 10-7 The Options ... dialog pop-up menu 

You can set the options for the current project, or you can set the defaults 
that TIUNK C will use when you create a new project. Use the Copy button 
at the top of the dialog box to copy the THINK C defaults to the current proj­
ect, or if you want the options you've set for a particular project to be the 
THINK C options. Note that even though only one page of the options 
shows up in the dialog at one time, the Copy button copies all of the op­
tions, even the ones in the pages you can't see. 

When you click on the Factory Settings button, THINK C sets all the options 
in all the pages back to their factory settings, the settings they had when you 
first took THINK C out of the box. 

When you click on the OK button, the changes for all pages of the dialog are 
saved. When you click on the Cancel button, the changes for all the pages of 
the dialog are discarded. It's like you never selected the Options ... com­
mand. 
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Using the Project Prefix • 
The following sections show you how to set the options for special needs: 

To set up the options to ••• 
Create a link map, listing every 
function in your application 

Use mINK C's extensions to C 

Read this •.. 
"Generating a link map" on page 168 

"mINK C Extensions" on page 174 

Include code in every file in your "Using the Project Prefix" on page 181 
project 

Compile code that strictly follows "Compiling ANSI-Conformant Code" 
the ANSI standard on page 182 

Use the global optimizer to make "Using the Global Optimizer" on page 
your code smaller and faster 184 

Use other optimizations to im­
prove your code 

Strictly to type-check your code. 

"Using Other Optimizations" on page 
186 

"Type Checking" on page 188 

Port code easier by changing how "Porting Code to THINK C" on page 
THINK C interprets your declara- 193 
tions and Pascal string literals 

Write code for a Macintosh with a "Writing Processor-Specific Code" on 
Mc68020 or Mc68881 page 191 

Some options are explained in other parts of the mINK C documentation: 

To set up the options to ..• 
Select your debugging options 

Use the code profiler 

Select your search options. 

Select your object-oriented pro­
gramming options. 

Using the Project Prefix 

Read this ••• 
"Debugging Options" on page 243 

Chapter 15, "The Profiler 

"Search options" on page 140 

Object-Oriented Programming, Chap­
ter 4, "Using Objects in mINK C" 

The project prefix lets you include some text in all the source files in your 
project. It's as if you put the project prefix at the beginning of all your source 
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For more information on 
how THINK C complies with 
the ANSI standard, see 
Chapter 22, "Language Ref­
erence." 

files. You set in this preftx in the Preftx page of the Options ••• dialog, 
shown in Figure 10-8. 

@ This Project ( » Copy» ) o New Projects 

~I PreflH I 
#Include <"1ocHeoders> 

~""'''''._M''''''M''''''''''~_''' 
I 

option. Us. tM pop-..p "...... to 90 to • sp.eiflc P., or us. tM lITO,", button to 
mon tM M"t or pr.vious P.s. -----------_. 

( Factory settings I ( OK J ( Cancel ) 

Figure 10-8 The Prefix page of the Options ... dialog 

If you use a precompiled header file, like MacHeaders, #include it here. By 
default, this page contains the line #include <MacHeaders>. 

Note 
THINK C does not precompile what's in the project prefix. 
To precompile something, you must use the Precom­
pile •.• command, described in "Precompiled Headers" on 
page 164. 

If you need to define a macro in all your files, deftne it here. For example, 
you may have some debugging code in your files that's compiled only if the 
macro DEBUG is defined. To include that code, include this line here: 

#define DEBUG 

When you don't need to include the debugging code anymore, just delete 
that line from this page. You don't need to edit every file in your project. 

Compiling ANSI-Conformant Code 
To compile ANSI-conformant code, you have to change some settings in the 
Languages Settings page of the Options ... dialog, shown in Figure 10-9. 
These settings turn on ANSI features and turn off the THINK C extensions. 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 195. and 
"Language extension op­
tions" on page 198 

Compiling ANSI-Conformant Code • 
@ ThIs Project ( » Copy» ) o New Projects 

[;]1 lansuase Settlnss I 

rl8l 
........ "' ....... 

I 
AHSIConf~ 

o #deflne --STDC_ @THINKC 

o RecognIze trlgraphs OTHINK C + Ob)ects 

o enums are always Ints rl8l ''"'' ......... ""_. 181 Check poInter types o Infer prototypes I @ RequIre prototypes 

I This Is u.. Options ~lot· CHcIc on ..., button to find out mon M>out tNt 

I 
option. IJH u.. pop-up menu to 90 to I ~tftc ~, or 11M u.. ,"ow button to 
mon u.. next or prrrlous ..... 

( Factory settings ) ( RNSI Settings ) [ OK J (. Cancel ) 

Figure 10-9 The Language Settings page of the Options ... dialog 

The ANSI Settings button on this page sets all the options on this page to 
their ANSI-conforming settings, as shown in this table: 

ANSI Setting5 sets this ... 
#define _STDC_ 
Recognize trigraphs 
enums are always ints 
Check pointer types 
Language Extensions 
Strict Prototype Enforcement 

to this ... 
On 
On 
On 
On 
Off 
On & "Infer prototypes" selected 

This table explains what the options do when they have their ANSI-compati­
ble settings: 

The ANSI-conformant 
setting of this ••• 
#define _STDC_ 

Recognize trigraphs 

does this ••• 
#Defines S TDC . If TIIINK C 
is ANSI-conformant, _STDC_ 
is 1. If THINK C isn't ANSI-con­
formant, _S TDC_ is O. If this 
option is off, WINK C doesn't de­
fine_STDC_. 
Recognizes trigraphs. For exam­
ple, ??' is recognized as ". De­
scribed in "Disabling trigraphs" 
on page 176. 

THINK C User Manual 183 



10 The Compiler • 

You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 795. and 
"Global optimizer options" 
on page 207 

For more information, see 
"Debugging Optimized 
Code" on page 242. 

The ANSI-conformant 
setting of this ••• 
enums are always ints 

Check pointer types 

Language Extensions 

Strict Prototype Enforcement 

does this ... 
Makes enumerated constants the 
same size as an in t. Described in 
"enums of any size" on page 176. 
Checks whether pointers match 
when you assign pointers or per­
form pointer arithmetic. De­
scribed in "Checking pointer 
types" on page 188. 
Disables aIlTIIINK C extensions, 
described in "TIIINK C Exten­
sions" on page 174. 
Infers a prototype when you first 
use a function. Described in "En­
forcing prototype use" on page 
189. 

Using the Global Optimizer 
TIIINK C includes a global optimizer than can speed up your code. To use 
the global optimizer, turn on the "Use Global Optimizer" option in the Code 
Optimization page. The options below "Use Global Optimizer" let you 
choose which optimizations you want THINK C to apply. The rest of this 
section describes each optimization in detail. 

.... t8l Use Global Optimizer ...................................................... , 

t8l1 nduction uariable elimination 
[8J CSE elimination 
t8l Code motion 
t8l Register coloring 

Figure 10-10 The "Use Global Optimizer" option 

You may not want to use the global optimizer while you're debugging. It 
generates machine code that is significantly different from your source code. 
For more information, Also, the global optimizer adds an additional pass 
over your compiled code and may double your compilation time. 

The section "Using Other Optimizations" on page 186 describes other opti­
mizations that don't require the global optimizer. 
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Induction variable elimination 

Using the Global Optimizer • 
This optimization makes loops faster, especially those that cycle through an 
array. It may make your code slightly larger. For example, take this loop: 

int a[ARRAY_SIZE], i; 

for (i=O; i<ARRAY SIZE; i++) 
a[i] = GetNextElelment(); 

Without this optimization, your code has to perform a multiplication each 
time it figures the address for the next array element (i * si zeof (int»). 
With this optimization, it remembers the address of the last element and just 
adds the size of an element to that address. 

Use this optimization if your code contains many loops. It's especially useful 
on a Macintosh with a MC68000, like a Macintosh Classic or Plus, which per­
forms 32-bit multiplication in software. 

CSE elimination 
This optimization makes your code smaller and faster. It replaces subexpres­
sions that are used more than once with a temporary variable set to the 
subexpression's value. For example, look at this code: 

a = i*2 + 3; 
b = sqrt(i*2); 

With this optimization, your code assigns i * 2 to a temporary variable and 
computes it only once. It's as if the code were written like this: 

temp = i*2; 
a = temp + 3; 
b = sqrt (temp) ; 

Use this optimization on all your code. It's especially useful if you also use 
the U Automatic Register Assignment" option on page 186. 

Code motion 
This optimization makes your loops faster. It moves expressions out of a 
loop that remain constant in each iteration. For example, take this loop: 

while ( ! feof (fp) ) 
i = x*5; 
DoSomething( fp, i ); 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 195. and 
"Other optimization op­
tions" on page 202 

With this optimization on, your code moves i = x* 5 outside the loop and 
computes it only once. It's as if the code were written like this: 

i = x*5; 
while ( ! feof (fp) ) 

DoSomething( fp, i ); 

Use this optimization if your code has a lot of loops. 

Register coloring 
This optimization makes your code smaller and faster. It searches your code 
for variables of the same type that are never used at the same time and has 
them share a register, if one is free. For example take this function: 

void foo(void) 
{ 

int i, j, k; 

for (i=O; i<10; i++); 
printf( "%d\n", i ); 

for (j=2; j<1024; j+=2); 
printf( "%d\n", j ); 

for (k=10; k>O; k--); 
printf( "%d\n", k ); 

Notice that i, j, and k are never used at the same time. With this optimiza­
tion on, mINK C has them share a register. 

Using Other Optimizations 
This section describes optimizations that the compiler performs. You turn 
them on in the left column of the Code Optimization page of the Options .•. 
dialog. 

t8l Defer & combine stack adjusts 
To let THINK C optimize reg-
istera/location, see "Using [81 Suppress redundant loads 
register variables" on page Figure 10-11 The other optimization options 
170 

To learn about the global 
optimizer, see "Using the 
Global Optimizer" on page 
184 

Defer & combine stack adjusts 
If this option is on, mINK C saves time and space in code that calls many 
functions in a row. 
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Using Other Optimizations • 
If this option is off, THINK C follows this function-calling rule: When a state­
ment calls a C function, that statement pushes the arguments on the stack 
before calling the function and pops them off after it returns. 

If this option is on, TIUNK C changes that rule. If your code contains a run of 
C functions, it doesn't pop a function's arguments off the stack immediately 
after one of the functions return. It continues to call the other functions and 
to push their arguments on the stack. It lets the arguments accumulate and 
keeps track of how many are on the stack. When the run of functions is 
done, it pops the arguments off all at once. 

Note 
THINK C can't use this optimization with Pascal functions 
such as Macintosh Toolbox functions or functions declared 
pascal. A Pascal function pops its arguments off the stack 
itself, before it returns. 

If you're debugging and you use the Skip to Here command, you may want 
to turn this option off. When this option is on, TIUNK C must keep track of 
how much is currently on the stack. If you skip to a statement where that 
amount is different from where you are, THINK C will pop off the wrong 
number of arguments and may crash. 

Suppress redundant loads 
If this option is on, THINK C doesn't load data into a register when that data 
is already in a register. This optimization makes your code smaller and faster. 
The factory setting is on. 

To understand how this optimization works, look at this example: 

int j=O, i=1, k; 

j = i + 1; 
k = j; 

When you reach the last statement (k = j), the value of j is in two places: 
a register and in memory. If this option is off, k gets the value from memory, 
requiring you to compute the memory address. If this option is on, k gets the 
value from the register, saving you the time and space the computation 
takes. 

THINK C loads j from memory into a register twice, once for each time it 
appears. If this option is on, THINK C loads it from memory only once. 
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You can test and change the 
settings of these options 
from your code. See" Access­
ing Option Settings in Your 
Code" on page 7 95. and 
"Type-checking options" on 
page 799 

If you're debugging, you may want to turn this option off. When you set a 
variable in a data window, the debugger puts the new value into memory. 
However, when this option is on, your program may be using a value in a 
register and not in memory. 

For example, look at the code above. After j = i + 1 executes, there are 
two copies of j, one in memory and one in a register. Your program is using 
the register copy. The value in the register and in memory is 2. If you exam­
ine j, the data window shows 2. 

Now, say you change the value of j in the data window to 10. When your 
program continues, k is set to 2, anyway. The data window changed the val­
ue of j in memory, but your program used the value of j in the register. 

Type Checking 
THINK C lets you choose how strictly it enforces type checking. You can 
have THINK C make sure that pointer types are assignment-compatible, and 
you can enforce strict type checking by requiring a function prototype for 
every function. These options are in the Language Settings page of the Op­
tions ... dialog. 

If you want to compile ANSI-conformant code, you must set these options a 
certain way. For more information, see "Compiling ANSI-Conform ant Code" 
on page 182. 

Checking pointer types 
When the "Check pointer types" option is on, THINK C makes sure that 
pointer types match when you assign one pointer to another or when you 
do pointer arithmetic. If this option is off, THINK C treats all pointers as 
equivalent types, and won't display the "pointer types do not match" error 
message. When subtracting two pointers, however, the two types must be 
pointers to objects of the same size . 

.. ANS I Conformance ......................................................................... , 

D #define _STDC_ 

D Recognize trigraphs 

D enums are always ints 

~ Check pointer types 
........................................................................................................................... 
Figure 10-12 The "Check pointer types" option 
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To relax prototype checking 
when you precompile a 
header file, see "Checking 
pointer types" on page 7 88. 

Type Checking • 
When you're precompiling a header file, turning this option off can do 
something else. If this option is off and the "Require prototypes" option is 
on, the pointer types in the argument lists of the header's prototypes are 
changed to void *. For example, it's as if this prototype: 

windowPtr GetNewWindow( int windowID, 
Ptr wStorage, Windowptr behind ); 

were defined like this: 

Windowptr GetNewWindow( int windowID, 
void *wStorage, void *behind ); 

Notice that the return type of the function isn't changed. The MacHeaders 
file is compiled like this, so you don't need to use the rarely used pointer 
types required in some Macintosh Toolbox calls. 

In a precompiled header, you set options with the #pragma options di­
rective, described in "Accessing Option Settings in Your Code" on page 195. 
To turn off the "Check pointer types" option and tum on the "Require proto­
types" option, include this line in your precompiled header: 

#pragma options(!check-ptrs, require-protos) 

Enforcing prototype use 
The "Strict Prototype Enforcement" option lets you choose how strictly 
TIDNK C enforces the use of prototypes. If this option is on, you can choose 
between two enforcement levels: "Infer prototypes" and "Require proto­
types." If this option is off, THINK C does nothing when you use or define a 
function without a prototype. 

r" [8] Strict Prototy pe Enforcement ························ .. ···· ... ·1 

I @ Infer prototypes I 
I 0 Require prototypes I 
, ................................................................................................................... ! 

Figure 10-13 The "Strict Prototype Enforcement" option 
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This table explains the two enforcement levels: 

If you 
choose •.. 
Infer prototypes 

Require prototypes 

Note 

TIIINK C does this when you use a 
function without a prototype ••• 
Infers a prototype from the first appear­
ance of a function. That appearance can 
be a function call or an old-style declara­
tion. If a subsequent call, declaration, or 
prototype doesn't match the inferred pro­
totype, it's an error. 
Raises an error. You can't use or define a 
function unless it has a prototype. New­
style function do not satisfy this require­
ment. 

There is one exception to the "Require prototypes" require­
ment. A static function does not need a prototype. Just de­
fine it before using it. 

When you use the "Require prototypes" option, TIUNK C does not perform 
argument promotion on an old-style function definition, if there is a proto­
type for it. Take this prototype and old-style definition for the same function: 

int AFunction(char); 

AFunction(b) 
char b; 

If "Require prototypes" is not selected, TIlINK C promotes b to an int, and 
the prototype and definition don't match. If "Require prototypes" is selected, 
TIlINK C treats the old-style definition as a new-style definition, and the pro­
totype and definition match. 

These examples show you how TIlINK C infers prototypes. If the first ap­
pearance of Print Float () is this call: 

PrintFloat("Pi is WI, 3.14159); 

Ti-nNK C infers this prototype: 

int PrintFloat( char *, double ); 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 195. and 
"G enerating processor -spe­
cific code options" on page 
200 

Writing Processor-Specific Code • 
And if the first appearance of P r in tIn t () is this old-style declaration: 

Printlnt( string, value) 
char *string; 
int value; 

printf( "%s%d\n", string, value ); 

TI-llNK C infers this prototype: 

int Printlnt( char *, int ); 

TI-llNK C follows the rules of argument promotion whe~ it infers prototypes. 
For example, it promotes parameters of type char and short to int, and 
parameters of type float to double. For example, from this function call: 

PrintShort ("This answer is: ", (short) 32); 

THINK C infers this prototype: (Note that TIIINK C promotes the short 
int to int.) 

int PrintChar( char *, int ); 

Writing Processor-Specific Code 
THINK C lets you write code for a specific processor. You can write code for 
the Mc6s020 CPU or the MC68881 floating-point unit To write processor­
specific code, use these three options in the Compiler Settings page of the 
Options ... dialog, shown in Figure 10-14: "Generate Mc68020 instructions," 
"Generate Mc68881 instructions," and "Native floating-point format." 

r~"(i";'~';'~~'t';"'6'B'O'2'O"'i~'~'t'~'~'~'ii'~'~'~"· .... ····· ........ ·· .. ·D .. 4='i~·y ... ~··'i'~ ... ~ .. ····· .... ··· .. ·· ...... ·· .... · ........................... . 
I t8l Generate 68881 instructions 0 8-byte doubles 

10 Classes are indirect by default 0 "\p" is unsigned char [] 

! 0 Methods are uirtual by default t8l Natiue floating-point format 

10 Optimize monomorphic methods ! 
: ......................................................................................................................................................................................................................................... : 
Figure 10-14 The options for writing processor-specific code 
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For more information on 
using register variables, see 
"Using register variables" 
on page 770. 
For more information on 
how THINK C represents 
floating-point numbers, 
see "F/oating point repre­
sentation" on page 7 72. 

Note 
Before your program uses code compiled for a specific pro­
cessor, make sure that processor is present, or your pro­
gram may crash. Use the Gestalt Manager, described in 
Inside Macintosh VI, Chapter 3, "Compatibility Guidelines, " 
or SysEnvirons (), described in Ins'ide Macintosh V, 
Chapter 1, "Compatibility Guidelines. " 

Writing code for the MC68020 
To write code for a Macintosh with a MC68020, turn on the "Generate 
Mc68020 instructions" option. THINK C generates code that is optimized for 
Macintoshes with the MC68020, MC68030, or Mc68040 Oike the Macintosh 
LC, II, or IIfx), and that will not run on Macintoshes with the Mc68000 Oike 
the Macintosh Classic or Plus). 

If the option is on, THINK C generates MC68020 instructions for bit-field op­
erations, addressing, and long word multiplication, division, and modulo 
operations. Also, the inline assembler accepts all Mc68020 instructions and 
addressing modes for assembly in an asm { ... } construct. 

Writing code for the MC68881 
To write code for a Macintosh with a MC68881, turn on the "Generate 
Mc68881 instructions" option. THINK C generates code that is optimized for 
Macintoshes with the Mc68881 or Mc68882 floating-point unit Oike the Mac­
intosh II or IIfx) or the MC68040, and that will not run on Macintoshes with­
out it Oike the Macintosh Classic, LC, or Plus). 

If this option is on, TI-UNK C generates code for the floating point coproces­
sor. You may declare up to four local floating-point variables as register 
variables, and THINK C will placed them into Mc68881 registers. 

If your code contains a lot of intensive floating-point computation, you may 
want to turn on the "Native floating-point" option. If both the "Generate 
Mc68881 instructions" and the "Native floating-point format" options are on, 
long doubles use the Mc68881 Extended format. If you call any SANE 
functions, you'll have to convert from the Mc68881 Extended format and the 
SANE Extended format. The float and short double types are identi­
cal for SANE and for IEEE. 

Note 
If you turn on the "Native floating-point" option, you need 
to recompile the ANSI library if your project uses it. 
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You can test and change the 
settings of these options 
from your code. See "Access­
ing Option Settings in Your 
Code" on page 795 and 
"Type options" on page 
797. 

Porting Code to THINK C 

Porting Code to THINK C • 
This section describes a few options that make porting code to TI-IINK C eas­
ier. The first part describes how to port code from other compilers and the 
second part describes how to port code from previous versions ofTI-IINK C. 
To port code easily, you use three options in the right column of the Compil­
er Settings page of the Options ... dialog, shown in Figure 10-15. 

I2J 4-byte ints 

I2J 8-byte doubles 

[8l1\p" is unsigned char [] 

D Natiue floating-point format 

Figure 10-15 The options for porting code 

Note 
The ANSI-compatibility options help your port ANSI-com­
patible programs. Those options are described in "Compil­
ing ANSI-Conformant Code" on page 182. 

Porting code from other compilers 
A common problem programmers have when porting code is that the com­
pilers define int to be different sizes. By default, THINK C defmes int to 
be two bytes long, smaller than a pointer. If you're porting code that as­
sumes that int is four bytes long or the same size as a pointer, you many 
want to turn on the "4-byte ints" option in the Compiler Settings page of the 
Options ... dialog. For more information on how TIIINK C represents inte­
gers, see "Integer representation" on page 172. 

Note 
No matter how this option is set, long int is always four 
bytes long and short int is always two bytes long. 

A less common problem is that compilers define double to be different siz­
es. If you're porting code that assumes that doubles are eight bytes long, 
turn on the "8-byte doubles" option in the Compiler Settings page of the Op­
tions ... dialog. For more information on how TI-IINK C implements float­
ing-point numbers, see "Floating point representation" on page 172. 
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Pascal string literals are 
string literals that start with 
\p or \P, like "\pTitle" 

Note 
If the "S-byte doubles" option is off and the "Language Ex­
tensions" option is off, no type in TIIINK C gives you eight­
byte floating-point numbers. 

Porting code from other versions of THINK C 
Previous versions of 1HINK C assumed Pascal string literals to be of type 
char [] . If you have code that took advantage of this assumption, turn off 
the ""\pl! is unsigned char []" option in the Compiler Settings page of the Op­
tions ... dialog. 

By default, TIIINK C now assumes Pascal string literals to be of type 
unsigned char [], which is compatible with the Macintosh Toolbox 
types Str255 and Stringptr. When you assign a Pascal string literal to a 
variable of type Str255 or StringPtr, you don't need to cast the string. 

Using #pragma Directives 
TIIINK C implements the following #pragma directives: 

once 
options 

parameter 
nooptimize 

The #pragma options directive is described in "Accessing Option Set­
tings in Your Code" on page 195. The rest are described below. 

The pragma once directive 
When this directive appears in a header file, TIIINK C includes it only once 
even if there is more than one # incl ude directive that includes the header 
file. 

#pragma once 

The pragma parameter directive 
This directive applies to a subsequent inline function definition and allows 
parameters to be passed in registers instead of on the stack. It specifies 
which register holds the return value which registers parameters are passed 
in. The #pragma parameter directive must appear before the inline dec­
laration. 

#pragma parameter return-regopt junction-name (param-reglistopt) 
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Accessing Option Settings in Your Code • 
Function-name is the name of a function that is subsequently defined inline. 
If the definition is not an inline definition, never defined, or already defined, 
the directive is ignored. 

The optional return-reg can be _AO, _Al, _D 0, or _D 1. 

The optional param-reglist is a parameter list made up Of_AO, _Al, 
_DO, _Dl, or_D2. 

The inline definition must have a prototype and the prototype must not end 
with .... The return type must be an integer type or a pointer type. The re­
turn type must be 4 bytes long if the return is in an address register. The ar­
gument types may not exceed 4 bytes, except when the inline definition is 
declared pascal, in which case the address of the parameter is used. An 
address register can hold a 2-byte value for arguments only. In no case can 
an address register hold a I-byte value. 

Examples: 

#pragma parameter AO NewHandleClear( DO) 
pascal Handle NewHandleClear(Size byteCount) 

= OxA322; 

#pragma parameter Delay( AO, Al) 
pascal void Delay(long numTicks,long *finalTicks) 

= {OxA03B,Ox2280}; 

The pragma nooptimize directive 
The nooptimi ze pragma directive allows the appearance of a call to a 
function to disable the global optimizer for the function that makes the call. 

#pragma nooptimi ze (junction-name) 

Function-name must have already been declared as a function, otherwise it 
is an error. 

Any function that calls a function that has been the subject of the noopti­
mi ze directive will not be optimized by the global optimizer, even if the op­
tion is on. For an example, look at the implementation of set jmp. 

This directive should only be used for functions that have atypical flow-of­
control properties. 

Accessing Option Settings in Your Code 
You can use preprocessor directives to change and test most of the options 
in the Options .•• and Set Project Type ••• dialogs. The _option directive 
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lets you query option settings and the options pragma directive lets you 
change them. Both directives take option names as arguments, which are 
described later in this section. 

Note 
There are two underscores in _option. 

To see if an option is enabled, use the _option directive in an f if direc­
tive. For example, this code fragment sets the macro INT_SIZE depending 
on how you set the "4-byte ints" option: 

fif option(int 4) 
#define INT SIZE 4 

-#else -
-#define INT SIZE 2 

-#endif -

To change the setting of an option, use the options pragma directive. It 
takes any number of option names, separated by commas. To turn an option 
on, include its name in the list. To turn an option off, put an ! in front of its 
name. For example; this code fragment turns on the "Generate 68020 in­
structions" option and turns off the "Generate 68881 instructions" option: 

-#if MACINTOSH LC 
#pragma options(mc68020, !mc68881) 

#elif 

fendif 

You can place an options pragma anywhere in your file. If it appears out­
side a function, it applies for the remainder of the file. If it appears inside a 
function, it applies to that entire function only. The previous settings are re­
stored when TIIINK C finishes compiling that function. You can change only 
certain options inside a function. 

Internal compiler options 
TI-llNK C sets these options automatically when it compiles your project. 
You can't change them with the options pragma directive, and you can't 
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Accessing Option Settings in Your Code • 
set them from any dialog. But you can test them with the _option direc­
tive. 

If this is set ••• 
a4_g1obals 

pcrel_strings 

Set Project Type ... options 

Then TIIINK. C ••• 
Uses A4 offsets (instead of AS) for globals. 
This option is set if your project is not an 
application. 
Generates strings in code. This option is 
set if your project is a single segment code 
resource. 
Generates jump table. This option is set if 
your project is an application or a multi­
segment desk accessory, device driver, or 
code resource. 

These are options in the Set Project Type ••• dialog. You can't change them 
with the options pragma directive, but you can test them with the 
_option directive. 

If this is set ... 
far code 

far data 

separate_strs 

Type options 

Then TIUNK C .•• 
Generates 32-bit code references. This op­
tion is like the "Far Code" option in the Set 
Project Type ••• dialog. 
Generates 32-bit data references. This op­
tion is like the "Far Data" option in the Set 
Project Type ••• dialog. 
Places strings in S TRS section. This option 
is like the "Separate STRS" option in the 
Set Project Type ••• dialog. 

These options control how THINK C interprets floating-point and integer 
declarations. They correspond to options in the Compiler Settings page of 

THINK C User Manual 197 



10 • The Compiler 

the options ..• dialog. You can't change them with the options pragma di­
rective, but you can test them with the _option directive. 

If this is set .•• 
int 4 

double 8 

Then .•• 
Integers are 4 bytes long, not 2. This op­
tion is like turning on the "4-byte ints" op­
tion. 
Doubles are 8 bytes long. This option is 
like turning on the "8-byte doubles" op­
tion. 
Floating-point numbers use the native for­
mat, instead of the universal format. This 
option is like turning on the "Native float­
ing-point" option. 

Language extension options 
These options control whether you can use some THINK C extensions to the 
C language. They correspond to options in the Languages Settings page of 
the Options ... dialog. You can't change them with the options pragma di­
rective, but you can test them with the _option directive. 

If this is set ... 
stdc 

trigraphs 

thinkc 

objectc 

Then TIflNK C ... 
Defines the macro _S TDC_. This op­
tion is like turning on the "#define 
_smc_ " option. 
Recognizes trigraph symbols. This option 
is like turning on the "Recognize tri­
graphs" option. 
Uses the TIIINK C extensions to the C lan­
guage. 
Uses the object-oriented programming ex­
tensions to the C language. 

Depending how thinkc and objectc are set, you get one of the three 
possible settings for the "Language extension level." 

If ,thlnkc is 
Off 
On 
On 

and objectc is 
Off 
Off 
On 

You have this setting ... 
ANSIC 
TI-ITNK C 
TI-ITNK C + Objects 

The Options ... dialog doesn't let you set thinkc off and objectc on. 
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Enumerated ~ype opt~on 
This option lets you choose what ~ize enumerated types can be. It corre­
spond to the "~nums are always ints" option in the Compiler Settings page of 
the Opti?ns .. ~ dialog. You can change it outside a function, but not inside 
one. 

If this is set .•. 
pack_enums 

Pascal string option 

Then .•• 
enums can be the size of any integral type. 

This option l~ts you choose the type of Pascal string liter~ls. It correspond to 
the ""\p" is ursigned char []" option in the Compiler Settings page of the Op­
tions ... dialog. You can change it outside a function, but not inside one. 

If this is set ..• 
signed-?strs 

Then ..• 
Pascal string literals en \p n) are of type 
char []. 

Object-oriented programming options 
These options let you compile object-oriented code written for a previous 
version of 1!-JINK C. They corr~~pond to options in the Comp~ler Settings 
page of the Options ... dialog: You can change them outside a function, but 
not inside one. 

If this is set .•• 
virtual 

indirect 

Type-checking options 

Then ..• 
Methods are virtual by default. This option 
is like turning on the "Methods are virtual 
by default" option. 
Classes are indirect by default. This option 
is like turning on the "Classes are indirect 
by qefault" option. 

These options let you control how strictly mINK C type-checks your code. 
They correspond to options in the Languages Settings page of the Op­
tions ... dialog. You can change them outside a function, but not inside one. 

If this is set ... 
checkytrs 

requireyrotos 
inferyrotos 

Then TIllNK C •.. 
Checks pointer types. This option is like 
turning on the "Check pointer types" op­
tion. 
Requires function prototypes. 
Infers a prototype when a function is first 
u~ed. , ... ~. 
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With requireyrotos and inferyrotos, you can get one of the three 
possible settings for the "Strict Prototype Enforcement" option. 

Hrequire_ 
protos is 
Off 

Off 

On 

and infer_ 
protos is 
Orf 

On 

On or Off 

You get 
this setting .•. 
"Strict Prototype Enforce­
ment" off. 
"Strict Prototype Enforce­
ment" on, and "Infer Pro­
totypes" selected. 
"Strict Prototype Enforce­
ment" on, and "Require 
prototypes" selected. 

Generating processor-specific code options 
These options let you generate code for a specific processor. They corre­
spond to options in the Compiler Settings page of the Options ... dialog. 
You can change them anywhere. 

H this is set ..• 
mc68020 

mc68881 

Note 

Then TIIINK C ••• 
Generates code for the Mc68020. This op­
tion is like turning on the "Generate 68020 
code" option. 
Generates code for the MC68881. This op­
tion is like turning on the "Generate 68881 
code" option. 

Ifnative_fp is on, you can't change the setting of the 
mc68881 option. 

Debugging options 
These options help you debug your code. They correspond to options in the 
Debugging page of the Options ... dialog. You can change them anywhere. 

If this is set ... 
profile 

force frame 

Then TIIINK C ... 
Generates calls to the pro filer. 
This option is like turning on the 
"Generate profiler calls" option. 
Generates a stack frame for each 
function call. This is option like 
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turning on the "Always generate 
stack frames" option. 

mac s bug_n arne s 
long_rnacsbug_names 

Generates Macsbug names. 
Uses long format for macsbug 
names. 

With macsbug_narnes and long_macsbug_narnes, you can get one of 
the three possible settings for the "Macsbugs Names" option. 

Ifmacsbu~ 
names is 
Off 
On 

On 

and lon~macs­
bu~names is 
On or Off 
Off 

On 

Global optimizer options 

Your get 
this setting •.• 
"Macsbugs Names" off. 
"Macsbugs Names" off, 
and "Short format" select­
ed. 
"Macsbugs Names" off, 
and "Long format" select­
ed. 

These options control the global optimizer, described in "Using the Global 
Optimizer" on page 184. They correspond to options in the Debugging page 
of the Options ... dialog. You can change them anywhere. 

If this is set... Then ... 
global_optimizer Use the global optimizer on this code. 

This option is like turning on the "Use 
Global Optimizer" option. 

gopt _induction If the global optimizer is on, simplify in­
duction expressions. This option is like 
turning on the "Induction variable elimi­
nation" option. 

gopt _ cse If the global optimizer is on, eliminate 
common expressions. This option is like 
turning on the "CSE elimination" option. 

gopt _loop If the global optimizer is on, move loop 
invariants. This option is like turning on 
the "Code motion" option. 

gopt_coloring If the global optimizer is on, optimize reg­
ister usage. This option is like turning on 
the "Register coloring" option. 

THINK C User Manual 201 



10 • The Compiler 

Note 
Inside a function, you can turn off global_optimizer, 
but you cannot turn it on. 

Other optimization options 
These options control other optimizations. They correspond to options in 
the Code Optimization page of the Options ... dialog. You can change them 
anywhere. 

If this is set. •. 
defer_adjust 

redundant loads 

honor_register 
assign_registers 

Then TIIINK C .•• 
Defers and combine stack adjusts. This 
option is like turning on the "Defer & 
combine stack adjusts" option. 
Suppresses redundant loads. This option 
is like turning on the "Suppress redundant 
loads" option. 
Honors register declarations. 
Lets the compiler assign variables to regis­
ters. 

With honor_register and assign_registers, you can get one of the 
three possible settings for the" Automatic Register Assignment" option, plus 
an extra one that wasn't included. 

If honor_ If assign_ You get 
register is registers is this setting •.. 
On Off "Automatic Register As-

signment" off. 
On On "Automatic Register As-

signment" on, and "Honor 
'register' fIrst" on. 

Off On "Automatic Register As-
signment" on, and "Honor 
'register' fIrst" off. 

Off Off Put nothing in registers. 
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Working 
with the Toolbox. 

11 
Le Madntosh Toolbox is the set of over 1,000 routines that give Madntosh 

applications the consistent interface. This chapter tells you what you have to 
do to call the routines described in Inside Macintosh. It also describes the 
few differences between the Apple interfaces to the Toolbox and the THINK 
C interfaces to the Toolbox. 

Contents 
Calling Toolbox Routines . . . . 

Passing arguments to Toolbox routines 
Working with Pascal strings . 
Calling AppleTalk routines . 
Calling Print Manager routines 

The Macintosh Header Files. . 
The Mac #includes folder . 
The Apple #includes folder 
The THINK #includes folder 

Working with Pascal Routines . 
Pascal callback routines . . 
Calling Pascal routines indirectly 

Working with Floating-point . . . 
Working with SANE. . 
The extended type . . 
A note on SANE implementations 

205 
205 
206 
207 
208 

208 
209 
209 
210 

212 
212 
213 

214 
214 
215 
216 
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For documentation on Hy­
perCard XCMDS and the 
Communications Toolbox, 
contact APDA. See "Apple 
Programmer's and Devel­
oper's Association (APDA)" 
on page 14. 

You don't need to know the 
details of C and Pascal call­
ing conventions, though 
you might find it useful. See 
Chapter 13, "Assembly 
Language." 

Calling Toolbox Routines • 
Calling Toolbox Routines 
With TI-lINK C, you can use all of the routines described in Inside Macintosh 
I-VI including the ones marked [Not in ROM]. To use the Toolbox rou­
tines, call them exactly as they appear in Inside Macintosh. The only thing 
you need to know is how to convert the Pascal declarations into C declara­
tions. 

Most Macintosh routines are implemented as traps that use Pascal calling 
conventions. TI-lINK C generates these traps inline instead of generating a 
subroutine call. For routines marked [Not In ROM], mINK C generates 
calls to library functions in MacTraps. Calls to these routines also follow 
Pascal calling conventions. 

To use a Macintosh Toolbox routine, you must be using the right library and 
the right headers. If you're using MacHeaders, you won't have to include a 
header file for the most common Toolbox routines. 

This library ... 
MacTraps 

MacTraps2 

AppleTalk 
nAppleTalk 
HyperXLib 
CommToolbox 
PrGlue 
SANE 

Contains .•• 
Glue for routines in Inside Macintosh I-V. 
definitions for QuickDraw globals, and 
the Gestalt glue. 
Glue for routines in Inside Macintosh VI 
and less common routines. 
The alternate AppleTalk library. 
The preferred AppleTalk library. 
Glue for HyperCard XCMDs. 
Library for the Communications Toolbox. 
Printing glue for earlier System Software. 
SANE routines 

Almost every Macintosh program needs to use MacTraps. If you use rou­
tines described in Inside Macintosh VI, you should also use MacTraps2. 

Passing arguments to Toolbox routines 
Since the argument declarations in Inside Macintosh are given in Pascal, you 
need to know how to convert them to C. This table gives you the general 
rule for converting argument declarations from Pascal to C: 

If the object is ••• 
a va r parameter 
4 bytes or smaller 
larger than 4 bytes 

Pass ... 
a pointer to the object 
the object 
a pointer to the object 
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Here are some examples of Pascal declarations and their C counterparts: 

Pascal Type 
integer 
longint 
char 
Boolean 
Byte 

var Byte 
ProcPtr 

Handle 
var Handle 
Ptr 
var Ptr 
OSType, ResType 
packed array 

[+ .. 4] of char 
Str255 
var Str255 
Stringptr 
var StringPtr 
Rect 
var Rect 
Point 
var Point 
Extended 

CType 
short 
long 
short 
Boolean or char 
Byte in struct declarations, 
short when passed as an argument. 
short * 
See "Working with Pascal Routines" on 
page 212. 
Handle 
Handle * 
Ptr 
Ptr * 
OSType, ResType, long 

long 
Str2550runsigned char * 
Str255 or unsigned char * 
Stringptrorunsigned char * 
Stringptr * or unsigned char ** 
Rect * 
Rect * 
Point 
Point * 
extended, or in certain cases, double 
See "Working with Floating-point" on 
page 214. 

Working with Pascal strings 
Toolbox routines that take strings as arguments expect them to be Pascal 
strings. Unlike null-terminated C strings, Pascal strings begin with a length 
byte. To write a Pascal string constant, start the string with" \ P" or "\p". 
This is how you would call the QuickDraw routine DrawString (): 

Dr~wString("\pThis is a Pascal string"); 

Because Pascal strings start with a length byte, the longest a Pascal string can 
be is 255 bytes. Pascal strings are not null terminated. Pascal string literals 
are of type unsigned char [] by default to agree with the definition of 
Str255. Older versions of THINK C treated Pascal string literals as 
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char []. You can change this behavior in the "Compiler Settings" page of 
the Options ..• dialog. 

You can use these routines to convert strings from one form to the other: 

To convert. .. 
A C string to a Pascal string 
A Pascal string to a C string 

use this function ••• 
CtoPstr () 
PtoCst r () 

These routines convert the strings in place, and return the converted string. 
These are their function prototypes: 

unsigned char *CtoPstr(char *s); 
char *PtoCstr(unsigned char *s); 

Note 
If you're not using MacHeaders, include pascal. h to 
use these functions. 

Calling AppleTalk routines 
If your application uses AppleTalk, you should be aware that there are two 
sets of AppleTalk interfaces. Apple calls the old interface (described in In­
side Macintosh Volume II) the alternate set. The new interface (described 
in Inside Macintosh Volume V) is called the preferred set. You can use ei­
ther or both sets of interfaces. 

To use the alternate AppleTalk routines, use the library AppleTalk. To use 
the preferred routines, use nAppleTalk and AppleTalk. In either case, 
you should include the header file AppleTalk. h. 

To use thls 
interface ... 
preferred 
alternate 

Use these libraries 
nAppleTalk and AppleTalk 
AppleTalk 

Earlier versions of THINK C used two header files, AppleTalk. hand 
nAppleTalk. h. This version uses only one header file, AppleTalk. h, 
supplied by Apple. The data structure definitions in the earlier version were 
adapted from the Pascal definitions in Inside Macintosh. The data structure 
definitions in the current header files are slightly different, so you may have 
to make changes to your source code. 
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Calling Print Manager routines 
There are two ways to use the Print Manager. If you want your project to run 
under System 4.1 or earlier, include Printing. h and add the library 
P rGl ue. This way, calls to Print Manager routines use glue routines or the 
printing traps if they exist. If your program runs only on later systems, you 
should use Print Traps. h so all calls to the Print Manager routines use the 
traps directly. 

Warning 
You can use either Printing. h or Print Traps. h. You 
cannot include both header files in the same source file, or 
you will get compiler errors. 

MacHeaders does not include either Printing. h or Print Traps. h. 

To run on System ... 
4.1 or earlier 

Use this library / header 
PrGlue / Printing. h 

later than 4.1 no library / Print Traps. h 

The Macintosh Header Files 
TInNK C gets its information about the Toolbox routines from the header 
files in the Mac * incl udes folder. The header files contain C prototypes 
for all the Toolbox routines. In many cases, the Toolbox routines are defined 
as inline functions. 

Note 
Earlier versions of mINK C had a built-in list of all the 
Toolbox routines and information about the arguments that 
they took. THINK C 5.0 does not have a built-in list. In­
stead, it uses the information in the header files. 

Beginning with this version, mINK C uses virtually the same header files 
that Apple provides with its MPW C compiler. In some cases, where the 
compilers differ, mINK C has its own header files or uses modified versions 
of the header files. 

For the most common Toolbox routines, you won't have to include any 
header files explicitly if you use the MacHeaders precompiled header. 
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The Mac #includes folder 
The Mac iincludes folder contains the following folders and files: 

Item 
Apple iincludes 

Mac iincludes.c 

MacHeaders 

THINK iincludes 

Description 
This folder contains all of the Macintosh 
header files from Apple. Some of them 
have been modified for TIIINK C. The 
next section describes the modifications. 
This file is the "source file" for MacHead­
ers, the default precompiled header. In­
structions in this file tell you how you can 
modify it to create a customized precom­
piled header. 
This is the default precompiled header. It 
contains the symbols from the most com­
monly used Toolbox manager. 
This folder contains header files unique to 
THINK C. The files are described in more 
detail below. 

The Apple #includes folder 

• 

This folder contains the header files for the Macintosh Toolbox. Most of 
these files come from Apple, and they are the official interfaces to the Macin­
tosh Toolbox. The following files have been modified for THINK C. All of 
the changes are marked in the file with conditional compilation directives, 
except for SANE. h which is completely replaced with a THINK C version. 

File 
Connections.h 

Files.h 

Packages.h 

Quickdraw.h 

SANE.h 

Sound.h 

Types.h 

Modification 
Change in en urn definitions to accommo­
date different size of int in TIIINK C. 
Change type of bit-field to take into ac­
count differences in bit-packing. 
Add i incl ude <BDC. h> directive. See 
description of BDC . h below. 
Change in en urn definitions to accommo­
date different size of int in THINK C. 
Replace with THINK C version. See de­
scription of SANE. h below. 
Don't define type Time to avoid conflict 
with low memory global named Time. 
Add special definition of extended that 
is always 80 bits wide and THINK C's defi­
nition of NULL, «void *) 0). 
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If you want to examine the changes, open the header me and search for the 
symbol THINK_C. 

The THINK #includes folder 
This folder contains header files unique to TIlINK C. They contain defini­
tions for the inline assembler, routines for working with globals in non-ap­
plication projects, defmitions of low memory globals, and so on. 

Most of these mes are included in MacHeaders: 

Flle 
asm.h 
BDC.h 
LoMem.h 
pascal.h 
SANE.h 
SetUpA4.h 
THINK.h 

asm.h 

Included in MacHeaders? 
yes 
yes 
yes 
yes 
no 
no 
yes 

This header file contains definitions for the inline assembler. It contains defi­
nitions for the trap modifier bits and inline function definitions that are used 
differently in assembly language than they are in C. To learn about the inline 
assembler, see Chapter 13, "Assembly Language." 

BDC.h 

This header file contains the function prototypes for the routines in the Bina­
ry-Decimal Conversion Package, StringToNum () and NumToString (). 
These routines are declared in the Apple header file, Packages. h. 

Since programmers use these functions often, and since Packages. h 
brings in Script. h, which is rather large, the TIlINK C version breaks out 
these functions into a smaller header file so it can be included in 
MacHeaders. 

LoMem.h 

This file contains definitions of the low memory globals that take advantage 
of TIHNK C's absolute address extension. The corresponding Apple header 
file is SysEqu. h. LoHem. h does not define every single low memory glo­
bal, just the most common ones. If you want to use a low memory global 
that's not defined in LoMem. h, you can use THINK C's absolute address ex­
tension to define it in your source file. 
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The Macintosh Header Files • 
You can use either LoMem. h or SysEqu. h. You cannot in-
clude both header files in the same source file, or you will 
get compiler errors. 

For example, this is the way the low memory global WindowList is de­
fined in LoMem. h and in SysEqu. h: 

WindowPeek WindowList : Ox9D6i II LoMem.h 

enum { 
windowList = Ox9D6 II SysEqu.h 

} i 

If you use LoMem. h, you can treat low memory globals the same way you 
would any other global variable: 

#include <LoMem.h> 
void F(void) 
{ 

WindowPeek Wi 

w = WindowListi 

II or MacHeaders 

II Get first window 

If you use SysEqu. h, you have to cast the value to use it: 

#include <SysEqu.h> II but not MacHeaders 
void G(void) 
{ 

WindowPeek Wi 

w = * (WindowPeek *) WindowListi 

If you're programming exclusively in THINK C, you should use LoMem. h. If 
you want to be able to compile your program with MPW C, use SysEqu. h. 

Note that MacHeaders includes LoMem. h by default. If you want to use 
MacHeaders, and you want to use SysEqu. h, you should build a new 
version of Mac Headers that includes SysEqu. h instead of LoMem. h. See 
"Precompiled Headers" on page 164 and the comments in Mac 
#includes. c for instructions. 
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pascal.h 

This header file contains the declarations for the functions CtoPstr () and 
PtoCstr () that translate C strings into Pascal strings and vice versa. See 
"Working with Pascal strings" on page 206 for a full description. 

SANE.h 

This is the header file for the THINK C implementation of SANE, the Stan­
dard Apple Numerics Environment. This header file contains the definitions 
of SANE types and the declarations of SANE functions. See "Working with 
SANE" on page 214 for more information. 

If you are using MPW C, be sure to use the SANE. h that Apple provides in­
stead of the SANE. h provided with THINK C. The two versions of SANE. h 
are not compatible. 

SetUpA4.h 

This header file contains the utility routines that let you use global variables 
in desk accessories, device drivers, and code resources. See "Global data in 
drivers" on page 108 and "Global data in code resources" on page 118 for 
more information. 

11IINK.h 

This header file contains definitions and declarations that have been part of 
previous versions of the THINK C environment but that have no counter­
parts in the Apple header files. For instance, the upper case versions of the 
Boolean values, TRUE and FALSE, are defined here, as are the macros 
topLeft and botRight for extracting points from rectangles. 

Working with Pascal Routines 
Because the Macintosh Toolbox routines expect to be called with Pascal call­
ing conventions, you will probably need to write functions in C that behave 
as though they were written in Pascal. 

Pascal callback routines 
Some Macintosh Toolbox routines take a pointer to another function as an 
argument. Those routines then call the function you passed in. The function 
you provide is called a callback routine. The Toolbox routines expect the 
callback routines to follow Pascal calling conventions. (To learn about the 
difference between Pascal calling conventions and C calling conventions, 
see Chapter 13, "Assembly Language. ") 

TI-IINK C gives you a way to write functions that behave as though they 
were written in Pascal. The function definition must begin with the pascal 
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keyword. Make sure you provide a return type. If your function needs to be­
have like a Pascal procedure, the return type is void. 

For the parameter declarations, follow the same rules as for calling Toolbox 
functions. Remember that non-va r parameters are passed by value, not by 
reference. If the size of a non-var parameter is greater than 4 bytes, pass its 
address, but do not modify the parameter in your function. 

For example, ModalDialog () lets you provide a filterProc to handle 
events in your dialog. This is how Inside Macintosh declares 
ModalDialog () : 

PROCEDURE ModalDialog (filterProc: ProcPtr; 
VAR itemHit: INTEGER); 

ModalDialog () expects the fil terP roc to have this declaration: 

FUNCTION MyFilter (theDialog: DialogPtr; 
VAR theEvent: EventRecord; 
VAR itemHit: INTEGER) : BOOLEAN; 

In TIIINK C, the declaration for MyFilter () would look like this: 

pascal Boolean MyFilter (DialogPtr theDialog, 
EventRecord *theEvent, short *itemHit) 

The call to ModalDialog () , then, looks like this: 

void F(void) 
{ 

extern pascal Boolean MyFilter(); 
short theItem; 

ModaIDialog(MyFilter, &theItem)i 

Keeping C and Pascal on speaking terms can be tricky, but THINK C tries to 
make it as painless as possible. 

Calling Pascal routines indirectly 
Only Macintosh Toolbox routines and functions that are declared pascal 
are called using Pascal conventions. If you have a pointer to a Pascal routine, 
you can call it indirectly through a pointer the same way you would a rou­
tine in C, but the pointer must be of type pointer-to-pascal-function. 
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For more information about 
floating-point types in 
THINK C see Chapter 70, 
"The Compiler, " and Chap­
ter 22, "Language Refer­
ence." 

For instance, this type definition defines PFunc as a pointer to a Pascal func­
tion that takes one short argument and returns short: 

typedef pascal short (*PFunc) (short); 

This function takes a Pascal routine as an argument and calls it indirectly: 

short DoPascal(PFunc theFn, short i) 
{ 

II theFn is a pointer to a pascal function that 
II returns short 

i (*theFn) (i); II call it indirectly 

i theFn(i); II this works too, but you 
II might not be able to 

return (i); 

II tell that it was called 
II indirectly 

Now suppose you have a function declared pascal like this: 

pascal short Addl(short v) 
{ 

return v + 1; 

You could call the DoPascal function defined above with it like this: 

j = DoPascal(Addl, 10); 

Working with Floating-point 
TI-llNK C lets you use different floating-point formats, so you can take ad­
vantage of any special floating-point hardware or write libraries that will 
work regardless of the client project's settings. The main issues surrounding 
flo~ting point and the Macintosh Toolbox ~nvolve SANE, the Standard Apple 
Numerics Environment and using the extended type. 

Working with SANE 
To use SANE, add the SANE library to your project, and include the file 
SANE. h in your source file. This library implements the SANE functions as 
well as some utility functions like x8 Otox96 (), x96tox80 () , 
str2dec () , cstr2dec () , dec2str () , and more. For more information 
these routines and on SANE, read Apple Numerics Manual, Second Edition 
(Addison-Wesley). 
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For a description of the 
option directive see 

"Accessing Option Settings 
in Your Code" on page 
195. 

Working with Floating-point • 
These eight functions are defined in both the SANE and ANSI libraries: 

atan() cos() exp() 
fabs() loge) sine) 
sqrt () tan () 

To use the SANE versions, include the file SANE. h before math. h. Similar­
ly, to use the ANSI versions, include the me rna th . h before the file SANE. h. 

The SANE library uses SO~bit extended values, so if your Compiler Settings 
are other than SANE.;native ("Generate 68881 instructions" off and "Native 
floating-point" on), be sure to use the x80tox96 () and x96tox80 () 
functions to convert between formats as in the example below. 

The extended type 
Some Toolbox routines, and most SANE routines, use the type extended 
for floating-point numbe,rs. In TIIINK C, the type extended is always an 
SO-bit SANE extended floating point number, regardless of the "Generate 
68881 instructions" and "Native floating-point" settings. When you're using 
SANE-Native mode ("Generate 68881 instructions" off and "Native floating­
point" on), the type extended is equivalent to long double, and you 
can use arithmetic and assignment operators on extended values. 

When "Generate 68881 instructions" is on, or when "Native floating-point" is 
off, the type extended is a struct. You can still use it to hold extended 
values, but you'll need to convert them to 96-bit values before you can use 
the arithmetic or assignment operators with them. 

For example, the Toolbox routine Frac2X takes a Fract value and con­
verts it to an extended value. The following TIIINK C function converts a 
Fract value to a long double value regardless of the compiler settings: 

long double Frac2Dbl (Fract f) 
{ 

long double result; 

iif! option (mc68881) && __ option(native_fp) 
result = Frac2X(f); 

ielse 
{ 

} 

iendif 

extended temp; 

temp = Frac2X(f); 
x80tox96 (&temp, &result); 

return (result); 
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To use the x80tox96 () and x96tox80 () functions, you need to add the 
SANE library to your project. These are the function prototypes for 
x80tox96 () and for x96tox80 (): 

void x80tox96 (extended *x80, long double *x96); 
void x96tox80(long double *x96, extended *x80); 

The 96-bit value that x 80 t ox 96 () stores in its second argument is in the 
TIllNK C universal floating-point format, so it's compatible with the 
MC68881. 

A note on SANE implementations 
The SANE library provided with TI-IINK C is not identical to the SANE library 
provided by Apple with MPW C, though it has the same functionality. 

MPW uses two SANE libraries--on for Mc68881 code generation and one 
for straight Mc680xO code generation-because the size of an MPW 
extended changes if the compiler is generating code for the MC68881. The 
TIllNK C extended is always the same size, 80 bits, regardless of code gener­
ation options. 

If you're curious, the sources for the THINK C SANE library are included in 
your TI-IINK C package. 
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12 

Lis chapter describes mINK C's source level debugger. The source level de­
bugger lets you debug your application the way you wrote it: in C. The de­
bugger lets you step through your program line by line, set breakpoints, 
examine and set the values of your variables. 

This chapter describes some of the more advanced features of the TIIINK C 
debugger. Chapter 5, "Tutorial: Bullseye," is a tutorial that teaches you how 
to use the debugger. You might want to work through that tutorial before 
you read this chapter. 

Before you begin 
Make sure the mINK C Debugger is in the same folder as TIIINK C. To use 
the source debugger you need at least 2 megabytes of memory, and you 
must be running THINK C under System 7.0 or MultiFinder. To debug large 
projects, you need about 4 megabytes. The debugger works only with appli­
cation projects. It won't work with code resources or device drivers. 

Contents 
Running with the Debugger. 

Turning the debugger on 
Running the project . 

The Debugger Windows. 
The Source window 
The Data window 

Working with the Source Window . . . . . . 
The current statement and the selected statement 
The current function indicator . 
Viewing other files in the source window 
Editing files while debugging 
Searching in the Source window 

Setting Breakpoints 
Simple breakpoints. . . 
Setting breakpoints in another file 
Setting temporary breakpOints . 
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Setting conditional breakpoints . . 
Using DebuggerO and DebugStrO 

Controlling Execution 
Go .. 
Trace . 
Step 
Step In 
Step Out 
Stop ... 
Go Until Here 
Skip To Here .. 
Stepping continuously 

Working with the Data Window. 
Entering an expression . . 
Editing expressions . . . 
Removing expressions . . 
Formatting values. . . . . 
Displaying and changing contexts 
Evaluating expressions . . 
Setting values . . . . . 
Working with expressions . 
Examining structs and arrays 

Error Messages in the Debugger. 

Saving the Debugger State 

Debugging Optimized Code . 

Debugging Options. . . . 
Use Source Debugger 
Use second screen 
Update program windows 
Always save session . . . 
Always generate stack frames 
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Another way to turn the de­
bugger on is to check the 
Use Debugger check box in 
the Debugging section of 
the Options ... dialog. 

The "bug" column 

Running with the Debugger • 
Running with the Debugger 
The debugger runs as a subordinate application with mINK C. Although 
there is a debugger document icon, you can't launch it from the Finder by it­
self. When you set the option to use the source debugger, mINK C takes 
care of launching it. Make sure that the mINK C Debugger file is in the 
same folder as mINK C. 

Turning the debugger on 
To run your application with the debugger, choose the Use Debugger com­
mand in the Project menu. This command turns the "Use Debugger" option 
on and off. When the option is on, mINK C adds a "bug" column to the 
project window. 

bullseye 11 
*Name obj size 

• bullMenus .c 696 ~ • bullseye.c 458 

• bullYindov.c 186 

.... ~.~.~.'!!:~~~ ..................................... 9802 ... ....................... 

- -

~ 
£2l 

Figure 12-1 A project window with a "bug" column 

THINK C generates debugging information for files that have gray diamonds 
next to them. Initially, all files get gray diamonds. mINK C never generates 
debugging information for libraries or projects used as libraries. 

Clicking in the "bug" column next to a file name turns the gray diamonds on 
and off. If you hold down the Option key as you click on a gray diamond, 
THINK C removes the gray diamonds from every me. If you hold down the 
Option key as you click in the "bug" column where there isn't a gray dia­
mond, mINK C turns the diamonds on for every file in the project. 
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• 12 The Debugger 

Running the project 
When you run your program, TlllNK C launches the source debugger in­
stead of launching your program. The debugger then gets ready to run your 
program. 

The debugger displays its own menu bar and two windows at the bottom of 
your screen. If you're using a Macintosh with more than one screen, and you 
have the "Use second screen" option on, the two debugger windows appear 
in the second screen. 

-* File Edit Debug Source Data Windows 

bullseye.c 

bullseye 11 

• bullH.nus.c 

• bulls~y~.c 

626 ~ 
420 -=-

• bullVindo'W.o 166 

........ ~.~.~.!.!:~p.~ ......................................... ~.~.!?~.!? .. 

Data 

mL:::::~:~:::::::m!!!L:::~:!:~~::::::~!C::::'~:::::::(!C::::~:~~:::::::,j[::::~~~~~::::]IIIII[~:::~:!:~~::~:::,1111111 
Q 

Figure 12-2 Running a program with the THINK C Debugger 

The larger window on the left is the Source window. It contains the debug­
ger status panel and the source text of your program. The window on the 
right is the Data window. Use the Data window to display and change the 
values of your variables. 

When your application is running, the screen shows the application's menu 
bar, and its windows are brought forward. When your application stops (at a 
breakpoint, for example), the debugger's menu bar appears, and its win­
dows are brought forward. 
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status panel ~ 

The Debugger Windows 

The Debugger Windows • 
The debugger windows show you the source of your program and the val­
ues of your variables. Since the debugger works like any other application 
running under MultiFinder, you need to be aware whether it is your applica­
tion or the source debugger in the foreground. Just because the debugger 
windows are frontmost doesn't mean that your program isn't running. In 
fact, if your application can run in the background under MultiFinder, it will 
continue doing its background processing even if the debugger is the active 
application. 

The Source window 
The Source window contains the source text of your program, the debug­
ger's status panel, statement markers, the current statement arrow, and the 
current function indicator. The title of the source window is the name of the 
source file. 

bullseye.c 

Ili[:::~:~::::]llli[:::~~~~::::::ll[:::!~:::::::II[::::~:~!:::::::!II:::::::!~;:~=::::::::IIIIIIII:~!~~::~:::1III 
~.' ma i n() 

current statement ---f---o-. 

arrow ~. { 

K) 

I <>. c:: <>f 
statement markers ~ <>! 

I n i tMac intosh ( ) ; 
Se tUpMenus ( ) ; 
SetUpW i ndow(); 

for (;;) 

current function --1-___ ~---.main 

See "Working with the 
Source Window" on page 
223. 

See "Controlling Execution" 
on page 231. 

See "Setting Breakpoints" 
on page 227. 

Figure 12-3 The source window of the THINK C debugger 

The Source window shows the source text of your program. When you 
start the debugger, this window shows the me that contains the main ( ) 
routine of your application 

The top of the Source window has a six button status panel. These buttons 
control the execution of your program. The names of these buttons match 
the commands in the debugger's Debug menu 

The column of diamonds running along the left side of the source text are 
statement markers. Every line of your program that generates code gets a 
statement marker. You can set breakpoints only at statement markers. 

THINK C User Manual 221 



72 The Debugger • 
See "The current state­
ment and the selected 
statement" on page 223. 

The black arrow to the right of the statement markers is the current state­
ment arrow. 1bis indicator shows you the current statement, the one 
that the debugger is about to execute. When you first start your program, the 
current statement arrow is at the first executable line of your program. 

See "The current function 
indicator" on page 224. 

entry field 

The source debugger uses the space at the lower left of the source window 
for the name of the current function. When you click here and hold the 
mou~e button dOwn, the debugger displays a pop-up menu that shows the 
call chain-the names of the functions that were called to get to the current 
function. 

The Data window 
The other debugger window is the Data window. In this window you can 
examine and set the values of your variables. 

Data 

enter button -t--------H-----' 

deselect button -1--------0------.1 

expression column -t---~ 

value column -1---------111--.... 

adjustable separator bar -t-------.... II 

Figure 12-4 The data window of the THINK C debugger 

The Data window is modeled after a spreadsheet. Expressions you type into 
the entry field appear in the left column when you press the enter button 
(check mark) or when you press the Return or Enter key. Pressing the Enter 
key leaves the expression selected. Pressing the Return key leaves the entry 
field empty so you can type in the next expression. The enter button works 
just like the Enter key. 

If you change your mind and don't want to enter an expression, press the 
deselect button ex mark). The expressions you enter appear in the left col­
umn and their values are displayed in the right column. 

You can select items in either the expression column or in the value column. 
If it's legal to edit the item, you can use the entry field to edit the item. 
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See "Editing files while de­
bugging" on page 226. 

Working with the Source Window • 
You can drag the center bar to make a column wider. 

To clear an expression in the Data window, select it and choose Clear from 
the Edit menu or press the Clear key. To clear all the expressions, choose 
Clear All Expressions. 

Working with the Source Window 
The debugger gets the text for the source window directly from your source 
file, so you see the me exactly the way you wrote it. As you step through 
your code and move from file to me, the debugger gets the text for the files it 
needs. The Source window only displays source text. You can select text to 
copy, but you can't change it. 

The debugger displays the source text only ifTI-IINK C generated debugging 
information for it. If you step into a function that's in a file that didn't have a 
gray diamond next to it in the project window, the debugger displays the 
message "Debugging information not available." 

If a source file is missing, or if you've edited a file while you're debugging, 
the debugger displays the message "Source text not available." 

The current statement and the selected statement 
The current statement is the one that the debugger is about to execute. 
The current statement arrow always points to the current statement. 

buliMenus.c 

111[::::~~:::::::IIIIII[::::~:~~~::::::::II[::::I:~:::::::II[::::~:~~:::::::II[:::~:~~:~~::::::::III!II[~:::~:~:~~:::~]I!! 

o I ca::~~:;::::: ~ ; ~ 

¢~ Checkltem(widthMenu J widthJ false); 
current statement ¢ i + wid th = menu Item; 

arrow --r¢r+-'~: I nva I Rect(&bu II seyeWi ndow->portRect); I 
break; 

current statement --t--1f-----\:--I----I 

• HandleMenu 

Figure 12-5 The current statement 
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• 12 The Debugger 

Some of the debugger commands require you to select a statement in the 
Source window. To select a statement, just click once anywhere on its line. 
This line is called the selected statement. 

buliMenus.c 

11I[::::~:~:::::::IIIIII[::::~:~:~~:::::]I[::::~~::::]1[::::~:~!:::::::II[::::!:~;:~~::::::::lllill[:~:::~:~:~~:::~:::1iI1 
¢I 
<>i 
<>1 

SysBeep(5) ; 
break; 

case widthlD: 
Checkltem(widthMenuJ widthJ false); 
width = menultem' 

selected statement __ +<>~I_--,t } break; 

• HandleHenu 

Figure 12-6 The selected statement 

All commands that work on the selected statement work on the current 
statement if there isn't a selected statement 

If the current statement arrow isn't visible (because you've scrolled away or 
because you're viewing another source file in the Source window), click on 
the current function indicator in the lower left of the source window, or 
press the Enter key. The source file that contains the current statement will 
appear in the Source window. 

The current function Indicator 
The current function indicator at the lower left of the Source window dis­
plays the name of the function that the current statement is in. If the current 
statement is in a library, the current function indicator displays the name of 
the me. If the current statement is in ROM, the current me indicator displays 
the address of the program counter. 

When you click and hold the mouse button down on the current statement 
indicator, you'll see a pop-up menu that shows you the call chain. The call 
chain follows stack frames through register A6, so if a function doesn't gen­
erate a stack frame, you won't see it in the call chain. You can turn on the 
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Working with the Source Window • 
"Always generate stack frames" option to have TI-IINK C generate a stack 
frame for almost every function. See page 244 for more information. 

111[::::~:~::::]IIIII[::::~:~:~~::::::::I!1:::::::I:~:::::::II[::::?:~~:::::::II[::::~:~;:~=::::::::IIIIII[:~:::~:~:~~:::~:::IIII 
Q! 

<>,. 
<>i 

Qi 

SysBeep (5 ) ; 
break; 

case widthlD: 
~--r;;:a,..,,-""""""'-~"""''''-'-'''''J wid thJ f a I se ) ; 

main 
HandleEuent 
HandleMouseDown 

.. HandleMenu , 
~---

Window->portRect); 
IIIIII 

Figure 12-7 The call chain pop-up menu 

If you choose an item in the call chain pop-up menu, the debugger opens 
the me that the selected function is in, and selects the line that the called 
function would return to. 
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Viewing other flies in the source window 
The Source window usually shows the file that contains the current state­
ment. To look at another file in the Source window (to set breakpoints in it, 
for example) you tell TIIINK C to send the text to the debugger: 

1. Click on the mINK C project window 
2. Click on the name of the file you want to look at 
3. Choose Debug from mINK C's Source menu. 
4. The file that you chose appears in the Source window. 

3 4 
, ~~~~~~ 
Add 
f1dd ... 

Flsmmls 
Get Info 

_I" , 

Che( I< synf m~ *V 
J' .. ep.·o( p.s~ 
DI~I~s~t.'",blt.' 

Illndoolf'lr bulls~lndow; 
fleet drogRect; 

P .. e(ompU ...... 
Compile *K 
lood library 
MaI(6 ... >l(c\ 

Browser 8CJ 

Figure 12-8 Viewing another file in the source window 
Now you can examine the me and set breakpoints in it. To get back to the 
current me, click on the current function indicator at the lower left of the 
Source window or press the Enter key. 

Note 
If you select text in the source file before you choose De­
bug from the Source menu, the mINK C debugger scrolls 
the me so the selected text is visible in the Source window. 

Editing flies while debugging 
Because mINK C is still running, you can edit your source files while you're 
debugging. To edit the file that's in the source window, choose the Edit 
:fllename.c' command in the Source menu. 

To edit any other file in your project, click on the project window (or choose 
your project name from the Windows menu), and edit your ftles normally. 

Naturally, the changes you make to source files won't take effect until you 
recompile. 
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Setting Breakpoints • 
Whenever the debugger needs the source text for a file, it looks for it on 
disk. The debugger caches the contents of the file as long as it can, but if it 
needs the memory for something else, it may reclaim the cache space. If you 
edit and save a file that the debugger has displayed in the Source window, it 
will continue to display the unedited version of the file as long as it's still 
cached. If the debugger sees that the source file on disk and the object code 
in the project don't match, it displays the message "Source text not avail­
able." in the Source window. 

Searching in the Source window 
To search for something in the source window, you use the TI-nNK C editor. 

1. Choose Edit '.{ikname.c' from the Source menu (or press Com­
mand-E) to open an edit window for the file in the Source win­
dow. 

2. Use the TIIINK C Find ••• command to find what you're looking 
for. 

3. Choose Debug from the THINK C Source menu (or press Com­
mand-I) to get back the source debugger. 

4. The line containing the selection in the editor window is dis­
played in Source window. 

Enter Sr.Ir.cllon :-:[ 
find Again :-:6 
Replace ae-
neph,ce Grind AI]810 :.:H 
Rp.I)loce flll 

find In NtHct file 

Go To LIne ... 
Mork ... 
Rr.molJr. twtftfkef ... 

:.:r 

-, 
31M 

3 
, 
fldd 
Rdd ••• 
flemm'e 
Get Info ., , 

Chad< Synt~K 
Prep.·o(I.'S~ 

D1~Ds~f.'mbtf.' 

Pre( omplh.' ,., 
ComJlile 
lODd library 
t-1al:e ... 

Browser 

>l!<Y 

$K 

>l{c\ 

... 

4 

Q 

Q 
Q 

Q 

Q 

• 

Rect ...,Rec t; 
Int color. tru.; 

EraseAec: t<k Ire laStcrt); 
II\jAac:t • clrc:lastcrt; 

whlla<lI\jRe<:t.laft ( II\jRe<:t.rl~t) 

Figure 12-9 Searching from the source window 

See "Controlling Execution" 
on page 231 to learn about 
the Go Until Here commana 

When the Source window displays what you're looking for, you'll usually 
want to use the Go Until Here command. 

Setting Breakpoints 
The mINK C debugger lets you set breakpoints at any diamond statement 
marker. When your program is running, the debugger stops execution just 
before a breakpoint. 
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12 • The Debugger 

You can set three kinds of breakpoints: simple breakpoints, conditional 
breakpoints, and temporary breakpoints. Execution always stops at a simple 
breakpoint. Conditional breakpoints let you use the value of an expression 
in the Data window to determine whether execution should stop. Tempo­
rary breakpoints let you set a breakpoint and start execution in a single step. 
When your program reaches a temporary breakpoint, execution stops, and 
the debugger automatically clears the temporary breakpoint. 

You can set breakpoints while your program is running, not just when it's 
stopped. 

You can also use the functions Debugger () and DebugStr () to force 
your program to stop and drop into the debugger. 

Simple breakpoints 
To set a breakpoint, click on a statement marker diamond. The diamond will 
turn from hollow to filled, indicating that the breakpoint is set 

bullseye.c 

111[::::~:~:::::::IIIIII[::::~:~:~~::::::::I11:::::::~~:::::::I11:::::::~:~!:::::::I11:::::::~~;:~~::::::::IIIIII[:~::~:~:~~:::~]III 

• 

break; {} 

case updateEvt: mill 
BeginUpdate(bullseyeWindow); .mm 
DrawBu I I seye( «W i ndowPeek) bu I I seyeW I i=i=i= 
EndUpdate(bullseyeWindow); mill 
break; 

case activateEvt: 

HandleEvent 

Figure 12-10 Setting a breakpoint 

To clear a breakpoint, click on the filled diamond. The statement marker 
changes to a hollow diamond to show you that the breakpoint is clear. The 
Clear All Breakpoints command in the Source menu clears every break­
point in every file. 

You can also use the Set Breakpoint and Clear Breakpoint commands in 
the Source menu to set and clear breakpoints. 
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Setting Breakpoints • 
1. Click on a statement in the source window to select it 
2. Choose Set Breakpoint or Clear Breakpoint from the Source 

menu to set or clear a breakpoint 

Setting breakpoints In another file 
The Source window usually shows the file that contains the current state­
ment To set breakpoints in another me, you must first tell TIllNK C to send 
the me to the debugger: 

1. Click on the mINK C project window (Or choose your project 
name from the Windows menu) 

2. Click on the name of the me you want to set the breakpoint in. 
3. Select Debug (Command-I) from mINK C's Source menu. The 

source debugger's Source window will display the text of the file 
you chose. 

4. Click on statement marker diamonds to set breakpoints. 

3 4 
I bullWlndow.c 
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i~" .... ~~~ ....... " .... ~ ..... ~ ..... ~ .... i ..... !.~~ .... jlll~ili 
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Check SyntaK !}(eV 
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~~ ...... _.......... Pilii 
II\jRec:t • clrcleSlcrti 

o whll.<lI\jRec:l.l.fl < II\jRec:l.rlcj"ll> ~ 
• HM4~ IOL Ii!iHUP,ii:,!i,!hr.~!I,I~,i!i!;!i:I,i;i!i!,:!!I!i!!!!imp.~ii!!1 ~ I2J 

LOBd library 
Make ••• >l£c\ 

Browser .... 
Figure 12-11 Setting a breakpoint in another file 

To get back to the current me, click on the current function indicator at the 
lower left of the Source window or press the Enter key. 

Setting temporary breakpoints 
Temporary breakpoints are useful if you want to go quickly to a particular 
line of your program. For instance, suppose you wanted to examine how 
your program handled menu selections. You'd set a temporary breakpoint at 
the first line of your menu handling routine. The program would run nor­
mally until you chose a command from one of your menus. 

To set a temporary breakpoint, hold down the Command or Option key as 
you click on a statement marker. When you release the mouse button, the 
debugger starts your program, and execution continues until you hit any 
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The Debugger 

switch CtheEvent.whal> 
( 
case .-ouseDown: 

breakpoint, not just the temporary breakpoint. The source debugger clears 
all the temporary breakpoints when you stop for any reason. 

Note 
The Go Until Here command sets a temporary breakpoint 
at the selected line. 

Setting conditional breakpoints 
The mINK C debugger lets you set conditional breakpoints. A conditional 
breakpoint is a breakpoint that has a condition associated with it. The de­
bugger stops execution at conditional breakpoints only when the condition 
evaluates to non-zero. 

To set a conditional breakpoint: 

1. Set a breakpoirit by clicking on the statement marker diamond 
2. Click on the line to select it 
3. Click on an expression in the Data window 
4. Choose Attach Condition from the Source menu. 
5. The breakpoint marker turns into a gray diamond to indicate that 

it's a conditional breakpoint. 

2 

Hand I eMouseDownC& theEvent >; 
break' 

• .. .. ~~~a. .. ~~ ..... i 
o bNcIk' 

case kel,jl)own: c:ase kel,jl)own: 
case autoK...,: c:ase autoK...,: 

If cctheEvent.lOOdlfirs & CIIdK...,> ,- o If CCtheE..,."t.1OOd1 firs & CIIdK...,> I-

• 
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~I:'t Brl:'okpoint • 
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~how [ondltlon 

., 

Edit 'builseye.c' an 

Figure 12-12 Setting a conditional breakpoint 
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Controlling Execution • 
In this example, the debugger will stop at the breakpoint only if you hold 
down the Option key as you click the mouse 
(theEvent .modifiers & optionKey == Ox0800). 

If you're already stopped at a simple breakpoint that you want to turn into a 
conditional breakpoint, just select an expression in the Data window, and 
choose Attach Condition. Since the debugger uses the current statement if 
there isn't a selected line, the cond~tion will be attached to the current state­
ment 

The Attach Condition command is dimmed if: 

• the expression can't be evaluated in the context of the breakpoint 
• a breakpoint isn't set 
• an expression in the Data window isn't selected 
• the expression is a floating poin~ expression 

As you debug your program, you may forget the condition that's associated 
with the breakpoint. To see the condition ~s~ociated with a conditional 
breakpoint: ' 

1 . Click on the line to select it 
2. Choose Show Condition 'from the Source menu. 

The condition associated with the conditional breakpoint will be selected in 
the Data window. 

To learn how to use the Data window, see "Working with the Data Window" 
on page::: 234. 

Using DebuggerO and DebugStrO 
The functions Debugger () and DebugStr () cause your program to stop 
and drop into the debugger just as if you had set a breakpoint The 
DebugStr () function takes a Pascal string as an argument The string ap­
pears in place of the status panel. For an example ofDebugStr () see page 
241. 

If you're not using the TIIINK C debugger, these functions cause your pro­
gram to drop into a low level debugger if one is installed. 

Controlling Execution 
The debugger uses six commands to control execution. To make it easier to 
debug your programs, there are three ways to use them: you can choose 
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them from the Debug menu, you can use the Command key equivalents, or 
you can use the buttons in the status bar of the Source window. 

The buttons in the status panel do double duty as status indicators. When 
your program is running, the Go button is lit When your program is 
stopped, the Stop button is lit. Remember that your program can still be run­
ning even if the debugger windows are frontmost. 

I::::::::::::::::::::::::::::::::::::::::::::::::::ZI:::::::::::::::::::::::::::::::::::::::::::::::Zt::::::::::::::::::::::::::::::::::::::::::::::::::I:::::::::: 

!m Go Imm Step I!I In I!I Out I!I Trace Imm .~ Stop ~'Im 
iii:::::::::::::::::::::::::::::::::::::::::::::::::::ti::::::::::::::::::::::::::::::::::::::::::::::::::::I:::::::::::::::::::::::::::::::::::::::::::::::::::::i 

Figure 12-13 The status panel 

Go 
The Go command starts your program if it was stopped. Your program runs 
until you stop it (with the Stop button, for example) or until it's about to exe­
cute a line with a breakpoint or until it hits an exception (dividing by zero, 
for instance). If your application is already running, the Go command brings 
it to the foreground. 

Trace 
The Trace command executes the current statement In most cases, the state­
ment indicator will go on to the next statement marker, even if the next state­
ment marker is in another function. The only time it won't is when the 
program counter steps into some code that the debugger doesn't have the 
source text for. This usually happens when you step into a trap that's not 
generated inline. So, for a brief period, the current statement arrow isn't real­
lyanywhere in your program, but somewhere in MacTraps instead. 
Though you can't see the current statement arrow, the current function indi­
cator at the lower left tells you which file it's in. 

Step 
The Step command is like the Trace command except that it goes on to the 
next statement marker in the current function. If you're at the end of a func­
tion, Step returns to the calling function. Use Step when you want to follow 
the execution within a function without falling into another function. (Tech­
nically speaking, Step skips over JSRs.) 

The first time you Step through a for loop, the current statement arrow 
jumps to the end of the loop because in the generated code, that's where the 
test is done. 
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See "Searching in the Source 
window" on page 227 to 
leam how to look for text 
from the debugger. 

Step In 

Controlling Execution • 
The Step In command executes Trace commands until the current statement 
arrow falls into a function. Step In is useful when you want to skip over a set 
of assignments or Toolbox traps, to fall into the next function call. If Step In 
reaches the last statement of the current function without falling into another 
function, it will stop immediately after the function returns. 

Step Out 
The Step Out command executes Step commands until the current statement 
arrow falls out of the current routine. This operation can be slow if there's a 
lot left to do, but it's a sure way of leaving the current routine. A faster way 
ofleaving the current routine is to use the Go Until Here command or to set 
a temporary breakpoint at the last diamond in the function. 

Stop 
The Stop command stops execution of your program. The Stop command 
works when any debugger window is active, and the Stop button only 
works when the source window is the active window. When you press the 
Stop button you'll usually be coming out of your call to GetNextEvent () 
orWaitNextEvent(). 

If your program is not in its event loop, you might not be able to make the 
debugger the frontmost application. In this case, Command-Shift-Period is 
the panic button. Use Command-Shift-Period to stop execution when one 
of your application's windows is frontmost or when you think it's stuck in a 
loop. 

Warning 
Command-Shift-Period won't work if you're stuck in an in-
finite loop in ROM. 

Go Until Here 
The Go Until Here starts execution and stops at the selected line. This com­
mand is exactly the same as setting a temporary breakpoint (see "Setting 
Breakpoints" on page 221) at the selected line. Use this command when you 
want to move through a block of code quickly. 

This command is more convenient than setting a temporary breakpoint 
when the line you want to go to is already selected. For instance, it's easier 
to press Command-H after you've found a string you're looking for. 
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Skip To Here 
The Skip To Here command changes the program counter to the selected 
line without executing any intervening code. Use it when you want to skip 
over code you know to be buggy but not crucial to the rest of the program's 
operation. 

Warning 
This command is potentially dangerous. Make sure the 
code you're skipping to doesn't depend on anything the 
skipped code does. For instance, it is a very bad idea to 
skip over initialization routines. 

Stepping continuously 
If you hold down the Option or Command key as you click on one of the 
status panel buttons (except Stop) you'll enter auto mode. In auto mode the 
debugger updates the Source and Data windows and repeats the command. 
To trace through every line of your program automatically, for example, 
hold down the Option key as you click on the Trace button. 

One useful technique is to set breakpoints at spots where you'd like to look 
at some variables and then do an Auto-Go. When your program hits the 
breakpoint, the debugger will update the Data window and start the pro­
gram up again. 

To cancel auto mode, type Command-Shift-Period. The debugger will finish 
the command and then stop. Note that if you're in Auto-Go mode, the Stop 
button just cancels auto mode. You'll have to click on the Stop button again 
to stop your program. 

Working with the Data Window 
The Data window lets you examine and modify the values of your variables 
as you debug your programs. You can type any legal C expression in the en­
try field. The expression you type appears in the expression column, and its 
value appears in the value column. You can display values in several formats 
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to make your debugging easier. You can also display structs and arrays in 
their own windows. 

Data 

entry field --++-'~ 

enter button --f-lltv:-fL..L.I..:.a...U--1~II-JIIi:.v.-:.LliouiiI:""--___ -IJ-L.L..-:~~~""-""-J 

myUnion.longlnt i Ox54455854 
deselect button m Un i on un i on Ox09C7BC 

---t=*:...;;;!(c.:::W":":i ~n-=:d':"":;o-wP"""""""'tr---:-) t~h-e--:E~v-e-n---:t-.-m-e-s-s-a-g-e--ft-s~tr~u::"":c~t:---='O~x:"":O:-;:9:-:0:-::D:-:'1=-='4 

(Wi ndowptr)theEvent. message Ox090D14 
theEvent struct Ox09C5E8 

expression column --i-----------' 

value column 

adjustable separator bar _______________ --'t 
Figure 12-14 The data window 

Entering an expression 
You can enter any expression that does not have a potential side effect. That 
means you cannot enter assignment statements, function calls, or expres­
sions involving ++, --, +=, etc. 

The debugger compiles the expressions you enter in the context of the se­
lected line in the Source window, or, if you haven't selected a line, in the 
context of the current statement. If the expression you enter is not defined 
within the context, the debugger displays an error message as the value of 
the expression. 

The quickest way to enter an expression into the Data window is to select it 
in the Source window and choose the Copy to Data command in the de­
bugger's Edit menu. 

Expressions in the Data window have either local scope or global scope. An 
expression has local scope if it refers to variables with dynamic storagej in 
other words if it refers to non-static variables local to a function. All other ex­
pressions have global scope. 

If you use the Enter key to enter an expression, the expression remains se­
lected. If you use the Return key to enter an expression, the entry field is 
ready to accept the next expression. Clicking on the enter button is the same 
as pressing the Enter key. 

THINK C User Manual 235 



12 • The Debugger 

Editing expressions 
To edit an expression in the Data window, select it in the left column. The 
expression will appear in the entry. Use standard Macintosh editing tech­
niques to edit the text of the expression. 

When you edit an expression in the data window, the context is the same as 
when you entered the expression. To change the context of an expression to 
the current context after you edit it, hold down the Option or Command key 
as you click on the enter button. 

Removing expressions 
To remove an expression from the Data window, select the expression you 
want to remove, and choose the Clear command from the Edit menu or 
press the Clear key. To remove all the expressions from the Data window, 
use the Clear All Expressions command in the Data menu. 

Formatting values 
When you enter an expression, it's added to the left column. The value of 
the expression appears in the right column. You can use the formats in the 
Data menu to change how the debugger displays the variables. 

To change a format, select an expression in the Data window. Then choose 
a format from the Data menu. Some of the formats won't be available. The 
formats available depend on the type of the expression. The default formats 
are shown in italics. 

Type 
integers 
unsigned 
pointers 

arrays 
structs 
unions 
functions 
floats 

Formats Available 
Decimal, Hex, Char 
Hex, Decimal, Char 
Pointer, Address, Hex, C String, Pascal 
String 
Address, C String, Pascal String 
Address 
Address 
Address 
Floating Point 
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This is what the display formats look like: 

Format 
Decimal 
Hex 
Char 
C String 
Pascal String 
Pointer 
Address 
Floating Point 

Example 
4523345,-23576 
OxA09E1487 
'e', 'TEXT' 
"abedef\nghi\33" 
n\pabedef\nghi\33" 
Ox7A7000 or Ox007A7000 
[] Ox09FE44,struet Ox08FC14 
1961.0102 

The C string and Pascal string formats display non-printing characters in 
backslash form. Whenever it can, the debugger uses the built-in escape 
characters (\n, \r, \b)j otherwise it uses \nn, where nn is an octal value. 

Of course, you can use type casting to use formats that aren't normally avail­
able. For example, if you really wanted to see an integer, i, as a C string, you 
would type this expression: (char *) i. 

To see any pointer as an array, just change its format to Address. This way, 
when you double-click on its value, you'll see an array window instead of 
the value of what the pointer points to. 

Displaying and changing contexts 
If you forget the context of an expression in the Data window, use the Show 
Context command in the Data menu. The Source window will display the 
context for the expression. 

When you select an expression, you can edit it in the entry field. When you 
press the enter button (or the Return or Enter keys), the debugger will 
recompile the expression in its original context. 

To change the context of an expression you've already entered or edited, se­
lect the context in the Source window, select the expression, then choose 
Set Context from the debugger's Data menu. You can do the same thing by 
holding down the Option or Command key as you click on the enter button 
(or press the Return or Enter key). 

Evaluating expressions 
The debugger re-evaluates the expressions in the data window every time 
your program stops. Expressions whose context isn't in the current function 
are not re-evaluated unless they have global scope. To keep the Data win­
dow from getting too cluttered, the debugger clears their values. 
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Sometimes, you don't want an expression to be re-evaluated. For instance, 
you might want to compare the values of the same expressions at different 
times. Select an expression and choose Lock from the Data menu. 

Setting values 
The debugger lets you change the values of your expressions as long as the 
expression would be legal in the left side of an assignment statement. 

Working with expressions 
Double-clicking in the left column of the data window makes a copy of the 
expression. This is useful if you want to lock one copy down while you let 
another be evaluated every time the debugger stops. 

Double-clicking on the value of struct, union or array opens up a new win­
dow. 

Double-clicking on a value formatted as Pointer enters a new, dereferenced, 
expression in the Data window. If you hold down the Shift key, the new ex­
pression will be dereferenced twice. 

If you hold down the Option key as you double-click, the new entry replac­
es the original entry. 

Examining structs and arrays 
You can examine fields of structs and arrays displayed in the Data window. 
(In this section, whatever you read about structs applies to unions as well.) 

When you double-click in the right column on an expression whose value is 
struct, the debugger opens up a struct window. The struct window looks 
like the data window. The names of the fields appear in the left column, and 
their values appear in the right column. 

~--------------~ 
0[8] 

message 
when 
where 
modifiers 

6 
Ox00090D14 
241706 
struct OxO 

Figure 12-15 A struct win~ow 
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You can change the values of the fields of the records the same way you 
change any variable. Of course, you can't change the names of the fields. 

Double-clicking on a value opens other windows the same way as double­
clicking in the main data window. A new expression appears in the main 
Data window for the new window. 

Note 
All steuct and array windows "belong" to the m~in Data 
window. For every steuct or array window there is an entry 
in the main Data window. 

Double-clicking on a field name enters a new expression in the main Data 
window. 

As mentioned above, Option-double-clicking replaces the original expres­
sion with the new one. For example: Suppose you had an steuct window for 
an EventRecord, theEvent. Option-double-clicking on the what field 
would make the steuct window disappear (the original expression is 
theEvent), and theEvent. what would appear in its place in the Data 
window. . 

Array windows are similar to steuct windows. The indices appear in the left 
column and values appear in the right column. Unlike the main Data win­
dow or steuct windows, every element in an array is displayed in the same 
format. 
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Because C compilers don't enforce array bounds, array windows have "infi­
nite" scroll bars. 

1~3 .. --111111 
234 
54 
3 

Figure 12-16 An array window 

If you select an index in the left column and change its value, the debugger 
will display the array from that index. 

To see a pointer as an array, set its format to Address and double-click on its 
value. 

Error Messages in the Debugger 
If executing a statement in the Source window or evaluating an expression 
in the Data window would cause a run time error, the mINK C debugger 
displays an error message in the status panel or in the value column of the 
Data window. 

In Figure 12-17, the Source window contains a small program that tries to ac­
cess illegal memory (a negative memory address, in this case). The data win-
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dow has an expression that tries to divide by zero and one that tries to 
dereference the illegal pointer. 

ready.c 
Data 

Figure 12-17 Errors reported in the debugger 

In most cases, the safest thing to do when you get an error in the Source 
window is to choose the ExitToShell command from the Debug menu. If 
you want to continue from the error, click on the error message in the 
Source window, and the status panel will reappear. 

If you use the DebugStr () function in your program your program stops, 
the string appears the same wayan error message would: 

ready.c 

Yilces I Almost divided by zero I 

{ 

<>l 
<>1 
<>i 
<>F 
<>1 

• 

short 
short 

i = 1; 
j = 0; 

if (j == 0) 
DebugStr("\pYikes! Almost divided by zero!"); 

else 
i = i I j; 

main 
11"-1 [ T············· .................................................................... "il r'\. n, 
I~ JE!E!!!~!~i~!i!i!~!!!i!!!i!~!!!i!!!!!!!i!!!!!i!i!iii!i!ii~!i!i!i!i!i!iii!i!iii!!!i!i!~1 .,., L:.J 

Figure 12-18 Using OebugStrO to report anomalous behavior 
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To prevent the debugger 
from saving your state, 
hold down the Option key 
as you quit the debugger. 

To put the debugger win­

Saving the Debugger State 
Use the Save command in the debugger's Flle menu to save all of your 
breakpoints, the expressions in the Data window, and the positions of all 
your debugger windows. Whenever you start the debugger again, it restores 
the debugger state. If you don't want the debugger to restore the state for a 
particular session, hold down the Option key as the debugger starts up. 

By default, the debugger does an automatic save when the "Always save ses­
sion" option is on in the Debugging page of the Options ••• dialog. If this 
options is off, you can still use the Save command to save the debugger 
state. No matter how that option is set, the debugger always restores the pre­
viously saved state. 

dows into their default posi- If you want to make sure that the 1HINK C debugger doesn't save any ses­
tions, hold down the Shift sion information, use the dear All Breakpoints command in the Source 
key as you start the debug-

menu and the Clear All Expressions command in the Data menu. Then ger. 

For more information about 
the global optimizer and 
other optimizations see 
"Using the Global Optimiz­
er" on page 784 and "Us­
ing Other Optimizations" 
on page 786. 

choose Save from the Flle menu. 

1HINK C stores some debugger state information directly in your source 
files. As you edit your files, the 1HINK C editor maintains breakpoints and 
the contexts of data window expressions. However, other editors do not up­
date the debugger state information. If you edit files with debugger informa­
tion in other editors, your breakpoints will be set at the wrong lines, and the 
data window expressions will be evaluated in the wrong contexts. 

Debugging Optimized Code 
The code optimizer changes the way that 1HINK C compiles your programs. 
You should be aware that optimized programs might behave differently un­
der the debugger than they would if they were not optimized. 

If you use the global optimizer, certain statements might never get executed, 
so the compiler doesn't generate code for them. That means that you would 
not be able to set a breakpoint there. If you have register coloring on, and 
the optimizer uses the same memory location for two separate variables, 
changing one variable in the Data window might change another one as 
well. If you use common subexpression elimination, changing the value of a 
variable in the data window might not make a difference if the subexpres­
sion it belongs to has already been evaluated. 

If you use the "Defer & combine stack adjusts" option, you should not use 
the Skip To Here command in the debugger to skip over a function call. If 
you use the "Suppress redundant loads" option, changes that you make to 
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values in the Data window might not "take" if the value was stored tempo­
rarily in a register. 

In general, you can use the TI-lINK C debugger to debug optimized code, 
but you need to be careful, and you need to be aware of how the optimizer 
changes your code. 

Debugging Options 
This section describes all the options that control the TIllNK C debugger. To 
set these options, choose the Options .•• command from the TIllNK C Edit 
menu, and turn to the debugging page. 

@Thll Project ! » Copy» I o New ProJects 

[;]1 Debugging I 

.... l8IlM SOIro. DftKIOOfI" I 0 Rlways generate stack frames 
181 Ule second screen o Generate pro flier calls 

I rDHeoAu9 ....... 
o Update program windows 

I 
181 Rlways saue session I 0 Shol1 fonnat I @ long fonnat I 

I this Is til. Options d11109. CHcIc on .... button to flnd out mor. M>out that 

I I opllon. Us. tt.. ................... 10 90 10. _ilia _ ........ tt.. .-row bull ... 10 
mon U. .. "t ... pr .... 1ous ,.,.. 

I 

( Factory lettlngl ) , OK J ( Cancel ) 

Figure 12-19 The debugging options 

Use Source Debugger 
This check box is the master switch for the TI-lINK C debugger. If it's on, 
TIllNK C launches the source level debugger when you choose the Run 
command. Clicking in this check box is exactly the same as choosing Use 
Debugger from the Project menu. 

Use second screen 
If you have more than one monitor, the debugger use the second one to dis­
play the source and data windows. This option is aV:iilable only when the 
"Use Source Debugger" option is on. 

Update program windows 
When this option is on, the debugger tries to update your windows for you 
when your project is stopped. If this option is off, your program must wait 
until control returns to it, so it can handle the update event itself. Since it 
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can't do so until it gets back to its event loop, an update may remain pend­
ing for some time. 

This option is useful if you're trying to step through code that draws in a 
window, and the window is partially obscured by a mINK C or mINK C 
debugger window. 

Since this window uses memory to save the window image, you might need 
to increase the mINK C debugger's memory partition if you're working on a 
large screen or in color. See "Memory Considerations" on page 246 for more 
information. 

Always save session 
If this option is on, the mINK C debugger saves the state of your debugging 
session before the debugger quits. It is as if you had chosen the Save com­
mand from the THINK C debugger's File menu. If this option is off, the de­
bugger does not save the debugger state automatically at the end of each 
session. If you do a manual save, though, the debugger will restore that state 
when you start the debugger again. See "Saving the Debugger State" on page 
242 for more information about saving sessions. 

Always generate stack frames 
If this option is on, mINK C always generates a stack frame (LINK/UNLK 
instructions), even for functions that normally wouldn't have one. If a func­
tion has no local variables and takes no parameters, mINK C does not gen­
erate a stack frame for it unless this option is on. Since the call chain pop-up 
menu relies on stack frames, you may want to turn on this option while 
you're debugging. 

Note 
If a function has no local variables, takes no parameters, 
and uses inline assembly, mINK C will not generate a 
stack frame for it, even if this option is on. 

Generate profiler calls 
When this option is on, mINK C generates code for the promer. To learn 
about the profiler, see Chapter 15, "The Profiler." This option doesn't affect 
the operation of the mINK C debugger. 
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Using Low Level Debuggers • 
If this option is on, THINK C generates names for low level debuggers like 
Macsbug so they can find the name of a function. There are two varieties of 
Macsbug names: 

Short format 

Long format 

Use only the first eight characters of the 
function name. All characters are translat­
ed to upper case. 
Use all the characters of the function 
name. Case is preserved. 

THINK C generates Macsbug symbols only for functions that have stack 
frames. If you have functions in your program that normally wouldn't re­
quire a stack frame, you might want to turn on the "Always generate stack 
frames" options above. 

Both kinds of Macsbug names appear right after the code for a function, so 
turning this option on will increase the size of your code. You should turn 
this option off when you build your application, desk accessory, device driv­
er, or code resource. 

Using Low Level Debuggers 
The THINK C source level debugger is great for figuring out what your ap­
plication is doing. But sometimes you need to get closer to the machine. The 
Monitor command in the Debug menu invokes a low level debugger like 
TMON or Macsbug. 

When you use the Monitor command, all registers and low memory globals 
contain the proper values for your program. The PC (program counter), 
however will not be pointing to the next instruction. Instead, it will be point­
ing somewhere in the debugger. 

Warning 
If you don't have a low level debugger installed, don't use 
the Monitor command. 

Using the Monitor command with TMON 2.8.x 
If you're using TMON 2.8.x, the value of the PC will be in TMON's V register. 
It's a good idea to keep a TMON disassembly window anchored to V so you 
can see your program's code when you use the Monitor command. 

If there was an expression or value selected when you dropped into TMON, 
the N register contains that value. 
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To return to the TI-lINK C debugger, use TMON's Exit command. 

Using the Monitor command with other debuggers 
If you're using another low-level debugger, like Macsbug, the correct value 
of the PC is right before the current PC. For instance, to display your pro­
gram's code in Macsbug, type: 

DM PC-4 
IL @. 

The value of the current Data window selection is not available in other low 
level debuggers. 

Leaving the low level debugger 
If you entered the low level debugger through the Monitor command, use 
your debugger's standard exit command. 

If you got into your low level debugger any other way, there is no simple 
way to return to the source debugger. You can use your low level debug­
ger's ExitToShell to abort your program as long as it's the foreground appli­
cation. Check the low memory global CurApName COxO 91 0). If it contains 
the name of your program, go ahead. 

Quitting the Debugger 
The best way to quit the debugger is to quit your application. You should 
use the ExitToShell command in the debugger's Debug menu only when 
you can't use your application's Quit command. 

Memory Considerations 
TI-lINK C, the source debugger, and your project each run in their own Mul­
tiFinder partition. The default partition sizes are: 

Application 
THINKC 
THINK C Debugger 
project 

Partition Size 
lOOOK 
250K 
384K 

If you want to run other applications, or if you find you're running out of 
memory, you can change the partition sizes. Change your project partition 
first. If you still don't have enough memory, change the size of the TI-llNK C 
partition. Finally, change the debugger's partition. 
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The default partition size for your project is 384K. Moderately sized projects 
don't usually need this much memory. You might want to try smaller values 
u can give more memory to other applications. 

TI-llNK C uses the most memory when it's compiling. IfTI-lINK C complains 
that it's running out of memory when you compile, close any open windows 
before rebuilding your project. The THINK C partition should be no smaller 
than 700K. 

If you have the "Update program windows" debugger option on, the debug­
ger partition might need to be bigger than 250K. You will definitely need to 
increase it if you're running with either large or color monitors. If this option 
is off, and you're running a small project, you can make the debugger parti­
tion as small as 200K. 

To change the size of your project's partition, use the Set Project Type ••• 
command in the Project menu. You can change the partition sizes for 
THINK C and the debugger from their Get Info ... boxes in the Finder. You 
can't change the partition size of an active application, so you'll have to quit 
THINK C first to change its partition size. 
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Assembly 
Language. 

13 
AssemblY language lets you write the most efficient code possible. Using it 

with TIIINK C is a powerful combination. This chapter tells you how to use 
assembly language in your mINK C programs. You can use mINK C's built 
in inline assembler, or you can use object fIles generated by other assem­
blers. This chapter also describes C and Pascal calling conventions so you 
can write well-behaved assembly code. 

What you should know 
You should know the assembly language for the Mc68000 family of micro­
processors. Motorola publishes the M68000 Family Programmer~ Refer­
ence Manual which contains descriptions for the Mc680xO processors, and 
the Mc6888x floating-point coprocessor. 

Contents 
Using the Inline Assembler. 

Writing assembly language code 
Writing processor-specific assembly code 
Using C identifiers in assembly language . 
Using floating point literals 
Labels and branching . . . . . . . 
Returning from a function. . . 
Multiple entry points . . . . . . . 
Using the Macintosh Toolbox in assembly language 
Register usage . . . . . 

Differences from Other Assemblers 
Hexadecimal constants 
Directives . . 
Addresses . . 

Tips ..... 
Using constants 
Local storage . 
Instruction size 

C Calling Conventions 
C calling sequence 
C function entry . 
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C function exit. . . . . . . . . . . . . . 267 
Functions that return struct, union, or double. . . . . 267 
Functions that accept a variable number of arguments. . 268 

Pascal Calling Conventions 269 
Pascal calling sequence 269 
Pascal function entry . 270 
Pascal function exit . 270 
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The MC68881 and 
MC68882 are also called 
"floating point units". 

Using the Inline Assembler • 
Using the Inline Assembler 
THINK C has in integrated inline assembler that lets you write assembly 
language in your C routines. To use the inline assembler, you must set the 
"Language Extensions" option on the "Language Settings" page of the 0p­
tions ... dialog to "lBINK C" or "lBINK C + Objects". 

You can use instructions for the Motorola Mc68000 and Mc68020 processors 
and for the Mc68881 floating point coprocessor. The inline assembler lets 
you refer to C variables and functions within assembly language routines. 
Your C routines can goto labels in the assembly routines and vice versa. 

Note 
The inline assembler doesn't support any instructions that 
are unique to the MC68030 or the Mc68040. 

Writing assembly language code 
The asm keyword invokes the inline assembler. The syntax for mixing as­
sembly language statements with C code is simple: 

asm { 
/* assembly instructions */ 
/* one per line */ 

The compiler treats this construct as a C statement It can appear anywhere a 
C statement can appear, which means that it must appear within a function. 

Use only one assembly language instruction per line. You can use semicolon 
style comments, but since you're still writing in C, you can use C style com­
ments as well. Preprocessor symbols and macros are expanded within as­
sembly language, just as they are within C. You can use a C constant 
expression wherever a constant would be legal in assembly language. 

The inline assembler supports all the standard Mc68000, Mc68020, and 
MC68881 instructions and addressing modes. THINK C does not support the 
assembly language extensions for the Mc68851 memory-management unit, 
so you can not use the memory management instructions available on the 
MC68030 or the MC68040. 

Note 
Using only Mc68000 assembly language ensures that your 
code will run on all Macintosh computers. 
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The inline assembler follows assembly language syntax conventions with a 
few exceptions. The DC (define constant) directive, which places literal val­
ues in the code stream, is the only assembly language directive the inline as­
sembler recognizes. Use C to declare data, to define symbolic constants, and 
to import and export symbols. 

The following identifiers are reserved in an assembly block. 

dO dl d2 d3 
d4 dS d6 d7 
aO al a2 a3 
a4 as a6 a7 
fpO fpl fp2 fp3 
fp4 fpS fp6 fp7 
sp pc zpc ccr 
sr usp isp msp 
vbr sfc dfc cacr 
fpcr fpsr fpiar dc 

The assembler is not case sensitive with respect to instruction mnemonics 
and size specifications C. B, • W, • S, • L, • P, . x, and. D). Register names can 
be either all uppercase or all lowercase, but not mixed case. For example, 
the inline assembler recognizes fpl and FP1, but not Fpl. 

When TIDNK C compiles a function that contains an assembly block, it auto­
matically turns off some optimization and debugging options for that func­
tion. It returns the options to their original settings when it compiles the next 
function. The following options are turned off: 

• Automatic Register Assignment 
• Defer & combine stack adjusts 
• Always generate stack frames 
• All global optimizer options 

Writing processor-specific assembly code 
The in line assembler supports all the standard MC68000, MC68020, and 
MC68881 instructions and addressing modes. However, to make sure your 
code runs on a certain Macintosh, you may need to specify which instruc­
tions and addressing modes are allowed in your assembly block. There are 
two ways to do this. 
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To learn about the Op­
tions ... dialog, see "Using 
the Options ... Dialog" on 
page 179. 

Warning 

Using the Inline Assembler • 
It's up to you to make sure that a specific processor is avail-
able before you allow your program to execute code for it. 
Use the Gestalt Manager to find out what processors a ma­
chine has. 

Usually, you'll use Options .•. dialog to make your selection. The options 
that affect assembly code are the "Generate 68020 instructions" and "Gener­
ate 68881 instructions" options in the Compiler Settings page of the Op­
tions ..• dialog. These options specify the type of assembly you can use in 
every a sm { ... } block. 

This table shows how to set these options for a certain type of assembly 
code: 

If the 68020 and the 68881 You can write this 
option is option is type of assembly code •.. 
Off Off Mc68000 assembly. 
On Orf Mc68020 assembly. 
Off On Mc68000 and Mc68881 as-

sembly. 
On On Mc68020 and Mc68881 as-

sembly. 

Note 
You cannot use Mc68020 instructions or addressing modes 
when the "Generate 68020 instructions" option is off. 

Sometimes, you need to override the settings in the Options .•. dialog. For 
instance, your program may be written for the MC68000, but if there is a 
Mc68020 available, you want certain routines to take advantage of it. You 
can specify which processor an assembly block is for by putting the proces­
sor's name between the asm keyword and the opening brace. For example, 
this block is for the Mc68000: 

asm 68000 { 
; MC68000 instructions 

You can specify that a block is for more than one processor, usually a specif­
ic CPU and the FPU (MC68881). Put the processor names, separated with 
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commas, between the asm keyword and the opening brace. For example, 
this block is for the Mc68020 and the Mc68881: 

asm 68020, 68881 { 
MC68020 and MC68881 instructions 

This table shows the processor names that the inline assembler recognizes 
and what code you can write for that chip: 

With this name ... 
68000 
68020 
68030 

68040 

68881 
68882 

You can write this code .•• 
Mc68000 assembly. 
Mc68020 assembly. 
MC68020 assembly. PMMU assembly is 
not su pported. 
MC68020 and Mc68881 assembly. PMMU 
aSsembly is not supported. 
Mc68881 assembly. 
Mc68881 assembly. 

Note that the inline assembler doesn't support any instructions unique to the 
MC68030, MC68040, or MC68882. In fact, the names 68030, 68040 and 
68882 are just synonyms for the other names. 

Using C identifiers in assembly language 
The inline assembler lets you use C identifiers directly. The base register (A 6 
for locals, AS or A4 for globals, PC for labels) is optional, but must be correct 
if supplied. 

If you've declared register variables, you can use their names wherever a 
register would be legal. The inline assembler is case sensitive with respect to 
C identifiers, just like the C compiler. 

If you declare a variable to be stored in a register and TIIINK C can't store it 
in one, the assembler will signal an error when you use the variable. For ex­
ample, this code fragment might signal an error: 
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{ 

register long *a, *b, *c, *d; 

asm { 
move.l (d), dO 



Using the Inline Assembler • 
You can reference fields of a struct directly. For example, if ymi have a 
variable of type windowRecord, you can get the ref Con field like this: 

long myRefcon(void) 
{ 

extern WindowRecord myWindowi 

asm { 
move.l my Window. ref Con, dO 

You can get the offset of a field of a structure in two ways. The simplest is to 
use the name of the structure, followed by a dot, followed by the name of 
the field. For example, this function returns the ref Con field of a 
windowRecord that you have a pointer to: 

long GetRefcon (WindowPtr wp) 
{ 

asm { 
movea.l 
move.l 

wp,aO 
WindowRecord.refCon(aO),dO 

The other way is to use the offsetof () macro defined in the me 
stddef. h. This function also returns the ref Con field of a 
windowRecord that you have a pointer to: 

#include <stddef.h> II for the offsetof() macro 

long GetRefcon2 (WindowPtr wp) 
{ 

Note 

asm { 
movea.l 
move. 1 

wp, aO 
offsetof(WindowRecord,refCon) (aO),dO 

The macro OFFSET () defined in asm. h works the same 
way as offsetof () and is available for compatibility with 
previous versions ofTHINI< C. 

Using floating point literals 
You may use valid C floating point literals as immediate-mode operands to 
Mc68881 instructions. When you need to specify an immediate operand that 
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is accepted by Mc68881 but that is not a valid C floating point literal, enclose 
the operand in quotes. For example, in the following statement" INF" 
stands for the Mc68881 representation of infinity: 

fmove.x #"INF",fp2 

In the following statement, if you don't use the quotes, the assembler would 
attempt to store the number as an integer and cause an overflow. The quotes 
tell the assembler to treat it as a double float: 

fmove.x #"123456678901234567890",fpl 

With . 0 appended, the number is a valid C floating-point literal and doesn't 
need quotes: 

fmove.x #123456678901234567890.0,fpl 

Labels and branching 
You can label assembly language instructions with C or assembler labels. An 
assembler label consists of an at sign (@) followed by one or more alphanu­
meric characters. Colons are optional following assembler labels, but must 
appear after C labels. 

void foo (void) 
{ 

asm 

@123 
@2yx: 
here: 

} 

/* A legal asm label */ 
/* A legal asm label */ 
/* A legal C label */ 

The scope of an assembler label is the enclosing function, not just the se­
quence of inline assembly in which it appears. This is the way C labels work, 
too. 

You can use these C branching statements within assembly language: 

Statement 
break 
continue 

return 
goto label 

Action 
exits the surrounding loop or switch 
skips to next iteration of the surrounding 
loop 
exits function 
same as bra @label 

You can goto C labels in assembly language from C code. 
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You can also refer to C labels from inline assembly, whether the label ap­
pears in assembly code or in C code. The label must be preceded by @ to in­
dicate to the assembler that it is a label. This avoids ambiguity in statements 
such as: lea foo, Al. 

The assembler optimizes branch instructions without size qualifications 
(such as BNE), choosing whether to generate a long or a short branch. This 
optimization does not apply to instructions with size qualifications, such as 
the BNE • S or BNE • W instructions. 

The assembler also optimizes branches around C statements appearing with­
in inline assembly. For example, 

while ( ... ) 

asrn { 
bne @l 
continue 

@l 

generates the same code as: 

while C .. ) 

asrn { 
beq 

@l ... 

cont: 
} 

@cont 

As above, this optimization applies only to instructions without size qualifi­
cations; for example, it apples to the BNE instruction, but not the BNE. S or 
BNE . W instructions. 
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If you JSR to a function from within assembly language, the function must 
be already declared. For example, to call the function MyFun () from assem­
bly: 

extern int MyFun(void); 

int OtherFun(void) 
{ 

asm { 

jsr MyFun 

It's up to you to make sure that you pass the correct arguments for a function 
you call from assembly language. For more information, see "C Calling Con­
ventions" on page 266 and "Pascal Calling Conventions" on page 269. 

Returning from a function 
Do not use the RTS instruction unless you're absolutely sure you know what 
you're doing. If you want to return a value, always use a return statement. 
TItis way, the C stack frame will be cleaned up properly. For more informa­
tion, see "C Calling Conventions" on page 266 and "Pascal Calling Conven­
tions" on page 269. 

Multiple entry points 
You can create multiple entry points into a function by using labels declared 
as extern. First, declare each additional entry point to be a new function. 
Then, inside an inline assembly block, mark the beginning of each addition­
al entry point with a label preceded by extern. The names of the label and 
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Previous versions of THINK 
C had a built-in list of trap 
names and did not require 
you to indude header files 
for the inline assembler. 

Using the Inline Assembler • 
the new function must be the same. For example, this code fragment creates 
an additional entry point into foo () called fool (): 

void foo1(void); 

void foo (void) 
{ 

asm 
moveq #O,dO 
bra.s @1 

extern fool: 
moveq #l,dO 

@1 

Warning 
Use this feature carefully! It is very powerful, but improper 
use can wreak havoc. 

Using the Macintosh Toolbox in assembly language 
In your assembly language code, you can use any of the Macintosh Toolbox 
functions defined in the headers included with THINK C. The inline assem­
bler is case sensitive with respect to trap names. If you like, you can precede 
trap names with an underscore. 

Note 
!fyou include Traps. h in your source file, you can't pre­
cede trap names with an underscore, because Traps. h 
uses the #define preprocessor directive to define all the 
trap names as constants. 

To use Toolbox routines, you must either include MacHeaders, or the 
header file a sm. h as well as the header file for the Toolbox routines you 
plan to use. 

The inline assembler uses inline function definitions to generate instructions 
for Toolbox traps. For instance, two of the Text Edit routines are defined like 
this in TextEdi t . h: 

pascal void TECopy(TEHandle hTE) = OxA9D5; 
pascal Point TEGetPoint(short offset 

TEHandle hTE) = {Ox3F3C,Ox0008,OxA83D}; 
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This example and the ones The inline assembler lets you use these two routines like this: 
that follow are meant to 
show how the inline assem­
bler generates code. Nor­
mally, you would not call 
these routines like this. 

void F (void) 
{ 

asm { 
TECopy 

-TEGetPoint 

It would generate machine code something like this: 

DC.W 
MOVE.W 
DC.W 

OxA9DS 
#8, -(SP) 
OxA83D 

trap for TECopy 
selector for TEDispatch 
trap for _TEDispatch 

This mechanism lets you treat certain Macintosh routines as if they were 
Toolbox traps even though they're really calls to dispatched traps or packag­
es. The mINK C inline assembler takes care of calling such routines the 
right way. For instance, the inline assembler lets you treat the SFGetFile 
Toolbox routine as if were a Toolbox trap: 

asm { 

SFGetFile 

What the inline assembler actually generates is this: 

asm { 

move_w 

Pack3 

#2,-(SP) 2 is the routine 
selector for 
SFGetFile 
The trap for Std File 

There are a few routines that have inline definitions that the assembler treats 
differently. For instance, the MaxMem Memory Manager routines is defined 
like this: 

#pragma parameter DO MaxMem( Al) 
pascal Size MaxMem(Size *grow)~{OxAllD,Ox2288}; 
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This example is for illustra­
tive purposes only. If you re­
ally wanted to allocate a 
deared handle in the sys­
tem heap, you'd use 
NewHandleSysClear 
defined in Memory. h. 

Using the Inline Assembler • 
But when _MaxMem is used in the inline assembler, only the trap OxAllD is 
generated. These special routines, as well as traps for routines that can only 
be called with glue in C, are defined in asm. h. 

The inline assembler lets you use the following 2-bit trap modifier flags to 
set bits 9-10 of certain traps. These trap modifiers are defined in asm. h: 

Trap family Modifier flag Usage 
Memory SYS Applies to system heap 

CLEAR Zero allocated block 
File & Driver ASYNC Asynchronous I/O 

HFS Use HFS version of trap 
IMMED Bypass driver queue 

Strings MARKS Ignore diacritical marks 
CASE Don't ignore case 

Get/Set Trap NEWOS as trap, new numbering 
NEWTOOL Toolbox trap, new num-

bering 
Toolbox AUTOPOP Return to caller's caller 

Remember that these modifiers apply only to particular traps. Here's an ex­
ample of a Toolbox routine call with trap modifier: 

Handle NewClearSysHandle(size) 
{ 

asm { 
move.l 

NewHandle 
move.l 

size,dO 
CLEAR+SYS 
aO,dO 

Most of the low-level File Manager routines (the PB routines) may be called 
synchronously or asynchronously. When you call these routines from C, you 
provide a Boolean argument to specify which way you want to call the rou­
tine, or you can use a special in line definitions to call exactly the one you 
want: 

void SamplePB (ParmBlkPtr pb, Boolean how) 
{ 

PBWrite(pb, how); /* call it one way */ 
/* or the other */ 

PBWriteSync(pb); /* Force it synchronous */ 
PBWriteAsync(pb); /* Force it asynch. */ 
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In the inline assembler, you can call the synchronous or asynchronous traps 
directly. If you don't specify which version of the trap you want, the inline 
assembler assumes you meant the synchronous one. 

void SampleAsmPB (void) 
{ 

asm { 
PBWriteSync 

-PBWriteAsync 
-PBWrite 
-PBWrite ASYNC 

use the synch version 
use the asynch version 
same as PBWriteSync 
same as =PBWriteAsync 

Register usage 
You may modify the following registers in inline assembly code without sav­
ing and restoring their values: 

AO 
00 
FPO 

Al 
01 
FPl 

02 
FP2 FP3 

If you use any other registers, you should save and restore their values. 

In general, if you need to use a register for other than scratch storage, you 
should declare a register variable and refer to it by name. 

If intervening C code is executed between two stretches of inline assembly, 
you can assume that the C code preserves the values of registers AS, A6, and 
A 7 - as well as A4 for drivers and code resources. All other registers may 
have been modified. It is safe to leave things on the stack while C code is ex­
ecuting, provided you clean up the stack before returning from the function. 

For more information, see "C Calling Conventions" on page 266 and "Pascal 
Calling Conventions" on page 269. 

Differences from Other Assemblers 
This sections describes the differences between TI-IINK C's inline assembler 
and most other assemblers. 

Note 
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Differences from Other Assemblers • 
Hexadecimal constants 
THINK C does not accept the syntax $NNNN to designate a hexadecimal con­
stant. Use the C syntax OxNNNN instead. 

THINK C treats hexadecimal constants as unsigned numbers. For example, 
OxFF is equ~valent to 255, OxFFFF is equivalent to 65535, and neither is 
equivalent to -1. 

Directives 
Two or more DC. B directives in a row are treated as one DC • B directive. 
This means that a DC. B directive can occupy an odd number of bytes when 
another DC • B directive follows. For example: 

de.b 'a' 
de.r:> 'b' 
de.b 'e' 
de.b 'd' 

is equivalent to: 

de.b 'a', 'b', Ie', 'd' 

However, preceding a DC. B directive with a label will word-align it. For ex­
ample, this: 

de.b 'a' 
@1 de.b 'b' 
@2 de.b 'e' 
@3 de.b 'd' 

will assemble in the same way as: 

de . b ' a " 0 , ' b " 0 , ' e " 0 , ' d " 0 

The DC. B directive accepts strings (both Pascal and C) as operands. The ter­
minating null byte is not assembled. Continuing the above example, this: 

de.b 'a', 'b', Ie', 'd' 
de . b 5, ' e " ' f " ' g " ' h " ' i ' 

is equivalent to this: 

de.b "abed" 
de.b "\pefghi" 
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If you want a string defined as a C string, you must supply the terminating 
null. You can do it like this: 

dc.b "ABCDE\O" 

The DC . W directive can accept a function name or a label as an operand and 
generate the PC-relative offset of the function or label as a word. The func­
tion or label must be defined within the segment in which the directive ap­
pears. 

The DC. S, DC. D, and DC. X directives accept floating-point constants. For 
example: 

dc.s 3.14 
dc.d "inf" 
dc.x "10000000000" 

Addresses 

single-precision float 
double-precision float 
extended-precision float 

The difference of two addresses is not a constant expression, so instructions 
like this are not allowed: 

move.w #@2-@I,dO 

Similarly, the inline assembler does not support the following syntax to as­
semble the PC-relative offset of the label @ 1: 

dc.w @1-* 

Instead, use this: 

dc.w @1 

For example, to code a dispatch table, use: 

dO contains 0,1,2, ... 
add.w dO,dO 
add.w @O(dO.w),dO 
jmp @O(dO.w) 

@O dc.w @1 case 0 
dc.w @2 case 1 

Tips 
Inline assembly can be tricky if you are not familiar with assembly language. 
It can be especially dangerous if you're used to thinking in terms of high-Iev­
ellanguages. The following problems are not specific to 1HINK C; they are 
common to assembly language in general. 
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Using constants 

Tips • 
Don't forget the # sign when using an immediate constant. Otherwise, the 
result will be very different than what you intended. 

extern short MemErr : Ox220i II declare MemErr 
II low mem global 

asm { 
move.w Ox220,DO 

move.w MemErr, 

move.w #Ox220, 

move.w 5, DO 

move.w #5, DO 

Local storage 

DO 

DO 

iMoves contents of 
i location Ox220 
i (MemErr) into DO 
iSame thing, but 
i symbolically 
iMoves the value Ox220 
i into DO 
iWRONG: On a MC68000 

this will cause an 
odd address error. 
On a MC68020 this will 
move the contents of 
location 5. 

iRIGHT 

Use C variables to declare local storage. If you use the directive DC instead, 
storage will be allocated in your code segment. Most of the time, this is 
not what you want. 

Instruction size 
Be sure to use the right-sized instruction to refer to variables. Example: 

function () 
{ 

short GetsTrashedi 
short Vi 

asm{ 
move.l 

move.w 

#3,v 

#3,v 

iWRONG: will overwrite 
i variable GetsTrashed 
iRIGHT: Word size 
i matches into 
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To see how THINK C com­
piles your code, use the DIs­
assemble ... command, 
described in "Disassem­
bling your code" on page 
168 

For more information on 
the "Far CODE" option, see 
"Using a larger jump table 
with Far CODE" on page 
100. 

C Calling Conventions 
Most of the time, the functions you write will be C functions. They will fol­
low C calling conventions for placing arguments on the stack and returning 
values in register DO. 

C calling sequence 
The caller pushes the arguments in right-ta-Ieft order, then calls the function. 
When the function returns, it's the caller's responsibility to remove the argu­
ments from the stack. The caller's code looks something like this: 

move ... , - (SP) i last argument 

move 
jsr 
add 

... , - (SP) i first argument 
function 
t ... , SP itotal size of arguments 

The function's code looks something like this: 

link A6, t ... 

move ... ,DO 
unlk A6 
rts 

i (optional) 

iresult 
i (optional) 

When the "Far CODE" option is on, the code generator generates 32-bit ab­
solute addresses for the jump table entry of a non-static routine. If the called 
routine ends up in the same segment as the calling routine, the linker replac­
es the 32-bit address with a 16-bit relative address from AS and a 16-bit NOP 
instruction. This replacement makes it more likely that the linker can remove 
the jump table entry for that function. 

C function entry 
The arguments to the function appear on the stack in right-ta-Ieft order. The 
first OeftmosO argument appears just above the return address, followed by 
the remaining arguments. 
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The stack looks like Figure 13-1 on entry (just after the call). 

arg-N 

arg-l 

SP -.. return address 

Figure 13-1 The stack during a C function entry 

The first argument can be found at 4 (SP) . If the function begins with a 
LINK A6, # ... instruction, the first argument can also be referenced by 
8 (A6) . 

All arguments occupy an even number of bytes on the stack. If there is no 
prototype for a char-size argument, it is placed in the high byte of an int 
which may be 2 or 4 bytes, depending on your option settings. 

If there is a prototype for a char-sized argument, it is placed in the low byte 
ofa short. 

C function exit 
C functions return their result (if any) in register DO. The result may be I, 2, 
or 4 bytes long. Unused high-order bits may contain garbage. 

The stack looks like Figure 13-2 on exit (just after the return). 

arg-N 

SP -.. L-I_a_r_g_-l ________ ----' 

Figure 13-2 The stack during a C function exit 

It is the caller's responsibility to remove the arguments from the stack. 

Functions that return struct, union, or double 
TI-llNK C uses a different method to return a result of type struct, union, 
or double, since values of these types are in general too large to fit in DO. 
(Some structs or unions may be small enough to be returned in DO, but 
the alternate method is used anyway.) 
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If the "Generate 68881 instructions" option is on, and the "Native floating­
point" option is on, all floating point values are returned in register FP O. 

After pushing the arguments, but before issuing the actual call, the caller 
pushes the address of the location where the return value is to be placed. 
This address appears at 4 (SP) (or 8 (A6») and the first argument appears 
instead at 8 (SP) (or 12 (A 6»). The function must get this address and store 
the result at the location it points to. The address is considered a hidden ar­
gument to the function, and it's the caller's responsibility to remove it from 
the stack. 

Because a function returning a struct, union, or double expects its call­
er to have placed a hidden argument on the stack, it is essential that the call­
er do so! Therefore, even when you are not interested in the actual return 
value, always be sure that the function is declared correctly before calling it. 

Note 
To ensure that mINK C places the return value in the right 
place, always use a ret urn statement. 

Functions that accept a variable number of arguments 
The C calling conventions make it easy to write functions that take a variable 
number of arguments. The first argument can always be found in the same 
place regardless of how many additional arguments are supplied. Because 
responsibility for removing the arguments from the stack lies with the caller, 
the function doesn't need to clean up the stack. 

The standard ANSI library includes the stdarg. h header file, which pro­
vides a standard interface for all C programs that handle variable arguments. 
As an elementary example, here is a function that returns the minimum of an 
arbitrary number of integers. The first argument is the number of additional 
arguments passed and must be at least 1. 

#include <stdarg.h> 

int minimum (int count, ... ) 
{ 

va_list xp; /* Declare the arg pointer */ 
int x, min; 

va_start (xp, count); /* Initialize the */ 
/* pointer. */ 

min = va_arg (xp, int); /* Get the first */ 
/* argo */ 
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To see how THINK C com­
piles your code, use the Dis­
assemble ... command, 
desaibed in "Disassem­
bling your code" on page 
768 

Pascal Calling Conventions • 
while (--count) { 

x = va arg (xp, int);/* Get the next */ 
if (x < min) min = x;/* argo */ 

Note 

va end (xp); 
return (min); 

/* Clean up. 

You don't need to add the ANSI library to your project to 
use the stdarg. h header file. 

*/ 

A function using Pascal calling conventions cannot accept a variable number 
of arguments, unless it is written in assembly language. 

Pascal Calling Conventions 
The Macintosh Toolbox expects that calls to it follow Pascal calling conven­
tions. When you write functions that expect to be called as Pascal functions, 
be sure to use the pascal keyword when you define them. This section 
tells you how Pascal functions expect to be called. 

Pascal calling sequence 
The caller pushes the arguments in left-to-right order, then calls the function. 
Upon return, the result Of any) may be found on the stack. The caller's code 
looks something like this: 

CLR -(A7) ; reserve space for result 
MOVE t ... , -(A7) ;first argument 

MOVE t ... , -(A7) ;last argument 
JSR ;go to the function 
MOVE (A 7) +, ... ;result 

The function's code looks something like this: 

LINK A6, t ... 

MOVE ... , ... (A6) 

UNLK A6 
MOVEA (A7)+, AO 
ADDQ t ... , A7 
JMP (AO) 

; (optional) 

;store return result 

; (optional) 
;return address 
;total size of arguments 
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Pascal function entry 
The arguments to the function appear on the stack in left to right order. The 
last (rightmost) argument appears just above the return address, followed by 
the remaining arguments in reverse order. If the function returns a result, 
space for it is reserved above the first argument If the return value is 1 byte 
long, 2 bytes are reserved. 

The stack looks like Figure 13-3 on entry (just after the call). 

Space for return value (if any) 

arg-N 

arg-l 

SP ~ return address 

Figure 13-3 The stack during a Pascal function entry 

The last argument can be found at 4 (SP) . If the function begins with a 
LINK A6, :/t ... instruction, the last argument can also be referred to as 
8 (A6) . 

All arguments occupy 2 or 4 bytes on the stack. A byte argument appears in 
the high byte of its word and is found at an even offset from SP (or A6). 

Pascal function exit 
The function stores its return result (if any) on the stack in the location re­
served by the caller. If the result is 1 byte long, it is placed in the high byte of 
the word reserved. 

The stack looks like Figure 13-4 on exit (just after the return). 

SP ~ I return value (if any) 

Figure 13-4 The stack during a Pascal function exit 

It ~s the function's responsibility to remove the arguments from the stack 

Note 
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Libraries + 
14 

Libraries are collections of compiled code you can use in many programs. 
They usually contain utility functions or interface functions to the operating 
system. The MacTraps and MacTraps2 libraries, for instance, contain the 
interfaces to the Macintosh Toolbox. 

This chapter shows you how to use libraries, how to build a library, and how 
to convert object files from other development environinents into TI-lINK C 
libraries. 

Contents 
Using Libraries 

Creating Libraries . . 
Projects as libraries 
Binary libraries 

Converting MPW .0 files into THINK C Projects 

273 
274 
274 
275 

275 
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Using Libraries 

Using Libraries • 
To add a library to a project, choose the Add ••• command in the Source 
menu You see the dialog in Figure 14-1. 

I a Mac Libraries I 

D RppleTalk 
D CommToolBoH 
D Graf3D 
D MacTraps 
D nRppleTalk 
D PrGlue 
D SRNE 

( ) 

( Driue ) 

( Bon(~ ) 

( 

[~-A d-d-R-II-"') 

10 (H(~HHH~(~) 
~----------------------------~~ 

Figure 14-1 The Add ... dialog 

The top list displays the contents of the folder you're in. The bottom list dis­
plays the files that will be added to your project when you click Done. You 
add files to the bottom list with these commands: 

• To add a file, select it and click Add, or double-click on it. 
• To add all the files from the folder you're in, click Add All. 
• To open a folder, select it and click Open, or double-click on it. 

(Add becomes Open when you click on a folder.) 
• To remove a file from the bottom list, select it and click Remove. 
• When you finish selecting files to add, click Done. 
• If you change your mind and don't want to add any files, click 

Cancel. 
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See Chapter 7, "The Proj­
ect, " to learn about the dif­
ferent components of a 
THINK C project. 

When you add a library to a project, its object code isn't loaded, so its object 
code size is zero. You can use the Load Library command in the Project 
menu to load a library, or you can let mINK C's auto-make facility to load it. 
The auto-make facility loads a library if it was never loaded or if it changed 
since the last time it was loaded. 

Creating Libraries 
TI-IINK C gives you two ways to create libraries. You can use any THINK C 
project as a library, or you can create a separate library document called a bi­
nary library. When you use a project as a library, the smart linker uses only 
the code it needs. Binary libraries, on the other hand, are smaller, and take 
up less space on disk. 

Most of the libraries in your mINK C package are actually THINK C 
projects. The binary library format is included mostly for compatibility with 
older versions of mINK C. 

Projects as libraries 
You can use any mINK C project document as a library. Libraries can con­
tain functions, globals, or other libraries. When you use a project as a library, 
TI-IINK C uses smart linking to build your project. The linker links only the 
CODE components that contain functions that your program uses 

If your library contains global variables, and you want to use it in code re­
sources, desk accessories, or drivers, you need to make sure that you com­
pile everything in the library with A4 addressing. To make THINK C compile 
your globals with A4-relative addressing, choose Set Project Type ••• from 
the Project menu and click on the Code Resource radio button. 

Note 
When you choose Code Resource in this case, it doesn't 
mean that you're building a code resource or that the li­
brary will only work with code resources. It's just a way of 
letting the mINK C compiler know that you want A4-rela­
tive globals. 

If your library doesn't contain any global variables, you can use it with either 
applications or code resources, drivers, or desk accessories. If your applica­
tion does contain global variables, you'll need to create two versions: one 
for applications and one for everything else. 

The ANSI libraries that come with your THINK C package are good exam­
ples of project libraries. If you want to explore them, make a copy of them 
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Converting MPW .0 files into THINK C Projects • 
first so you don't damage the original ones accidentally. Then use the Open 
Project ••• command in the Project menu to open them. 

Binary libraries 
Use the Bulld Library command in the Project menu to create a binary li­
brary. When you use this command, you'll see a standard file dialog asking 
you to name the library. By convention, libraries end in .lib. When you 
use a library in your project, the linker adds all of the object code in the li­
brary to your project. 

Binary libraries are seldom used. The facility to use and create them is pro­
vided for compatibility with older versions of TmNK C and some third party 
products. 

Converting MPW .0 files into THINK C Projects 
If you have an MPW .0 file that you want to use in a 1HINK C project, use 
the oConv utility that comes with your 1HINK C package. This section gives 
you step-by-step instructions on how to use oConv. If you want more infor­
mation about oConv, see Chapter 16, "oConv." 

Converting an MPW .0 file into a 1HINK C project is a two pass process. First 
you use the oConv utility to create a vocabulary me from the .0 file. Then 
you edit the vocabulary file and use oConv again to create a project from the 
.0 file and the edited vocabulary file. 

To create a vocabulary file from a .0 file, follow these steps: 

1. Double-click on oConv to launch it 
2. Make sure that both the TrapList and the ".v" file check boxes are 

checked 
3. Choose the.o file you want to convert, and click on the Convert 

button 
4. Click on the Cancel button to quit oConv 

The oConv utility produces a 1HINK C project and a vocabulary file.Ignore 
the project file for this part of the process. 

Note 
There are some .0 file records that the oConv utility cannot 
convert. If you get an error during this pass, look at Chapter 
16, "oConv," to see if there is a way to work around the er­
ror. 
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The vocabulary file contains the name of every external function in the .0 

file. In most cases, these names are in all upper case. Use the TIUNK C editor 
or any other text editor to edit the vocabulary file so the function names 
have the correct upper and lower case spellings. 

.. ~iJ .. [i] 
SomeFile.a.o oConv SomeFile.a .11 

I .. ~ 
SomeFile.a.v 

Figure 14-2 Creating a vocabulary file from an MPW .0 file 

Now that you have a vocabulary file, the second part is a little simpler. 

1. Double-click on oConv to launch it 
2. Make sure that both the TrapList and ".v" file check boxes are 

checked 
3. Choose the same .0 file that you chose before 
4. Click on Cancel to quit oConv 

In this second pass, oConv uses the vocabulary file that you created and ed­
ited in the first pass. The resulting project contains all the functions in the ap­
propriate case. 

[i] 
SomeFile.a .0 oConv SomeFile.a :11 

I t 
SomeFile.a.v 

Figure 14-3 Creating a THINK C project from an MPW .0 file 
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The Profiler • 
15 

Profiling your program lets you analyze how it runs. A profiler can log how 
much time your program spends in each function, and it can trace your pro­
gram by printing the name of each routine as it's called. This chapter shows 
you how to use the THINK C profiler. 

Contents 
Using the Profiler 

Logging Time Statistics 

Tracing Your Functions 

Modifying the Profiler. . . 
Changing where to print . . 
Changing which timer to use . 
Changing the pro filer's report 
Recompiling the profiler 

Summary ... 
User functions 
Internal functions 
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284 
284 
285 
286 

287 
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287 
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Using the Profiler • 
The profiler helps you analyze how your program runs. It can log how much 
time your program spends in each function, and it can trace your program 
by printing the name of each routine as it's called. 

To use the profiler, follow these steps: 

1 . Check the "Generate profiler calls" check box in the Debugging 
page of the Options ... dialog. When this option is on, TIIINK C 
inserts calls to profile routines at the beginning and end of your 
functions. 

2. Include both the profile library and the ANSI library in your 
project. They're in the C Libraries folder. Make sure you 
#include profile. h in the file that calls InitProfile (). 

3. Call Ini tP rofile () in your program to start the profiler. This 
function takes two arguments. The first nsyms is the maximum 
number of functions that the pro filer will track. The second 
depth is the maximum call depth. A good default for both argu­
ments is 200 (for example, Ini tP rofile (200,200»). 

4. Set the variables yrofile and _trace to control what the 
profiler does. Ini tProfile () initially sets yrofile to non­
zero and _trace to zero. If yrofile is non-zero, the pro filer 
logs time statistics. If _trace is non-zero, the profiler traces your 
routines. 

5. If you want to see the timing statistics, make sure the profiler 
prints them out. You must call DumpProfile () or exi t () , or 
use the console environment. 

For example, this program initializes the profiler, writes a profile, and exits: 

#include <profile.h> 

main () 
{ 

/* Initialize the profiler with the */ 
/* recommended arguments. */ 
InitProfile( 200, 200 ); 

/* Have the profiler write a trace */ 
/* of your code */ 
_trace = 1; 

/* Do some stuff. */ 

THINK C User Manual 281 



75 The Pro filer • 

For more information on 
the Options ... command, 
see "Using the Options ... 
Dialog" on page 179. 

For more information on 
the console environment, 
see the Standard Libraries 
Reference, Chapter 3, "Us­
ing Console Windows. " 

For more information on 

/* Write a profile. */ 
DumpProfile(); 

/* Do some more stuff. */ 

/* Exit. The profiler writes a */ 
/* profile automatically. */ 
exiteD); 

The profiler won't collect statistics for some unusual functions. These condi­
tions control whether the profiler can profile a function: 

• Locals Variables. Does the function declare any local variables? 
• Function Parameters. Does the function declare any parameters? 
• Inline Assembly. Does the function use inline assembly? 
• Stack Frames Option. Is the "Always generate stack frames" op­

tion in the Options ..• dialog on? 

When the conditions for a function match one of the cases in this table, the 
pro filer won't collect statistics for the function: 

Locals 
Variables 
none 
none 

Function 
Parameters 
none 
none 

Inline 
Assembly 
present 
none 

Stack frames 
Option 
on or off 
off 

To find out why the profiler doesn't profile these functions, see U Always gen­
erate stack frames" on page 244. 

logging Time Statistics 
The profiler can log the amount of time spent in each function. To print these 
results to stdout at any time, call DumpP rofile () . The profiler automat­
ically prints out these results when your program exits, if your program does 
one of these: 

• Calls exi t () to exit 
• Uses the console environment. 

exi t () and abort ( ) , Note 
see the Standard Libraries 
Reference, Chapter 5, "The 
Standard Library Func-

If your program exits by calling Exit ToShell () or 
abort () , the profiler doesn't print its statistics automati­
cally. 

tions." 
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The profiler uses the units of the VIA 1 timer. Each unit is 1.2766 J.iSec (ap­
proximately 780,000 in a second). You can change the units to ticks (60ths of 
a second) by editing the profiler code. You might need to use the tick 
counter if your program uses the Sound Driver, since the Sound Driver uses 
the VIA timer. Also the VIA timer is less accurate if there's a lot of interrupt­
level activity. See section "Changing which timer to use" on page 284. 

This is an example of the profiler report. It's for a program that compares 
two sorting algorithms. 

Function Minimum Maximum Average % Entries 

compare 26 238 27 4 12948 
std_swap 64 948 67 2 2353 
SlowSort 582 4880405 1643130 68 3 
QuickSort 61 61 61 0 3 

QuickSort 57 58 57 0 3 
QuickSort1 27 177573 1051 8 564 
std_compare 85 436 88 15 12948 
TryAlgorithms 364 24996 9294 0 

This describes the report's headings: 

Heading 
Function 
Minimum 
Maximum 
Average 
% 

Entries 

Description 
Name of the function. 
Minimum time spent in routine. 
Maximum time spent in routine. 
Average time spent in routine. 
Percentage of profiling period spent in the 
routine. (The profiling period is the accu­
mulated time spent in routines that were 
compiled with the "Generate pro filer 
calls" option on.) 
Number of times the routine was called. 

If you don't want the pro filer to keep these statistics, set the variable 
yrofile to 0 after you call InitProfile (). 

Tracing Your Functions 
The pro filer can also print a trace of the functions your program calls as it 
runs. Every time you call a function, the profiler prints out the function's 

3 
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For more information on 
cecho2printer (), 
cecho2file (), and 
f reopen ( ) , see Stan­
dard Libraries Referenc~ 
Chapter 5, "The Standard 
library Functions. " 

name, indenting it to show how far nested it is. For example, this is an ex­
cerpt from the trace of the sorting program: 

TryAlgorithms 
SlowSort 
QuickSort 

QuickSort 
-QuickSortl 

std_compare 
compare 

std_compare 
compare 

According to this trace, TryAlgorithms () called SlowSort () and 
QuickSort () , then QuickSort () called _QuickSort () , and so on. 

If you want the profiler to trace your functions, set the variable _trace to a 
non-zero value after you call Ini tP rofile () . 

Modifying the Profiler 
This section describes how to change where the pro filer prints its reports 
and which timer the profiler uses. 

Changing where to print 
The profiler prints its report and trace to stdout. By default, stdout is a 
console window, a simple window that acts like a glass terminal. You can 
have the profiler print to both a console and a file, to both a console and a 
printer, or to just a file. 

To print to .•. 
a console and a file 
a console and a printer 
just a file 

Use this function ..• 
cecho2file () 
cecho2printer () 
freopen () 

For example, these statements initialize the profiler and redirect stdout to 
the file profiler report: 

InitProfile( 200, 200 ); 
freopen( "profiler report", "w", stdout ); 

Changing which timer to use 
You can choose whether the profiler uses the VIA timer or the tick counter. 
The profile library shipped with THINK C uses the VIA timer. 
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Usually you'll want to use the more precise VIA timer Each of its units is 
1.2766 J.lSec (approximately 1I780,OOOth of a second) and each tick unit is 
lA50th of a second. However, you may need to use the tick counter in these 
two cases: 

• You use the Sound Driver. The Sound Driver uses the VIA timer 
and will interfere with the pro filer. 

• Your program has a lot of interrupt-level activity. The VIA timer is 
less accurate in this case. 

To create a profile library that uses the tick counter, follow the steps in sec­
tion "Recompiling the profiler" on page 286. When you come to the step 
"Make your changes," comment out the line that defines VIATIMER. It 
should look like this: 

1* #define VIATIMER *1 

Changing the protiler's report 
You can change the profiler's report. For example, you might alter how a 
field is computed or what it looks like. Follow the steps in section "Recom­
piling the profiler" on page 286. When you come to the step "Make your 
changes," edit the function DumpProfile (). 

You'll need to edit two statements in DumpProfile (). The first is the 
printf () statement that prints a line of information for each function pro­
filed. Here it is, with comments explaining the arguments: 

printf("%#-32s%8lu %8lu %8lu %3u %8lu\n", 
p->fname, 
p->min == LONG MAX ? a : p->min, 
p->max, -
p->count ? p->total I p->count : 0, 
total ? (int) (100. * p->total/total) 
p->count); 

II 
II 
II 
II 

0,11 
II 

Name 
Min 
Max 
Ave 
% 
Ent. 

The second is the printf () statement that prints the report's heading. You 
need to edit it only if you change the length of a field: 

printf("\n%-32s Minimum Maximum Average 
"%% Entries\n\n", "Function"); 

" 

This example shows how to print the percentage as a floating-point number 
with five digits of accuracy, instead of as an integer. Firstly, edit the format 
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string argument in the first printf () statement. Since the percentage will 
be a floating point number, change its formatspedfier from %3u to %5. 2f. 

printf("%'-32s%8lu %8lu %8lu %5.2f %8lu\n", 

Secondly, change the arg~ment that computes the percentage. Simply delete 
the (int) cast, which casts the argument to an integer, and change 0 to 
o. o. 

total? (100.* p->total/total) : 0.0, /* % */ 

Lastly, add some spaces to the report's heading, since the percentage field is 
longer. Add three spaces between %% and Entries: 

printf("\n%-32s Minimum Maximum Average " 
"%% Entries\n\n", "Function"); 

Recompiling the profiier 
To change how theprofller works, you need to edit and recompile the pro­
file project. These steps show you how: 

1. In the Finder, create a new copy of the profile project and give 
it a new name, like new profile. 

~. Open the new project with mINK C. 
3. Open the file profile. c. 
4. Make your changes. 
5. Choose the Save As ••• command. Go to the Sources folder in 

the C Libraries folder. Save the file under a new name, such 
as new profile. c. 

6. Choose the Compile command to recompile the file. 

Warning 
When you rebuild the profiler library, make sure that the 
"Generate profiler calls" option is not selected. You cannot 
profile the pro filer. You would be in an infinite loop at run 
time. 

Now you can use the new project as a library in any of your projects. 
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Summary • 
This section describes the functions and variables in the profile library. 
They're declared in profile. h. 

User functions 
Use these functions and variables in your program to control how the profil­
er works. 

void InitProfile( unsigned nsyms, unsigned depth ); 

Start profiling; It takes these arguments: 

Argument 
nsyms 
depth 

Description 
The maximum number of functions to track 
The maximum call depth. 

void DumpProfile(); 

Write the statistics collected so far to stdout. You can call this function any 
time to print the current statistics. The profiler automatically calls it when 
your program exits. 

int yrofile; 

Variable. If non-zero, the pro filer collects timing statistics as your functions 
execute. By default, yrofile is non-zero. You can change the value after 
you call InitProfile () . 

int _trace; 

Variable. If non-zero, the profiler traces your functions Every time you enter 
a function the profiler prints its name to stdout. By default, _trace is 
zero. You can change the value after you call InitProfile (). 

Internal functions 
The pro filer calls these functions before and after each function call. You 
shouldn't call them in your programs. 

void yrofile_( unsigned char *fname ); 

Called at the beginning of each fundion when the "Generate profiler calls" 
option is on. When this routine is called, the stack contains the address of a 
Pascal string that is the name of the function. yrofile_ () changes the re­
turn address of the routine to be yrofile_exit (). 
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static void *-profile_exit(); 

Called at the end of a function. Code to execute this routine is not generated. 
Instead, -profile_ () changes the stack so the original routine "returns" 
to this one. 
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oConv. 
16 

Rom time to time, you may need to use an object me that was compiled with 
Apple's Macintosh Programmers Workshop. The oConv utility converts .0 

files into a form that WINK C can use. 

Contents 
Using oConv to Convert MPW .0 Files 

Converting Large .0 Files. . . . . 
Create a list of symbols. . . . 
Split up the symbols . . . . 
Make the pieces . . . . . . 
Use oConv to convert the pieces 

Conversion Limits. . . 
Segmentation limits . 
Computed references 
Reference records . 
SADE records. . . 
MPW runtime routines . 
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292 
293 
293 
293 
293 
294 
294 
294 
294 
294 
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Using oConv to Convert MPW .0 Files • 
Using oConv to Convert MPW .0 Files 
The oConv application converts object files created by Apple's MPW compil­
ers and assemblers into THINK C projects. You can use these projects as li­
braries or, if you prefer, you can build a library from the resulting project 

Note 
"Converting MPW.o files into mINK C Projects" on page 
275 gives you step-by-step instructions on how to convert 
MPW. 0 files into mINK C projects. If you want to convert 
a file quickly, look there first, then come back here to learn 
more about oConv. 

When you double click on the oConv icon, you'll see a standard file dialog. 

la Gestalt Glue I 
[) Ge$taItGlue.a.o c:J Eustacia 

Ej<H t 

[ Orlue 

n Conuert B 
[Conuert All] 

Addressing: @ AS 0 A4 Cancel] 

Uocabulary: 181 TrapList 0 ".u" file 1.0.4 

Figure 16-1 The oConv dialog 

The converter displays only files of type 'OBJ '. That means that it can 
convert MPW . 0 files as well as mINK Pascal libraries. When you double 
click on a . 0 file name (or click on the Convert button), the converter gener­
ates a file ending in . 7t. For instance, if you convert a me called xyz zy .0, 

the resulting project file will be called xyz zy . 1t. 

When the converter is through converting the file, it displays the standard 
file dialog again to let you convert more files. To quit the converter, click on 
the Cancel button. 

To convert all the . 0 files in a folder, click on the Convert All button. The 
converter doesn't convert files that have already been converted. 

The converter lets you choose whether to use AS or A4 addressing. If you'll 
be using the project in an application, choose AS. If you'll be using it in a 
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This is how to type the spe­
dal characters: 

00 Option 5 
• Option 8 
= Option x 
® Option r 

desk accessory, device driver, or code resource, use A4 addressing. To learn 
more about A4 addressing, read "Global data in drivers" in Chapter 7. 

In some. 0 files, symbol names appear in all upper case. The vocabulary 
mechanism provides a way to translate such names back to their proper cap­
italizations. Only names entirely in upper case will be translated. 

When TrapList is checked, the Toolbox glue routine names are added to the 
vocabulary. This includes all the routines in Inside Macintosh. 

When the ".v" file option is checked, the converter looks for a vocabulary 
file for each. 0 file. The vocabulary file is a text file that contains the proper 
capitalization for each symbol in the. 0 file, one symbol per line. If the file to 
be converted is named xyzzy. 0, the vocabulary file must be named 
xyzzy. v. 

If the vocabulary file doesn't exist, the converter will create it. The file will 
contain one line for each symbol that appears entirely in upper case in 
the.o file. You can edit this file to supply the proper capitalization, and then 
run oConv again. 

Converting Large .0 Files 
If you want to convert an object file that has more than 32K of code and 
data, you need to break it up into smaller object files that oConv can handle. 
The best way to split up large object files is to use Apple's Macintosh Pro­
grammers Workshop. The instructions in this section give you one way of 
splitting up large. 0 files. 

Create a list of symbols 
The first thing you need to do is find out the names of the symbols in the ob­
ject file. Use the MPW dumpobj tool to do this. Suppose that the object file 
you want to convert is called OFILE. o. Use this MPW command to get a list 
of symbols: 

dumpobj OFILE.o -d -h -i -jn > OLIST.txt 

The list in the output file, OLIST. txt, has size information about each sym­
bol that you don't need to do the conversion. Use this MPW command to 
clean up the file: 

replace -c ~ /·~[O-9]+ (~)@a~/ @a OLIST.txt 
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Split up the symbols 
Now you need to split up the symbols into groups for the smaller object file. 
For example, suppose that OLI ST. txt contains these symbols: 

DrawThings 
CalcThings 
UtilThings 
MemThings 

To split up the large object me into three pieces, you need create three lists. 
Each list should contain the names of the symbols you don 't want in the 
smaller piece. Make these lists by copying OLIST. txt and editing it. Call 
the resulting lists filterl. txt, filter2. txt, and filter3. txt. 

Suppose you want to break up the large object nIe into these three pieces: 

piecel.o 
DrawThings 
Ca1cThings 

piece2.o 
UtilThings 

Your nIter files would look like this: 

fllterl.txt 
UtilThings 
MemThings 

Make the pieces 

fllter2. txt 
DrawThings 
CalcThings 
MemThings 

piece3.o 
MemThings 

fllter3. txt 
DrawThings 
CalcThings 
UtilThings 

Now you can use the filter lists to create the pieces from the original object 
file. You need to use the MPW lib tool for each piece: 

lib OFILE.o -0 piecel.o -df filterl.txt -Sym Off 
lib OFILE.O -0 piece2.0 -df filter2.txt -Sym Off 
lib OFILE.o -0 piece3.0 -df filter3.txt -Sym Off 

Use oConv to convert the pieces 
Finally, you can use oConv to convert the smaller pieces. 

Conversion Limits 
Though oConv can convert many object files into THINK C projects, there 
are some object file records it can't convert. 
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Segmentation limits 
OConv ignores all segmentation directives in an object file, and places all the 
converted code into a single segment. The code and data in an object file 
cannot exceed a total of 32K bytes. 

Computed references 
OConv only converts computed references (object records of type 10) that 
are 16-bit modified references to code. It will not convert 8-bit or 32-bit com­
puted references to code or 8-, 16-, or 32-bit references to data. 

Reference records 
OConv cannot convert reference records (object records of type 9). This 
kind of code causes MPW to generate reference records: 

extern short func(); 
short (*fp) () func; 

short (**pfp) &fp; 

SADE records 

II data to code, 32-bit 
II load-time addition 
II of AS 
II data to data, 32-bit 
II load-time addition 
II of AS 

OConv ignores all object file records of type greater than 10. 

MPW runtime routines 
Sometimes, an object file will convert with no problems, but when you try to 
use it, you get an Clundefined symbols" error message. If the object file was 
produced from a high level language, like MPW C or MPW Pascal, these ref­
erences are usually calls to runtime routines for long multiplication and divi­
sion. To use object files that make calls to MPW runtime routines, you may 
want to extract the runtime routines from the MPW runtime libraries. 

294 THINK C User Manual 



THINKC --------+ 
Resource Utilities 

.. . " . 

Part Six 
1 7 Resource Description 

Files 
18 Using SARez 
19 Using SADeRez 

THINK C User Manual 295 



· -------------------------------------------------------

296 THINK C User Manual 



Resource 
Description Files + 

17 
Resource description files are the files compiled by SARez and produced by 

SADeRez. See Chapter 18, "Using SARez," and Chapter 19, "Using SADeRez," 
for more information on these utilities. Complete background information 
on Macintosh resource files is given in Inside Macintosh 1, Chapter 5; Inside 
Macintosh Iv, Chapter 3, Inside Macintosh V, Chapter 3; and Inside Macin­
tosh VI, Chapter 13. 

Both SARez and SADeRez started out life as tools in Apple's Macintosh Pro­
grammer's Workshop (MPW), where they were known as Rez and DeRez. 
MPW has a command-line interface, much like UNIX. At times it will seem 
these utilities work a bit oddly or have options you can't use. This is because 
of their heritage. But, despite their upbringing, they are still a powerful and 
useful utilities. 

Contents 
The Resource Compiler and Decompiler 

Resource decompiler . . . . 
Standard type declaration files . 

Structure of a Resource Description File. 
Sample resource description file 

Resource Description Statements. . 
Syntax notation . . . . . . 
Special terms . . . . . . . . 
Include - include resources from another file 
Read - read data as a resource . 
Data - specify raw data . . . . . . . 
Type - declare resource type . . . . . 
Delete - delete a resource . . . . . . . 
Change - change a resource's vital information 
Resource - specify resource data . . . 

Labels. . . . . . . . . . . . . . 
Built-in functions to access resource data 
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Preprocessor Directives 

Variable definitions . 
1£-Then-Else processing 
Print directive . . . 

Resource Description Syntax. 
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The Resource Compiler and Decompiler • 
The Resource Compiler and Decompiler 
The resource compiler, SARez, compiles a text file (or files) called a re­
source description file and produces a resource file as output. The re­
source decompiler, SADeRez, decompiles an existing resource, producing a 
new resource description file that can be understood by SARez. Figure 17-1 
illustrates the complementary relationship between SARez and SADeRez. 

Resource 
File 

Resource Decompiler 
(SADeRez) 

Figure 17-1 SARez and SADeRez 

Resource Compiler 
(SARez) 

Resource 
Description 

File 
('TEXT ,) 

SARez can combine resources or resource descriptions from a number of 
files into a single resource file. SARez can also delete resources and change 
resource attributes. SARez has preprocessor directives that let you substitute 
macros, include other files, and use if-then-else constructs. (These directives 
are described in section "Preprocessor Directives" on page 328.) 

Resource decompiler 
SADeRez creates a textual representation of a resource file based on re­
source type declarations identical to those used by SARez. (If you don't 
specify any type declarations, the output of SADeRez takes the form of raw 
data statements.) The output of SADeRez is a resource description file that 
may be used as input to SARez. This me can be edited in any text editor, so 
you can add comments, translate resource data to a foreign language, or 
specify conditional resource compilation with the if-then-else structures of 
the preprocessor. 
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Standard type declaration files 
Three text files, Types 0 r, SysTypes 0 r, and pict 0 r, contain resource 
declarations for standard resource types. These files are located in the 
{Rlncludes} folder. 

This file ... 
Typesor 

SysTypes.r 

Pict.r 

Contains ••• 
Type declarations for the most common 
Macintosh resource types (' ALRT ' , 
'DITL', 'MENU', and so on). 
Type declarations for 'DRVR', 'FOND', 
'FONT', 'FWID', 'INTL', 'NFMT',and 
many others 
Type declaration for PICT resources for 
debugging PICTs 

Using SARez and SADeRez 
SARez and SADeRez are primarily used to create and modify resource files. 
Figure 17-2 illustrates the process of creating a resource file. 

Resource 
description 

(0 r) file 
('TEXT') 

Resource Editor 
(ResEdit) 

Resource Compiler 
(SARez) 

Resource 
file 

Figure 17-2 Creating a resource file 
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5 tructure of a Resource Description File • 
Structure of a Resource Description File 
The resource description file consists of resource type declarations (which 
can be iricluded from another file) followed by resource data for the de­
clared types. Note that the resource compiler and resource decompiler have 
no built-in resource types. You need to define your own types or include the 
appropriate . r files. 

A resource description file may contain any number of these statements: 

Statement 
include 
read 

data 
type 

resource 

change 

delete 

Description 
Include resources from another file. 
Read data fork of a file and include it as a 
resource. 
Specify raw data 
Type declaration - declare resource type 
descriptions for subsequent resource 
statements. 
Data specification - specify data for a re­
source type declared in a previous type 
statement 
Change the type, ID, name, or attributes of 
existing resources. 
Delete existing resources. 

Each of these statements is described in the sections that follow. 

A type declaration describes how the declaration of a resource of that type 
will look like. You must declare a type (with a type statement) before you 
make a resource of that type (with a resource statement). Otherwise, you 
can freely mix type and resource statements in a me. You can redefine a 
type any number oftimes, even a type defined in Types. r, SysTypes. r, 
or pict. r. 

A resource description file can also include comments and preprocessor di­
rectives. Comments can be included any place white space is allowed in a 
resource description file, by putting them within the comment delimiters 1* 
and * I. Note that comments do not nest. For example, this is one comment: 

1* Hello 1* there *1 

SARez also supports C++ style comments: 

type 'tost' { II Ignore rest of this line. 
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Preprocessor directives substitute macro definitions and include files, 
and provide if-then-else processing before other SARez processing takes 
place. The syntax of the preprocessor is very similar to that of the C-Ian­
guage preprocessor. 

Sample resource description file 
An easy way to learn about the resource description format is to decompile 
some existing resources. For example, using SADeRez to decompile an ap­
plication's resources might generate this: 

resource 'WIND' (128, "Sample Window") { 
{64, 60, 314, 460}, 
documentProc, 
visible, 
noGoAway, 
OxO, 
"Sample Window" 

} ; 

This resource data corresponds to the following type declaration, contained 
in Types. r: 

type 'WIND' { 
recti 

} ; 

integer documentProc, 
dBoxProc, plainDBox, 
dBoxProc, noGrowDocProc, 
zoomProc=8, rDocProc=16; 

byte invisible, visible; 
fill byte; 
byte noGoAway, goAway; 
fill byte; 
unsigned hex longint; 
pstring Untitled="Untitled"; 

/* bounds */ 
/* procID */ 

/* visible */ 

/* close box */ 

/* ref Con */ 
/* title */ 

Type and resource statements are explained in detail in the reference section 
that follows. The SADeRez utility is explained in detail in Chapter 19, "Using 
SADeRez." 

Resource Description Statements 
This section describes the syntax and use of the seven types of resource de­
scription stateme~ts available for the resource compiler: incl ude, read, 
data, type, delete, change, and resource. 
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Expression is defined later in 
this chapter in section "Ex­
pressions" on page 332. 

Syntax notation 

Resource Description Statements • 
The following syntax notation is used to describe the resource description 
statements: 

terminal 

nonterminal 

[ optional] 

repeated ... 

a I b 
( grouping 

Plain text indicates a word that must ap­
pear in the statement exactly as shown. 
Special symbols (Le., -, *, =) and punctu­
ation (Le., commas", II and semicolons 
" ; ") must also be entered exactly as 
shown. 
Items in italics can be replaced by any­
thing that matches their definition. 
Square brackets mean that the enclosed 
elements are optional. 
An ellipsis (. .. ), when it appears in the 
text of this reference only, indicates that 
tpe preceding item can be repeated one or 
more times. 
A vertical bar indicates an either/or choice 
Parentheses indicate grouping (useful 
with the I and ... notation). 
Curly single quotation marks (' ... ') indi­
cate that one of the syntax notation char­
acters (for example, [or]) must be 
written as a literal. In this example, the 
brackets would be typed literally. They do 
not mean that the x is optional 

Spaces between syntax elements, constants, and punctuation are optional. 
They are shown for readability only. 

Tokens in resource description statements may be separated by spaces, tabs, 
. ,-

returns, or comments. 

Special terms 
The following terms represent a minimal subset of the nonterminal symbols 
used to describe the syntax of commands in the resource description lan­
guage: 

Term 
resource-type 
resource-name 
resource-ID 
ID-range 

Definition 
long-expression 
string 
word-expression 
ID [ :Jp] 
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A full syntax definition can be found at the end of this chapter. 

Include - Include resources from another file 
The include statement lets you read resources from an existing file and in­
clude all or some of them. 

Syntax 

An incl ude statement can take the following forms: 

include file 
[resource-type [ , (' resource-name I ID [ : ID] ~ 1 ] ; 

Read the resource of type resource-type with the specified resource name or 
resource ID range in file. If the resource name or ID is omitted, read all re­
sources of the type resource-type in file. If resource-type is omitted, read all 
the resources in file. 

incl ude file not resource-type ; 
Read all resources not of the type resource-type in file. 

include file resource-type1 as resource-type2 ; 
Read all resources of type resource-type 1 and include them as resources of 
resource-type2. 

include file resource-type1 '( I resource-name I ID [ :ID] ~ I 

as resource-type2 '( I ID [, resource-name] [, attributes ... ] ~ '; 
Read the resource of type resource-type1 with the specified name or ID 
range infile, and include it as a resource of resource-type2with the specified 
ID. You can optionally specify a resource name and resource attributes. (Re­
source attributes are defined below.) 

Note 
SADeRez ignores all incl ude statements. 

Some examples follow: 

include "otherfile"; 
/* include all resources from the file */ 

include "otherfile" 'CODE'; 
/* read only the CODE resources */ 

include "otherfile" 'CODE' (128); 
/* read only CODE resource 128 */ 
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To learn more about at­
tributes, see Inside Macin­
tosh I, Chapter 3, "Resource 
Manager." 

Resource Description Statements • 
AS resource description syntax 
The following string variables can be used in the as resource description to 
modify the resource information in include statements: 

Description Variable 
$$Type Type of resource from include file 
$$ID ID of resource from include file 
$$Name 
$$Attributes 

Name of resource from include file 
Attributes of resource from include file 

For example, to include all 'DRVR' resources from one file and keep the 
same information but also set the SYSHEAP attribute: 

INCLUDE "file" 'DRVR' (0:40) AS 
'DRVR' ($$ID, $$Name, $$Attributes 64) ; 

The $$Type, $$ID, $$Name, and $$Attributes variables are also set 
and legal within a normal resource statement. At any other time the values 
of these variables are undefined. 

Resource attributes 
You can specify attributes as a numeric expression, or you can set them in­
dividually by specifying one of the keywords from any of the following 
pairs: 

Default 
appheap 

Alternative 
sysheap 

nonpurgeable purge able 

unlocked locked 

unprotected protected 

nonpreload preload 

Meaning 
Specifies whether the re­
source is to be loaded into 
the application heap or the 
system heap. 
Purgeable resources can 
be automatically purged 
by the Memory Manager. 
Locked resources cannot 
be moved by the Memory 
Manager. 
Protected resources can­
not be modified by the Re­
source Manager. 
Preloaded resources are 
placed in the heap as soon 
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unchanged changed 

as the Resource Manager 
opens the resource file. 
Tells the Resource Manag­
er whether a resource has 
been changed. SARez does 
not allow you to set this 
bit, but SADeRez will dis­
play it if it is set 

Bits 0 and 7 of the resource attributes are reserved for use by the Resource 
Manager and cannot be set by SARez, but are displayed by SADeRez. 

You can specify more than one attribute by separating the keywords with a 
comma (, ). 

Read - read data as a resource 
The read statement lets you read a file's data fork as a resource. 

Syntax 
read resource-type 

t (J ID [, resource-name [ , attributes] ~ J file ; 

DeSCription 
Reads the data fork from file and writes it as a resource with the type re­
source-type and the resource ID ID, with the optional resource name re­
source-name and optional resource attributes (as defined in the preceding 
section). For example, 

read 'STR ' (-789,"Test String",SysHeap,PreLoad) 
"Test8"; 

Note 
SADeRez ignores all read statements. 

Data - specify raw data 
Use the data statement to specify raw data as a sequence of bits, without 
any formatting. 

Syntax 

da t a resource-type t (J ID [, resource-name] [ , attributes ... ] ~ J t{ J 

data-string 
t} J ; 
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Description 
Reads the data found in data-string and writes it as a resource with the type 
resource-type and the ID !D. You can optionally specify a resource name, re­
source attributes, or both. 

For example, 

data 'PICT' (128) { 
$"4F35FF8790000000" 
$"FF234F35FF790000" 

} ; 

Note 
When SADeRez generates a resource description, it uses 
the da t a statement to represent any resource type that 
doesn't have a corresponding type declaration or cannot be 
disassembled for some other reason. SADeRez ignores any 
data statements in the resource description files you pro­
vide. 

Type - declare resource type 
A type declaration provides a template that defines the structure of the re­
source data for a single resource type or for individual resources. If more 
than one type declaration is given for a resource type, the last one read be­
fore the data definition is the one that's used. This lets you override declara­
tions from include files or previous resource description files. 

Syntax 
type resource-type [ f (' !D-range ~ '] f{ I 

type-specification ... 
f} I ; 

Description 
Causes any subsequent resource statement for the type resource-type to 
use the declaration {type-specification ... }. The optional ID-rangespecifica­
tion causes the declaration to apply only to a given resource ID or range of 
IDs. 
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TYPe-specification is one of the following: 

bitstring[n] 
byte 
integer 
longint 
boolean 
char 
string 
pstring 
wstring 
cst ring 
point 
rect 
fill 
align 

switch 
array 

Zero fill 
Zero fill to nibble, byte, word, or long 
word boundary 
Control construct (case statement) 
Array data specification-zero or more in­
stances of data types 

These types can be used singly or together in a type statement. Each of 
these type specifiers is described in the sections that follow. 

Note 
Several of these types require additional fields. The exact 
syntax is given in the sections that follow. 

You can also declare a resource type that uses another resource's type decla­
ration by using the following variant of the type statement: 

308 THINK C User Manual 

type resource-type 1 [ (( I ID-range ~ I 

as resource-type2 [ (( I ID ~ '] ; 



Data-type specifications 

Resource Description Statements • 
A Data-type statement declares a field of the given data type. It can also as­
sociate symbolic names or constant values with the data type. The data-type 
specification can take three forms, as shown in this example: 

type 'XAMP' { 
/* declare a resource of type 'XAMP' */ 
byte; 

} ; 

byte off=O, on=l; 
byte = 2; 

The first byte statement declares a byte fieldj the actual data is supplied in a 
subsequent resource statement. 

The second byte statement is identical to the first, except that the two sym­
bolic names off and on are associated with the values 0 and 1. These sym­
bolic names could be used in the resource data. 

The third byte statement declares a byte field whose value is always 2. In 
this case, no corresponding statement would appear in the resource data. 

Numeric expressions and strings can appear in type statementsj they are 
defined in section "Expressions" on page 332. 

Numeric types: The numeric types (bitstring, byte, integer, 
longint) are fully specified like this: 

[ $$unsigned$$] [radix] numeric-type 
[ = expr I symbol-definition. .. ]; 

The unsigned prefix signals SADeRez that the number should be displayed 
without a sign-that the high-order bit can be used for data and the value of 
the integer cannot be negative. The unsigned prefix is ignored by SARez 
but is needed by SADeRez to correctly represent a decompiled number. 
SARez uses a sign if it is specified in the data. Precede a signed negative con­
stant with a minus sign ( -)j OxFFFFFF 8 5 and - 0 x 7 B are equivalent in val­
ue. 

Radix is one of the following string constants: 

hex 
binary 

decimal 
literal 

octal 

You can supply numeric data as decimal, octal, hexadecimal, or literal data. 
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Numeric-type is one of the following: 

bitstring I[ 1 length l' 

byte 

integer 

longint 

Declare a bitstring of length bits 
(maximum 32). 
Declare a byte (8-bit) field. This is 
the same as bitstring [8]. 

Integer C16-bit) field. This is the 
same asbitstring[16]. 
Long integer (32-bit) field. This is 
the same as bi tstring [32] . 

SARez uses integer arithmetic and stores numeric values as integer numbers. 
SARez translates booleans, bytes, integers, and longints to 
bi tstring equivalents. All computations are done in 32 bits and truncat­
ed. 

An error is generated if a value won't fit in the number of bits defined for the 
type. The valid ranges for values of byte, integer, and longint con­
stants are as follows: 

Type 
byte 
integer 
longint 

Maximum 
255 
65,535 
4,294,967,295 

Minimum 
-128 
-32,768 
-2,147,483,648 

Boolean type: A Boolean is a single bit with two possible states: 0 (or 
false) and 1 (or true). (true and false are global predefined identifi­
ers.) Boolean values are declared as follows: 

boolean [ = constant I symbolic-value ... ]; 

The type boolean declares a I-bit field; this is equivalent to 

unsigned bitstring[l] 

Note 
This type is not the same as a Boolean variable as defined 
by Pascal. 

Character type: Characters are declared as follows: 

char [= string I symbolic-value... ]; 

Type char declares an 8-bit field (this is the same as writing string [1]). 
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Here is an example: 

type 'SYMB' { 

Resource Description Statements • 
char dollar = "$", percent "9,."­o , 

} ; 

resource 'SYMB' (128) 
dollar 

} ; 

String type: String data types are specified like this: 

string-type ['[' length 11 [= string I symbol-value ... ]; 

String-type is one of the following: 

[hex] string 

pstring 

wstring 

cstring 

Plain string has no length indicator or 
termination character is generated. The 
optional hex prefix tells SADeRez to dis­
play it as a hex string. String [n] con­
tains n characters and is n bytes long. The 
type char is shorthand for String [1] . 
Pascal string has a leading byte contain­
ing the length information is generated. 
Pst ring [ n] contains n characters and is 
n+1 bytes long. Pstring has a built-in 
maximum lerigth of 255 characters, the 
highest value the length byte can hold. If 
the string is too long to fit the field, a 
warning is given and the string is truncat­
ed. 
Word string is a very large pst ring. Its· 
length is stored iri the first two bytes. 
Therefore, a word string can contain up to 
65,535 characters. Wstring [n] contains 
n characters and is n+ 2 bytes long. 
e string generates a trailing null byte. 
cstring [n] contains n-1 characters 
and is n bytes long. A C string of length 1 
can be assigned only the value "", be­
cause cst ring [ 1] has room only for the 
terminating null. 

Each string type may be followed by an optional length indicator in brackets 
( [ n]). Length is an expression indicating the string length in bytes. Length is 
a positive number in the range 1 ~ length ~ 2,147,4 83,647 for 
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string and cstring, and in the range 1 ~ length ~ 255 for 
pstring, and in the range 1 ~ length ~ 65,535 for wstring. 

Note 
You cannot assign the value of a literal to a string type. 

If no length indicator is given, a pst ring, wstring, or cst ring stores 
the number of characters in the corresponding data definition. If a length in­
dicator is given, the data may be truncated on the right or padded on the 
right. The padding characters for all string types are nulls. If the data con­
tains more characters than the length indicator provides for, the string is 
truncated and a warning message is given. 

Warning 
A null byte within a cst ring is a termination indicator 
and may confuse SADeRez and C programs. However, the 
full string, including the explicit null and any text that fol­
lows it, will be stored by SARez as input. 

Point and rectangle types: Because points and rectangles appear so fre­
quently in resource files, they have their own simplified syntax: 

point [ = point-constant I symbolic-value ... ]; 
rect [ = rect-constant I symbolic-value... ]; 

where 
pOint-constant = r{' x-integer-expr, y-integer-expr r}' 

and 
rect-constant = r{' integer-expr, integer-expr, 

integer-expr, tnteger-expr r}' 

These type statements declare a point (two 16-bit signed integers) or a rect­
angle (four 16-bit signed integers). The integers in a rectangle definition 
specify the rectangle's upper-left and lower-right points, respectively. 

Fill and align types 
The resource created by a resource definition has no implicit alignment. It's 
treated as a bit stream, and integers and strings can start at any bit. The fill 
and align type specifiers are two ways of padding fields so that they begin 
on a boundary that corresponds to the field type. Align is automatic and 
fill is explicit. Both fill and align generate zero-fIlled fields. 
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Fill specification: The fill statement causes SARez to add the specified 
number of bits to the data stream. The fill is always o. The form of the state­
ment is 

fill Jill-size [ '[' length 1'] ; 

where Jill-size is one of the following strings: 

bit 
word 

nibble 
long 

byte 

These declare a fill of 1, 4, 8, 16, or 32 bits (optionally multiplied by the 
length modifier). Length is an expression s; 2,147,483,647. 

The following fill statements are equivalent: 

fill word[2]; 
fill long; 
fill bit[32]; 

The full form of a type statement specifying a fill might be: 

type ' XRE S' { data-type specifications; fill bi t [2]; }; 

Note 
SARez supplies zeros as specified by fill and align 
statements. SADeRez does not supply any values for fill 
or align statements; it just skips the specified number of 
bits, or until data is aligned as specified. 

Align specification: Alignment causes SARez to add fill bits of zero value 
until the data is aligned at the specified boundary. An alignment statement 
takes the following form: 

align align-size; 

where align-size is one of these strings: 

nibble 
long 

byte word 

Alignment pads with zeros until data is aligned on a 4-,8-, 16-, or 32-bit 
boundary. This alignment affects all data from the point where it is specified 
until the next align statement. 
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Array type 
An array is declared as follows: 

[ wide ] array [ array-name I '[' length 1'] '{ , 
array-list 

The array-list, a list of type specifications, is repeated zero or more times. 
The wide option outputs the array data in a wide display format (in SA­
DeRez)-the elements that make up the array-list are separated by a comma 
and space instead of a comma, Return, and Tab. Either array-name or 
[length] may be specified. Array-name is an identifier. 

If the array is named, then a preceding statement should refer to that array in 
a constant expression with the $$CountOf (array-name) function; other­
wise SADeRez will treat the array as an open-ended array. For example, 

type 'STR#' {/* define a string list resource */ 
integer = $$Countof(StringArray); 
array StringArray { 

pstring; 
} ; 

} ; 

The $$CountOf () function returns the number of array elements (in this 
case, the number of strings) from the resource data. 

If [length] is specified, there must be exactly length elements. 

Array elements are generated by commas. Commas are element separators. 
Semicolons are element terminators. In this example, however, it may be a 
good idea to use semicolons as element separators: 
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type 'xyzy' { 
array Increment { 

integer = $$ArrayIndex(Increment); 
} ; 

} ; 

resource 'xyzy' (0) { 

} ; 

{ /* zero elements */ 
} 
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resource 'xyzy' (1) 

{ /* two elements */ 

} ; 

resource 'xyzy' (3) { 
} /* two elements */ 

; ; 

} ; 

/* The only way to specify one element in 
* an array that has all constant elements, 
* is to use a semicolon terminator. 
*/ 

resource 'xyzy' (4) { 
{ /* one element */ 

} ; 

Switch type 
The switch statement specifies a number of case sta~ements for a given 
field or fields in the resource. The format is: 

swi tch '{' case-statement... '} '; 

where a case-statement has this form: 

case case-name : [ case-body ; ] ... 

Case-name is an identifier. Case-body may contain any number of type spec­
ifications and must include a single constant declaration per case, in this 
form: 

key data-type constant 
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Which case applies is based on the key value. For example, 

type 'DITL'{ 

} ; 

/* dialog item list declaration 
* from Types.r 
*/ 

... type specifications ... 

switch { /* one of the following */ 
case Button: 

booleanenabled, disabled; 
key bitstring[7] = 4; /* key value */ 
pstring; 

case CheckBox: 
booleanenabled, disabled; 
key bitstring[7] = 5; /* key value */ 
pstring; 

... andsoon. 

} ; 

Sample type statement 
The following sample type statement is the standard declaration for a 
'WIND' resource, taken from the Types. r file: 

type 'WIND' { 
recti 

} ; 

integer documentProc, 
dBoxProc, plainDBox, 
dBoxProc, noGrowDocProc, 
zoomProc=8, rDocProc=16; 

byte invisible, visible; 
fill byte; 
byte noGoAway, goAway; 
fill byte; 
unsigned hex longint; 
pstring Untitled="Untitled"; 

/* bounds */ 
/* procID */ 

/* visible */ 

/* close box */ 

/* ref Con */ 
/* title */ 

The type declaration consists of header information followed by a series of 
statements, each terminated by a semicolon (;). The header of the sample 
window declaration is 

type 'WIND' 

The header begins with the type keyword followed by the name of the re­
source type being declared-in this case, a window. You may specify a stan-
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dard Macintosh resource type, as shown in Inside Macintosh VI, Chapter 13 
"Resource Manager "I or you may declare a resource type specific to your 
application. 

The left brace ({) introduces the body of the declaration. The declaration 
continues for as many lines as necessary until a matching right brace (}) is 
encountered. You can write more than one statement on a line, and a state­
ment may be on more than one line Oike the integer statement above). 
Each statement represents a field in the resource data. Recall that comments 
may appear anywhere where white space may appear in the resource de­
scription file; comments begin with / * and end with * / as in C. 

Symbol definitions 
Symbolic names for data type fields simplify the reading and writing of re­
source definitions. Symbol definitions have the form 

name = value [ , name = value ] ... 

For numeric data, the"= value' part of the statement can be omitted. If a se­
quence of values consists of consecutive numbers, the explicit assignment 
can be left out-if value is omitted, it's assumed to be one greater than the 
previous value. (The value is assumed to be zero if it's the first value in the 
list.) This is true for bi tstrings (and their derivatives, byte, integer, 
and longint). For example, 

integer documentProc, dBoxProc, plainDBox, 
altDBoxProc, noGrowDocProc, 
zoomProc=8, rDocProc=16; 

In this example, the symbolic names documentProc, dBoxProc, 
plainDBox, al tDBoxP roc, and noGrowDocP roc are automatically as­
signed the numeric values 0, 1, 2, 3, and 4. 

Memory is the only limit to the number of symbolic values that can be de­
clared for a single field. There is also no limit to the number of names you 
can assign to a given value; for example, 

integer documentProc=O, dBoxProc=l, 
plainDBox=2, altDBoxProc=3, 
rDocProc=16, Document=O, Dialog=l, 
DialogNoShadow=2, ModelessDialog=3, 
DeskAccessory=16i 

Delete - delete a resource 
Sometimes you may want to delete a resource without switching to ResEdit. 
Some resource operations, such as those needed by "internationalizing" sys-
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17 Resource Description Files • 
tern disks and applications need to translate menu and dialog text, and 
hence require deleting or changing resources. 

Syntax 
delete resource-type ['( I resource-name I !D[ :!D] ~ 1 ; 

Description 
Delete the resource of type resource-type from the output file with the speci­
fied resource name or resource ID range. If the resource name or ID is omit­
ted, all resources of type resource-type are deleted. 

Note 
The delete function is valid only when you are append­
ing to an existing file. It makes no sense to delete resources 
while creating a new resource file from scratch. Also, SA­
DeRez ignores all delete commands. 

You can delete resources that have their protected bit set only if you select 
the OK to Replace Protected Resources option in SARez. 

Change - change a resource's vital information 
You can change a resource's vital information by using this function. Vital in­
formation includes the resource type, ID, name, attributes, or any combina­
tion of these at once. 

Syntax 
change resource-type1 [ '( I resource-name I ID[:!D] ~ I ] 

to resource-type2 '( I ID [, resource-name] [, attributes ... ] ~ '; 

Description 
Change the resource of type resource-type1 from the output file with the 
specified resource name or resource ID range to a resource of type resource­
type2with the specified ID. You can optionally specify a resource name and 
resource attributes. If the resource name or attributes are not specified, the 
name and attributes are not changed. 

For example, this statement sets the protected bit on all 'CODE' resources: 

change 'CODE' to $$type ($$ID,$$Attributes I 8); 
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Resource Description Statements • 
The change function is only valid when you are append­
ing to an existing file. It makes no sense to change resourc­
es while creating a new resource file from scratch. Also, 
SADeRez ignores all change commands. 

Resource - specify resource data 
Resource statements specify actual resources, based on previous type dec­
larations. 

Syntax 
resource resource-type '( 'ID [, resource-name] [, attributes] ') I '{ I 

[data-statement [, data-statement ]... ] 

Description 
Specifies the data for a resource of type resource-type and ID /D. The latest 
type declaration declared for resource-type is used to parse the data specifi­
cation. Data-statements specify the actual data; data-statements appropriate 
to each resource type are defined in the next section. 

The resource definition causes an actual resource to be generated. A 
resource statement can appear anywhere in the resource description file, 
or even in a separate file specified on the command line or as an #include 
file, as long as it comes after the relevant type declaration. 

Note 
SADeRez ignores all resource statements. 

Data statements 
The body of the data specification contains one data statement for each dec­
laration in the corresponding type declaration. The base type must match 
the declaration. 

Base type 
string 

bitstring 

rect 
point 

Instance types 
string,cstring,pstring,wstring, 
char 
boolean,byte,integer,longint, 
bitstring 
rect 
point 
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See Inside Macintosh I, 
Chapter 9, "Window Man­
ager, " for information 
about resources in windows. 

Switch data: Switch data statements are specified by using this format: 

switch-name data-body 

For example, the following could be specified for the 'DITL' type given 
earlier: 

CheckBox { enabled, "Check here" }, 

Array data: Array data statements have this format: 

({ I [ array-element [ , array-element] ... ] (} I 

where an array-element consists of any number of data statements separat­
ed by commas. 

For example, the following data might be given for the' STR#' resource de­
fined earlier: 

resource 'STR#' (280) { 

} ; 

{ "this", 
"is", 
"a" , 
"test" 

Sample resource deflnition 
This section describes a sample resource description file for a window. 
Here, again, is the type declaration given above in section "Sample type 
statement" on page 316: 

type 'WIND'{ 
recti 

} ; 

integer documentProc, 
dBoxProc, plainDBox, 
dBoxProc, noGrowDocProc, 
zoomProc=8, rDocProc=16; 

byte invisible, visible; 
fill byte; 
byte noGoAway, goAway; 
fill byte; 
unsigned hex longint; 
pstring Untitled="Untitled"; 

/* bounds */ 
/* procID */ 

/* visible */ 

/* close box */ 

/* ref Con */ 
/* title */ 
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Resource Description Statements • 
Here is a typical example of the window data corresponding to this declara­
tion: 

resource 'WIND' (128, "My window", appheap, 
preload) { 

{40,80,120,300}, 
documentProc, 
Visible, 
goAway, 

/* Status report window */ 
/* Bounding rectangle */ 
/* documentProc etc.. */ 
/* Visible or Invisible */ 
/* GoAway or NoGoAway */ 
/* Reference value Ref Con */ 0, 

"Status 
} i 

Report" /* Title */ 

This data definition declares a resource of type 'WIND', using whatever 
type declaration was previously specified for 'WIND'. The resource ID is 
128; the resource name is "My window". Because the resource name is 
represented by the Resource Manager as a pst ring, it should not contain 
more than 255 characters. The resource name may contain any character in­
cluding the null character ( , \ ° ° ° ,). The resource will be placed in the ap­
plication heap when loaded, and it will be loaded when the resource file is 
opened. 

The first statement in the window type declaration declares a bounding rect­
angle for the window: 

recti 

The rectangle is described by two points: the upper-left corner and the low­
er-right corner. The points of a rectangle are separated by commas like this: 

{ top, left, bottom, right } 

An example of data for these coordinates is 

{ 40, 80, 120, 300 } 

Symbolic names: Symbolic names may be associated with particular values 
of a numeric type. Notice that a symbolic name is given for the data in the 
second, third, and fourth fields of the window declaration. For example, 

integer documentProc=O, dBoxProc=1, 
plainDBox=2, altDBoxProc=3, 
noGrowDocProc=4, zoomProc=8, 
rDocProc=16; /* window Type */ 

This statement specifies a signed 16-bit integer field with symbolic names as­
sociated with the values 0 to 4, 8, and 16. The values 0 through 4 need not 

THINK C User Manual 321 



1 7 Resource Description Files • 
be indicated in this casej if no values are given, symbolic names are auto­
matically given values starting at 0, as explained previously. 

In the sample window declaration, we gave the values True (1) and False 
(0) to two different byte variables. For clarity, we used those symbolic 
names in the window's resource data; that is, 

visible, 
goAway, 

instead of their equivalents 
TRUE, 

or 

TRUE, 

1, 
1, 

labels 
Labels support some of the more complicated resources such as 'NFNT' 
and color QuickDraw resources. Use labels within a resource type declara­
tion to calculate offsets and permit accessing of data at the labels. 

Syntax 
label 
character 
number 
alphanum 

Description 

• • = character {alphanum} ... '. J 

· -= t, I A I B Ie ... 
•• = 0 I 1 I 2 I 3 I 4 5 I 6 I 7 I 8 I 9 
· . = character I number 

Labeled statements are valid only within a resource type declaration. Labels 
are local to each type declaration. More than one label can appear on a state­
ment. 

Labels may be used in expressions. In expressions, use only the identifier 
portion of the label (that is, everything up to, but excluding, the colon). See 
the section "Declaring labels within arrays" on page 324 for more informa­
tion. 
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The value of a label is always the offset, in bits, between the beginning of 
the resource and the position where the label occurs when mapped to the 
resource data. In this example, 

type 'cool' { 
cstring; 

endOfString: 
integer = endOfString; 

} ; 

resource 'cool' (8) { 
"Neato" 

the integer following the cstring would contain: 

( len(nNeato n) [5] + null byte [1] ) * 
8 [bits per byte] 

= 48. 

Built-in functions to access resource data 
In some cases, it is desirable to access the actual resource data that a label 
points to. Several built-in functions allow access to that data: 

$ $Bi tF ield (label, startingPosition, numberOjBits) 

• 

Returns the numberOjBits (maximum of 32) bitstring found startingPosition 
bits from label. 

$ $Byte (label) 
Returns the byte found at label. 

$ SWord (label> 
Returns the word found at label. 

$$Long (label) 
Returns the longword found at label. 

For example, the resource type' STR 'could be redefined without using a 
pstring. Here is the definition of 'STR 'from Types. r: 

type 'STR' { 
pstring; 
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Here is a redefinition of's TR 'using labels: 

type 'STR ' { 
len: byte = (stop - len) / 8 - 1; 

string[$$Byte(len)]; 
stop: ; 
} ; 

Declaring labels within arrays 
Labels declared within arrays may have many values. For every element in 
the array, there is a corresponding value for each label defmed within the ar­
ray. Use array subscripts to access the individual values of these labels. The 
subscript values range from 1 to n where n is the number of elements in the 
array. Labels within arrays that are nested in other arrays require multidi­
mensional subscripts. Each level of nesting adds another subscript. The 
rightmost subscript varies most quickly. Here is an example: 

type 'test' { 
integer = $$CountOf(array1); 
array array1 { 

integer = $$CountOf(array2); 
array array2 { 

foo: integer; 
} ; 

} ; 
} ; 

resource 'test' (128) { 
{ 

} ; 

{1,2,3}, 
{4,5} 

In the above example, the label f 00 takes on these values: 

foo[1,1] 
foo[1,2] 
foo[1,3] 
foo[2,1] 
foo[2,2] 

32 
48 
64 
96 
112 

$$Word(foo[1,1]) 
$$Word(foo[1,2]) 
$$Word(foo[1,3]) 
$$Word(foo[2,1]) 
$$Word(foo[2,2]) 

1 
2 
3 
4 
5 

A new built-in function may be helpful in using labels within arrays: 

$$Arraylndex (arrayname) 
This function returns the current array index of the array arrayname. An er-
ror occurs if this function is used anywhere outside the scope of the array ar­
rayname. 
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Label limitations 
Keep in mind the fact that SARez and SADeRez are basically one-pass com­
pilers. This will help you understand some of the limitations of labels. 

Note 
To decompile (or "DeRez") a given type, that type must not 
contain any expressions with more than one undefined la­
bel. An undefined label is a label that occurs lexically after 
the expression. To define a label, use it in an expression 
before the label is defined. 

This example demonstrates how expressions can only have only one unde­
fined label: 

type 'test' { 
/* In the expression below, 
* start is defined, next is undefined. 
*/ 

start: integer = next - start; 
/* In the expression below, 
* next is defined because it was used in a 
* previous expression, but final is undefined. 
*/ 

middle: integer = final - next; 
next: integer; 
final: 
} ; 

Actually, SARez can compile types that have expressions containing more 
than one undefined label, but SADeRez cannot decompile those resources 
and simply generates data resource statements. 

Note 
The label specified in $$BitField () , $$Byte (), 
$$Word () I and $$Long () must occur lexically before the 
expression; otherwise, an error is generated. 

Using labels: two examples 
The first example shows the modified 'ppa t ' declaration using the new 
SARez labels. Boldface text in the example indicates everything that is differ­
ent between the 2.0 and 3.0 versions of 'ppa t ' because of the use of la­
bels. Without using labels, the whole end section of the resource would 
have to be combined into a single hex string (everything following the 
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PixelData label). Using labels, the complete 'ppat' definition can be 
expressed in SARez language. 

/* PixPat record */ 

type 'ppat' { , 
integer oldPattern; newpattern, ditherPattern; 

/* Pattern type */ 
unsigned longint =.PixMap / 8; 

/* Offset to pixmap */ 
unsigned longint =PixelData / 8; 

/* Offset to data */ 
fill long; /* Expanded pixel image */ 
fill word; /* Pattern valid flag */ 
fill long; /* expanded pattern */ 
hex string [8]; /* old-style pattern */ 

/* PixMap record */ 
PixMap: 

fill long; /* Base address 
unsigned bitstring[1] = 1; 

/* New pixMap flag 
unsigned bitstring[2] = 0; 

/* Must be 0 
unsigned bitstring[13]; 

/* Offset to next row 
recti /* Bitmap bounds 
integer; /* pixMap vers number 
integer unpacked; /* Packing format 
unsigned longint; /* size of pixel data 
unsigned hex longint; 

*/ 

*/ 

*/ 

*/ 
*/ 
*/ 
*/ 
*/ 

/* h. resolution (ppi) (fixed) */ 
unsigned hex longint; 

/* v. resolution (ppi) (fixed) */ 
integer chunky, chunkyPlanar, planar; 

integer; 
integer; 
integer; 
unsigned 
unsigned 

/* Pixel storage format 
/* # bits in pixel 
/* # bits per field 
/* # components in pixel 

longint; /* Offset to next plane 
longint = ColorTable / 8; 

fill long; 
/* Offset to color table 
/* Reserved 

*/ 
*/ 
*/ 
*/ 
*/ 

*/ 
*/ 

PixelData: 
hex string [(ColorTable - PixelData) / 8]; 
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ColorTable: 

} ; 

unsigned hex longint; 
/* ctSeed 

int~ger; /* trans Index 
integer = $$Countof(ColorSpec) - 1; 

1* ctSize 
wide array ColorSpec { 

integer; , 

} ; 

unsi~ed integer; 
unsigned integer; 
~signed integer; 

/* value 
/* RGB: red 
/* green 
/* blue 

Labels 

*/ 
*/ 

*/ 

*/ 
*/ 
*/ 
*/ 

• 

Here is another example of a new resource definition with the new features 
in bold. In this example, the $$BitField() function is used to access in­
formation stored in the resource, in order to calculate the size of the various 
data areas added at the end of the resource. Without labels, all data would 
have to be combined into one hex string. 

/* IconPMap (pixMap) record */ 

type 'cicn' { 
fill long; /* Base address 
unsigned bitstring[l] = 1; 

/* New pixMap flag 
unsigned bitstring[2] = 0; 

/* Must be 0 
pMapRowBytes: unsigned bitstring[13]; 

/* Offset to next row 
Bounds: recti /* Bitmap bounds 

integer; /* pixMap vers number 

*/ 

*/ 

*/ 

*/ 
*/ 
*/ 
*/ 
*/ 

integer unpacked; /* Packing format 
unsigned longint; /* Size of pixel data 
unsigned hex longint; 

/* h. resolution (ppi) (fixed) */ 
unsigned hex longint; 

/* v. resolution (ppi) (fixed) */ 
integer chunky, qhunkyPlanar, planar; 

integer; 
integer; 
integer; 
unsigned longint; 
unsigned longint; 
fill long; 

/* Pixel storage format 
/* * bits 'in pixel 
/* * components in pixel 
/* # bits 'per field 
/* Offset to next plane 
/* Offset to color table 
/ * Reserved' 

*/ 
*/ 
*/ 
*/ 
*/ 
*/ 
*/ 
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/* IconMask 
fill long; 

maskRowBytes : 

(bitMap) 
/* 

integer; 
/* 
/* 

record */ 
Base address 

recti 
Row bytes 
Bitmap bounds 

/* IconBMap (bitMap) record */ 
fill long; /* Base address 

iconBMapRowBytes: integer; 

} ; 

/* Row bytes 
recti /* Bitmap bounds 
fill long; /* Handle placeholder 

/* Mask data * / 
hex string [$$Word(maskRowBytes) 

($$BitField(Bounds, 32, 16) 
- $$BitField(Bounds, 0, 16) 

/* BitMap data */ 

* 
/* bottom */ 
/* top */ )]; 

hex string [$$Word(iconBMapRowBytes) * 
($$BitField(Bounds, 32, 16) /* bottom */ 
- $$BitField(Bounds, 0, 16) /* top */ )]; 

/* Color Table */ 
unsigned hex longint; /* ctSeed 
integer; /* translndex 
integer = $$Countof(ColorSpec) - 1; 

wide array ColorSpec 
integer; 

} ; 

unsigned integer; 
unsigned integer; 
unsigned integer; 

/* PixelMap data */ 

/* ctSize 

/* value 
/* RGB: red 
/* green 
/* blue 

hex string [$$BitField(pMapRowBytes,0,13) * 
($$BitField(Bounds,32,16) /* bottom */ 

- $$BitField(Bounds, 0, 16) /* top */ )]; 

Preprocessor Directives 

*/ 

*/ 
*/ 

*/ 

*/ 
*/ 
*/ 

*/ 
*/ 

*/ 

*/ 
*/ 
*/ 
*/ 

Preprocessor directives substitute macro definitions and include files and 
provide if-then-else processing before other SARez processing takes place. 
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The syntax of the preprocessor is very similar to that of the C-Ianguage pre­
processor. Preprocessor directives must observe these rules and restrictions: 

1. Each preprocessor statement must be expressed on a single line, 
beginning on a new line and terminated by a return character. 

2. The pound sign ( 4f ) must be the first character on the line of the 
preprocessor statement (except for spaces and tabs). 

3. Identifiers (used in macro names) may be letters (A-Z, a-z), dig-
its (0-9), or the underscore character ( ). 

4. Identifiers may be any length. 
5. Identifiers may not start with a digit. 
6. Identifiers are not case sensitive. 

Variable definitions 
The 4fdefine and 4fundef directives let you assign values to identifiers: 

4fdefine ~cro da~ 
4fundef macro 

The 4fdefine directive causes any occurrence of the identifier macro to be 
replaced with the text da~. You can extend a macro over several lines by 
ending the line with the backslash character (\), which functions as the 
SARez escape character. For example, 

4fdefine poem "I wander \ 
thro\' each \ 
charter\ld street" 

(Quotation marks within strings must also be escaped.) 

4fundef removes the previously defined identifier ~cro. Macro can also be 
defined and undefined in the Preprocessor ... dialog in SARez or in the Pre­
processor box in SADeRez. 

The following predefined macros are provided: 

Variable 
true 
false 
rez 

derez 

Value 
1 
o 
1 or 0 (1 if SARez is running, 0 if SADeRez 
is running) 
lor 0 (0 ifSARez is running, 1 ifSADeRez 
is running) 
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Include directives 

The # incl ude directive reads a text file: 

# incl ude file 

Include the text file file. The maximum nesting is to ten levels. For example, 

#include "MyTypes.r" 

Note that the # incl ude preprocessor directive (which includes a file) is dif­
ferent from the previously described incl ude statement, which copies re­
sources from another file. 

If-Then-Else processing 
These directives provide conditional processing. 

# i f expresSion 
[ # eli f expression 
[ #else] 
#endif 

Expression is defined in section "Expressions" on page 332. When used with 
the #if and #elif directives, expression may also include this expression: 

defined identifier 

or 

defined (' identifier ~ , 

The following may also be used in place of #if: 

#ifdef macro 
#ifndef macro 

For example, 

330 THINK C User Manual 

#define Thai 
Resource 'STR' (199) 
#ifdef English 

"Hello" 
#elif defined (French) 

"Bonjour" 
#elif defined (Thai) 

"Sawati" 
#elif defined (Japanese) 

"Konnichiwa" 
#endif 
} ; 



Resource Description Syntax • 
Print directive 
The =ll=printf directive is provided to aid in debugging resource description 
files: 

=ll=printf <formatString, arguments. .. ) 

The format of the =ll=printf statement is exactly the same as the printf () 
statement in the C language, with one exception: There can be no more than 
20 arguments. This is the same restriction that applies to the $$format () 
function. The =ll=print f directive writes its output to diagnostic output. Note 
that the =ll=printf directive does not end with a semicolon. 

Note 
SARez and SADeRez will not print the results of the 
=ll=printf directive if you do not select an error file or if 
there are no errors. (SARez and SADeRez don't print error 
files if there are no errors to report.) 

For example: 

#define Tuesday 3 
#ifdef Monday 
#printf("The day is Monday, day #%d\n", Monday) 
#elif defined (Tuesday) 
#printf("The day is Tuesday, day #%d\n", Tuesday) 
#elif defined(Wednesday) 
#printf("The day is Wednesday, day #%d\n", Wednesday) 
=ll=elif defined (Thursday) 
=ll=printf("The day is Thursday, day #%d\n", Thursday) 
#else 
=ll=printf("DON'T KNOW WHAT DAY IT IS!\n") 
=ll=endif 

The above file generates this text: 

The day is Tuesday, day =11=3 

Resource Description Syntax 
This section describes the details of the resource description syntax. 
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Numbers and literals 
All arithmetic is performed as 32-bit signed arithmetic. These are the basic 
constants: 

• Decimal (nnn ... ): Signed decimal constant between 
4,294,967,295 and -2,147,483,648. 

• Hex (Oxbbb ... or $bbb ... ): Signed hexadecimal constant be­
tween OX7FFFFFFF and oxe 0 0 0 0 0 0 o. 

• Octal (0000 ... ): Signed octal constant between 017777777777 
and 0200 0 0 000 0 0 O. 

• Binary (OBbbb .. .): Signed binary constant between 
OB11111111111111111111111111111111 and 
OB10000000000000000000000000000000. 

• Literal (, aaaa I): A literal may contain one to four characters. 
Characters are printable ASCII characters or escape characters. If 
there are fewer than four characters in the literal, then the charac­
ters to the left (high bits) are assumed to be null characters 
(' \ 00 0 ' ) . Characters that are not in the printable character set, 
and are not the characters \ ' and \ \ (which have special mean­
ings), can be escaped according to the character escape rules. 
(See "Strings" later in this section.) 

Literals and numbers are treated in the same way by the resource compiler. 
A literal is a value within single quotation marks; for instance, 'A' is a 
number with the value 65; on the other hand, "A" is the character A ex­
pressed as a string. Both are represented in memory by the bitstring 
01000001. (Note, however, that nAn is not a valid number and 'A' is not a 
valid string.) The following numeric expressions are all equivalent: 

'B' 
66 
'A'+l 

Literals are padded with nulls on the left side so that the literal 'ABC' is 
stored as shown in Figure 17-3. 

"ABC" = I \000 I A B c 

Figure 17-3 Padding of literals 

Expressions 
An expression may consist of simply a number or literal. Expressions may 
also include numeric variables, labels, and system functions. 
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This table lists the operators in order of precedence with highest precedence 
first-groupings indicate equal precedence. Evaluation is always left to right 
when the priority is the same. Variables are defined following the table. 

Operator 
1. (expr) 

2. -expr 

-expr 

! expr 

3. exprl * 
exprl / 
exprl % 

4. exprl + 
exprl -

5. exprl « 
exprl » 

6. exprl > 
exprl >= 
exprl < 
exprl <= 

7. exprl 
exprl != 

8. exprl & 

9. exprl ,., 

10. exprl 

11. exprl && 

12. exprl I I 

expr2 
expr2 
expr2 

expr2 
expr2 

expr2 
expr2 

expr2 
expr2 
expr2 
expr2 

expr2 
expr2 

expr2 

expr2 

expr2 

expr2 

expr2 

Meaning 
Parentheses can be used in the normal 
manner to force precedence in expression 
calculation 

Arithmetic (two's complement) negation 
of expr 
Bitwise (one's complement) negation of 
expr 
Logical negation of expr 

Multiplication 
Division 
Remainder from dividing exprl by expr2 

Addition 
Subtraction 

Shift left-shift exprlleft by expr2 bits 
Shift right-shift exprl right by expr2 bits 

Greater than 
Greater than or equal to 
Less than 
Less than or equal to 

Equal 
Not equal 

Bitwise AND 

Bitwise XOR 

Bitwise OR 

Logical AND 

Logical OR 

The logical operators!, >, >=, <, <=, ==, ! =, &&, and I I evaluate to 1 (true) 
or 0 (false). 
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To learn more about 
#"printf, see section 
"Print directive" on page 
331 

Variables and functions 
Some resource compiler variables contain commonly used values. All SARez 
variables start with $ $ followed by an alphanumeric identifier. 

The following variables and functions have string values (typical values are 
given in parentheses): 

$$Date 
Current date. Useful for putting timestamps into the resource file. The format 
is generated through the ROM call IUDateString () . ("Thursday, May 
20, 1987") 

$$Format (nfonnatString", arguments) 
Works just like the #"printf directive except that $$format () returns a 
string rather than printing to standard output. 

$$Name 
Name of resource from the current resource. The current resource is the re-
~6urce being generated in a resource statement, being included from an 
~ncl ude statement, being deleted from a delete statement, or changed in 
~ change statement. 

For example, to include all 'DRVR' resources from one me and keep the 
same information, but also set the SYSHEAP attribute: 

INCLUDE "file" 'DRVR' (0:40) AS 
'DRVR' ($$ID, $$Name, $$Attributes I 64); 

The $$Type, $$ID, $$Name, and $$Attributes variables are undefined 
outside of a change, delete, include, or resource statement. 

$$Resource (nfilename", 'type', ID I "resourceName") 
Reads the resource 'type' with the ID ID or the name "resourceName" 
from the resource file "filename", and returns a string. 

$$Shell (" strlngExpr") 
Included for MPW-compatibility. In SARez and SADeRez, this returns the 
null string (" "). In MPW's Rez and DeRez, it returns the current value of the 
exported Shell variable {strlngExpr}. Note that the b~aces are omitted, and 
the double quotation marks must be present. 

$$Time 
Current time. Useful for time-stamping the resource file. The format is gener­
ated through the ROM call IUTimeString (). ("7: 50: 54 AM") 

334 THINK C User Manual 



$$Version 
Version number of SARez. (nV3 . 0 n) 

Resource Description Syntax • 
These variables and functions have numeric values: 

$$Attributes 
Attributes of resource from the current resource. See the $$Name string vari-
able. 

$$Bi tField (label, startingPosition, numberOfBits) 
Returns the numberOfBits (maximum of 32) bitstring found startingPosition 
bits from label 

$ $Byte (label) 
Returns the byte found at /abel 

$$Day 
Current day. Range 1-31. 

$$Hour 
Current hour. Range 0-23. 

$$ID 
ID of resource from the current resource. See the $ $Name string variable. 

$ $ Long ( label) 
Returns the longword found at /abel. 

$$Minute 
Current minute. Range 0-59. 

$$Month 
Current month. Range 1-12. 

$$PaekedSize (Start, RowBytes, RowCount) 
Given an offset (Start) into the current resource and two integers, RowBytes 
and RowCount, this function calls the Toolbox routine UnpaekBits () 
RowCounttimes. $$PaekedSize () returns the unpacked size of the data 
found at start. Use this function only for decompiling resource files. An ex­
ample of this function is found in Piet. r. 

$$ResoureeSize 
Current size of resource in bytes. When de co mpiling , $$ResoureeSize is 
the actual size of the resource being decompiled. When compiling, 
$ $ Re s ouree Size returns the number of bytes that have been compiled so 
far for the current resource. (See the 'KCHR' resource in SysTypes. r for 
an example.). 
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$$Second 
Current second. Range 0-59. 

$$Type 
Type of resource from the current resource. See the $ $Name string variable. 

$$Weekday 
Current day of the week. Range 1-7 (that is, Sunday-Saturday). 

$$Word (/abel) 
Returns the word found at /abel. 

$$Year 
Current year. 

Strings 
There are two basic types of strings: 

• Text string (" a ... II): The string can contain any printable char­
acter except '" , and \ '. These and other characters can be creat­
ed through escape sequences. (See section "Escape characters" 
on page 337.) The string"" is a valid string of length O. 

• Hex string ($" hh ... II): Spaces and tabs inside a hexadecimal 
string are ignored. There must be an even number of hexadeci­
mal digits. The string $"" is a valid hexadecimal string of 
length O. 

Any two strings (hexadecimal or text) will be concatenated if they are placed 
next to each other with only white space in between. (In this case, returns 
and comments are considered white space.) 

Figure 17-4 shows a Pascal string declared as 

pstring [10]; 

whose data definition is 

"Hello". 

Figure 17-4 Internal representation of a Pascal string 

In the input file, string data is surrounded by double quotation marks ("). 
You can continue a string on the next line. A separating token (for example, 
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a comma) or brace signifies the end of the string data. A side effect of string 
continuation is that a sequence of two quotation marks (" ,,) is simply ig­
nored. For example, 

"Hello ""out " 
"there." 

is the same string as 

"Hello out there."; 

To place a quotation mark character within a string, precede the quotation 
mark with a backslash like this 

"Hello \"out\" there." 

Escape characters 
The backslash character (\) is provided as an escape character to allow you 
to insert nonprintable characters in a string. For example, to include a new­
line character in a string, use the escape sequence \n. 

These are the valid escape sequences: 

Escape Hex 
Name Sequence Value 
Tab \t $09 
Backspace \b $08 
Return \r $OA 
Newline \n $OD 
Form feed \f $OC 
Vertical tab \v $OB 
Rubout \? $7F 
Backslash \\ $5C 
Single quotation mark \ I $3A 
Double quotation mark \" $22 
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17 Resource Description Files • 
You can also use octal, hexadecimal, decimal, and binary escape sequences 
to specify characters that do not have predefined escape equivalents. The 
forms are: 

Base Form (# digits) Example 
2 \ 0 B bbbbbbbb (8) \OB01000001 
8 \000(3) \101 
10 \ODddd(3) \OD065 
16 \Oxhh (2) \OX41 
16 \$hh (2) \$41 

Here are some examples: 

\077 
\OxFF 
\$F1\$F2\$F3 
\Od099 

/* 3 octal digits */ 
/* 'Ox' plus 2 hex digits */ 
/* '$' plus 2 hex digits */ 
/* 'Od' plus 3 decimal digits */ 

Note 
An octal escape code consists of exactly three digits. For in­
stance, to place an octal escape code with a value of 7 in 
the middle of an alphabetic string, write AB \ 0 07CD, not 
AB\ 7CD. 

You can select the Don't Escape Characters option in SADeRez to print char­
acters that would otherwise be escaped (characters preceded by a back­
slash, for example). Normally, only characters with values between Ox20 
and OxD8 are printed as Macintosh characters. With this option, however, all 
characters (except null, newline, tab, backspace, form-feed, vertical tab, and 
rubout) will be printed as characters, not as escape sequences. See Chapter 
19, "Using SADeRez," for details. 
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18 

S ARez is a utility that creates resources from a textual description. It started 
out life as Rez, a tool in Apple's Macintosh Programmer's Workshop (MPW). 
MPW has a command-line interface, much like UNIX. At times it will seem 
SARez works a bit oddly or has options you can't use. This is because of its 
heritage. But, despite its odd upbringing, SARez is still a powerful and useful 
tool. 

Contents 
What Is SARez? . 

Running SARez 

Choosing Input Files 

Choosing an Output File. 

Setting Options. . . . . . . . . . . . . 
Setting the search paths for #include and include 
Defining and undefining macros 
Choosing an error and alternate input files 

Saving and Restoring Options 

The Messages Window . . 

341 
341 
342 

343 
345 
346 
347 
347 
350 

350 
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What Is SARez? • 
What Is SARez? 
SARez (which means Stand-Alone Rez and is pronounced "SayRez") creates 
the resource fork of a file from a textual description. That textual description 
is found in one or more resource description files. The format for resource 
description files is described in Chapter 17, "Resource Description Files. " 

Running SARez 
When you run SARez, you see the dialog in Figure 18-1. To compile a re­
source description file, you open a SARez options file you previously saved, 
or you can manually set the input files, output files, and other options. When 
you click the button titled "Sarez," SARez compiles your files. If there are no 
errors, it exits. If there are errors, it displays them in the message window, 
described below. You can then edit, print, or save the contents of the mes­
sages window. To cancel without compiling, click the button titled "Cancel," 
or choose Quit from the File menu. More information on setting and saving 
your options is below. 

== Untitled 
..... Sarez Options 
····Resource Output File .. ················································· ............. ~ D Progress information 

IR t I Type Ililaali' D Redeclared types ok 
ez.ou Creator 1111 D Modification date 

[@ Rewrite resource file ( 0 e scription Files ... ) 
o Make res~urce file read-only ( #Include Paths ... ) 

r .. Resource Rllgnment ........................................... ~ 

, ... ~ .. ~.~.!.~ ........ 2 ... ~.~.~.~ ....... 2 ... ~.~.~.~.~.~.~~ ..... ..J ( In clud e Pa t h s ••• ) 
o Merge resources into resource file i (preprocessor... ) 

o OK to n~pJ<~o~ 1)C'oh~(;t(~d n~~oun~s I ( Redirection .•• ) ........................................................................................................................................... : 

SARez 
fcommand Line 

I 
..... Help ( ) 
Rez is <l tool used to compile resources. 

Cancel 

~ Sarez ~ 
3.2 

Figure 18-1 The SARez dialog 

The SARez dialog has two parts. In the first part, enclosed in a box titled 
"Sarez Options," you choose your files and options for SARez's operation. In 
the second part, containing the boxes named "Command Line" and "Help," 
you can see how the options work. 
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The Command Line box may seem out of place in a Macintosh program, but 
remember SARez started life as Rez, an MPW tool. The Command Line box 
displays a Rez command line that has the same options set as the SARez dia­
log. You cannot edit this line. 

The Help box gives you information about the dialog. When you click on an 
option or a box, a description of it appears in this box. 

Choosing Input Files 
To choose the description files to use as input, click on the Description 
Files ... button to display a dialog. The one shown in Figure 18-2 has 
Types. r (in the {Rlncludes} folder) and Sample. r chosen as the de­
scription files. 

la Rez/DeRez I 
CJ My Types ~ c:lMoose 
CJ Rlncludes 

( ) Q Sample.r l: j<H t 

( Driue ) 
............................................ 

( Done ) 

ro ( Cancel ) 
@ Only files ending in .r o AI~ teHt files 

Resource Description Files: 

:R I ncludes:Types.r Q 
n D Sample.r fWd 

() 
( n(~rrHW(~ ) 

Figure 18-2 The Description Files ... dialog 

These radio buttons determine which files appear ~n the top list: 

• Only Files Ending in.r Such as Sample. r. 
• All Text Files Regardless of their names. 

You can add and remove files with these commands: 

• To add a description file, select it from the standard file list in the 
top pane, and click Open. Its name is added to the list in the low-
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Choosing an Output File • 
er pane. You can also double-click on the file to add it to the bot­
tom list 

• To remove a description file from the bottom list, select it, and 
click Remove. 

• When you've selected all your description files, click Done. 
• To cancel what you've done and leave the list of files as it was, 

click Cancel. 

Note 
If you don't select any files in the Description Files ... dia­
log, SARez will use the alternate input file set in the Redi­
rection ... dialog. If you don't select an alternate me in the 
Redirection ... dialog, SARez will act as if it were reading an 
empty file. Most of the time, you'll want to use the Descrip­
tion Files ... dialog. 

Choosing an Output File 
To choose the file SARez writes your resources to, use the Resource Output 
File box, shown in Figure 18-3. This box is part of the SARez dialog . 

.... Resource Output File ................................................................ .. 

In t 
Type APPL 

_ ez.ou 
Creator ???? 

@ Rewrite resource file 
D Make resource file read-only 

: ... Resource Alignment ........................................... ~ 
I @ Byte 0 Word a LongWord i 
: ................................................................................................................. ; 

a Merge resources into resource file 
D OK 10 repJ<H.~ pro h~t~1 (~d r(~~our.~s 

Figure 18-3 The Resource Output File box 
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To choose the file, click on the button in the upper left hand corner of the 
box. The pop-up menu in Figure 10-4 appears . 

../D/rite output to Rez,out 
Select an eHisting output file ... 
Write output to a new file ... 

Figure 18-4 Resource Output File menu 

This is what the choices mean: 

• Write output to Rez.out Writes to file called Re z . out, creating 
it if necessary. This is the default 

• Select an exIsting output file .•• Displays a standard file dialog 
that lets you choose an existing file. In the dialog, you can choose 
what it displays: only MPW tools and applications or all files. 

• Write output to a new file... Displays a standard file dialog 
that lets you enter the name of a new file to create. 

In the Type and Creator boxes, you enter the type and creator of the file. 
These must be four-letter values. If you are writing to an existing file, SARez 
changes the type and creator of the file to the new values. 

The rest of the buttons control how SARez treats the resource fork it creates. 
These two determine whether to overwrite the existing resource fork: 

• RewrIte Resource File Erases the file's resource fork and re­
places it with the resources created from your description files. 
This is the appropriate choice for creating a new file or overwrit­
ing an old one. 

• Merge Resources Into Resource File Keeps the resource fork 
and appends your resources to them. If one of your resources 
have the same type and ID as an existing resource and the exist­
ing resource isn't protected, your resource will overwrite it. 

If you choose Rewrite Resource File, you'll see two more options: 

• Make Resource File Read-only Sets the mapReadOnly flag in 
the resource map. 

• Resource AlIgnment Lets you choose how you want your re­
sources aligned: along byte, word, or longword boundaries. The 
default is byte 
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If you choose Merge Resources into Resource File, you'll see this option: 

• OK to Replace Protected Resources Overrides the protected 
bit in resources. Even if an existing resource has the protected bit 
set, SARez will overwrite it when a new resource has the same 
type and ID. 

Setting Options 
The SARez Options box contains several check boxes for setting some op­
tions, several buttons that display dialogs for more detailed information, and 
the Resource Output File box for setting the output file. This section de­
scribes all the buttons and check boxes in the right column, except for De­
scription Files .... , which you've already seen in the section "Choosing Input 
Files" on page 342 and the Resource Output File box, which is described in 
the section "Choosing an Output File" on page 343. 

SarezOptions---------------------------------------------, 
r .. Resource Output File····················· ...... · .. ······· .... ··········· .. ·· ........ , D Progress information 
I I I Type ~PPl D Redeclared types ole 
: .Rez.out D M d"f" t" d t 
i Creator ???? 0 I Ica Ion a e 

[

@ Rewrite resource file ( Description Files ... J 
o Malee resource file read-only ( #Include Paths ... J 

r .. Resource Rlignment ........................................... , 

L~ .. ~.~.!.~ ........ 9. ... ~.~.~.~ ....... 9. ... ~.~.~.~.~.~.~~ ...... .J : (I n c Iud ePa t h s ... ) 
o Merge resources into resource file I (Preprocessor... J 

................ ~ ... ~~.~ ... ~.~~ ... ~.:~~.~~.!.~~.~ .. : ... ~~.~.~~.~.~:..~~.~.~~.~! ... ~.:~~.~.~~.~~.~.~:..~ ... I ( Red i re c t ion... ) 

Figure 18-5 The Sarez Options box 

The three check boxes in the upper-right hand corner control these options: 

• Progress information If selected, SARez writes information on 
each type and resource created and the SARez version number to 
the error file (selected in the Redirection ... dialog). 

• Redeclared types OK If selected, SARez will not print a warn­
ing message to the error file when a resource type is redec1ared. 

• Modification date If selected, SARez doesn't change the output 
file's modification date. Be careful. If an error occurs, SARez sets 
the output file's modification date to zero, even if you select this 
option. 
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18 Using SARez • 
Setting the search paths for #include and include 
The #Include Paths ... and Include Paths ... dialogs let you specify folders 
(also called directories or search paths) that SARez will search when it looks 
for an include or #include file. The #Include Paths ... dialog in Figure 18-6 
has the folder Rlncludes in the list of folders to be searched.The Include 
Paths ... dialog is similar. 

(Rdd Current Directory: ) 

101 Rez/DeRez I 
Cl My Types 
Cl R Includes 

G:::::JMoose 

Driue 

Done 

{) Cancel 
~----------------------~ 

# I nclude Search Paths: 

I:R I nel udes: 
U fJdd D 
( fJ(~mm~(~ ) 

Figure 18-6 The Include Paths ... dialog 

You can add and remove folders with these commands: 
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• To add a folder to the list of folders searched, select it from the 
standard file list in the top pane, and click Add. It's name is added 
to the list below. 

• To add the folder you're currently in, click Add Current Directory. 
For example, clicking Add Current Directory in Figure 18-6 
would add Rez/DeRez to the list. 

• To open a folder to see the other folders in it, select it, and click 
Open. You can also double click on it. 

• To remove a description file from the bottom, select it, and click 
Remove. 

• When you've selected all the folders you want, click Done. 
• To cancel what you've done and leave the list of folders as it was, 

click Cancel. 



-Preprocessor ••• 

Defines: 

Defining and undefining macros 

Setting Options • 
The Preprocessor ... dialog lets you define and undefine macro variables. In 
the Defmes box, enter the variables you want defined and their values. Use a 
new line for each pair of variables and values. If you don't enter a value, the 
variable is set to the null string (" "). In the Undefines box, enter the vari­
ables you want undefined. For example, setting up the Preprocessor ... dia­
log as in Figure 18-7 is like adding these lines to the beginning of each 
description file: 

idefine LIGHTSPEED 186282 
idefine THINK PASCAL 
iundef DESK ACC 

Undefines: 

L I GHTSPEED 186282 [Q DESK_ACq ~ 
THINK_PASCAL 

K5 K5 

SARez -d 'LIGHTSPEED 186282' -d THINK-PASCAL -u DESK_ACC 
rscommond Line 

I 
r-Help ( ) 
Preprocessor variables can be DEFINE'd and UNDEFINE'd in this dialog. 

Cancel 

(r ~ Continue 

Figure 18-7 The Preprocessor ... dialog 

Choosing an error and alternate input files 
The Redirection ... dialog lets you choose an alternate input file and the error 
file. The alternate input file is what SARez reads if there are no description 
files set in the Description Files ... dialog. The error file is an additional place 
to write out error, warning, and status messages. SARez always writes its 
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-Redirection .•• 

Input 

! 

rscommand line 
~ ARfZ l Akb~r :Errors 

r-Help 

messages to the messages window, described below. The dialog in Figure 
18-8 sets the error file to be Errors and sets no alternate input file. 

Error @10H 
I !Moose:Errors I 

I 
( Cancel ) 

Ru c~n rud stand~rd input and send warnings to diagnostic output. 

( ~ Continue 

Figure 18-8 The Redirection ... dialog 

Clicking on the button under Input brings up the pop-up menu in Figure 18-
9. 

Input 
../Nolnput 

EHisting File •.. 
Standard Input 
Null Oeuice 

Figure 18-9 The Input menu 

This is what the options mean: 

• No Input The same as setting the alternate input file to be an 
empty file. 

• Existing File... Lets you select a file to read from. 
• Standard Input, Null Device These act the same as No Input. 

Note 
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SARez uses the input file you set here only if you don't 
choose description files in the Description Files ... dialog. 
Most of the time, you'll want to use the Description Files ... 
dialog and leave the alternate input file set to No Input. 



Setting Options • 
The menu under Error lets you choose an additional place to write error, 
warning, and status messages. SARez always writes its messages to the mes­
sages window, described in section "The Messages Window" on page 350. 
You might use this menu if you always want your messages saved to a par­
ticular file. 

Clicking on the button under Error brings up the pop-up-menu in Figure 18-
10. 

Error 
../NoOulpul 

New File .•• 
EMisting File ... 
Standard Output 
Standard Diagnostic 
Null Deuice 

Figure 18-10 The Error menu 

This is what the options mean: 

• No Output Writes messages only to the messages window. 
• New File... Lets you create a file to write messages to. 
• Existing File... Lets you choose an existing file to write messag­

es to. 
• Standard Output, Standard Diagnostic, Null Device These 

act the same as No Output. 

If you select an existing file as your error file, you'll see two radio buttons 
near Error, as in Figure 18-11. 

Error @ ~ 0 ~~ 

IMoose:Errors I 
Figure 18-11 The Error menu buttons 

You can choose whether or not to overwrite the existing file: 

• ~ The new messages will overwrite the existing file. 
• ~~ The new messages will be appended to the end of the exist­

ing file. 
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Saving and Restoring Options 
SARez lets you save your option settings in a SARez options fIle. This options 
file contains the names of your input and output fIles, in addition to all the 
other option settings. When the SARez dialog box is the front window, the 
File menu contains these commands to let you save and restore your set­
tings: 

• New Clears your current settings and lets you create a new op­
tions file. 

• Open .•• Lets you choose a fIle you previously saved and re­
stores those settings. 

• Save Saves the current settings to the options file you're using. If 
you aren't using an options file (that is, you haven't opened or 
saved one), it lets you create one. 

• Save As... Lets you create an options file containing your cur­
rent settings. 

When you can double-click on a SARez options file in the Finder, SARez 
doesn't display its dialog. It just compiles your files, displays your errors (if 
any), and exits. 

The Messages Window 
If SARez encounters no problems while compiling your files, it will just exit 
to the Finder when it's done. But if SARez needs to display any error, warn­
ing, or status messages, it uses the messages window, like the one in Figure 
18-12. 

You can freely ed~t the contents of the message window, as if it were a text 
editor. You can add your own comments and cut, copy, or paste, using the 
Edit menu. 

When the messages window is in the front, the File menu contains these 
commands to let yOU save and print your messages: 

• Close Closes the messages window. 
• Save Saves your messages to a fIle. If you haven't chosen a fIle 

yet, it lets you choose one. 
• Save As •.• Lets you choose a file to save your messages to. 
• Page Setup... Displays the standard Page Setup ••• dialog for 

your printer. 
• Print... Lets you print the contents of the messages window. 
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Stdin, StdOut, StdErr 

The Messages Window • 
e:r 

File MSample.rM; Line 1; ••• SAAez - Can't find the declaration ~ 
for the resource type 'plct' (Ox70696374). 
File "Sample.r"; ••• SARez - Since errors occured l Rez.oul's 
resource fork was not written. 

Figure 18-12 The messages window 

With the Font and Size menus, you can change the tont SARez displays and 
prints your messages with. 

Note 
If you always save your messages to a particular file, you 
can use the Redirection ... dialog to choose an error file. 
SARez will write your messages to both the messages win­
dow and the error file. 
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19 

S ADeRez creates a text representation of the resource fork of a file. It started 
out life as DeRez, a tool in Apple's Macintosh Programmer's Workshop 
(MPW). MPW has a command-line interface, much like UNIX. At times it will 
seem SADeRez works a bit oddly or has options you can't use. This is be­
cause of its heritage. But, despite its odd upbringing, SADeRez is still a pow­
erful and useful tool. 

Contents 
What Is SADeRez? . 

Running SADeRez 

Choosing Input Files. . . 
Choosing the resource file 
Choosing a description file 
Choosing #include paths 

Choosing Output Files . . . 

Setting Options. . . . . . . . 
Choosing the types to decompile 
Preprocessor . . . . 

Saving and Restoring Options 

The Messages Window . . 

355 
355 
356 
357 
357 
358 
359 
361 
361 
362 

363 
363 
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What Is SADeRez? • 
What Is SADeRez? 
SADeRez (which stands for Stand-Alone DeRez and is pronounced "Say 
Dee' Rez") creates a text representation (a resource description file) of the 
resource fork of a file, according to the resource type declarations in one or 
more resource description files. 

A resource description file is a file of type declarations in the format used by 
the resource compiler, Rez. The type declarations for standard Macintosh re­
sources are in the files Types. rand SysTypes. r, in the {RIncludes} 
folder. If no resource description file is specified, the output consists of 
data statements giving the resource data in hexadecimal form, without any 
additional format information. The format for resource description files is 
described in Chapter 17, "Resource Description Files." 

Note 
SADeRez uses resource description files as both input and 
output. The input description files define resource types 
(such as I WIND I), and the output description file defines 
actual resources (such as the document window for your 
application) 

If the output of SADeRez is used as input to SARez, with the same resource 
description files, it produces the same resource fork that was originally input 
to SADeRez. SADeRez is not guaranteed to be able to run a declaration back­
wards; if it can't, it produces a data statement instead of the appropriate 
resource statement. 

SADeRez ignores all include (but not #include), read, data, change, 
delete, and resource statements found in the resource description files. 
(But it still parses these statements for correct syntax.) 

Running SADeRez 
When you run SADeRez, its dialog is grayed out, except for the File To De­
compile button. You can either open a SADeRez options file you previously 
saved or choose a file to decompile. Now, the dialog looks like the one in 
Figure 19-1. To continue, you can change your options and click the button 
titled "Saderez button." If there are no errors, SADeRez compiles your file 
and exits. If there are errors, SADeRez displays them in the messages win­
dow, described below. To cancel without decompiling, click the button ti-
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tied "Cancel" or choose Quit from the Flle menu. More information on 
choosing and saving your options follows. 

Untitled 
~SaderezOptions--------------------~---------------------, 

( File to decompile] r~~~~~'~'~'~';"""""""~'~'i'~""""""""""""· ... ··1 

(r;;;~~.;~;~;;'.E5.::) 1001 
i 0 No warnings for redeclared types! ~ ............................................................................................. : 
I 0 Progress information I r·Preprocessor········································ ..... j 

li~riu~;-~14~!.~~~~~ .. ..J 1.0.0.1 
rscommand Line 
I s AD~r~z Moos. :fi1~ 

~Help--------------------------------------~ Cancel 
DeRez -- th. rfSourc~ decompiler. This tool can decompile a resource file 
into a text representation suitable for Rez input. 

~------------------------------------------~ 

Figure 19-1 The SADeRez dialog 

n Saderez II 
3.2 

The SADeRez dialog has two major parts. In the first part, enclosed in a box 
titled "Saderez Options, " you set options for SADeRez's operation. There is 
more information about these options below. In the second part, containing 
the boxes named "Command Line" and "Help," you can see how the options 
work. 

The Command Line box may seem out of place in a Macintosh program. But, 
remember SADeRez started life as DeRez, an MPW tool. The Command Line 
box displays a DeRez command line that has the same options set as the SA­
DeRez dialog. You cannot edit this line. 

The Help box gives you information about the dialog. When you click on an 
option or a box, a description of it appears in this box. 

Choosing Input Files 
You must choose at least two input files. First, choose a resource file, a file 
containing resources you want decompiled. Next, choose one or more re­
source description files, containing definitions of resource types. You specify 
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Choosing Input Files • 
these with the buttons in the upper-left-hand corner of the SADeRez dialog, 
as shown in Figure 19-2. 

( File to decomPile) 

( Types Files... ) (# I NCLUDE Paths ... ) 

Figure 19-2 The buttons for specifying input files 

Choosing the resource file 
First, you'll need to choose a resource file. The File To Decompile button 
displays a standard file dialog that lets you select one. The dialog offers to let 
you select any file or only an application or MPW tool. 

Choosing a description file 
The Types Files ... button displays a dialog that lets you select one or more 
description files. The dialog in Figure 19-3 has Types. r (in the 
{Rlncludes} folder) selected as the description file. 

Ie Rlncludes I 
() Cmdo.r ~ t::='I Moose 
() MPWTypes.r 
() Pict.r ( I: j(H t ) 
[) SysTypes.r ( Driue ) 
() Types.r 

............................................ 

( Done ) 

{) ( Cancel ) 
@ Files ending in .r o RII teHt files 

Resource Description Files: 

:R I ncludes:Types.r Q n D fWd 

() 
( Fh~rrHW(~ ) 

Figure 19-3 The Types Files ... dialog 

These buttons choose which files appear in the top list: 

• Only Files Ending in.r Such as Type s . r 
• All Text Files Regardless of their names 
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19 Using SADeRez • 
You can add and remove files with these commands: 

• To add a description file to the list in the bottom pane, select it in 
the standard file list in the top pane, and click Open. It's name is 
added to the list below. You can also double-click on the file to 
add it to the bottom list. 

• To remove a description file from the bottom list, select it, and 
click Remove. 

• When you've selected all your description files, click Done. 
• To cancel what you've done and leave the list of files as it was, 

click Cancel. 

Choosing #include paths 
If any of your description files contain finclude statements, you'll need to 
select the folders (also called directories or search paths) in which SADeRez 
can fihd them. to choose these, click on the #INCLUDE Paths ... button to 
display a dialog. The dialog in Figure 19-4 has the folder {RIncl udes} in 
the list of folders to be searched. 

( Rdd Current Directory: ) 

161 Rez/DeRez I 
CJ My Types Q c=-Moose 
CJ Rlncludes 

I: j(H t 

Drive 

...........................•••......•....... 

Done 

~ Cancel 

...................•••.......•......••...... 
#Include Search Paths: 

1:8 I nel udes: 
O~l(Hl 

~ n fJdd D 
( fJ(HrwlJ(~ ) 

Figure 19-4 The #INCLUDE Paths ... dialog 

Note 
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SADeRez ignores include statements in the resource de­
scription flIes. 



Choosing Output Files • 
You can add and remove folders with these commands: 

• To add a folder to the list of folders searched in the bottom pane, 
select it in the standard file list in the bottom pane, and click Add. 
It's name is added to the list in the bottom pane. 

• To add the folder you're currently in, click Add Current Directory 
button. For example, clicking Add Current Directory in Figure 19-
4 would add Rez/DeRez to the bottom list. 

• To open a folder to see the other folders in it, select it, and click 
Open. You can also doublecJick on it. 

• To remove a description file from the bottom list, select it, and 
click Remove. 

• When you've selected all the folders you want, click Done. 
• To cancel what you've done and leave the list of folders as it was, 

click Cancel. 

Choosing Output Files 
You need to choose an output description file. This will contain the defini­
tions of the resources in your resource file. You can also choose an error file, 
an additional place to write error, warning, and status messages. SADeRez 
always writes its messages ~o the messages window, described below. You 
would choose an error file if you always want your messages saved to a par­
ticular file. 

You choose these files with the buttons in the lower-left-hand corner of the 
SADeRez Options box. The buttons in Figure 19-5 set the description file to 
be the new file Te~t. r and the error file to be the existing file Errors. 

, ............................................................................................................................ ... 
~ Output Error @ 1 0 11 j 
IIMoose:Test.r IMoose:Errors II 
: .................... ~ ..................... ~ .................................................................................. : 
Figure 19-5 ~he buttons for specifying C?utput files 

THINK C User Manual 359 



19 Using SADeRez • 
Clicking on the button under either Output or Error brings up the same pop­
up menu, shown in Figure 19-6 . 

../NoOulpul 
New File .•. 
EHisting File ... 
Standard Output 
Standard Diagnostic 
Null Deuice 

Figure 19-6 The output file menu 

This is what the options mean: 

• No Output Doesn't write out the output 
• New File •.. Lets you create a file to write to. 
• Existing File... Lets you select an existing file to write to. 
• Standard Output, Standard Diagnostic, Null Device These 

act the same as No Output. 

If you select an existing file as an output file, you'll see two radio buttons 
above the menu, as in Figure 19-7 (In the menu under Output, the buttons 
are labeled ">" and "»"). 

Error @ ~ 0 ~~ 

IMoose:Errors I 
Figure 19-7 The output file menu buttons 

These let you choose whether or not to overwrite the existing file: 
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• ~ or> The new output will overwrite the existing file. 
• ~~ or» The new output will be appended to the end of the ex­

isting file. 



Setting Options 

Setting Options • 
The rest of the SADeRez Options box lets you select options describing how 
to decompile your file. The list of options in Figure 19-8 is between the input 
and output buttons. 

Width of decompiled strings ~ 
rt~fN'o"'w'a'r'~'i'nil's"'io'r"re'd'e'c"i"a'r'e'd"iy'p·e·s····~ 
~ D Progress information ~ 
~ D Write Rez 1.0 compatible output ~ 
~ D Donlt escape characters ~ , ............................................................................................................................ , 
Figure 19-8 Some options 

This is what the options mean: 

• Width of decomplled strings Sets the maximum string size. It 
must be in the range 2-120. This controls string width in the out­
put. 

• No warnings for redeclared types If selected, SADeRez will 
not print a warning message to the error file when a resource 
type is redeclared in the description files. 

• Progress information option If selected, SADeRez writes its 
version number and information on the decompiled resources to 
the error file. 

• Write Rez 1.0 compatible output If selected, SADeRez will 
generate a description file that is backward compatIble with Rez 
1.0. 

• Don't escape characters If selected, characters that are nor­
mally escaped (such as \ Oxff) are no longer escaped. Instead 
they are printed as extended Macintosh characters. (Note: Not all 
fonts have all the characters defined.) Normally, only characters 
with values between Ox20 and OxD8 are printed as Macintosh 
characters. With this option, however, all characters (except null, 
newline, tab, backspace, form feed, vertical tab, and rubouO are 
printed as characters, not as escape sequences. 

ChOOSing the types to decompile 
In the Types box, you can choose which types of resources SADeRez de­
compiles. This box contains two lists: 

• Decompile box If you want to decompile only a few resource 
types, enter their names here. For example, with the box in Fig-
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19 Using SADeRez • 
ure 19-9, SADeRez will decompile resources of type 'WIND' 

only. 

· .. ·Types· .. · .. · .......... ··· .... ··· ...... · ............ · .. · .......... · .. ·· .. · .. ... 

Decompile : .. ~.~.~J~ ............................. : 
WIND I I 

.... L... ... -... -... -•••• -... -... -... -... -•••• - ... -............ ...:. ... ....I •••• t::::::::::::::::::::::::::::::::::::::::1.. 
Figure 19-9 Decompile only WIND 

• Skip box If you want to decompile every resource type with a 
few exceptions, enter the exceptions here. For example, with the 
box Figure 19-10, SADeRez will decompile all resources, except 
those of type 'PICT' . 

.. Types .... ·· ........................ ·· .... · ...... · .... · ............ · ........ ... 

,.!~.~1.~ .. ~?~~~.~?..~.~.~~ ........... r-S_~_i;;..,..p ----r-::--, 

l ~ Pier 

!igi:i~~~"1"g::Y~f·i5~~~J·iille.eveiYtlil"ii·ij""OUfl'ftTs 
You can use only one list at a time. Whenever one has anything in it, the oth­
er is grayed out. If you don't use either list, SADeRez will decompile every­
thing in the input file. 

Preprocessor 
In the Preprocessor box, you can define and undefine macro variables. In 
the Defines list, enter the variables you want defined and their values. Use a 
new line for each pair of variables and values. If you don't enter a value, the 
variable is set to the null string (1111). In the Undefines list, enter the variables 
you want undefined. For example, setting up the Preprocessor box as in Fig-
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Saving and Restoring Options • 
ure 19-11 is like adding these lines to the beginning of each resource de­
scription file: 

idefine c 186282 
idefine PASCAL 
iundef DESK ACC 

,···Preprocessor .......................................... .. 
Define Undefine 
c 186282 DESK_RCC 
PRSCAL 

Figure 19-11 The Preprocessor box 

Saving and Restoring Options 
SADeRez lets you save your option settings in a SADeRez options file. This 
options file contains the names of your input and output files, in addition to 
all the other option settings. 

When the SADeRez dialog box is in the front, the File menu contains these 
commands to let you save and restore your settings: 

• New Clears your current settings and lets you create a new op­
tions file. 

• Open... Lets you choose a file you previously saved and re­
stores those settings. 

• Save Saves the current settings to the options file you're using. If 
you aren't using an options file (that is, you haven't opened or 
saved one), it lets you create one. 

• Save As... Lets you create an options file containing your cur­
rent settings. 

When you can double-click on a SADeRez options file in the Finder, SA­
DeRez doesn't display its dialog. It just compiles your files, displays your er­
rors (if any), and exits. 

The Messages Window 
If SADeRez encounters no problems while decompiling your file, it will just 
exit to the Finder when it's done. But if SARez needs to display any its error, 
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warning, or status messages, it uses the messages window, like the one in 
Figure 19-12: 

Stdin, Stdout, StdErr 
File "mIJResources.r" Line 1; ••• SADeRez - OS error -43 (Error ~ 
message f i I e no t ava I ab Ie) dur i ng open 0 f .. f 00" . r-­
File NmlJResources.rN Line 1; ••• SADeRez - Fatal Error, can't 
recover. 

Figure 19-12 The messages window 

You can freely edit the contents of the message window, as if it were a text 
editor. You can add your own comments and cut, copy, or paste, using the 
Edit menu. 

When the messages window is in the front, the File menu contains these 
commands to let you save and print your messages: 

• Close Closes the messages window. 
• Save Saves your messages to a file. If you haven't chosen a me 

yet, it lets you choose one. 
• Save As... Lets you choose a file to save your messages to. 
• Page Setup •.• Displays the standard Page Setup •.• dialog for 

your printer. 
• Print... Lets you print the contents of the messages window. 

With the Font and Size menus, you can change the font SADeRez displays 
and prints your messages with. 
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Note 

The Messages Window • 
If you always save your messages to a particular file, you 
can use the Redirection ... dialog to choose an error file. SA­
DeRez will write your messages to both the messages win­
dow and the error file. 
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THINK C Menus + 
20 

Lis chapter describes each of the mINK C menu commands. It is organized 
by menu, from left to right along the menu bar. Within each menu, com­
mands are described in the order in which they appear in the menu. 

Contents 
The Apple Menu 

About THINK C ... 

The File Menu . . 
New ... . 
Open ..... . 
Open Selection 
Close 
Save .... 
Save As... . . 
Save a Copy As ... 
Revert . . . . 
Page Setup... . . 
Print... . . . . 
Modify Read-Only 
Transfer ... 
Quit. . 

The Edit Menu 
Undo 
Cut . 
Copy 
Paste. 
Clear. . 
Select All . . 
Set Tabs & Font. .. 
Shift Left 
Shift Right . 
Balance. . 
Options .... 

The Search Menu 
Find ..... 
Enter Selection 
FindAgain. . 

371 
371 

371 
371 
371 
372 
372 
372 
372 
373 
373 
373 
373 
373 
373 
373 
374 
374 
374 
374 
375 
375 
375 
375 
375 
375 
376 
376 

392 
392 
394 
394 
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Replace . . . . . 
Replace & Find Again 
Replace All . . . 
Find in Next File . 
GoTo Line... . . 
Mark... . ... 
Remove Marker... . 

394 
394 
394 
394 
395 
396 
397 

The Project Menu . 398 
New Project... . 398 
Open Project. . . 398 
Close Project . 398 
Close & Compact 398 
Set Project Type. . . 398 
Remove Objects . 402 
Bring Up To Date . 403 
Check Link . . . 403 
Build Library. ... . . . . . . . . . . . . . . . . . 403 
Build Application ... , Build Desk Accessory ... , Build Device Driver. .. , 

Build Code Resource. . . 404 
Use Debugger 404 
Run 404 

The Source Menu 
Add . 
Add ..... . 
Remove .. 
Get Info... . 
Check Syntax 
Preprocess . 
Disassemble 
Precompile ... 
Debug 
Compile . . . . . . 
Load Library, Load Project 
Make .... 

Windows Menu 
Clean Up . 
Zoom .. 
Full Titles 
Close All . 
Save All . . 
Project window 
Edit Windows . 

405 
405 
406 
406 
407 
407 
407 
407 
407 
408 
408 
408 
408 

410 
410 
410 
410 
410 
411 
411 
411 
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About THINK c ... 

Use the File menu com­
mands to work with files 
that you open and edit with 
the THINK C text editor. This 
menu also has the com­
mands that let you launch 
other applications and that 
let you quit THINK C. 

New 

Open ... 

The Apple Menu 

The Apple Menu • 
This command tells you what version ofTl-llNK C you're using. When you 
choose this command, you'll see a star field. Click the mouse to see the ver­
sion ofTIIINK C. Click the mouse two more times to end the display. 

The File Menu 

New 
Open ••• 
Open Selection 
Close 

Saue 
Saue As ... 
Saue A Copy As ••• 
Reuert 

Page Setup ••• 

3€N 
3€O 
3€D 
3€W 

3€S 

Print •.• 3€P 

Modify Read-Only 

Transfer •.. 
Quit 3€Q 

This command opens a new Untitled window. You must save this file with a 
. c extension if you plan to compile it or add it to the project. However, you 
can use the Check Syntax command on the Source menu to compile it 
without adding it to the project. 

This command displays a dialog box that lets you select from existing files 
on the disk and open one for editing. When you first begin a project, one 
way to add a file is to open it with this command, then compile it or add it 
with the Add command. (The Add ••• command lets you add multiple files 
without compiling or opening the files. Once files have been added to the 

THINK C User Manual 371 



20 THINK C Menus • 

Open Selection 

Close 

Save 

Save As ... 

project, they can be opened by double-clicking on the file name in the 
project window.) 

You can open multiple files and the edit windows will stack up with the ti­
tles showing, so you can easily click on any window to bring it to the front. 

If you open too many files at once, you may have to close some windows to 
free up memory when you compile. 

This command lets you open an #included header fIle simply by selecting its 
name in the current program text. You don't need to select the . h extension 
(or full path name for HFS files). The selection will automatically be extend­
ed to the right to include it as long as the file name itself is selected. 

This command is the same as clicking on the active window's close box. If 
you try to close an edit window, and the file has been modified since it was 
last saved, a dialog box will ask you if you want to save the changes, discard 
them, or cancel the Close command. To close the project window, use the 
Close Project command in the Project menu. 

If the "Confirm Saves" option in the Options ..• dialog box is off, TI-IINK C 
will save changed files without asking. 

This command saves the file in the active edit window to disk. If the file is 
currently untitled, a dialog box will ask you to name the file. 

Note that an updated file can be compiled and added to the project without 
being saved, as long as it has been saved at least once and given a name 
with a . c extension. 

This command lets you save the current file under another name. If you 
have made edits in the current session, they will be saved under the new 
name. The original file will remain unchanged, and as you continue editing, 
you will be editing the new file. This feature is useful for switching to a new 
version of a file, leaving the old file as a backup. 

Save As ..• tries to preserve the tie between the file you are editing and its 
entry in the project window. If the file appears in the project window, and 
the name you want to save it as has a . c extension, and if the new name 
doesn't already appear in the project window, then the entry for the file in 
the project window is changed to match the new file name. Use Save a 
Copy As ••• if you don't want this to happen. 
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Revert 

Page Setup ... 

Print ... 

Modify. Read-Only 

Transfer ... 

Quit 

The File Menu • 
Unlike Save As ••• , this command does not affect the status of the file cur­
rently being edited; it simply snapshots it to another file. This is a good way 
to make backups without fmding yourself editing the backUp! 

Neither Save As ••• nor Save a Copy As ••• will let you save into a me already 
open in an edit window. 

This command restores the last-saved version of the current me, and dis­
cards any edits made in the current session. 

This command displays the standard Page Setup ••• dialog that lets you 
specify the size of the paper you're printing on, and whether the file should 
be printed upright on the page (tall orientation) or sideways (wide orienta­
tion). See your Macintosh owner's manual for details. 

This command lets you print the current file or the Link Errors window. The 
Print ... dialog box lets you set the page range among other options. You 
can also choose the "Print Pages in Reverse Order" option. When you press 
the OK button, your file will begin to print. Each page of the file has a head­
er showing the name of the file and the last modification date. The thumb of 
the vertical scroll bar moves from top to bottom (when printing in forward 
order), and from bottom to top (when printing in reverse order), to show 
you the printing progress. To cancel printing, press Command-Period. 

If you turn on the "Projector-aware" option, this command lets you modify a 
file that MPW Projector has marked read-only. For more information on us­
ing MPW Projector with THINK C, see "Using MPW Projector with THINK C" 
on page 136. 

This command lets you launch another application without frrst returning to 
the Finder. When you're running under MultiFinder, this command launches 
applications without quitting THINK C. 

This command exits THINK C and returns to the Finder. 
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20 THINK C Menus • 
The Edit menu contains the 
standard Madntosh editing 
commands (Cut, Copy, 
Paste) as well as other com­
mands that let you format 
your THINK C source files. 
The Edit menu also contains 
the Options ... command 
that lets you set several 
THINK C options so the envi­
ronment suits your personal 
needs. 

Undo 

Cut 

Copy 

The Edit Menu 

Undo 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 
Select All 3€A 

Set Tabs & Font ..• 
Shift Left 3€[ 
Shift Right 3€] 
Balance 3€B 

Options ••• 3€; 

TheUndo command reverses the last edit operation. The actual name of this 
command changes to let you know exactly what operation you'll be undo­
ing. After a Paste, for instance, the name of this command changes to Undo 
Paste. Once you've undone something, the name of this command changes 
to Redo. 

If there isn't anything to undo, this command will be dimmed. If the opera­
tion to undo doesn't belong to the frontmost window, the name of the com­
mand will indicate that there is something to do, but the command will be 
dimmed. 

You can't undo a Replace All, Revert, or a Set Tabs & Font ••• command. 

111is command removes selected text and places it in the Clipboard. It re­
pl~ces the current contents of the Clipboard (if there are any). Use the Paste 
command to insert text from the Clipboard into your file at the insertion 
po~pt. 

This command copies the selected text and places it in the Clipboard. The 
copy can now be pasted somewhere else using the Paste command. 
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Paste 

Clear 

Select All 

Set Tabs fit Font ... 

Shift Left 

Shift Right 

The Edit Menu • 
This command copies the contents of the Clipboard into the file being edited 
at the insertion point. If text is currently selected, it is replaced. 

This command clears the selected text. The selection is not placed on the 
Clipboard. The Clear key on your keyboard has the same effect as the Clear 
command. 

This command selects all the text in the current edit window. 

This command lets you change the tab stops and the font used by the 
TI-llNK C editor. You can select different tab stops and fonts for each edit 
window. When you choose this command you'll see a dialog box like the 
one in Figure 20-1. 

Tabs: [gI] ~ OK ~ ( cancel) 

Font: Monaco 
tt II 9 

The quick brown fox jumps over the lazy dog. 

Figure 20-1 The Set Tabs fit Font ... dialog 

Type a number to set the number of spaces per tab. To change the font, click 
on the font name. You'll see a pop up menu with the names of the fonts in 
your System file. Click on the font size to see a pop up menu of the sizes for 
the font. 

If you are using a proportionally spac~d font like New York or Geneva, the 
TI-llNK C editor uses the width of the letter m to figure out the width of a tab. 

When you change the font or tab settings, the editor adds EFNT and ETAB 

resources to your text files to record the new settings. Other text editors use 
these resources as well. 

This command shifts a selected range of lines to the left. It deletes the first 
character of each line in the selected range, as long as the line begins with a 
tab. 

This command shifts a selected range of lines to the right. It inserts a tab at 
the start of each line in the selected range. 
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Balance 

Options ... 

This command extends the current selection in both directions until it en­
closes the smallest surrounding balanced text enclosed in parentheses (), 
brackets [], or braces { }. Successive invocations select larger sequences of 
text 

This is a quick way to check whether all your function definitions are prop­
erly balanced. Start at the beginning of a file and search for the first left brace 
(" {"). Then use Balance and Find Again commands repeatedly until you 
get to the end of the file. 

Balance is a textual operation. It doesn't know about comments or strings, 
so if you have a lone brace, bracket, or parentheses in a comment, it will try 
to find a match for it 

This command opens a dialog box that lets you set six groups of options: 

• Preferences, on page 377, lets you specify how TI-IINK C behaves 
when it rebuilds projects, and opens and closes files. 

• Language Settings, on page 379, lets you choose which exten­
sions to the C language you can use. 

• Compiler Settings, on page 382, lets you control how TI-llNK C 
generates code. 

• Code Optimization, on page 387, lets you control how TI-llNK C 
optimizes your code. 

• Debugging, on page 389, lets you specify how the TI-IINK C de­
bugger .works. 

• PreflX, on page 391, lets you write preprocessor code that TI-IINK 
C will include in all your files. 

You can set the options for the current project, or you can set the defaults 
that TI-IINK C will use when you create a new project. Use the Copy button 
at the top of the dialog box to copy the TIIINK C defaults to the current proj­
ect, or, if you want the options you've set for a particular project to be the 
TI-IINK C options. Note that even though only one page of the options 
shows up in the dialog at one time, the Copy button copies all of the op­
tions, even the ones in the pages you can't see. 

When you click on the Factory Settings button, TI-llNK C sets all the options 
in all the pages back to their factory settings, the settings they had when you 
first took TIIINK C out of the box. The factory settings are included in the 
options' deSCriptions. 

When you click on the OK button, the changes for all pages of the dialog are 
saved. 
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The Preferences page of the 
Options ... dialog lets you 
set the defaults used in the 
Find ... dialog, specify how 
THINK C behaves when it re­
builds projects, doses files, 
doses projects, and how it 
deals with memory. (When 
you set this options in the 
Find ... dialog, they apply 
only for the current session.) 
The Find ... command, is'de­
scribed on page 392. 

The Edit Menu • 
PREFERENCES 

@ This Project ( » Copy» ) o New Projects 

~I Preferences I 

S. .. oh Options 181 Confirm project updates 
D Whole words only 181 Confirm nuBS 
D Wrap around D Rlways compact projects 
181 Ignore case D Generate link map 

181 Projector-aware 

[~~ 

-- I 
( Fa( tOrl.1 scttin~J~ ) ~ OK J ( Cancel ) 

Whole words only 

When this option is set, the editor's search and replace functions will work 
on whole words only. For example, a search for "string" will not match the 
word "strings." The factory setting is off. 

When you set this option in the Find ••• dialog, it applies only for the current 
session. The Find ••. command is described on page 392. 

Wrap around 

When this option is set, the editor's search and replace functions will search 
the entire file, rather than from the current position to the end of the file. 
When the end of the file is reached, the search "wraps around" to the begin­
ning of the file and continues. The factory setting is off. 

Ignore case 

When this option is set, the editor's search and replace functions will disre­
gard case when performing a search. A search string will match either upper 
or lower case. The factory setting is on. 

Confirm project updates 

When this option is off, THINK C does not display the "Bring project up to 
date?" dialog when you choose the Run or any of the Build ••• commands. 
THINK C assumes you would have answered Yes. The factory setting is on. 

THINK C User Manual 377 



20 THINK C Menus • 

The format of a link map is 
described in "Generating a 
link map" on page 768 

For more information, see 
"Using MPW Projector with 
THINK (" on page 7 36. 

Confirm saves 
When this option is off, TI-IINK C automatically saves changes to a file that 
you have modified without asking if you are sure you want to do so. The 
factory setting is on. 

This is a dangerous option to turn off, since it protects you from inadvertent­
ly replacing previous versions of your files with newly modified versions. 
However, it is very convenient when you want to do program development 
in quick, incremental steps. 

Always compact projects 

If you turn this option on, the project document will be compacted when 
you Close the project, Transfer .•. , or Quit (but not when you Run). The 
factory setting is off. 

To achieve its remarkable speed, TI-IINK C pre-allocates space in the project 
for anticipated requirements, and does not necessarily free up the space 
when an item is deleted. As much as 20% of an uncompacted project docu­
ment can contain unused space. 

Compaction may be time-consuming, so you will normally want this option 
on only when disk space is at a premium. The amount of space freed will 
vary. To compact a project without setting this option, use the Close & 
Compact Project command in the Project menu. 

Generate link map 

If this option is on, THINK C writes a link map for your application when 
you build it. The factory setting is off. 

The link map lists all your project's segments, including one for global data. 
For each function (or global variable) in a segment, the map lists its name, its 
position in the segment, and the file it's defined in. 

TI-ITNK C creates the link map only when you use the Bulld Application .•• 
command. The name of the map is the name of the project with . map ap­
pended. For example, the link map for the Bullseye.1t project is 
Bullseye.1t .map. TI-IINK C places the link map in the project folder and 
erases any link map that was there. 

Projector-aware 

When this option is on, TI-IINK C checks for a Projector resource (CKID re­
source) every time it opens a source file. THINK C displays an icon in the 
lower left corner of the editing window that tells you whether Projector 
marked the file as read-only. If the file is a read-only file, its window will 
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The Languages Settings 
page lets you choose wheth­
er THINK C compiler uses 
some extensions to the C 
language. 

The Edit Menu • 
have a crossed-out pencil icon. If it's not a read-only file, its window will 
have a regular icon. If it's a modified read-only file, its window will have a 
pencil icon with a dotted cross-out. 

LANGUAGE SETfINGS 

@ This Project ( » Copy» I o New Projects 

(;}I Lan~uo~e Settln2s I 
r 181 L~ Extonslons 

I 
AHSIConf~ 

o #deflne _STOt- I @'HINKC 

o Recognize trlgraphs OT"INI( C + Objects 

o enums are always Ints 

r~""""'''''''''''''' 181 Check pointer types @ Infer prototypes 

I o Require prototypes 

[~~ 
I 

( F ~I( tOflJ se11lnH~ ) ( RNSI Settings ) ( OK ) ( Cancel ) 

All the options in this page control whether TIIINK C is ANSI-conformant. 
This is the only page that contains the ANSI Settings button. When you click 
on that button, the options in this page are set up so that TIIINK C is ANSI­
conformant. The button is grayed out ifTIIINK C is already ANSI-conform­
ant. 

#define _STDC_ 

If this option is on, TIIINK C defines the macro _S TDC_. If it's off, TIIINK 
C doesn't define _STDC_ at all. The factory setting is off. The ANSI-con­
formant setting is on. 

IfTI-IINK Cis ANSI-conformant, _STDC_ is defined to be 1. IfTIIINK C 
isn't ANSI-conformant, _STDC_ is defined to be O. 

Recognize trigraphs 

If this option is on, you can use trigraph sequences in your code The factory 
setting is off. The ANSI-conformant setting is on. 

Turn this option on only if you're writing strictly conforming ANSI C pro­
grams. Many Macintosh programs use character strings that resemble tri­
graphs. For example, this file type: 

I????' 
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For more information, see 
"Checking pointer types" 
on page 788. 

is interpreted as 

'?" 

TIllNK C replaces the trigraph ?? ' with" and complains that the character 
literal lacks a closing apostrophe (,). To write that file type with the "Recog­
nize Trigraphs" option on, use this: 

'???\?' 

enums are always ints 

When this option is on, all enumeration constants are the same size as an 
into When this option is off, enumeration constants can be the same size as 
a char, short int, int, or long into The factory setting is off. The 
ANSI -conformant setting is on. 

If this option is off, TIUNK C makes enumeration constants as small as possi­
ble. And, if necessary, it will make a constant as large as a long into For 
example, these constants will only be as large as a char: 

enum { red=l, yellow, green }; 

And these constants will be as large as a long int: 

enum { million=1000000, billion=1000000000 }; 

If this option is on, THINK C makes all enumeration constants the size of an 
into You cannot use constants as large as a long into 

If you're writing ANSI-conformant code, turn this option on. Otherwise, 
you'll want to leave it off. 

Check pointer types 

When this option is on, mINK C makes sure that pointer types match when 
you assign one pointer to another or when you do pointer arithmetic. If this 
option is off, THINK C treats all pointers as equivalent types, and won't dis­
play the "pointer types do not match" error message. When subtracting two 
pointers, however, the two types must be pointers to objects of the same 
size. 

Language Extensions 

This option lets you use mINK C's extensions to the C language. You can 
choose between two sets of extensions: "mINK C" or "TI-llNK C + Objects." 
If you don't select this option, you can use only ANSI C with no extensions. 
To be ANSI -conformant, turn this option off. 
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For a list of the THINK C ex­
tensions, see "THINK C Ex­
tensions" on page 774. 

To relax prototype checking 
when you precompile a 
header file, tum off the 
"Check pointer types" op­
tion, described on page 380. 

For details, see "Enforcing 
prototype use" on page 
789. 

The Edit Menu 

This table explains the two sets of extensions: 

If you choose ..• 
TIDNKC 

TIDNK C + Objects 

You can use .•• 
TIDNK C extensions, but no object exten­
sions. 
TIDNK C and object extensions. 

• 

The TI-lINK C extensions to the C language make programming on the Mac­
intosh easier. They include inline assembly, the pascal keyword, and / / 
comments. The object extensions let you write object-oriented code in C. 
They're described in Object-Oriented Programming, Chapter 4, "Using Ob­
jects in TI-lINK C. " 

If you use the object extensions, these words become keywords, and you 
can't use them as identifiers: 

class 
new 

delete 
virtual 

This list explains which option is best for your program: 

• If your program must be 100% ANSI-compatible, choose turn off 
"Language Extensions." Make sure the rest of the options in this 
page are set to their ANSI-compatible settings. 

• If your program doesn't use objects, choose "mINK C. " 
• If your program uses objects or the TI-lINK Class Library, choose 

"THINK C + Objects." 

Strict Prototype Enforcement 

This option lets you choose how strictly TIUNK C enforces the use of proto­
types. If this option is on, you can choose between two enforcement levels: 
"Infer prototypes" and "Require prototypes." If this option is off, TIIINK C 
does nothing when you use a function without a prototype. The factory set­
ting is "Infer prototypes. " The ANSI-conformant setting is "Infer prototypes." 

This table explains the two enforcement levels: 

If you 
choose .•. 
Infer prototypes 

TIllNK C does this when you use a 
function without a prototype ..• 
Infers a prototype from the first appear­
ance of a function. That appearance can 
be a function call or an old-style declara­
tion. If a subsequent call, declaration, or 
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The Compiler Settings page 
lets you control how THINK 
C compiles your code. 

Require prototypes 

Note 

prototype doesn't match the inferred pro­
totype, TIUNK C raises an error. 
Raises an error. You can't use or define a 
function unless it has a prototype. New­
style function definitions do not count as 
prototypes. 

There is one exception to the "Require prototypes" require­
ment A static function does not need a prototype. Just de­
fine it with a new-style function definition before using it 

COMPILER SE1TINGS 

@Thls Project ( » Copy» ) o New Projects 

~ I Complier Settings 

[j Generate 6B020 Instructions 

o Generate 6BBBI Instructions 

181 Classes are Indirect by default 

181 Methods are ulrtual by default 

181 Optimize monomorphic methods 

o 4-byte Ints 

DB-byte doubles 

181 "'p" Is unsigned char [] 

o Natlue floating-point format 

Cancel 

Generate 68020 instructions 

If this option is on, TI-lINK C generates code that is optimized for Macintosh­
es with the MC68020, MC68030; or Mc68040 Oike the Macintosh LC, II, or 
IIfx), and that will not run on Macintoshes with the Mc68000 Qike the Macin­
tosh Classic or Plus). If it's off, TI-lINK C generates code that will run on all 
Macintoshes. The factory setting is off. 

If the option is on, TI-lINK C generates Mc68020 instructions for bitfield op­
erations, addressing, and long word multiplication, division, and modulo 
operations. Also, the inline assembler accepts all Mc68020 instructions and 
addressing modes for assembly in an asm { ... } construct. 
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For more information on the 
"Native floating-point for­
mat" option, see page 385. 

Indirect dassesare imple­
mented as handles. Direct 
dasses are implemented as 
pointers. 

Note 

the Edit Menu 

Before your program uses Mc68020 instructions, make 
there is a MC68020, Mc68030, or MC680400r your program 
may crash. Use the Gestalt Manager, described in Inside 
Macintosh VI, Chapter 3, "Compatibility Guidelines." 

Generate 68881 instructions 

• 

If this option is on, TIIINK C generates code that is optimized for Macintosh­
es with the Mc68881 or Mc68882 floating-point unit Oike the Macintosh II or 
IIfx) or the Mc68040, and that will not run on Macintoshes without it Oike 
the Macintosh Classic, LC, or Plus). If it's off, TIIINK C generates code that 
will run on all Macintoshes. The factory setting is off. 

If this option is on, TIIINK C generates code for the floating point coproces­
sor. You may declare up to five local floating-point variables as register 
variables, and TIIINK C will placed them into Mc68881 registers. 

If both this option and the "Native floating-point format" option are on, long 
doubles use the Mc68881's 96-bit format. Since SANE expects 80 bit dou­
bles, you'll need to convert from one format to the other. The float (32 
bits) and short double (64 bits) types are identical for SANE and for the 
Mc68881. 

Note 
Before your program uS,es Mc68881 instructions, make sure 
there is a MC68881 i Mc68882, or MC68040, or your pro­
gram may crash. Use the Gestalt Manager, described in In­
side MaCintosh VI, Chapter 3, "Compatibility Guidelines." 

Classes are indirect by default 

If this option is on, classes declared with the class keyword are indirect by 
default. If this option is off, they are direct by default. This option is available 
only in the "TIIINK C + Objects" option is on. The factory setting is on. 

This option doesn't affect classes declared with struct. A root class de­
clared with struct must use direct or indirect. 

No matter how this option is set, you can still use the words direct and 
indirect to deciare explicitly how to allocate a class. 

For more information ori. whether to declare classes direct or indirect, see 
Object-Oriented Programming, Chapter 4, "Using Objects in TIIINK C." 
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A monomorphic method is 
a method that does not 
override another method 
and is never overridden it­
self. 

Methods are virtual by default 

If this option is on, all methods are virtual, even those that aren't declared 
virtual. If this option is off, only methods declared virtual are virtual. 
This option is available only in the "mINK C + Objects" option is on. The 
factory setting is on. 

This option doesn't affect all methods. Some are always virtual; others are 
never virtual: 

• Static methods, including allocators and deallocators, are never 
virtual. 

• Constructors are nevervirtual. 
• Destructors are a/ways virtual 

If you're using code you wrote with the previous version of mINK C, either 
turn this option on or declare your methods virtual. The previous version 
didn't use the virtual keyword and made all methods virtual. 

If you're writing new code, turn this option off and declare your methods 
virtual as necessary. Your code will be more compatible with C++. 

Optimize monomorphic methods 

If this option is on, mINK C optimizes monomorphic methods by generat­
ing a call directly to the method. If this option is off, mINK C generates a 
call to a run-time dispatcher. 

You'll rarely need to turn this option off. You'll keep it on unless you're 
working with a program that has replaceable code modules. 

4-byte ints 

When this option is on, integers are the same size as long integers, four­
bytes long. When it's off, they're the same size as short integers, two-bytes 
long. The factory setting is off. 

Use four-byte integers if you're porting code from a compiler that uses four­
byte integers, like MPW C, or you're porting code that assumes integers and 
pointers are the same size. Otherwise, use two-byte integers, since the 
Mc68000 family handles them more efficiently. 

Note 
No matter how this option is set, long integers are always 
four-bytes long and short integers are always two-bytes 
long. 
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8-byte doubles 

When this option is on, doubles are the same size as short doubles, eight­
bytes long. When it's off, they're the same size as long doubles. The factory 
setting is off. 

Use eight-byte doubles if you're porting code from a compiler that uses 
eight-byte doubles, like MPW C. Otherwise, leave the option off, and TI-IINK 
C uses the most efficient size possible. 

When this option is off, the size of doubles is controlled by the "Generate 
68881 instructions" option, and the "Native floating-point format" option. 
For more information, see page 385. 

Note 
Ifboth the "8-byte doubles" option is on and the "Language 
Extensions" option is set to "THINK C," no type in THINK C 
gives you eight-byte floating-point numbers. 

It\ pit is unsigned char [] 

When this option is on, Pascal string literals are of type unsigned 
cha r [ ] . Otherwise, they're of type cha r [ ] . The factory setting is on. 

Pascal string literals are string literals that start with \p, like this: 

n\pUntitledn 

If this option is oni Pascal string literals are compatible with the Macintosh 
Toolbox types Str255 and Stringptr. When you assign a Pascal string 
literal to a variable of type Str254 or StringPtr, you don't need to cast 
the string. 

Previous versions of THINK C assumed Pascal string literals to be of type 
char []. Turn this option off only if you have code that took advantage of 
this assumption. 

Native floating-point format 

When this option is off, THINK C uses the universal floating-point format for 
long doubles. When it's on, mINK C uses either the native SANE or 
Mc68881 floating-point format. The factory setting of this option is off. 
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Note 
Usually, doubles use the same format as long doubles. 
However, doubles use the same format as short doubles if 
the "8-byte doubles" option, on page 385, is on. 

The universal format is a floating-point format you can use no matter what 
the setting of the "Generate 68881 instructions option" is. TI-llNK C automat­
ically convert numbers to and from the universal format. The conversions 
are too quick to notice unless your applications are computation intensive. 
For more information on these different formats, see "Floating point repre­
sentation" on page 172. 

If this option is on, THINK C uses a native floating-point format for long 
doubles. Which native format it uses depends on the setting of the "Generate 
68881 instructions" option. This chart shows which format it uses: 

If Native Float- and Generate Then long doubles use 
ing-point is 68881 is thls format ... 
Off Off Universal 
Off On Universal 
On Off Native SANE 
On On Native Mc68881 

If your project contains any libraries or projects that were compiled in the 
universal format, turn this option off. These THINK C libraries use the uni­
versal format: 

• ANSI 
• ANSI-small 
• ANSI-A4 

• profile. 

If you're writing a library for general use, turn off both the "Native floating­
point format option" and the "Generate 68881 instructions" option. Projects 
can use your library no matter how they set the "Generate 68881 instruc­
tions" option, as long as they turn off the "Native floating-paint format" op­
tion. 

If you want the fastest code possible and use no libraries compiled in the 
universal format, turn the "Native floating-point format option" on. The con­
versions to and from the universal format are eliminated. 
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The Code Optimization 
page lets you control how 
THINK C optimizes your 
code 

For more information on this 
option, see "Defer & com­
bine stack adjusts" on page 
186. 

The Edit Menu • 
CODE OPTIMIZATION 

@Thls Project ( » Copy» ) a New Projects 

[;]1 Code Optimization I 

cg] Defer & combine stock adjusts cg] Un Glob.1 Optimiz .... 

cg] Suppress redundant loads cg] Induction uarlable ellmlnlltion 
cg] CSE elimination r cg] AutOfNtlo Rt9ist .... As.ignmeont 

I 
cg] Code motion 
cg] Register coloring _ 0 Honor 'register' first 

[~~ 

I 
( Factory settings ) ~ OK )) ( Cancel ) 

The options in this page fall into two categories. The options in the left col­
umn control optimizations that the compiler performs. Using them doesn't 
increase your compile time much. 

The options in the right column control the global optimizer. The global op­
timizer adds an additional pass over your compiled code to improve it. It 
may double the amount of time it takes to compile your code. 

Defer & combine stack adjusts 

If this option is on, TI-IINK C saves time and space in code that calls many 
functions in a row. The factory setting is on. 

If this option is off, THINK C follows this function-calling rule: When a state­
ment calls a C function, that statement pushes the arguments on the stack 
before calling the function and pops them off after it returns. 

If this option is on, TI-IINK C changes that rule. If your code contains a run of 
C functions, it doesn't pop a function's arguments off the stack immediately 
after one of the function returns. It continues to call the other functions and 
push their arguments on the stack. It lets the arguments accumulate and 
keeps track of how much is on the stack. When the run of functions is done, 
it pops the arguments off all at once. 

Suppress redundant loads 
For more information on this 
option, see "Suppress redun- If this option is on, THINK C doesn't load data into a register when that data 
dant loads" on page 187. is already in a register. This optimization makes your code smaller and faster. 
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For more information on this 
option, see HRegister color­
ing H on page 786. 

For more information on this 
option, see "Induction vari­
able elimination" on page 
785. 

For more information on this 
option, see "(SE elimina­
tion" on page 7 85. 

Automatic Register Assignment 

If this option is on, TIUNK C automatically assigns variables to registers to 
make your code as small as possible. With the option below, you can choose 
whether THINK C also puts the variables declared register into registers. 
If this option is off, TIIINK C puts only those variables declared register 
into registers. 

If you select this option, the "Honor 'register' first" option below appears. 
This table explains what that option does: 

H "Honor 'register' 
first is" ... 
On 

Off 

Use Global Optimizer 

TIllNK C ••• 
Puts the variables declared register in 
registers and puts the variables it wants in 
the remaining registers. 
Ignores your register declarations and 
puts the variables it wants in registers 

This option controls the global optimizer. It is a "master switch." If it's off, 
the options below it are disabled. If it's on, the options below it are enabled, 
set to the values they had the last time the master switch was on. The next 
four sections describe those options. 

You probably won't use the global optimizer while you're debugging. It 
adds an additional pass over your compiled code and may double your 
compilation time. Also, it generates machine code that is significantly differ­
ent from your source code. The debugger may not be able to pick out the 
machine code instructions that correspond to a statement. 

Induction variable elimination 

This optimization makes loops faster, especially those that cycle through an 
array. It will make your code slightly larger. Use this optimization if your 
code contains a lot of loops. It's especially useful on a Macintosh with a 
MC680oo, like a Macintosh Classic or Plus, which performs 32-bit multiplica­
tion in software. 

CSE elimination 

This optimization makes your code smaller and faster. It replaces subexpres­
sions that are used more than once with a temporary variable set to the 
subexpression's value. Use this optimization on all your code. It's especially 
useful if you also use the "Register coloring" option on page 389. 
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For more information on this 
option, see HCode motion 1/ 

on page 185. 

For more information on this 
option, see "Register color­
ing" on page 186. 

The Debugging page lets 
you specify how the THINK 
C debugger works. 

The Edit Menu • 
Code motion 
This optimization makes your loops faster but may make your code slightly 
larger. It moves expressions out of a loop that remain constant in each itera­
tion. Use this optimization if your code has a lot of loops. 

Register coloring 
This optimization makes your code smaller and faster. It searches your code 
for variables of the same type that are never used at the same time and treats 
them as if they were the same variable. If there's a register free, it lets them 
share that register. 

DEBUGGING 

@ This Project ( » Copy» 1 o New Projects 

~I Debugging I 

181 Us. So<rc. o.bu99H ------- 181 Rlways generate stack frames 

181 Use second screen o Generate profiler calls 

181 Update program Windows rl8l
"" .......... • 181 Rlways saue senlon @ Short format 

I o Long formllt 

[~~ 

I 
( Factory settings) ~ OK J ( Cancel ) 

Use Source Debugger 

When this option is checked, THINK C launches the source level debugger 
when you run your project. It is a "master switch." If it's off, the options be­
low it are disabled. If it's on, the options below it are enabled, set to the val­
ues they had the last time the master switch was on. The next three sections 
describe those options. 

Checking this option is the same choosing the Use Debugger command in 
the Project menu. 

Use second screen 

When this options is on, and you're running on a Macintosh with more than 
one screen, THINK C will display the source debugger windows in the sec­
ondscreen. 
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For more information on this 
option, see "Always gener­
ate stack frames" on page 
244. 

Update program windows 

When this option is on, the debugger tries to update your windows for you 
when your project is stopped. The factory setting is off. 

Without this option checked, your program must wait until control comes 
back so it can handle updates itself. Since it cannot do so until it gets back to 
its event loop, an update may remain pending for some time. 

This option is especially useful when you're trying to step through code that 
draws in a window. This option uses memory to save your window's image. 
If there isn't enough memory, the debugger won't be able to perform auto­
matic updates. If you have a large or color screen, you might want to in­
crease the debugger's partition size. For details, see "Update program 
windows" on page 243. 

Always save session 

When this option is on, the debugger always saves your breakpoints and the 
contents of your data windows when you exit the debugger. When this op­
tion is off, you must choose Save from the debugger's Flle menu to save 
your session. 

Always generate stack 'frames 

When this option is checked, TIHNK C generates a stack frame for almost 
every functio.n called. When this option is off, TIIINK C doesn't generate a 
stack frame for functions that don't have local variables or parameters. The 
factory setting is off. 

If you're using the debugger's call chain menu or the profiler, turn this op­
tion. Otherwise, leave it off. You're program will be smaller and faster with­
out the unnecessary stack frames. 

Generate pro flIer caIIs 

When this option is on, TIIINK C generates calls to code pro filer routines. 
The code profiler collects timing statistics about your functions. The factory 
setting is off. 

TIIINK C can profile orily for functions that have stack frames. To create 
stack frames for almost every function, turn on the "Always generate stack 
frames" option on page 390. 

See Chapter 15, "The Profiler," to learn more about the code profiler. 
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The Prefix page lets you 
write preprocessor code that 
THINK C will indude in al/ 
your files. 

The Edit Menu 

Macsbug Names 

This option lets you choose whether TI-IINK C includes function names in 
your compiled code for assembly language level debuggers such as Macs­
bug or TMON. If this option is on, you can choose between two types of 
names "Short format" and "Long Format." If this option is off, TI-IINK C 
doesn't include function names in your compiled code. 

• 

TmNK C generates symbols only for functions that have stack frames. To 
create stack frames for almost every function, turn on the "Always generate 
stack frames" option on page 390. Be aware that while Macsbug symbols are 
useful for debugging, they ad~ at least eight bytes to every procedure. 

If you use "Short format" names, function names are limited to eight charac­
ters. Underscores are stripped off. Names shorter than eight characters are 
padded with spaces. For methods (like TDrawwindow: : FileWri te), 
only the first eight characters of the class and method are stored Oike, 
TDrawWin: :FileWrit). The TI-IINK C debugger, TMON, and all versions 
of Macsbug can use these names. 

If you use "Long format" names, function names can be any length. For 
methods Oike TDrawWindow: : FileWri te), the full class and method 
names are stored Oike TDrawWindow: : FileWri te). The TI-IINK C de­
bugger and Macsbug 6.0 and later can use these names. 

PREFIX 

@ This Project ( » Copy» I o New Projects 

~I PrefiH I 
#Include <TCLMacHeaden> 

[~~ I 
( fa( torcJ seHlng~ ) [ OK ) ( Cancel ) 

This page lets you include some text in all the source files in your project. It's 
as if you put the code from this page at the beginning of all your source fIles. 
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The commands in the 
Search menu let you find 
and replace strings in your 
source files. THINK C has ex­
tensive search and replace 
functions induding multi­
file searching and pattern 
matching searching. To 
learn how to search for pat­
terns, see "Searching for a 
Pattern (Crep)" on page 
744. 

Find ..• 

If you use a precompiled header file, like MacHeaders, #include it here. By 
default, this page contains the line -#include <MacHeaders>. 

If you need to define a macro in all your files, defme it here. For example, 
you may have some debugging code in your files that's compiled only if the 
macro DEBUG is defined. To include that code, include this line here: 

fdefine DEBUG 

When you don't need to include the debugging code anymore, just delete 
that line from this page. You don't need to edit every file in your project. 

The Search Menu 

Find •.. ~F 

Enter Selection ~E 

Find Again ~G 

Replace ~= 

Replace & Find Again ~H 

Replace All 

Find In NeHt File ~T 

Go To line ... 
Mark ... 
Remoue Marker ..• 

~, 

~M 

This command lets you specify a string to search for. If the string is found, it 
is highlighted. If it is not found, the editor simply beeps. 
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At the start of an editing session, only the Find ••• command is active. The di­
alog box that appears in response to this command lets you specify a string 
to search for, as well as an optional replacement string. 

Search for: Replace with: 

~11_M_CF ___ ln_lt __________ ~1 I~ ______________ ~ 
o Whole Word5 Only 

o Wrap Rround 

181 Ignore Ca5e I( 

o Grep 0 Multi-File Search 

Find ))( Don't Find ) ( Cancel 

Figure 20-2 The Find ..• dialog 

You can also set search options in this dialog box. Note that you can also set 
these options in the Search Options page of the Options ••• dialog. When 
you set the options in the Find .•. dialog, though, they apply only to the cur­
rent session. If you want to set the defaults permanently for the project 
you're working on or for new projects you create, use the Options .•. dialog. 

Whole words only 

WrapAround 

Ignore Case 

When this option is set, the editor's search 
and replace functions will work on whole 
words only. For example, a search for 
"string" will not match the word "strings". 
This option is off by default. 

When this option is set, the editor's search 
and replace functions will search the en­
tire file, rather than from the current posi­
tion to the end of the file. When the end of 
the file is reached, the search "wraps 
around" to the beginning of the file and 
continues. This option is off by default. 

When this option is set, the editor's search 
and replace functions will disregard case 
when performing a search. A search string 
will match either upper or lower case. 
This option is set by default. 

In addition to the Find button ("Go ahead with the search") and the Cancel 
button ("Pretend I never invoked this command"), there is a Don't Find but­
ton in the dialog box. Pressing this button causes the editor to accept the 
new string and option settings but doesn't initiate a search. This is useful for 
setting values for a replace operation without executing the first Find. 
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Enter Selection 

Find Again 

Replace 

Replace & Find Again 

Replace All 

Find in Next File 

This command sets the search string to the current selection, clearing Grep 
and Multi-File Search. You can then use Find Again to begin searching, or 
Find ••• to set search options. 

This command searches for the next occurrence of a previously specified 
string. 

This command replaces the current selection with a replacement string. If 
you haven't provided a replacement string, this command will clear the 
string that has been found (that is, it will replace it with nothing). Usually, 
you use this command after finding a string. 

This command replaces the current selection with the replacement string, 
then finds the next instance of the search string, but does not replace it. Use 
this command to step through a series of replacements. After each replace­
ment, you will see the next instance of the search string, so you can decide 
whether you want to replace it. If you want to replace the string, use the Re­
place or Replace & Find Again commands. If not, use the Find Again 
command to find the next occurrence of the string. 

If you haven't provided a replacement string, this command clears the string 
that has been found (that is, it will replace it with nothing). 

This command replaces every instance of the search string. If the Wrap 
Around option is on, it replaces every instance in the file. If the Wrap Around 
option is off, it replaces every instance from the current cursor position to 
the end of the file. Use this command when you don't want to give your ap­
proval for every replacement. If you haven't provided a replacement string, 
this command will clear the string that has been found (that is, it will replace 
it with nothing). 

This command lets you search for a string through more than one file. 

To use this command, you must check the Multi-File Search check box in the 
Find ••• dialog box. When you check this box, another dialog box displays 
all of the text files known to TIIINK C. You can scroll through the list and se­
lect individual files by clicking on them to place a check mark by the name, 
or you can use the buttons in the dialog box to Check All, Check None, 
Check All .c or Check AlI.h. (If a file is already selected, clicking on its name 
will remove the check mark.) 

When you've checked the files you want to include in the multi-file search, 
click OK to return to the Find ..• dialog box. 
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GoTo Line .•• 

The Search Menu • 
TIllNK C will search for the string specified in the Find ••• dialog box 
through each of the files that have been checked, starting with the first one. 
If the search string is found in a given file, TIUNK C opens an edit window 
containing the file, and the search string is selected. At this point, you can go 
on and make any edits you choose. If you want to search further in the cur­
rent file, you can use the Find ••• , Find Again, Replace, and Replace All 
commands, which work within the current file. When you're ready to go on 
with the multi-file search, use the Find in Next File command. 

Multi-file search is useful when you are writing a program, and decide to 
modify a function that is used in multiple files. You can open each of the 
files containing the search string, so you can switch back and forth between 
the various edit windows as necessary. (This feature is also helpful when 
you are tracking down link errors due to undefined or multiply defined sym­
bols.) 

This command lets you move to a specific line in your file. You need to 
know the line's number. Lines are numbered consecutively, with the first 
line in the file being number 1. 

When you choose Go To Line ••. , you'll see the dialog in Figure 20-3. 

[ OK ) 
1
23 Go To Line: 

( Cancel ) 
Figure 20-3 The Go To Line •.• dialog 

The default line is the line that the insertion point is in. Edit it and click OK. 
If you change your mind, click Cancel. The editor moves the insertion point 
to the beginning of the line you entered. 
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Mark .•. This command lets you place a marker in a file. Place the insertion point in 

the line you want to mark or select some text in that line. Choose the 
Mark. •• command in the Search menu. You'll see the dialog in Figure 20-4. 

Marker name: 

[HandleEuent 

OK n ( Cancel) 

Figure 20-4 The Mark ... dialog 

Edit the default name if you want, and click OK. If you selected text, the edi­
tor uses that text as the default name. If you don't select text, the editor uses 
the word nearest the insertion point as the default name. If you don't want to 
insert a marker after all, click Cancel. 

To go to a marker in a file, hold down the Command key and click in the title 
bar of the file's editing window. A pop-up menu of the file's markers ap­
pears, sorted alphabetically. 
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Remove Marker ••• 

The Search Menu • 
This command lets you delete a marker from a file. It displays the dialog in 
Figure 20-5. 

Remoue selected markers: 

HandleEuent 
HandleMouseDown 

main 

n OK n Cancel 

Figure 20-5 The Remove Marker ••• dialog 

Select the markers you want to delete and click OK. If you change your 
mind, click Cancel. The next time you see the marker pop-up menu, you'll 
notice that the deleted markers are gone. 
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The commands in the ProJ­
ect menu work with the cur­
rent project. You can open 
and create projects, set the 
project type, make sure all 
the files in the project are 
compiled and loaded. This 
menu also contains the com­
mands you'll use when 
you're ready to build a file 
containing your application, 
desk accessory, deVice driver, 
or code resource. 

New Project ... 

Open Project ... 

Close Proj~ct 

Close & Compact 

Set Project Type ... 

The Project Menu 

Project 
New Project ..• 
Open Project ••• 
Close Project 
Close & Compact 

Set Project Type ... 
Remoue Objects 

Bring Up To Date 3€U 
Check link 3€l 
Build library ... 
Build Application ... 

Use Debugger 
Run 3€R 

This command creates a new project and opens an empty project window. 
Only one Pfoject can be open at a time. 

This command opens an existing project. 

This command closes the current project and then lets you open an existing 
project or create a new project. If you try to close a project with open flles 
which have been changed but not saved, a dialog box will ask you if you 
want to save them. To disable this dialog, turn the "Confirm Saves" option 
off in th~ Preferences page of the Options •.• menu. When this option is off, 
c~anged files will automatically be saved when you close. 

This command is the same as Close Project, but it makes the project docu­
ment as small as possible without removing any object code. Use this com­
mand before you back up your project, or when you plan to use a project as 
a library (Chapter 14, "Libraries") or when you plan to transmit the project 
through a modem (See also the Remove Objects command on page 402). 

This command lets you set the project type. The default project type is Ap­
plication, but you can change it to Desk Accessory, Device Driver, or Code 
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The Application dialog lets 
you spedfy how string liter­
als and floating point con­
stants are stored and lets 
you set some of the fields of 
the S I Z E resource M ulti­
Finder uses. 

The Project Menu • 
Resource. All project types let you specify the File Type and Creator of the 
file created by one of the Bulld ••• commands. To learn the details of each 
project type, Chapter 7, "The Project." 

Set the project type before compiling any of your sources. TI-IINK C will 
need to throwaway any existing object code if you switch the project type 
once there is compiled code in the project. If the project already contains 
files, TI-IINK C will ask if you're sure you want to 'change the project type. 

The Set Project Type ••• dialog box lets you specify different attributes for 
each type. 

APPUCATION 

@Rppllcotlon 

o Desle Rccessory 

o Deulce Drluer 

o Code Resource 

Portltlon (K) ~ 

SIZE Flogs 8100801 

fIIeType ~ 

Creotor ~ 

DFor to DE 

DFor DRTR 

o Separate STRS 

t OK J tancel 

Partition 

The value in this field is the amount of memory MultiFinder allocates for 
your application. The default is 384K, which is more than enough for most 
moderate size applications. 

SIZE Flags 

The pop up menu lets you set the bits that tell MultiFinder and System Soft­
ware 7 how compatib~e your application is. You can use the pop up menu or 
type a hex value into the field. For more information on the menu's choices, 
see "Setting the partition size and SIZE resource flags" on page 101. 

Separate STRS 

When this options is set, string literals and floating point constants are 
placed in their own STRS component. Otherwise, strings and floating point 
constants are part of the DATA component 

Far CODE 

If you need a large jump table, check the "Far CODE" option. It allows a 
jump table as large as 256K, since it uses address that are 32-bits long instead 
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of 16-bits long. Your application will be about 6% larger because of the long­
er addresses. If the "Far CODE" option is off, your jump table can be only 
32K. 

Note 
If the "Far CODE" option is on, each of your project's files 
can contribute only 4095 jump table entries. 

For more information, see "How Far CODE and Far DATA work" on page 
100 and -Mixing Near CODE and DATA with Far CODE and DATA" on page 
101. 

Far DATA 

If you use a lot of global data, check the "Far DATA" option. It allows you to 
have an unlimited amount of global variables, since it uses address that are 
32-bits long instead of 16-bits long. Your application will be about 8% larger 
because of the longer addresses. If the "Far DATA" option is off, your project 
can contain only 32K of global variables. 

Note 
If the "Far DATA" option is on, each of your project's file 
can contribute only 32K of global data. This limit means, for 
example, that you can't use an array that's over 32K. 

For more information, see "How Far CODE and Far DATA work" on page 
100 and "Mixing Near CODE and DATA with Far CODE and DATA" on page 
101. 
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The Desk Accessol}' and De­
vice Driver dialogs are simi­
lar. For desk accessories the 
File Type and Creator fields 
are filled in for you so the re­
sulting file will be a Font/DA 
Mover file. There are other 
differences between Desk 
Accessories and Device Driv­
ers which have to do with 
the header fields. For details, 
see "Building Desk Accesso­
ries and Device Drivers" on 
page 704. 

DESK ACCESSORY 
DEVICE DRIVER 

o Rppllcatlon 

@ Desk Rccessory 

o Deulce Drluer 

o Code Resource 

FlleType §O 
Creator I DMOU I 
o Multi-Segment 

Name ..... U _________ --' 

Type ~ 

OK 

o Rppllcatlon 

o Desk Rccessory 

@ Deulce Drluer 

o Code Resource 

ID~ 

H Cancel 1 

FlleType ~ 

Creator ~ 

o Multi-Segment 

Name 1:...11 _________ --'1 

Type ~ 10 c=J 

OK (( cancel) 

Multi-Segment 

The Project Menu • 

When this option is on, your desk accessory or device driver can have up to 
30 segments. 

Name 

This field is the name of your desk accessory or device driver. By conven­
tion, desk accessory names begin with a null byte. TIIINK C takes care of 
this for you. Device drivers begin with a period. If you don't provide one, 
TIllNK C will add one for you. 

Type 
Desk accessories and device drivers are resources of type DRVR. You can 
change the type if you have some reason for doing so. 

ID 

The ID number of the DRVR resource. Desk accessories default to 12. The 
FontlDA Mover will renumber your desk accessory (and its owned resourc­
es) if there is a conflict. 
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The Code Resource dialog 
lets you spedfy whether your 
code resource will begin with 
a standard header, its name, 
type, and ID, and its re­
source attributes. 

Remove Objects 

CODE RESOURCE 

o Appllcetlon 

o Desk Rccessory 

o Deulce Drluer 

@ Code Resource 

FlleType ~ 

Creator ~ 

I 0 Multi-Segment 

Nama II--________ ---J 

Type c==J 
o Custom Header 

OK 

Multi-Segment 

ID c==J 
Attn IE3 §] 

K Cancel 1 

When this option is on, your code resource can have up to 30 segments. 

Name 

The name of your code resource. For most code resources, the name is op­
tional. 

Type 
The resource type of your code resource. 

ID 

The ID number of your code resource. 

Custom Header 

When this option is off, TI-lINK C uses a standard header for your code re­
source. The header places the address of your resource in register AO and 
branches to your main () function. If you check this option, your code re­
source will begin with the first function in the file in which main () is de­
fined. 

Attrs 

The resource attributes Oocked, purgeable, system, etc.) of your code re­
source. You can select the attributes from the pop up menu, or you can set 
them by typing a hex number into the field. 

This command removes all the object code from a project. It reverses the ef­
fects of all previous compilations and loading of libraries. The project docu­
ment is "dehydrated"; it can be "reconstituted" by recompiling all source files 
and reloading all libraries. 
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Bring Up To Date 

Check Link 

Build Library •.• 

The Project Menu • 
Use Remove Objects when you need to make the project document as 
small as possible, e.g., for archiving or for transmitting to someone else. 

This command compiles and source files that need to be compiled and loads 
any libraries that haven't been loaded. 

This command checks for all the same error conditions as Run or Bulld Ap­
plication ••• would, but without running the project or building an applica­
tion. If any files need to be made, you will be asked whether you want to 
bring the project up to date, even if you have set Confirm Auto-Make off. 

The Check Link command displays errors in the Link Errors window. If 
there are multiply defined or undefined symbols, the names of the files con­
taining the symbols appear in parentheses. 

D link Errors 
multiply defined: here_l-am (main.c, auxfns.c) ~ 
undefined: not-here (main.c) 

Q L Jmmmmmmmm~mmmmmmmmmmmmmmmmmmmmm~i~immmmmmmmmi Q '2J 
Figure 20-6 The Link Errors window 

When the Link Errors window comes up as the result of an attempt to Run 
or Bulld ••. , this additional information is not displayed. Since some disk ac­
tivity is required to compute the information, it is only displayed when you 
specifically request Check Link. 

This command saves the current project as a single binary me that can be 
added as a library to other project documents. A dialog box prompts you for 
the name of the library file. The convention is name. Lib; however, a library 
may have any valid file name. Note that you can include a project in another 
project without first saving it explicitly as a library. See Chapter 14, "Librar­
ies," for details. 
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Build Application ..• 
Build Desk Accessory .. . 
Build Device Driver .. . 
Build Code Resource .•. 

Use Debugger 

Run 

This command saves the current project as an application, desk accessory, 
device driver, or code resource. A dialog box lets you name the resulting file 
(the dialog on the left is for applications, desk accessories, and drivers; the 
one on the right is for code resources): 

I ~ MlnlEdlt Folder I I~ mycDEU fOlderl 

D flU99yEdlt.c ~ =Tess D (lh:-".11 Q =Moose 
D mllll.OIe.( D (d.:-.,.c 
D mllll.prln1.( i I:,.:-&t D Inl1.n EJt.>ct 

D mllll.llIlndoUl~.c 
~. [Irille D Inl1.( Driue 

D ~IIIIEdl t. TJ D myCDEU 
D MilliEdit .. rt.l'uc K> 

Saue application as: I Soue I Saue code resource liS: I Snue I 
U4t@ljh [ Cnntel ImycDEu [ Cllncel 

181 Smart Link 181 Smllrt Link 181 Merge 

Figure 20-7 The Build ... dialog, with and without the Merge button. 

If the Smart Link option is checked, TIIINK C uses the smallest number of 
code components of the source files or libraries to create the resulting file. It 
takes a little longer to put the application or resource together, but the result­
ing file will be as small as possible. Uncheck this option if you're building 
frequently for testing. 

If the Merge option is checked in the Build Code Resource .•• dialog, you 
can place your code resource into an already-existing file. Just type in the 
name of the file. 

If there is a file with the same name of the project that ends in . r s rc in the 
same folder as the project, the resources in the. rsrc file will be merged 
into the resulting file. However, code resources built with the Merge option 
will not use the. rsrc file. 

This command turns the source debugger on and off. When the source de­
bugger is on, you'll see a "bug" column in the project window, and when 
you run the project the debuggers windows appear on the screen. Selecting 
this command is the same as clicking on the "Use Debugger" check box of 
the Debugging page of the Options ... dialog box. See Chapter 12, "The De­
bugger," to learn how to use the source level debugger. 

This command will run the program contained in the project. If the project is 
not up to date, a dialog box will ask if you want to bring it up to date. If the 
"Confirm Auto-Make" option in the Options ... dialog box is not checked, 
then the project will automatically be brought up to date. This lets you edit a 
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The commands in the 
Source menu let you add 
and remove source files to 
your project. This menu also 
contains commands to ae­
ate precompiled headers, to 
compile source files, to load 
libraries, and to control the 
auto-make fadlity yourself. 

Add 

The Source Menu • 
source file and run the changed program, without ever explicitly recompil­
ing or relinking the program. 

If the project type is Desk Accessory, the Run command uses an auxiliary 
program, DAShell, to run your desk accessory. THINK C needs to build you 
desk accessory and save it in a file first, then THINK C launches DAShell. 
Your desk accessory will be in the Apple menu. 

The Source Menu 

Add 
Add ... 
Remoue 
Get Info 
Debug 3€1 

Check SyntaH 3€Y 
Preprocess 
Disassemble 

Precompile ... 
Compile 3€K 
Load Library 
Make •.. 3€\ 

Browser 3€J 

This command adds the file in the frontmost edit window to the project to 
the project window. The file must end in . c. 
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Add .•• 

Remove 

This command lets you add existing source files and libraries to a project. It 
brings up the dialog in Figure 20-8. 

[) RppleTalk 
[) CommToolBoH 
[) Graf3D 
[) MacTraps 
[) nRppleTalk 
[) PrGlue 
[) SRNE 

c:> Rkbar 

Driue 

Cancel 
................................................................................................................................ _ ..................................... . 

~ 
( Rdd n 
( Rdd RII ) 
( H(HnOl.t(~ ) 

Figure 20-8 The Add •.. dialog 

The top list displays the contents of the folder you're in. The bottom list dis­
plays the files that will be added to your project when you click Done. You 
add files to the bottom list with these commands: 

• To adq a file, select it and click Add, or double-click on it. 
• To add all the files from the folder you're in, click Add All. 
• To open a folder, select it and click Open, or double-click on it. 

(Add becomes Open when you click on a folder.) 
• To rempve a file from the bottom list, select it and click Remove. 
• When you finish selecting files to add, click Done. 
• If you change your mind and don't want to add any files, click 

Cancel. . 

This command removes a selected source file or library from the project. 
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Get Info ... 

Check Syntax 

Preprocess 

Disassemble 

Precompile ... 

The Source Menu • 
The Get Info ••• command display a dialog box that contains the sizes of 
each project component. The displays initially contains information for the 
currently selected file. 

MiniEdit.c 

CODE DRTR STRS JUMP 

File 1699 390 0 72 

Segment 2 15360 1094 0 4272 

Project 16104 1094 0 4394 

(NeHt)[ Preu] File [ OK J [r~.~H tl (Pow] Segment 

Figure 20-9 The Get Info ... dialog 

The dialog shows the size of the CODE, DATA, STRS, andJUMP components 
for the selected file. If the file hasn't been compiled, these values will be 
zero. The dialog also shows the same information for the segment and the 
entire project. The Next and Prev buttons let you examine the other files and 
segments in the project. 

This command lets you compile a file in order to check its syntax. This com­
mand compiles the front window but does not add the file to the project 
window or post the results of the compilation to the project document. You 
can check the syntax of the contents of the edit window, even an untitled 
window. Compile, by contrast, works only on files that end in . c. 

This command runs the code in the frontmost window through the THINK C 
preprocessor and displays the result in a new window. It's especially useful 
if you think you have a bug in one of your macros. The preprocessor ex­
pands your macro, includes the contents of your #include files, and evalu­
ates your :fI:ifdef statements. You can save and print the contents of this 
window like you would any other file. 

This command dissasssembles the code in the frontmost window and dis­
plays the result in a new window. This command helps you figure out how 
efficient your code is and how to write inline assembly code. You can save 
and print the contents of this window like you would any other file 

This command creates a precompiled header from the contents of the front­
most edit window. Precompiled headers may not have any code or data def-
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Debug 

Compile 

Load Library 
Load Project 

Make ..• 

initions. You can include #include files (even other precompiled headers) in 
precompiled headers. 

When you're using the source level debugger, this command sends the 
frontmost edit window (or the selected file in the project window) to the 
Source window of the debugger. 

This command will compile either the contents of the active edit window, or 
the currently selected file in the project window. The results of the compila­
tion will be posted to the project document. 

Only files that end in . c can be compiled. To check the syntax of a source 
file without adding it to the project document, use the Check Syntax com­
mand instead. The Compile command is dimmed when a library file is se­
lected in the project window. 

These commands are active when the selected file in a project window is a 
library or a project. (You can use projects as libraries. See Chapter 14, "li­
braries," for details.) When you select this command, TIUNK C loads the 
code for the library into the project. To add a library to a project for the first 
time, use the Add ..• command. 

When you select this command, a dialog box appears showing all the files in 
the project inside a scroll box. The files that THINK C thinks need to be 
recompiled (or in the case of libraries, reloaded) are checked. You can alter 
the list if you like by using the cursor to check or uncheck files, or by click­
ing the Check All, Check All.c or Check None buttons. Your changes will 
not be remembered if you click the Cancel button. 

When you press the Make button, THINK C will bring the project up to date. 
It will recompile files that need to be recompiled and load libraries that need 
to be reloaded. If you press the Don't Make button, the project will be up-
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The Source Menu 

dated next time you use any of the commands that the update the project: 
Bring Up To Date, Run, Check link, or Make •••. 

Source files to compile: 3 

Libraries to load: 

~ bullHenus.c 
~bullsey~.c 

~bullYindo..., .c 

.~.~~~!.~.~.p..~ .......................... _ ......................... . 

Ch(Hk nu 

( Ch(H k nil .t: ) 

( Check None] 

Use Disk 

~ Quick Scan 

~~[ iiiiiiiiiiiiMiiiiiiiiaiiiiiiiikiiiiiiiieiiiiiiiiiiiiJ (Don't Make) ( cancel) 

Figure 20-10 The Make ... dialog 

• 

If you click the Use Disk button and the Quick Scan check box is checked, 
THINK C checks the date/time-modified of all the files in the project. Nor­
mally this is not necessary because THINK C automatically tracks the chang­
es you make as you edit. This knowledge is project-specific, though, so if 
you have a source file that belongs to two different projects and you change 
it in one, the other project won't know it's been changed unless you say Use 
Disk. 

If the Quick Scan check box is not checked, THINK C does a more extensive 
check. If a file can't be found, THINK C searches the tree the file was origi­
nally in to find the file. (The Use Disk feature can't help you detect when 
you've moved files from one tree to another. See "Moving Files Within a 
Project" on page 157 for details.) 

Use Disk displays its progress ifthe Quick Scan option is off. You can abort it 
by typing Command-. (command-period), although the next Use Disk will 
start again at the beginning. 

If a source file or library is not found by Use Disk, its status (Le. whether it is 
checked in the Make ..• box) is unchanged. However, if a source file is 
found but one of the files it includes is not found, the source file is marked 
as needing to be compiled (i.e., it is checked). 
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The Windows menu has 
three sections, separated by 
dotted lines. The first section 
has five commands: Clean 
Up, Zoom, Full Titles, Close 
All, and Save All. The sec­
ond section has an entry for 
the project window and one 
for each Untitled window. 
The third section has an en­
try for each file open in an 
edit windo~ in alphabetical 
order. 

Clean Up 

Zoom 

Full Titles 

Close All 

Clicking Cancel does not undo the effect of Use Disk. Unlike the other but­
tons, which simply add (or remove) a check mark to those specified by 
Auto-Make, Use Disk actually updates the date/time record associated with 
each file that is in the project. You can, of course, manually check or 
uncheck files after telling nUNK C to Use Disk. 

Windows Menu 

IliindonJs 
Clean Up 
200m 3€/ 
Full Titles 
Close All 
S<a~(~ HH 

myProject.l1 ~O 

Untitled 3€3 

aUHfns.c 3€ 1 
main.c 3€2 

Restacks the windows as though they were freshly opened. The rearmost 
window is assigned the first slot, as though it was the first window opened, 
the next-rearmost window is assigned the second slot, etc. The front-to-back 
order of the windows is not changed. 

Resizes the frontmost window to occupy the full screen. If the window al­
ready at full screen, it is restored to its previous position and size. This is the 
same as clicking the window's zoom box in the upper right corner of the 
window. 

This is a checkable item, initially unchecked. When checked, the title of 
each edit window indicates the volume name and directory name as well as 
the file name. 

This command closes all the edit windows. If the "Confirm Saves" option is 
checked, TI-IINK C asks whether you want to save each modified window, 
otherwise windows are automatically saved. Holding down the Command 
or Option key as you click in the close box of an edit window is the same as 
Oose All. 
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Save All 

Project window 

Edit Windows 

Windows Menu 

Saves all the modified windows. No confirmation is requested. 

The project window is brought to the front. (The menu item will be the 
name of the project, not the literal words "Project window".) 

• 

Brings the selected window to the front. The number reflects the "slot num­
ber", i.e., the initial position of the window. (The nrst created window occu­
pies slot #1, and slots #6-10 occupy the same screen positions as slots #1-5, 
etc. Slots vacated by closed windows are reused at the next opportunity.) 
The number of windows is limited only by available memory, but only win­
dows in the first nine slots have a Command-key equivalent. A diamond (0) 
appears next to windows which have been modified. 
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Debugger Menus + 
21 

~is chapter describes each of the source level debugger's menu commands. 
It is organized by menu, from left to right along the menu bar. Within each 
menu, commands are described in the order in which they appear in the 
menu. 

Some of the debugger's commands operate on the selected statement. To se­
lect a statement, just click on its line in the Source window. If there isn't a se­
lected statement, the commands operate on the current statement. 

Contents 
The Apple Menu 415 

Shortcuts ... 415 

The File Menu 415 
Save . 415 

The Edit Menu 415 
Undo 415 
Cut 415 
Copy 415 
Paste. 415 
Clear. 416 
Copy To Data . 416 

The Debug Menu 416 
Go 416 
Step. 416 
Step In . 416 
Step Out 417 
Trace 417 
Stop. 417 
Go Until Here. 417 
Skip To Here 417 
Monitor. 418 
ExitToShell 418 

The Source Menu 419 
Set Breakpoint 419 
Clear Breakpoint . 419 
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Clear All Breakpoints . 
Attach Condition 
Show Condition 
Edit 'filename.c' 

419 
419 
419 
419 

The Data Menu . . . . 420 
Clear All Expressions . 420 
Set Context . . . . 420 
Show Context . . . . . . . . . . . . . . . . . . 420 
Decimal, Hexadecimal, Character, Pointer, Address, C string, Pascal 

string, Floating Point 421 
Lock . . . . 421 

The Windows Menu. 
projectname . 
filename.c . 
Data .... 

422 
422 
422 
422 
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Shortcuts ... 

The file menu lets you use 
save your current debugging 
session 

Save 

The Edit menu lets you use 
the standard editing com­
mands on expressions in the 
Data window. 

Undo 

Cut 

Copy 

Paste 

The Apple Menu 

The Apple Menu • 
This command displays a series of dialog boxes that describe some shortcuts 
that make working with the debugger faster. 

The File Menu 

This command saves your current debugging session, including your break­
points and the contents of your data windows, so the debugger can restore 
your session the next time you use the debugger. If the "Always save ses­
sion" option is on in the Debugging section of the Options .•• dialog, the de­
bugger also saves your session whenever you quit the debugger. The 
Options ... dialog is described in "Using the Options ... Dialog" on page 179. 

The Edit Menu 

Undo 

Cut 
Copy 
Paste 
Clear 

Copy To Data :}gO 

This command undoes any edits you make to an expression in the Data win­
dow. Choosing this command is the same as clicking on the deselect button 
and then selecting the same expression again. 

This command deletes the selected text and copies it to the Clipboard. You 
can't cut text out of the Source window. 

This command copies the selected text to the Clipboard. 

This command pastes the text in the Clipboard into the current window. You 
can't paste into the Source window. 
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Clear 

Copy To Data 

Use the Debug menu to 
control the execution of your 
program. The first six com­
mands in this menu have 
equivalent buttons in the 
Source window status panel. 

Go 

Step 

Step In 

This command removes the selected expression from the Data window. 

This command is active only when the Source window is the frontmost win­
dow. It copies a selected expression from the Source window and pastes it 
into the Data window, where the expression is compiled. It's up to you to 
make sure that the text selected in the Source window is a valid expression. 
Copy To Data leaves the expression selected, so you can use some of the 
formatting commands right away. 

The Debug Menu 

Go 
step 
step In 
Step Out 
Trace 
stop 

3€G 
WS 
3€1 
3€O 
3€T 
3€. 

Go Until Here 3€H 
Skip To Here 

Monitor 3€M 
EHitToShell 

The Go command starts your program if it was stopped. Your program will 
run until you stop it (with the Stop button, for example) or until it's about to 
execute a line with a breakpoint or until it hits an exception (dividing by 
zero, for instance). If your application is already running, the Go command 
brings it to the foreground. 

The Step command goes on to the next statement marker in the current 
function. If you're at the end of a function, Step returns to the calling func­
tion. Use Step when you want to follow the execution within a function 
without falling into other functions. (Technically speaking, Step skips over 
JSRs.) 

The Step In command executes your program until the current statement ar­
row falls into a function. Step In is useful when you want to skip over a set 
of assignments or Toolbox traps, to fall into the next function call. If Step In 
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Step Out 

Trace 

Stop 

Go Until Here 

Skip To Here 

The Debug Menu • 
reaches the last statement of the current function without falling into another 
function, it will stop immediately after the current function returns. 

The Step Out command executes your program until the current statement 
arrow falls out of the current function. This operation can be slow if there's a 
lot left to do, but it's a sure way of leaving the current routine. A faster way 
of leaving the current routine is to use the Go Until Here command or to set 
a temporary breakpoint at the last diamond in the function. 

The Trace command executes the current statement. In most cases, the 
statement indicator will go on to the next statement marker, even if the next 
statement marker is in another function. The only time it won't is when the 
program counter steps into some code that the debugger doesn't have the 
source text for. This usually happens when you step into a trap that's not 
generated in line. So, for a brief period, the current statement arrow isn't re­
ally anywhere in your program, but somewhere in MacTraps instead. 
Though you can't see the current statement arrow, the current function indi­
cator at the lower left tells you which file it's in. 

The Stop command stops execution of your program. The Stop command 
works when any debugger window is active, and the Stop button only 
works when the source window is the active window. When you press the 
Stop button you'll usually be coming out of your call to GetNextEvent () 
orWaitNextEvent(). 

If your program is not in its event loop, you might not be able to make the 
debugger the frontmost application. In this case, Command-Shift-Period is 
the panic button. Use Command-Shift-Period to stop execution when one 
of your application's windows is frontmost or when you think its stuck in a 
loop. (Command-Shift-Period won't work if you're stuck in an infinite loop 
in ROM, though.) 

The Go Until Here starts execution and stops at the selected line. This com­
mand is exactly the same as setting a temporary breakpoint (see "Setting 
temporary breakpoints" on page 229) at the selected line. Use this command 
when you want to move through a block of code quickly. 

The Skip To Here command changes the program counter to the selected 
line without executing any intervening code. Use it when you want to skip 
over code you know to be buggy but not crucial to the rest of the program's 
operation. 
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Monitor 

ExltToShell 

Warning 
This command is potentially dangerous. Make sure the 
code you're skipping to doesn't depend on anything the 
skipped code does. For instance, it is a very bad idea to 
skip over initialization routines. 

The Monitor command drops you into a low level debugger. All your regis­
ters (including status registers) and low memory globals will be correct. The 
PC (program counter) will be somewhere in the source debugger, not in 
your program. You can still get the value of your PC. 

If you're using TMON, the PC is in TMON's V register. If you selected an ex­
pression in the Data window, its value is in TMON's N register. 

If you're using Macsbug, your PC is one long word before the current PC. To 
look at the instructions in your program, type: 

DM PC-4 
IL @. 

Note 
If you don't have a low level debugger installed, don't use 
the Monitor command. 

This command aborts the source level debugger. You should use your appli­
cation's Quit command to quit the debugger. Use ExitToShell only if you 
can't use your application's Quit command. 
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The Source menu contains 
commands for working with 
the Source window. 

Set Breakpoint 

Clear Breakpoint 

Clear All Breakpoints 

Attach Condition 

Show Condition 

Edit 'filename.c' 

The Source Menu 

Set Breakpoint 
Clear Breakpoint 
Clear All Breakpoints 

Attach Condition 
Show Condition 

Edit 'filename.c' 3€E 

Sets a breakpoint at the selected statement. 

Clears the breakpoint at the selected statement 

Clears all the breakpoints in the project. 

The Source Menu • 

Use the Attach Condition command to attach an expression in the Data 
window to a breakpoint to create a conditional breakpoint. To set a condi­
tional breakpoint: 

1. Set a breakpoint by clicking on the statement marker diamond 
2. Click on the line to select it 
3. Click on an expression in the Data window 
4. Choose Attach Condition from the Source menu. 

Use the Show Condition command to display the condition attached to a 
conditional breakpoint. If the selected statement has a conditional break­
point (a gray diamond), the attached expression in the Data window will be 
highlighted. 

Brings THINK C to the foreground and opens an edit window for the me in 
the Source widow. This is the inverse of the Debug command in THINK C's 
Source menu. 
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The commands in the Data 
menu operate on expres­
sions in the Data window. 
You can set and show the 
context of expressions, 
change their display format, 
and lock expressions to keep 
them from being reevaluat­
ed. 

Clear All Expressions 

Set Context 

Show Context 

The Data Menu 

Clear All EHpressions 

Set ConteHt 
Show ConteHt 

Decimal 
HeHadecimal 
Character 
Pointer 
Address 
C String 
Pascal String 
Floating Point 

Lock 

This command clears the contents of the Data window and closes all your 
array and struct windows. It's especially useful if you don't want the debug­
ger to restore the contents of your Data window the next time you use the 
debugger. 

This command makes the selected statement in the Source window the con­
text of the selected expression in the Data window. 

This command highlights the statement that is the context of the expression 
selected in the Data window. 
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Decimal 
Hexadecimal 
Character 
Pointer 
Address 
C string 
Pascal string 
Floating PoTnt 

Lock 

The Data Menu • 
These commands control how expressions appear in the Data window. The 
default format depends on the data type of the expression. The type of the 
expression also determines what other formats you can use. 

The default formats are shown in italics. 

Type 
integers 
unsigned 
pointers 

arrays 
structs 
unions 
functions 
floats 

Formats Available 
Decimal, Hex, Char 
Hex, Decimal, Char 
Pointer, Address, Hex, C String, Pascal 
String 
Address, C String, Pascal String 
Address 
Address 
Address 
Floating Point 

This is what the display formats look like: 

Format 
Decimal 
Hex 
Char 
C String 
Pascal String 
Pointer 
Address 
Floating Point 

Example 
4523345,-23576 
OxA09E1487 
'c', 'TEXT' 
"abcdef\nghi\33" 
"\pabcdef\nghi\33" 
Ox7A7000 or Ox007A7000 
[] Ox09FE44,struct Ox08FC14 
1961.0102 

The C string and Pascal string formats display non-printing characters in 
backslash form. Whenever it can, the debugger uses the built-in escape 
characters (\n, \r, \b)j otherwise it uses \nnn, where nnn is an octal val­
ue. 

Of course, you can use type casting to use formats that aren't normally avail­
able. For example, if you really wanted to see an integer, i, as a C string, you 
would type this expression: (char * ) i. 

The debugger reevaluates all the expressions in the Data window every time 
execution stops. To keep an expression from being reevaluated, select it, 
then choose Lock When an expression is locked, a small lock icon appears 
next to it. 

To unlock an expression, select the expression, and choose the Lock com­
mand again. 
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The commands in the WIn­
dows menu work on the 
source debugger's windows. 

projectname 

filename.c 

Data 

The Windows Menu 

11iindolUS 
projectname S€O 

filename.c 3€ 1 
Data 3€2 

The real name of this command is the name of your project. Choose this 
command to bring mINK C to the foreground and make the project win­
dow the active window. 

The real name of this command is the name of the file displayed in the 
Source window. When you choose this command, the Source window be­
comes the active window. 

This command makes the main Data window the active window. 
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Reference + 

22 
~INK C is a conforming implementation of the C programming language as 

defined in the ANSI C standard, A merlcan National Standard for Informa­
tion Systems-Programming Language-C X3.159-1989. This chapter de­
scribes how TI-IINK C implements those aspects of the language that the 
standard denotes as implementation defined. 

The section numbers in 
this chapter correspond to 
the sections in the ANSI 
standard. 

Contents 
Introduction. . . . . . . . . 

Implementation-defined behavior 
Undefined behavior. . . 
Setting ANSI conformance 
About the standard libraries 

Language Reference . . . . 
2.1.1.2 Translation Phases . 
2.1.1.3 Diagnostics . . .. . 
2.1.2.2.1 Program Startup . 
2.1.2.3 Program Execution 
2.2.1 Character Sets. . . 
2.2.1.2 Multibyte Characters . . . . . 
2.2.4.2.1 Sizes of Integral Types <limits.h> 
3.1.2 Identifiers . . . . . 
3.1.2.2 Linkages of Identifiers . . 
3.1.2.5 Types . . . . . . . . 
3.1.3.4 Character Constants . . . 
3.1.7 Header Names . . . . . 
3.2.1.2 Signed and Unsigned Integers 
3.2.1.3 Floating and Integral . . . 
3.2.1.4 Floating Types . . . . . 
3.3 Expressions . . . . . . . 
3.3.2.3 Structure and Union Members 
3.3.3.4 The sizeof Operator . 
3.3.4 Cast Operators 
3.3.5 Multiplicative Operators 
3.3.6 Additive Operators . . 
3.3.7 Bitwise Shift Operators . 
3.3.8 Relational Operators. . 
3.5.1 Storage"7Class Specifiers. 
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3.5.2.1 Structure and Union Specifiers 
3.5.2.2 Enumeration Specifiers. 
3.5.3 Type Qualifiers. . . 
3.5.4 Declarators . . . . 
3.6.4.2 The switch Statement 
3.8.1 Conditional Inclusion . 
3.8.2 Source File Inclusion . 
3.8.3 Macro Replacement 
3.8.6 Pragma Directive . . 
3.8.8 Predefined Macro Names . . 
4.1.5 Common Defmitions <stddef.h> 
4.2 Diagnostics <assert.h> . . . 
4.3.1 Character Testing Functions . 
4.5.1 Treatment of Error Conditions 
4.5.6.4 The fmod Function . 
4.7.1.1 The signal Function. 
4.9.2 Streams . . . . . 
4.9.3 Files . . . . . . 
4.9.4.1 The remove Function 
4.9.4.2 The rename Function 
4.9.5.2 The fflush Function . 
4.9.6.1 The fprintfFunction . 
4.9.6.2 The fscanf Function. 
4.9.9.1 The fgetpos Function 
4.9.9.4 The ftell Function . 
4.9.10.4 The perror Function . . . . 
4.10.3 Memory Management Functions . 
4.10.4.1 The abort Function 
4.10.4.3 The exit Function . 
4.10.4.4 The getenv Function 
4.10.4.5 The system Function 
4.11.6.2 The strerror Function 
4.12.1 Components of Time 
4.12.2.1 The clock Function 

TI-llNK C Extensions 
Inline assembly 
pascal keyword . 
C++ style comments 
short double type. . . . . 
Identifiers after #else and #endif 
Inline function definitions . . 
Low memory global definitions 
Mc68881 unary inline functions 
Function prototypes . . . . 
Dimensionless arrays allowed . 
Void·. . . . . . 
Predefined symbols . 

TI-llNK C Object Extensions 
Keywords . . . . 
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Introduction • 
Introduction 
This chapter describes the way mINK C implements the behavior that the 
standard identifies as "implementation defined." It also documents consis­
tent behavior in mINK C that the standard identifies as "undefined behav­
ior." These behaviors represent conforming extensions. This chapter is not a 
substitute for the ANSI standard. 

Implementation-defined behavior 
The standard defines implementation-defined behavior as: 

behavior, for a correct program construct and correct data, 
. that depends on the characteristics of the implementation 
and that each implementation shall document. 

Implementation-defined behavior covers such things as the way error mes­
sages are reported, the number of significant characters in identifiers, the 
format for integers and floating point numbers, and so on. 

Undefined behavior 
The standard defines undefined behavior as: 

behavior, upon use of a nonportable or erroneous program 
construct, of erroneous data, or of indeterminately valued 
objects, for which the standard imposes no requirements. 

In most cases, undefined behavior is ignored, generates a diagnosed error, 
or results in runtime error. This section uses the notation "(Conforming Ex­
tension)" for instances when mINK C behaves in a predictable manner for 
cases that the standard specifies as undefined. If you are writing portable C 
code, your program should not rely on the behavior described that way. 

Setting ANSI conformance 
The default options settings for mINK C are not ANSI conformant. To make 
THINK C an ANSI conformant compiler, use the Option .•. command in the 
Edit menu, choose the "Language Settings" page, and click on the "ANSI Set­
tings" button. Any options that affect ANSI conformance appear on that 
page. 

About the standard libraries 
For more information about implementation-defined behavior or mINK C 
extensions to the standard libraries described in section 4.0 of the standard, 
refer to the Standard Libraries Reference that came with your THINK C 
package. 
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The section numbers in 
this chapter correspond to 
the sections in the ANSI 
standard. 

language Reference 
2.1.1.2 Translation Phases 
The last line of a file does not need to end with a new-line character. (Con­
forming Extension) 

2.1.1.3 Diagnostics 
Errors that occur during translation are reported in a Macintosh alert box. 
The offending line is highlighted in a text editing window. Link errors are re­
ported in a "Link Errors" window. 

When the preprocessor encounters an .ferror directive, the words "#error 
directive" appear in a Macintosh alert box, and the line containing the 
.ferror directive is highlighted in a text editing window. 

2.1.2.2.1 Program Startup 
If the ccornmand function is not used, argc is set to 1, and argv [0] is the 
empty string. If the ccornmand function is used, argc and argv are set ac­
cording to the values provided in the ccornmand dialog box. See the de­
scription of ccornmand in the Standard Libraries Reference for more 
information. 

2.1.2.3 Program Execution 
In programs that use the console package, the console window is an interac­
tive device. In Macintosh programs, the interactive device is output-only. 

2.2.1 Character Sets 
The source and execution characters include the full Macintosh character 
set. 

2.2.1.2 Multlbyte Characters 
There are no shift states for muItibyte characters. Multibyte characters are 
one byte long. 

2.2.4.2.1 Sizes of Integral Types <limits.h> 
The number of bits in a character in the execution character set is eight. 

3.1.2 Identifiers 
All characters in an identifier are significant. The number of significant char­
acters in an identifier with external linkage is 255. Case is significant in iden­
tifiers with external linkage. 
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3.1.2.2 Linkages of Identifiers 

Language Reference • 
The same identifier may have internal and external linkage. Internal linkage 
takes precedence over external linkage. (Conforming Extension) 

extern int foo; 

static int foo = 63; 

3.1.2.5 Types 

/* this foo has */ 
/* external linkage */ 
/* this foo has */ 
/* internal linkage */ 

Integers are represented as 2's complement binary numbers. The sizes of in­
teger types are: 

Type Bytes 
char 1 
short 2 
long 4 
int 20r4 

You can select the size of the type int with the Options .•• command. 

The limits for the integer types are given in the header file <limi ts. h> and 
documented in the Standard Libraries Reference. 

THINK C uses five different representations for floating point values. De­
pending on the options set, different representations map to different types. 
The floating point representations are: 

• 4 byte IEEE single precision 
• 8 byte IEEE double precision 
• 10 byte SANE extended precision 
• 12 byte Mc68881 extended precision 
• 12 byte universal extended precision 

These formats, except THINK C Universal, are documented in detail in the 
Apple Numerics Manual, Second Edition (Addison-Wesley) by Apple Com­
puter and M68000 Family Programmer's Reference Manual. 

The universal floating-point format is a THINK C extension that lets TI-nNK 
C use the same format whether the program uses Mc68881 code generation 
or SANE. The universal format is the same as the Mc68881 extended format, 
but it duplicates the exponent part in the second word. 
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exponent mantissa 12 byte 

THINK C Universal 
exponent 

exponent I always zero mantissa 12 byte 
MC68881 Extended 

10 byte 
SANE Extended 

\ exponent I mantissa 

exponent \ '-~_--,--_______ m_an_t_is_sa _______ -, 8 byte IEEE 

exponent----~I·~ __ I~ __ m __ an_t_is_sa ______ ~ 4 byte IEEE 

Figure 22-1 Floating-point formats 

This table shows how tloating-point types map to tloating-point tormats. 

Type Format 
float 4 byte IEEE 

short double 8 byte IEEE 

long double 10 byte SANE 

long double 12 byte Mc68881 

long double 12 byte universal 

double long double 

double 8 byte IEEE 

3.1.3.4 Character Constants 

Option settings 
Any option setting 

"mINK C" language extension on 

"Generate 68881 instructions" off 
"Native floating-point format" on 

"Generate 68881 instructions" on 
"Native floating-point format" on. 

"Native floating-point format" off. 

"8-byte doubles" off. 

"8-byte doubles" on. 

If a string literal begins with the sequence \p or \p it is treated as a Pascal 
string. The \p or \p is replaced with the length of the string. The type of 
Pascal strings is unsigned char [], or optionally, char []. Pascal 
strings are not null terminated. 

The mapping of characters in the source character set to the execution char­
acter set is one-to-one. Multibyte characters are 1 byte long and map one-to­
one with single byte characters. 

The basic execution character set consists of all 256 Macintosh characters. 
There are no integer character constants or escape sequences that cannot be 
represented in the basic execution character set. 
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An integer constant may contain 1, 2, or 4 characters from the execution 
character set. The value of a 2-character constant 'AB' is Ox 4142 and of 
type short. The value for a 4-character constant' ABeD' is Ox41424344 
and of type long. 

The backslash character \ is ignored for all unspecified escape sequences. 
(Conforming Extension) 

3.1.7 Header Names 
In header name preprocessing, header names are treated as character strings 
with different delimiters. The characters " \, ", and / * are allowed be­
tween the < and> delimiters, and the characters " \, and / * are allowed 
between the " delimiters. (Conforming Extension) 

3.2.1.2 Signed and Unsigned Integers 
If an integer is converted to a shorter signed integer, the low-order bits are 
retained and the high order bit of the shorter integer is treated as the sign bit. 

If an unsigned integer is converted to a signed integer of equal length, and 
the value cannot be represented in the signed integer, there is no change in 
representation, but the high bit becomes the sign bit. 

3.2.1.3 Floating and Integral 
When a value of an integral type is converted to a floating type, if the value 
being converted is in the range of values that cannot be represented exactly, 
the result is rounded in the current rounding mode. The default rounding 
mode is round to nearest, and may be changed by the program. 

3.2.1.4 Floating Types 
If a floating value being converted is in the range of values that can be repre­
sented, but cannot be represented exactly, the result is rounded in the cur­
rent rounding mode. The default rounding mode is round to nearest, and 
may be changed by the program. 

3.3 Expressions 
Bitwise operations on signed integers are carried out as if they were un­
signed. 

3.3.2.3 Structure and Union Members 
If a member of a union object is accessed using a member of a different type, 
the data stored at that location are treated as if they were a member of the 
accessing type. 
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3.3.3.4 The sizeof Operator 
The type of the sizeof operator is size_t, which is defined as 
unsigned long. 

3.3.4 Cast Operators 
A pointer to a function may be converted to a pointer to an object without 
losing the value of the pointer. (Conforming Extension) 

When converting from a pointer to an integer, if the integer is 4 bytes, then it 
uses all the bits w~thout a change of representation but interpreted as the 
type of the integer. If the integer is smaller than a pointer then the low order 
bytes are used. 

3.3.S Multiplicative Operators 
The sign of the remainder is the same as the sign of the dividend. 

a b a / b a % b 

5 3 1 2 

-5 3 -1 -2 

5 -3 -+ 2 

-5 -3 1 -2 

Figure 22-2 Results of division and modulus operators 

3.3.6 Additive Operators 
Adding to or subtracting from a pointer that does not behave like a pointer 
to an element of an array is allowed. Memory is treated as a linear address 
space. Pointers that do not behave as if they point to the same array object 
may be subtracted. (Conforming Extension) 

The type of integer required to hold the difference between two pointers is 
ptrdiff_t whiCh is defined as long. 

3.3.7 Bitwise Shift Operators 
A right shift of a negative-valued signed integral type copies the sign bit in. 

3.3.8 R~lational Operators 
Pointers may be compared using a relational operator even if they do not 
point to the same aggregate or union. (Conforming Extension) 
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3.5.1 Storage-Class Specifiers 
The way TIlINK C allocates registers depends on the settings in the "Code 
Optimization" page of the Options ••• menu. 

If the "Automatic Register Assignment" option is off, the following registers 
are available to register allocation: 

Registers 
A2-A4 
D3-D7 

FP4-FP7 

Used for 
Pointer types 
Integral types, pointer types, and floats if 
"Generate 68881 instructions" is on 
12-byte floating-point types if "Generate 
68881 instructions" is on 

If the project is not an application (code resource, device driver, or desk ac­
cessory), register A4 is not available for register allocation. 

If the "Automatic Register Assignment" option is on, and the "Honor 'regis­
ter' first" suboption is on, TIlINK C places as many variables declared regis­
ter into registers as described above. 

The order that registers are allocated in is unspecified. Structs and unions are 
never placed in a register, even if they would fit into one. 

3.5.2.1 Structure and Union Specifiers 
A bit-field may be declared with any integral type.The size of the declared 
type determines the "word" size for that bit-field, so a "word" may be 8, 16, 
or 32 bits wide. 

A sequence of bit-fields with the same word size are packed into a word. No 
bit-field may be wider than its word size. If a bit-field would straddle a word 
boundary, it is placed in the next word. 

Bit-fields are assigned beginning with the high-order bit of a word. An un­
named field with a width of 0 "closes out" the current word. A bit-field with a 
different word size from the preced~ng bit-field causes this closing out to 
happen automatically, just as a non-bit-field member does. (Conforming Ex­
tension) 

A plain int bit-field is treated as a signed into 

All structures and unions are padded if necessary to be even-size. Padding is 
inserted after a member only to meet the alignment requirements of the next 
member or at the end of the structure or union. Only odd-sized data items 
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(e.g. char, odd-sized array of char, char-size enums, etc.) do not need to 
be aligned. 

3.5.2.2 Enumeration Specifiers 
Enumeration types are of type int if the "enums are always ints" option is 
on. Otherwise the type of an enumeration type is the first one in the follow­
ing list that is sufficient to hold all the values: 

"4-byte ints" off 
char 
int 
long 

3.5.3 Type Qualifiers 

"4-byte ints" on 
char 
short 
int 

In a compound assignment to a volatile-qualified type, TI-lINK C may gener­
ate a fetch and a store. Otherwise each use of the volatile-qualified type re­
sults in a fetch or a store. If the volatile object is larger than 4 bytes, the 
compiler may need to generate multiple fetches or multiple stores. 

3.5.4 Declarators 
The maximum number of declarators is at least 12 but usually significantly 
greater. The actual number depends on the particular combination of declar­
ators. 

3.6.4.2 The switch Statement 
The maximum number of case values in swi tch statements is limited only 
by available memory. 

3.B.l Conditional Inclusion 
The token defined has special meaning only if it appears literally with an 
#if or #elif directive. (Conforming Extension) 

The value of a single-character constant in a constant expression that con­
trols conditional inclusion matches the value of the same character constant 
in the execution character set. Such character constants can have a negative 
value. 

3.B.2 Source File Inclusion 
The mechanism that THINK C uses to locate header files is described in 
Chapter 9, "Files & Folders." 

The name in the # incl ude directive is interpreted as a Macintosh file 
name. Case is not significant, and colons are treated as volume and directory 
separators. 

432 THINK C User Manual 



3.B.3 Macro Replacement 

Language Reference • 
A macro argument that consists of no preprocessing tokens is treated as no 
tokens. (Conforming Extension) 

3.B.6 Pragma Directive 
THINK C implements the following ipragma directives: 

once 
option 

parameter 
nooptimize 

pragmaonce 
When this directive appears in a header file, THINK C includes it only once 
even if there is more than one iinclude directive that includes the header 
file. 

ipragma once 

pragma parameter 
This directive applies to a subsequent inline function definition and allows 
parameters to be passed in registers instead of on the stack. It specifies 
which register holds the return value and which registers parameters are 
passed in. The #pragma parameter directive must appear before the in­
line declaration. 

Note 
Inline function definitions are not normally part of the 
ANSI-conformant implementation of THINK C, but are en­
abled as a conforming extension if a #pragma parame­
ter directive appears. For more information about inline 
function definitions, see "Inline function definitions" on 
page 177. 

ipragma parameter return-regopt function-name (param-reglistopt) 

Function-name is the name of a function that is subsequently defined inline. 
If the definition is not an inline definition, never defined, or already defined, 
the directive is ignored. 

The optional return-reg can be _AD, _A1,_DO, or_D1. 

The optional param-reglist is a parameter list made up of_AD, _A1, 
_DO, _01, or_D2. 
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The inline definition must have a prototype and the prototype must not end 
with 0 0 o. The return type must be an integer type or a pointer type. The re­
turn type must be 4 bytes long if the return is in an address register. The ar­
gument types may not exceed 4 bytes, except when the inline defmition is 
declared pascal, in which case the address of the parameter is used. An 
address register can hold a 2-byte value for arguments only. In no case can 
an address register hold a 1-byte value. 

Examples: 

ipragma parameter AO NewHandleClear( DO) 
pascal Handle NewHandleClear(Size byteCount) 

= OxA322; 

ipragma parameter Delay( AO, Al) 
pascal void Delay (long numTicks,long *finalTicks) 

= {OxA03B,Ox2280}; 

pragma options 

This directive allows programmers to turn certain options on and off from 
source. 

ipragrna options (option-list) 

Option-list is a comma separated list of one of the following identifiers. If the 
identifier is given, the option is turned on. If ! identifier is given, the option 
is turned off. 

option 
signedystrs 
virtual 
indirect 
pack_enums 
trigraphs 
requireyrotos 
inferyrotos 
checkytrs 
mc68020 
mc68881 
macsbug_names 
long_macsbug_names 
profile 
honor_register 
force frame 
assign_registers 

Meaning if on 
"\po . 0" is char [] 
Methods are virtual by default 
Classes are indirect by default 
Select appropriate size for enum types 
Decode trigra phs 
Function prototypes are required 
Infer function prototypes 
Check pointer types 
Generate code for 68020 
Generate code for 68881 
Generate macsbug names 
Use long format for macsbug names 
Generate profiling calls 
Honor register declarations 
Always generate stack frames 
Assign variables to registers 
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option 
defer_adjust 
redundant loads 
global_optimizer 
gopt_induction 
gopt_cse 

gopt_loop 
gopt_coloring 

Meaning if on 

Language Reference • 
Defer and combine stack adjusts 
Suppress redundant loads 
Run global optimizer 
(global optimizer) Induction variables 
(global optimizer) Common subexpres­
sion elimination 
(global optimizer) Loop invariants 
(global optimizer) Register coloring 

For more information about using the options pragma directive, see "Ac­
cessing Option Settings in Your Code" on page 195. 

pragma nooptimize 
The nooptimize pragma directive allows the appearance of a call to a func­
tion to disable the global optimizer for the function that makes the call. 

#pragrna nooptimi ze <junction-name) 

Function-name must have already been declared as a function, otherwise it 
is an error. 

Any function that calls a function that has been the subject of the 
nooptimi ze directive will not be optimized by the global optimizer, even 
if the option is on. For an example, look at the implementation of set jmp. 

This directive should only be used for functions that have atypical flow-of­
control properties. 

3.8.8 Predefined Macro Names 
The following predefined macro names can be the subject of #undef and 
#define preprocessing directives: _LINE_, _FILE-, _DATE_, 

_TIME_, _STDC_. They must be undefined with #undef before they 
can be defined with #define. (Conforming Extension) 

The identifier defined is interpreted specially in context in tif or #elif 
preprocessing directives. It can be the subject of #define and #undef pre­
processing directives. (Conforming Extension) 

_DATE_ and _TIME_ are always available. 
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4.1.5 Common Definitions <stddef.h> 
The following types are defined in <stddef. h> 

Type 
NULL 

size t 
ptrdiff_t 

4.2 Diagnostics <assert.h> 

Definition 
«void *) 0) 
unsigned long 
long 

The diagnostic printed by assert is of the form "Assertion failed: expression, 
file .xyz, line nnn". The message appears on stderr, and, if possible, is fol­
lowed by the message "press return to exit". 

4.3.1 Character Testing Functions 
The character testing functions operate on the following ranges: 

Function Range 
isalnum a-z, A-Z, 0-9 
isalpha a-z, A-Z 
iscntrl OxOO-OxlF, Ox7F 
islower a-z 
isprint Ox20-0x7E 
isupper A-Z 

4.5.1 Treatment of Error Conditions 
The values returned by mathematics functions on domain errors are docu­
mented for each function in the Standard Libraries Reference. 

The mathematics functions do not set errno to ERANGE on underflow 
range errors. 

4.5.6.4 The fmod Function 
If the second argument to fmod is 0, fmod returns ° and sets errno to 
EDOM. 

4.7.1.1 The signal Function 
The set of signals, their semantics, the default handling of signals is de­
scribed in the documentation of signal in the Standard Libraries Refer­
ence. 

No implementation-defined blocking of signals is performed. The default 
handler is reset if a SIGILL signal is received. 

436 THINK C User Manual 



4.9.2 Streams 

Language Reference • 
The last line of a text stream does not require a terminating new-line charac­
ter. Trailing blanks are not stripped off when writing to a text stream. No null 
characters are appended to a binary stream. 

4.9.3 Files 
The file position indicator of an append mode stream initially points to the 
end of the file. Zero-length files actually exist A write on a text stream does 
not truncate beyond that point Writing in place is allowed. 

THINK C implements buffered and unbuffered I/O. Line buffered I/O is the 
same as fully buffered I/O. 

The rules for composing valid file names are identical to Macintosh file-nam­
ing rules. In general, file names may have up 31 characters, and the: char­
acter separates directory names. See Standard Libraries Reference, Chapter 
2, "Using the Standard Libraries," for more information. 

The same file can be opened more than once if the Macintosh file system al­
lows it. 

4.9.4.1 The remove Function 
It is an error to remove an open file. 

4.9.4.2 The rename Function 
It is an error to use rename to give a file a name that already exists. 

4.9.5.2 The fflush Function 
If you use fflush on a stream that is being used for input or update, and 
the most recent operation was input, the buffer is cleared, and the next read 
will go to disk. (Conforming Extension) 

The fflush function always return the buffer to a neutral state, so this func­
tion can be used to switch between input to output regardless of the last I/O 
operation. (Conforming Extension) 

4.9.6.1 The fprintf Function 
If the conversion specification for the fprintf function contains a 41= flag 
and the conversion specifier is s, the matching argument is treated as a Pas­
cal string. (Conforming Extension) 

The output for the %p conversion in fprintf is the same as %. 81X, eight 
digit, hexadecimal integer that uses capital letters and leading zeros. 
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4.9.6.2 The fscanf Function 
The input format for the %p conversion in fseanf is the same as %lx, a 
hexadecimal integer. 

A dash ( -) character that is neither the first nor the last character in the scan­
list for % [ conversion is treated as a range specifier. For example, % [ 0 - 9 ] 
means the range of characters from '0' to '9' inclusive. 

4.9.9.1 The fgetpos Function 
If fgetpos fails, errno is set to ENODEV. 

4.9.9.4 The ftell Function 
If ftell fails, errno is set to ENODEV . 

4.9.10.4 The perror Function 
The function perror prints the supplied error string, the string "Error: " 
and the value of errno. 

4.10.3 Memory Management Functions 
If the number of bytes of memory requested from ealloe, malloe, 
realloe is 0 these functions return a pointer to a unique zero-size block of 
memory. 

4.10.4.1 The abort Function 
The abort function closes all open and temporary files. 

4.10.4.3 The exit Function 
The argument to the exi t function is always ignored. 

4.10.4.4 The getenv Function 
The getenv function always returns NULL. 

4.10.4.5 The system Function 
The system function always ignores its argument and always returns zero. 

4.11.6.2 The strerror Function 
The string that strerror returns is "Error: "and the value of its argu­
ment. 

4.12.1 Components of Time 
The time functions are not aware of daylight savings time or the local time 
zone. 
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4.12.2.1 The clock Function 
The clock function returns the number of ticks (60ths of a second) since 
the Macintosh was turned on. 

THINK C Extensions 

• 

This section describes the extensions to ANSI C that are enabled when you 
set the "Language Extensions" option to "TIIINK C". 

Inline assembly 
The identifier asm is reserved for the inline assembler. For more information 
about the inline assembler, see Chapter 13, "Assembly Language." 

pascal keyword 
The identifier pascal is reserved to define functions that follow Pascal call­
ing conventions. For examples, see "Working with Pascal Routines" on page 
212. For a description of Pascal calling conventions, see "Pascal Calling Con­
ventions" on page 269. 

c++ style comments 
Two slashes (j /) introduce a comment. The comment ends at the new-line 
character. 

short double type 
The type short double is allowed. It is an 8-byte IEEE floating point 
number. 

Identifiers after #else and #endif 
An identifier after an #endif or #else preprocessing directive is ignored. 

#ifdef DEBUG 
printf ( "oops! \n") ; 

#endif DEBUG 

Inline function, definitions 
Inline function definitions are allowed. The #pragma parameter direc­
tive may be used to assign registers to parameters. An inline function defini­
tion consists of either one hexadecimal literal, or a series of comma­
separated hexadecimal literals enclosed in braces. The hexadecimal literals 
represent machine language instructions. 
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ipragrna parameter AO NewHandleClear( DO) 
pascal Handle NewHandleClear(Size byteCount) 

= OxA322; 

pascal void PrOpen(void) 
= {Ox2F3C,OxC800,OxOOOO,OxA8FD}; 

When the compiler generates code for an inline function, it merely inserts 
the machine code. 

low memory global definitions 
Global variables may be defined to refer to absolute memory addresses. 

extern short MemErr : Ox220; 

This construct is only legal in global scope. The extern storage-class speci­
fier is optional. It was required in earlier versions of mINK C. 

MC68881 unary inline functions 
Unary inline functions for the Mc68881 may be defined like this: 

double atanh (double) : OxOD; 

The value after the colon is used as the seven bits of the second word of the 
Mc68881 instruction. See <rna th . h> for examples. 

Function prototypes 
The parameter list ( ... ) is allowed in a function prototype. 

Dimensionless arrays allowed 
Dimensionless arrays are allowed as the last member of struct definitions. 
The member does not contribute to the size of the struct. For example: 

struct { 
short count; 
char data[]; 

} CountData; 

Void * 

/* sizeof(CountData) is 2 */ 

The type void * is compatible with function pointers and data pointers. 

Predefined symbols 
The preprocessor symbol THINK_Cis defined as 5 in TIHNK C 5.0. It is de­
fined as 1 in TI-IINK C 4.0. It is not defined at all for prior versions. 
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THINK C Object Extensions 
This section summarizes the extensions to ANSI C when the "Language Ex­
tensions" option is set to "TIIINK C + Objects". For more information about 
the way THINK C implements objects, see Object-Oriented Programming, 
Chapter 4, "Using Objects in TIIINK C." 

Keywords 
When the "TIIINK C + Objects" language extension option is on, TIIINK C 
reserves the following names as keywords: 

class 
new 

delete 
virtual 

The following names are interpreted specially in context, but they are not 
keywords: 

direct 
operator 
public 

indirect 
private 
this 

inherited 
protected 
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What's New + 
A 

Just about all of THINK C has been rewritten for THINK C 5.0. The most im­
portant change is the new ANSI-conformant compiler. 

Note 
The section "Porting to mINK C 5.0" on page 458 gives 
you some guidelines on how to proceed. If you read noth­
ing else in this appendix, read that section. 

The other changes you'll find in this appendix include System 7 support, an 
optimizer, and new object extensions. 

Contents 
Upgrading mINK C . . . . . . 

Compatibility with earlier releases 

System 7 Compatible. . 

100% ANSI -Conformance 

Optimizing Compiler. . 

Other Compiler & Linker Features 
More control over the compiler . 
New ways of looking at your code. . . . . . 
Including preprocessor code throughout your project 
Fewer limits on large programs 
Easier to port programs 

Debugger Remembers Settings. 

New Editor Features . . . . 
New function key shortcuts 
GoTo Line.... . . . . 
Markers. . . . . . . 
New Add ... dialog . . . 

Calling Macintosh Toolbox Routines . 
Using MacHeaders 
Using MacTraps . . . . . . 
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Using Toolbox interface files 

New Command-key Equivalents 

More Object Extensions . . . . . . . . 
More object.:.oriented programming features 
Class Browser . . . . . . . . . 
Expanded mINK Class Library 

Rewritten Manual on the Standard Libraries . 

Porting to TIDNK C 5.0. . . . . . . . 
Double check your Toolbox function calls 
long and Point are not the same type 
short and int are not the same type . . . 
Beware of promotable types . . . . . 
Function prototypes must have a return type 
Declaring function arguments 
Get rid of extra punctuation . . . . . 
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Upgrading THINK C 

Upgrading THINK C • 
To upgrade your copy ofTI-IINK C, backup and delete all the files that came 
in the TI-IINK C package and upgrades (but not your own projects and 
source files). Then follow the instructions in Chapter 2, "Installing THINK C 
5.0." Since this upgrade includes many new or revised libraries, you should 
reinstall everything from scratch. 

Compatibility with earlier releases 
THINK C 5.0 automatically reads and converts projects created with WINK 
C 3.0 and later. All object code will be removed, so you will need to recom­
pile the project. TI-llNK C 5.0 can use libraries created with THINK C 3.0 and 
later. But be sure to use the new version of Mac Traps and all other sup­
plied libraries. 

You will not be able to use projects or libraries from versions earlier than 3.0. 
Instead, create a new project and add your existing source files. 

System 7 Compatible 
TI-llNK C 5.0 is System 7 compatible. It lets you and your applications take 
full advantage of the new system software. THINK C 5.0 does the following: 

• Runs with 32-bit addressing 
• Produces applications that run with 32-bit addressing Oike all ver-

sions since mINK C 3.02) 
• Runs with virtual memory 
• Recognizes all Toolbox routines in Inside Macintosh VI 
• Contains the THINK Class Library 1.1, with System 7.0 support. 

TI-llNK C lets you work with the alias of a project file. The project tree begins 
where the original project is. However, mINK C does not support aliases in 
these cases: 

• Putting aliases in a project 
• Including aliases in an =It incl ude statement 
• Using an alias as a project's resource (. rsrc) file 
• Inserting an alias of a folder in your 1HINK C tree or project tree. 

100% ANSI-Conformance 
TIDNK C 5.0 is 100% ANSI-conformant. In addition to function prototypes 
and new-style declarations, it now supports stricter type-checking and the 
const and volatile qualifiers. 
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Since THINK C 5.0 is ANSI-conformant, you may need to revise some pro­
grams that compiled under earlier versions ofTI-IINK C. To port your code to 
this new compiler, see "Porting to TI-IINK C 5.0" on page 458. 

To compile ANSI-compatible code, you have to set up some options in the 
Options •.• dialog. For more information, see "Compiling ANSI-Conformant 
Code" on page 182. 

As in the previous version of mINK C, the ANS I library is a complete imple­
mentation of the ANSI standard library. It's described in the Standard Librar­
ies Reference. 

Optimizing Compiler 
THINK C can optimize your code, so it runs faster and takes up less space. 
The global optimizer, which adds an additional pass over your code, can do 
the following: 

• Induction variable elimination 
• Common sub-expression elimination 
• Code motion 
• Register coloring. 

The TI-IINK C compiler can also perform these optimizations, without the 
global optimizer: 

• Defer & combine stack adjusts 
• Suppress redundant loads 
• Automatic register assignment. 

Other Compiler & Linker Features 
The TI-IINK C 5.0 compiler is completely new. This section describes some 
of the most important features, including more control over the compiler, 
new wa ys to look at your code, the project prefix, and options to make port­
ing code easier. And the linker lets you write programs with virtually no limit 
on the number of routines or global variables. 

For information on more new compiler features, see Chapter 10, "The Com­
piler. " To port your existing code to the new compiler, see "Porting to 
THINK C 5.0" on page 458. 
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More control over the compiler 
The Options ••• dialog includes many more options than earlier versions of 
TI-llNK C. You now have control over more aspects of the TIDNK C compil­
er, including the following: 

• How to optimize your code 
• Which language extensions to use 
• The sizes of int and double 
• How to represent floating-point numbers 

For more information, see "Using the Options ... Dialog" on page 179. 

@ This Project ( » Copy» ) o New Projects 
-

[;]1 Preferences I 

S .. rch Options !81 Confirm project updates 
o Whole words only ] !81 Confirm saues 
o Wrap around o Rlways compact projects 
!8Ilgnore case o Generate link mop 

!81 Projector-aware 

I This Is 1M Options d~lo9. Click on ~ button t. find out mo,.. about th~t 

I 
option. Uu 1M pop-IJp "........ to 90 to a sp.cific p~. or us. t~ ~row button to 
mov. 1M IWxt or prnious p~s. 

( Factory settings) (( OK ~ ( Cancel ) 

Figure A-l The Options ... dialog 

Your can also test and change these options in your code with the 
#"pragma options and _option directives. For more information, see 
"Accessing Option Settings in Your Code" on page 195. 

New ways of looking at your code 
TIDNK C 5.0 lets you look at your code and finished applications in three 
new ways to help debug your programs and understand how they work: 

• To debug your macros, use the Preprocess command in the 
Source menu and see the preprocessor output for your file. 

• To see how THINK C compiles your code, use the Disassamble 
command in the Source menu and see the assembly code your 
file produces. 

• To see a map of what's in your finished application, use the 
"Generate link map" option in the Preferences page of the Op­
tions .•• dialog. 
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For more information on these reports, see "11IINK C Reports" on page 167. 

Including preprocessor code throughout your project 
The project prefIx lets you include some text in all the source fIles in your 
project. It's as if you put the code at the beginning of all your source fIles. 
For example, you could put the line idefine DEBUG in the project pre­
fIx, and the symbol DEBUG is defined in all your project's fIles. You set the 
project prefIx on the PrefIx page of the Options ••• dialog. For more infor­
mation, see "Using the Project PrefIx" on page 181. 

@ This Project ( » Copy» } o New Projects 

[;)1 PrefiH I 
#Include <MatHea den> 

I This is u.. Option. di~lo<J. Click on at'o\I button to find out mo,.. ~t th~t 
option. Un u.. pop-up rntnu to 90 to ~ s~ific P •• or' us. t~ wro'af button to 
mov. u.. Mxt or' pr.viou. P.s. 

( rectory settings) (( OK )) ( Cencel ) 

Figure A-2 The Prefix page of the Options ... dialog 

Fewer limits on large programs 
In previous versions of THINK C, large programs could run out of space for 
global data or the jump table. In THINK C 5.0, you have an almost unlimited 
amount of space for global data and a jump table with the "Far CODE" and 
"Far DATA" options in the Set Project Type ••• dialog. For more information, 
see "Using a larger jump table with Far CODE" on page 100 and "Using more 
global data with Far DATA" on page 100. 

Easier to port programs 
Porting a program to THINK C can be especially difficult if a program as­
sumes that the type int or double is a different size from THINK C's. 
THINK C 5.0 includes two options that let you change the size of those types 
and port programs more easily: "4-byte ints" and "8-byte doubles." For more 
information, see "Porting code from other compilers" on page 193. 

Debugger Remembers Settings 
By default, the 11IINK C debugger remembers its state when you leave the 
debugger. The debugger remembers all of your breakpoints, the expressions 
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in the Data window, and the positions of all your debugger windows. For 
more information, see "Saving the Debugger State" on page 242. 

New Editor Features 

• 

The TI-IINK C editor has new features to help you move around files quicker. 

New function key shortcuts 
The TI-IINK C editor uses more function keys to help you move inside your 
files faster. This table describes what they do: 

Press this key ... 
Command-left-arrow 
Command-Right-arrow 
Forward Delete (00) 
Home 
End 
Page Up 
Page Down 
Option-Page-Up 
Option-Page-Down 
Option-Home 
Option-End 

Go To Line ... 

To do this ••• 
Move the insertion point left one word. 
Move the insertion point right one word. 
Delete the next character. 
Scroll to the beginning of the me. 
Scroll to the end of the file. 
Scroll to the previous screen. 
Scroll to the next screen. 
Scroll to the left. 
Scroll to the right. 
Scroll all the way to the left 
Scroll all the way to the right 

The Go To Line ••. command in the Edit menu lets you move to a specific 
line in your file. For more information, see "Moving to a specific line" on 
page 132. 

~ OK J) 
1
23 Go To Line: 

( Cancel ) 
Figure A-3 The Go To Line ... dialog 

Markers 
Markers let you move around your program quickly. They work like book­
marks in a book. You can place markers at the beginning of each routine, or 
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just at certain key points in your program. For more information see "Using 
Markers" on page 134. 

o bullseye.c 
-include "bullMenus '\"HandleEuent 
-include "bulll.lindc HandleMouseDown 

extern Windowptr 
extern Aect 

How does this code work? 
I nitMacintosh 

void InitMacintosh( main 
vo i d Hand I eMouseDow'-n"""":(:-::E~ve-n"":"t:"Re-c-o-rd-:--"""":*~t":""h-:eE=-v-e-n t~)~;--
void HandleEvent(void); 

1**** 
* InitMacintosh() 
* * Initialize all the managers & memory 
* ****1 

Figure A-4 The marker pop-up menu 

New Add ... dialog 
The Add ••. dialog now lets you add several files to your project at once. For 
more information, see "Using Libraries" on page 273. 

CJ RppleTalk 
CJ CommToolBoH 
CJ Graf3D 
CJ MacTraps 
CJ nAppleTalk 
CJ PrGlue 
CJ SANE 

Figure A-S The Add ... dialog 

C) Rkbar 

( Driue 
..................................•........• 
( 

Rdd D 
Rdd RII 
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For more information on 
calling Madntosh Toolbox 
routines, see Chapter 11, 
"Working with the Toolbox. 'I 

Calling Macintosh Toolbox Routines • 
Calling Macintosh Toolbox Routines 
THINK c 5.0 handles Toolbox routines differently to take advantage of the 
new project prefIx option and to be more compatible with the interfaces 
from Apple. 

Note 
Since TI-IINK C 5.0 supports ANSI C's stricter type-checking 
you may need to revise some of your code. For more infor­
mation, see "Porting to TIIINK C 5.0" on page 458. 

Using MacHeaders 
TI-llNK C 5.0 no longer has a "<MacHeaders>" option. Instead, to use 
MacHeaders, make sure the line #include <MacHeaders> is in the 
project prefIx on the Prefix page of the Options ... dialog. When you com­
pile, THINK C acts as if the project prefIx is at the beginning of all your files. 
You still can't #include more than one precompiled header in your project. 

When you create a new project, TI-IINK C automatically inserts the line 
iinclude <MacHeaders> in the project prefix. When you convert a 
project from a previous version of THINK C, THINK C includes the line 
iinclude <MacHeaders> only if you had checked the u<MacHeaders>" 
option. 

Using MacTraps 
Since System 7.0 adds many new routines to the Macintosh Toolbox, the 
glue for the Toolbox is now in two libraries: MacTraps and MacTraps2. 
Old programs need only MacTraps. But if you revise your program to take 
advantage of System 7.0, it also needs MacTraps2. MacTraps contains 
glue for routines in Inside Macintosh 1-V. defInitions for QuickDraw globals, 
and the Gestalt glue. MacTraps2 contains glue for routines in Inside Mac­
intosh VI and less common routines. 

Using Toolbox interface files 
Beginning with this version, THINK C uses virtually the same header files 
that Apple provides with its MPW C compiler. In some cases, where the 
compilers differ, THINK C has its own header files or uses modified versions 
of the header files. For more information, see "The Macintosh Header Files" 
on page 208 

!fyour project uses MacHeaders, you don't need to change any of your 
sources. The MacHeaders that comes with TIIINK C 5.0 uses the new files. 
!fyou have a custom version of Mac Headers or include some Toolbox 

THINK C User Manual 453 



• A What's New 

header files on your own, you need to update your 41= incl ude statements to 
use the new file names. 

The new Toolbox interfaces are organized along the lines of the Inside Mac­
intosh chapters. Each file contains the routines described in a chapter of In­
side Macintbsh. For example, 

This file ... 
Events.h 
windows.h 
Menus.h 

Contains the routines described in ••• 
Vol. I, Chapter 8, "The Toolbox Event Manager" 
Vol. I, Chapter 9, "The Window Manager" 
Vol. I, Chapter 11, "The Menu Manager" 

This table will help you update your 4tinclude statements. However, the 
new file doesn't always contain ail the definitions that were in the old file. If 
THINK C complains that a function isn't prototyped, look for it in another 
file. 

Old File 
Appletalk.h 
asm.h 
Color.h 
ColorToolbox.h 
ControlMgr.h 
DeskBus.h 
DeskMgr.h 
DeviceMgr.h 
DialogMgr.h 
DiskDvr.h 
EventMgr.h 
FileMgr.h 
FontMgr.h 
HFS.h 
IntlPkg.h 
ListMgr.h 
MacTypes.h 
MemoryMgr.h 
MenuMgr.h 
MultiFinder.h 
nAppleTalk.h 
OSUtil.h 
PackageMgr.h 
pascal.h 
PrintMgr.h 
PrintTraps.h 

New File 
same 
same 
Quickdraw.h 
Quickdraw.h 
Controls.h 
same 
Desk.h 
Devices.h 
Dialogs.h 
Disks.h 
Events.h 
Files.h 
Fonts.h 
Files.h 
Packages.h 
Lists.h 
Types.h 
Memory.h 
Menus.h 
Memory.h 
AppleTalk.h 
OSUtils. h (note the s) 
Packages.h 
same 
Printing.h 
same 
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Old File 
Quickdraw.h 
ResourceMgr.h 
SANE.h 
ScrapMgr.h 
ScriptMgr.h 
SCSIMgr.h 
SegmentLdr.h 
SerialDvr.h 
SetUpA4.h 
SlotMgr.h 
SoundDvr.h 
SoundMgr.h 
StartMgr.h 
StdFilePkg.h 
SysErr.h 
TextEdit.h 
TimeMgr~h 

ToolboxUtil.h 
video.h 
VRetraceMgr.h 
WindowMgr.h 

New Command-key Equivalents • 
New File 
same 
Resources.h 
same 
Scrap.h 
Script.h 
SCSI.h 
SegLoad.h 
Serial.h 
same 
Slots.h 
Sound.h 
Sound.h 
Start.h 
StandardFile.h 
Errors.h 
same 
Timer.h 
Toolutils.h 
same 
Retrace.h 
Windows.h 

New Command-key Equivalents 
The Command-key equivalents for Close, Print ... , and Select All now fol­
low the common Macintosh conventions. These are the new Command-key 
equivalents: 

Command 
Close 
Print. .. 
Select All 

Key 
Command-W 
Command-P 
Command-A 

These commands now have command-key equivalents: 

Command 
Options ... 
Go To Line ... 
Mark. .. 
Browser 

Key 
Command-j (Semicolon) 
Command-, (Comma) 
Command-M 
Command-J 
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To free up Command-keys, these commands have different Command-key 
equivalents from what they had in previous versions of mINK C. 

Command 
Find Again 
Replace 
Replace and Find Again 
Debug 
Get Info 
Make ... 

More Object Extensions 

New Key 
Command-G 
Command-= 
Command-H 
Command-I 
none 
Command-\ 

Old Key 
Command-A 
Command-P 
Command-W 
Command-G 
Command-I 
Command-M 

THINK C 5.0 makes it easier to write object-oriented programs with more 
object extensions, a class browser, and an enhanced class library. 

More object-oriented programming features 
THINK C includes more object-oriented extensions, including: 

• The class keyword 
• Both virtual and non-virtual methods 
• Access control, with public, pri vate, and protected 
• Allocators and deallocators (also called operator new and 

operator delete) 
• Constructors and destructors 
• Class functions (also called static member functions) 
• Class variables (also called static members). 

For more information, see Object-Oriented Programming Manual, Chapter 
4, "Using Objects with THINK C. " 

Class Browser 
The Class Browser window shows the hierarchy of your classes and helps 
you to explore it. To display the Browser, choose the Browser command in 
the Source menu. For more information, see Object-Oriented Programming 
Manual, Chapter 6, "The Class Browser." 
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Figure A-6 The Class Browser 

Expanded THINK Class Library 
TI-llNK C 5.0 includes the TI-IINK Class Library 1.1, which contains many 
new and improved classes, such as 

• Improved text-handling, including more Undo support and a 
styled text pane 

• System 7 support, including AppleEvents, aliases, and more 
• Improved error-handling 
• Larger panes, with 32-bit coordinates 
• Improved printing support 
• Multi-window document support. 
• Classes for dialogs, tables, and pop-up menus 

• 

For more information, see Object-Oriented Programming Manual, Chapter 
7, "Using the TI-IINK Class Library." 

Rewritten Manual on the Standard libraries 
If you use TI-UNK C's standard libraries Oike ANSI or unix), look at the 
completely revised Standard Libraries Reference. It contains more detailed 
information on how TI-IINK C implements the ANSI standard library and in­
cudes example programs for almost all the functions in the libraries. 
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For more information on the 
"Strict Prototype Enforr:e­
ment" option, see "Check­
ing pointer types" on page 
188. 

Porting to THINK C 5.0 
TInNK C 5.0 includes a completely new compiler and reorganized header 
files. If you were careful to write easily portable code, you'll need to revise 
very little. If you didn't write easily portable code, you'll need to revise much 
more. 

TInNK C is now 100% conformant with the ANSI standard for the C lan­
guage. You can disable its stricter type checking and new features, such as 
trigraphs, in the Options •.• dialog. For more information, see "lliINK C Ex­
tensions" on page 174 and "Type Checking" on page 188. 

This section describes changes that are especially important for mINK C 
and Macintosh programmers. For more general advice on ANSI C, read a 
book on ANSI C, such as The C Programming Language, Second Edition by 
Kernighan and Ritchie, or (better still) a book on porting, such as Portability 
and the C Language (Hayden Books) by Rex Jaeschke. 

Double check your Toolbox function calls 
In mINK C 5.0, the arguments in your Toolbox function calls must be type­
compatible with the function's formal arguments. It's no longer enough for 
your arguments to be the same size. They now must be the right type, too. 

You can disable the stricter enforcement by turning off the "Strict Prototype 
Enforcement" option in the Language Settings page of the Options .•. dia­
log. However, you'll probably find that stricter enforcement saves you time 
in the long run by catching more bugs. Disable the option only if you're 
porting code from a previous version of lliINK C and you're sure it ran 
properly. 

Stricter prototype enforcement is especially noticeable with arguments that 
are declared as pointers. It's no longer enough for the argument to be four 
bytes long. You must now make sure that you cast the argument to a pointer 
type. For example, the last argument to GetNextWindow () must be a 
pointer, so you must change a call like this 

GetNewWindow(resID, OL, -lL); 

to one of these: 

GetNewWindow (resID, OL, (void *) -1); I I OK 
GetNewWindow (resID, OL, (Ptr) -1); I I OK 
GetNewwindow(resID, OL, (WindowPtr) -1); II BEST 

When you pass a callback routine to a Macintosh Toolbox function, you 
must prototype it properly. For example, to use a modal dialog filter, you 
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must declare a filter of type ModalFilterProcPtr, which Apple declares 
like this, in Dialogs. h: 

typedef pascal Boolean (*ModaIFilterProcPtr) ( 
DialogPtr theDialog, EventRecord *theEvent, 
short *itemHit ); 

You must prototype your filter like this: 

pascal Boolean MyFilter (DialogPtr myDialog 
EventRecord *myEvent, short *myltem); 

And call ModalDialog () like this: 

ModalDialog(MyFilter, anltem); 

If you want even stricter prototype enforcement for your Toolbox calls, com­
ment out the #pragma options directive in Mac #includes. c, as 
shown below, and recompile it. 

II comment out this line for full prototypes 
II #pragma options(!check-ptrs) 

Now you must be sure that your arguments are exactrythe right pointer 
type, not just any pointer type. For example, the call to GetNewwindow ( ) 
must look like this: 

GetNewWindow (resID, OL, (WindowPtr) -lL ); 

long and Point are not the same type 
The types long and Point are the same size, but they are not compatible 
types. If you want to pass a long int as a Point, you must cast it. For 
example, this code won't work: 

Re c t r = { 0 , 0 , 1 0 , 1 0 } i 

if ( PtlnRect (OxOOOS0006, &r) ) { ... } 
II ERROR: OxOOOS0006 is a 
II long literal, 
II not a Point 

Unfortunately, the correction isn't as simple as you might think. You cannot 
cast a long literal to a Point. You must assign the value to a temporary 
variable and cast the variable. Also, you cannot cast a long directly to a 
Point. You must take the address of the long, cast the address to 
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(Point *), and dereference it with *. For example, you can change the 
example above to this: 

Rect r = { 0, 0, 10, 10 }; 
long p = OxOOOS0006; 

if ( PtlnRect(*(Point *)&p, &r) ) { ..• } 
II OK: p is cast correctly. 

Or, better yet, to this: 

Rect r = { 0, 0, 10, 10 }; 
Point p = { OxOOOS, Ox0006 }; 

if ( PtlnRect (p, &r) ) { ... } 
II BEST: p is a Point 

short and int are not the same type 
In TI-IINK C, int and short int are the same size by default, but they 
are not compatible types. For example, using this function prototype with 
this function definition will give you an error: 

int square (int); 

short square (short x) 
{ 

return x*x; 

Note 

II ERROR:int doesn't 
II match short 

For more portable code, use short instead of into Not all 
compilers for the Mc6sooo have the same size int, but 
they all have the same size short. 

Beware of promotable types 
As the ANSI standard requires, TI-IINK C uses argument promotion to be 
compatible with old programs. In argument promotion, TI-IINK C promotes 
a short or char argument to int, and promotes a float or short 
double argument to double. TI-IINK C performs argument promotion in 
these two cases: 

• Calling a function without a prototype 
• Using an old-style function declaration. 

Argument promotion can cause a lot of trouble if you mix old-style defini­
tions and new-style declarations. Your best defense is to avoid mixing them. 
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Either leave your old declarations alone or convert all of them. Don't go half­
way. 

Argument promotion can also cause trouble if you call a function without a 
prototype. For example, the following program won't work: 

main () 
. { 

short j, i = 2; 
j = square(i); 

short square(short x) 
{ 

return x*x; 

II ERROR: Declaration 
II doesn't match 
II THINK C's 
II expectation. 

When you first use square () , THINK C assumes that it returns an int and 
that its argument isn't a promotable type. When THINK C sees how you ac­
tually declare square (), it assumes you made a mistake and gives you an 
error. 

The best solution to this problem is to use a prototype, so TIIINK C doesn't 
create a declaration, like this: 

short square(short); 

main () 
{ 

short j, i = 2; 
j = square(i); 

short square(short x) 
{ 

return x*x; 

II Use a prototype so 
II there's no confusion. 

II RIGHT: Declaration 
II matches 
II prototype. 

Argument promotion can also cause trouble if you prototype a function that 
you declare with an old-style declaration. In this example, the prototype and 
declaration don't match since TIIINK C promotes x from short to into 

int square(short); 

int square (x) 
short x; 

return x*x; 

II ERROR: THINK C promotes x 
II to int, so it does 
II not match prototype. 
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For more information on 
"Require prototypes, " see 
"Type Checking" on page 
788. For more information 
on the Options ... dialog, 
see "Using the Options ... 
Dialog" on page 779. 

The best solution is to convert the old-style declaration to a new-style decla­
ration, like the one above. However, if your source files contain a lot of old­
style declarations, you have another solution. If you turn on the "Require 
prototypes" and "Language Extensions" options in the Language Settings 
page of the Options ... dialog, TIIINK C does not promote arguments in 
old-style declarations. TIIINK C can do this because, with "Require proto­
types" on, it knows you've proto typed all your functions properly. 

Function prototypes must have a return type 
You must include a return type in a prototype. Previous versions ofTIIINK C 
assumed that the return type was into This was accepted as a prototype in 
previous versions of TIIINK C: 

square (int); II ERROR: No return type 

You must include the int declaration: 

int square (int); II RIGHT: Includes return type 

You can still leave out the return type in a function definition, and TIIINK C 
assumes it returns an into However, it's best to always include a return val­
ue for more readable code. 

Declaring function arguments 
TIIINK C is more strict when you use functional arguments. The function 
you pass must be declared exactly like the argument in the declaration. For 
example, this code won't compile: 

void foo(void); 
void bar(int); 
void bar(char); 

void DoFunc( void f(void) ); 

main () 
{ 

DoFunc(foo); 

DoFunc(bar); 

DoFunc (baz) ; 

II A function that takes 
II another function as an 
II argument. 

II OK: 
II 
II 
II ERROR: 
II 
II ERROR: 
II 

foo() matches the 
prototype for the 
argument 
bare) doesn't match 
the prototype. 
baz() also doesn't 
match the prototype. 
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If your argument must match functions with different argument lists, declare 
the functional argument with ( •.. ) . However, it will not match functions 
that use arguments with promotable types. For example, if you define 
DoFunc () like this: 

void DoFunc( void f( ... ) )i 

it can take f 00 () and ba r () as arguments, but not ba z ( ) . 

You can declare functional prototypes with ( ... ) only if the "TI-IINK C" ex­
tensions option is on. For more information see "TI-IINK C Extensions" on 
page 174. 

Get rid of extra punctuation 
THINK C 5.0 does not allow a semicolon after the closing brace in a function 
definition For example, this function definition is wrong: 

int square (int x) 
{ 

return x*x; 
} ; II ERROR: Semicolon after 

II last brace. 
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Troubleshooting + 
B 

TrOUbleshOOting is the most time-consuming part of writing any program. 
This appendix describes how to solve some common problems you might 
have while using mINK C. Among the problems discussed are 

• Crashing 
• Bomb alerts, like the one in Figure B-2 
• The "out of memory" bug alert 
• Unexpected function results. 

This appendix does not discuss bug alerts with error messages, like the one 
in Figure B-1. Appendix C, "Error Messages," describes these messages and 
suggests how to fix the errors. This chapter does discuss how to avoid bomb 
alerts, like the one in Figure B-2, and the "out of memory" bug alert. 

II j\ 'Y"'ONeITO' 
II 

Figure B-1 A bug alert, explained in Appendix C, "Error Messages." 

Sorry, a system error occurred. 

10 - xx 

Figure B-2 A bomb alert, explained in this appendix. 
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How to Find Your Solution • 
How to Find Your Solution 
To find the solution to your problem, start with the section "First Try This ... " 
below. It describes how to solve some problems that can crop up no matter 
what you're doing. 

If those solutions don't work, determine when your problems occurs and 
look at the appropriate section: 

• "Launching THINK C and Opening Projects" on page 469 
• "Compiling a Project" on page 470 
• "Crashing While Running Your Project" on page 471 
• "Getting Unexpected Function Results" on page 473 
• "Using the Debugger" on page 476. 

If you can't find a solution in the appropriate section, try reading the other 
sections. Sometimes, you don't notice a problem until well after its cause has 
passed. 

As a last resort, read "When All Else Fails ... " on page 477. It tells you how to 
call Symantec Technical Support. 

First Try This ... 
This section describes how to solve the most common problems that can 
show up no matter what you're doing in THINK C. 

• Check for virus infection 
• Investigate virus alerts 
• Check for INIT conflicts. 

Check for virus infection 
Viruses cause a large number of unpredictable problems that you can easily 
confuse with programming errors. If you program frequently, you need anti­
viral software, like SAM (Symantec Antivirus for Macintosh), Virex, or Disin­
fectant. Be sure to read the documentation and use the software diligently. 

A common virus is nVIR, especially in computer labs or any place where 
many people use one machine. The nVIR virus is easy to find without spe­
cial software. Open your THINK C application with ResEdit and look for any 
nVIR resources. If you find any, get an antivirus program to eliminate it. 
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Viruses frequently cause these problems: 

• A "Don't Panic" dialog. A classic symptom of the nVIR virus. 
• Extra beeping when launching or quitting an application. An 

nVIR symptom. 
• Crashing when you quit an application. An nVIR symptom. 
• Getting a bomb alert with ID=-39. An nVIR symptom. 
• The "Out of Memory" bug or bomb alert. Viruses sometimes take 

up memory and do nothing else. If you can't find any other possi­
ble causes, look for a virus. 

Investigate virus alerts 
If your antivirus software detects suspicious activities, it will alert you fre­
quently when you use TI-IINK C. TI-IINK C creates code resources from your 
source files and adds them to files, usually applications and desk accessories 
you're creating. Adding code resources is an activity that antivirus software 
finds suspicious. 

If your antivirus software tells you that TI-IINK C is adding or changing a re­
source to a file, check for a virus. If you have no virus, continue what you 
were doing and let TI-IINK C make the change. If you can teach your antivi­
rus software to let some programs make changes, you 'n want to teach it to 
let TI-IINK C add and change resources. 

Check for INIT conflicts 
Poorly behaved INITs (or Startup Documents) also cause a large number of 
unpredictable problems that are easily confused with programming errors. 

If your program has a problem that you can't find in your code, reboot your 
Macintosh without any INITs. You can do this two ways: 

• Remove all the INITS from your system folder and reboot. 
• Create a new system folder, put the System and Finder from your 

old system folder in it, and reboot. 

If the problem disappears, you know an INIT helped cause it. 

To find a troublesome INIT, remove half your INITs and reboot. If there's no 
problem, you know the INIT is in the half you removed. If there still is a 
problem, you know the IN IT is in the half you let remain. Split the half with 
the troublesome INIT again and continue this process until you find it. 
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Old version of these INITs frequently cause problems with TIIINK C. If you 
have any problems, make sure you're using the most recent versions. 

• MacroMaker 
• Automac 
• MasterStrokes 
• SuperClock 
• early versions of Easy Access 
• Radius FPD and Radius TPD 
• QuickFolder 
• Staircase 
• Stepping Ou t II 

launching THINK C and Opening Projects 
This section describes how to solve problems that happen when you launch 
THINK C or open a project, either by choosing Open Project .•. in TIUNK C 
or by double-clicking on a project in the Finder. 

Look for your problem in this list, and read its suggested solution. If you 
can't find your problem here, try going through all the solutions. 

• Crashing. Read "Low memory" on page 469. 
• The "Out of Memory" bug alert. Read "Low memory" on page 

469. 
• An error alert with ID=-192. Read "Missing resource error" on 

page 470. 
• An error alert with ID=-39. Read "Check for virus infection" on 

page 467. 
• A "Don't Panic" alert. Read "Check for virus infection" on page 

467. 
• Extra beeping. Read "Check for virus infection" on page 467 

Low memory 
If you're using the THINK C debugger, see the "Memory Considerations" on 
page 246. Otherwise, you may have too small a partition for TIIINK C or a 
corrupted project file. Try these solutions: 

• Change THINK C's partition size. When you work with a large 
project, especially one that uses the THINK Class Library, TIIINK 
C may need more memory than it usually does. To change the 
partition size, select TIIINK C in the Finder, choose Get Info ••• 
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To learn how to edit 
MacHeaders, see "Editing 
the MacHeaders file" on 
page 765. 

from the File menu, and edit the value in the box labeled "Appli­
cation Memory Size" (or "Current Size" in System 7). 

• Recompile your project. If you can't compile or run your project, 
. its object code may be corrupted. Choose Remove Objects from 
the Project menu and recompile your project. 

• Rebuild your project. Sometimes, a buggy project accidentally 
writes to its project file and corrupts it. If you can't open your 
project, try opening another one. If it does open, rebuild your 
project from scratch, creating a new project file and adding the 
source files. 

• Reinstall THINK C. A buggy project may damage your mINK C 
application. If you think your THINK C application is damaged, 
reinstall mINK C on a different disk or on a different folder on 
your floppy. If you can get your work done with the new copy, 
use it instead of the old one. 

Missing resource error 
The Macintosh system errors -192 mean that mINK C couldn't find a re­
source. Here are some solutions for that problem: 

• Use libraries made with THINK C 5.0. Don't use a project or li­
brary, like MacHeaders, MacTraps, and ANSI, made with an 
old version of THINK C. If you are using your own version of 
MacHeaders, precompile it again with THINK C 5.0. Otherwise 
use the new versions of these libraries supplied with mINK C 
5.0. 

• Use THINK C 5.0 to open projects made with THINK C 5.0. If you 
have two versions of THINK C, you might accidentally launch the 
old version when you double-click on a project made with the 
new version. Remove the old version, or double-click on mINK 
C 5.0 and open your project there. 

• Reinstall GateKeeper. If you use the GateKeeper INIT, it may be 
improperly installed. Reinstall it again, according to its instruc­
tions. 

• Don't move THINK C when it's running. If you move mINK C 
into a different folder while it's running, it won't be able to find its 
files. 

Compiling a Project 
This section describes solutions to some problems that happen when you 
compile a project. This section does not explain the error messages that ap­
pear in bug alerts. They're explained in Appendix C, "Error Messages." 
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Crashing While Running Your Project • 
Look for your problem in this list, and read its suggested solution. If you 
can't find your problem here, see Appendix C, "Error Messages." 

• A bomb alert with ID=-192. Read "Missing resource error" on 
page 470. 

• A bomb alert with ID=-39. Read "Check for virus infection" on 
page 467. 

• Crashing while building an application. Read "Corrupted re­
source file" below 

Corrupted resource file 
If you think your resource file may be corrupted, try these solutions: 

• Let ResEdit fix it. Open the resource file with ResEdit, which tries 
to fix corrupted resource files. 

• Use a released version of ResEdit. Be sure to use the ResEdit in­
cluded with WINK C. Sometimes, beta versions of ResEdit are 
buggy. 

• Rebuild it. If ResEdit can't fix your file, rebuild it from scratch. 

Crashing While Running Your Project 
This section describes how to fix problems that cause your program to crash 
or display a bomb alert. 

Look for your problem in this list, and read its suggested solution. If you 
can't find your problem here, look through all the solutions. 

• A "bus error" (ID=1) bomb alert. You tried to access an address 
that doesn't exist. Read "Pointer errors" on page 472. 

• An "address error" (ID=2) bomb alert. You tried to access memo­
ry illegally (that is, you try to access a word or longword on an 
odd-byte boundary). Read "Pointer errors" on page 472. 

• A "stack collision with heap" (ID=28) bomb alert. Your program's 
stack became too large and started to overwrite your program's 
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B Troubleshooting • 

To learn more about re­
source files, see "Using re­
source files with projects" on 
page 96. 

To learn more about chang­
ing the partition size, see 
"Setting the partition size 
and SIZE resource flags" on 
page 707. 

heap. Read "Stack errors" on page 473 and "Pointer errors" on 
page 472. 

• An "out of memory" (ID=25) bomb alert. Your program ran out of 
memory. Read "Pointer errors" on page 472 and "Stack errors" on 
page 473. 

• Damaging your hard disk. You may have written to the I/O ad­
dress space and corrupted your disk. Read "Pointer errors" on 
page 472. 

• Crashing when you call a function the first time. You may not 
have enough memory to load in the function's segment Read 
"Pointer errors" on page 472 and "Stack errors" on page 473. 

• Crashing when you call a function you called before. You may 
have use an uninitialized pointer that contains the return address 
for the function. Writing to the pointer corrupts the function. 
Read "Pointer errors" on page 472. 

Pointer errors 
Using pointers improperly can cause a large number of problems~ If you're 
having problems with pointers, try these solutions: 

• Initialize pointers. When you declare a pointer, TIUNK C doesn't 
initialize it or allocate space for what it points to. 

• Check array bounds. TIIINK C doesn't check whether your array 
subscripts are within the array bounds. 

• Check return values. A function that allocates memory or loads a 
resource may fail and return null. If you use the pointer, you 
might corrupt low memory. 

• Check your resource file. If a function that loads a resource re­
turns null, maybe it couldn't find the resource file. Make sure 
your resource file is in the same folder as your project and has the 
same name as your project with . rs rc appended. 

• Increase your program's partition size. If a function that allocates 
memory returns null, your program may really be out of memory. 
Choose Set Project Type ..• to see if your partition is large 
enough for your memory requests. 

• Prototype your functions. You might be passing an argument 
that's not a pointer to a function that expects a pointer. If you 
prototype your functions, THINK C displays a bug alert when 
you make this mistake. To make sure you include prototypes, 
turn on the "Strict Prototype Enforcement" option and choose 
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To learn more about the 
"Require Prototypes" option, 
see "Enforcing prototype 
use" on page 189. 

Getting Unexpected Function Results • 
"Require prototypes" in the Languages Settings page of the Op­
tions ... dialog. 

• Check your arguments. You might pass the wrong argument to a 
Toolbox routine. For example, calling DisposHandle () with 
the handle to a resource will crash your program. You should use 
ReleaseResource(). 

• Pass pointers to var parameters. If a Pascal function has a var 
parameter, pass it a pointer to the argument. 

Stack errors 
When your application's stack gets too big, it starts overwriting the applica­
tion's heap. Every sixtieth of a second, the Macintosh Operating System 
checks for a stack overflow. If one occurs, it brings up a "stack collision with 
heap" (ID=28) bomb alert. But you may not get a clear sign that the stack is 
overflowing. Before the Operating System can catch the overflow, it might 
cause another problem or even crash your project with a "bus error" (ID= 1) 
or "address error" (ID=2) bomb alert. 

If you think your stack might be overflowing, try one of these solutions: 

• Use less stack space. Use fewer or smaller local variables. Allo­
cate large variables on the heap. 

• Increase the stack size. Use SetApplLimi t () (in Inside Macin­
tosh If) to give your project a larger stack. 

Getting Unexpected Function Results 
This section describes some reasons why functions don't always return what 
you expect. To find a solution to your problem, read the section that deals 
with the function you're having trouble with: 

• "Using your own functions" on page 473. 
• "Using the ANSI library" on page 474. 
• "Using Macintosh Toolbox functions" on page 475. 
• "USing math functions" on page 476. 

If you can't find a solution in the appropriate section, try reading the others 
and the "Pointer errors" on page 472. 

Using your own functions 
If one of your own functions isn't returning what you expected, try this solu­
tion: 

• Prototype your functions. You might be passing an argument 
that's not the right type. If you prototype your functions, THINK 
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8 Troubleshooting • 
To learn more about the 
"Require Prototypes" option, 
see "Enforcing prototype 
use" on page 789. 

To learn more about chang­
ina the Dartition size. see 
To learn more about using 
printf (), see the Stan­
dard Libraries Reference, 
Chapter 4, "Using printf and 
scanf." 

C displays a bug alert when you make this mistake. To make sure 
you include prototypes, turn on the "Strict Prototype Enforce­
ment" option and choose "Require prototypes" in the Languages 
Settings page of the Options .•• dialog. 

Using the ANSI library 
If you have trouble with any ANSI library functions, try these solutions: 

• Don't profile ANSI. Many functions in ANSI won't work if the li­
brary is profiled. 

• Include the right header file. If you don't #include the right head­
er file, mINK C may let you call your function but return invalid 
results. 

• Reinstall the ANSI library. If all else fails (including the solutions 
below), you may have a corrupted ANSI library. Reinstall it from 
your original disks. 

If you have trouble with the ANSI I/O functions, try these solutions: 

• Check the result of f open ( ) . Make sure it's not null. 
• Include stdio. h. If you don't #include stdio. h, mINK C 

may let you call the functions but return invalid results. Even if 
you don't call any I/O functions, you need to #include stdio. h 
if you declare any variables of type FILE or FILE*. 

If you have trouble with the ANSI memory allocation functions, try these so­
lutions: 

• Include stdlib. h. If you don't #include stdlib. h, mINK C 
may let you call the functions but return invalid results. 

• Check your return values. Make sure the allocation function 
doesn't return null. 

• Double-check your arguments. Make sure that the arguments that 
should be of type size_t are size_to Remember that multi­
plying two integers gives you an integer, not a long integer, even 
if the result doesn't fit in an integer. To make the result a long in­
teger, cast one of the integers to be a long integer. 

• Increase your application's partition size. If a memory allocation 
function returns null, you might really be out of memory. Choose 
Set Project Type ... to see if your partition is large enough for 
your memory requests. 

• Use the right format specifier in printf () . When you print the 
value of a pointer, use either the pointer specifier %p, or one of 
the long int specifiers, like %ld or %lx. 
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To learn more about re­
source files, see "Using re­
source files with projects" on 
page 96. 

To learn more about using 
exi ting (), see the Stan­
dard libraries Reference. 

Getting Unexpected Function Results • 
Using Macintosh Toolbox functions 
Failing to initialize the Macintosh Toolbox managers is a common source of 
problems. This function takes care of all the initializations most programs 
need: 

void InitMac(void) 
{ 

InitGraf( &thePort ); 
InitFonts () ; 
FlushEvents( everyEvent, 0 ); 
Ini tWindows () ; 
InitMenus(); 
TEInit () ; 
InitDialogs(OL); 
InitCursor(); 
MaxApplZone () ; 

If you still have trouble with the Toolbox functions, try these solutions: 

• Double-check your arguments. Make sure that all the parameters 
are the correct size, of the correct type, and in the correct order. 
Remember that a Pascal function with a var parameter expects a 
pointer to the argument. 

• Check the return values. Check whether functions that allocate 
memory or get resources return null. Check whether any function 
returns an error code. These error codes are described with the 
functions in Inside Macintosh. 

• Don't use AddResFile () . Instead, use a resource file in the 
same folder as your project. If you use AddResFile () while 
running under THINK C, you corrupt your project's header and 
you must rebuild your project from scratch 

• Fix your resource file. You may have a corrupted resource file. 
Open it with ResEdit, which tries to fix corrupted resource files. If 
ResEdit can't fix it, rebuild it. 

• Check the name of your resource file. Make sure it has exactly the 
same name as your project with. rsrc appended. Remember 
that spaces count. For example, the resource file for 
My Appl.1t should be My Appl.7t. rsrc, not 
MyAppl.1t. rsrc or My Appl. rsrc. 

• Check your resource ID numbers. Make sure the ID numbers in 
the resource file and the ID numbers in your source code match. 

• Clean up before sublaunching. Before you launch another appli­
cation from your application, call_ exi ting () (in the ANSI li­
brary). 
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B Troubleshooting • 
To learn more about using 
printf () , see Standard 
libraries Reference, Chap­
ter 4, "Using printf and 
scant." 

To learn more about chang­
ing the partition size, see 
"Setting the partition size 
and SIZE resource flags" on 
page 101. 

To learn more about 
precompiled headers, see 
"Precompiled Headers" on 
page 164. 

Using math functions 
If you have trouble printing the result of any math function, try this: 

• Use the right format specifier in print f ( ) . When you print 
floating point numbers, use %g for the best results. Remember 
that % f rounds to six places after the decimal, so small values 
print as o. 

Using the Debugger 
This section describes how to solve problems with the TI-IINK C Debugger. 
For more information on how to use the debugger, see Chapter 12, "The De­
bugger." If you're having trouble with low memory, see the "Memory Con­
siderations" on page 246. 

• Use MultiFinder. The debugger needs MultiFinder to work. 
• Make sure you have enough memory. For a small project, you 

need 2Mb of RAM to use the debugger. For a large project, you 
may need more. 

• Select Use Debugger. The Use Debugger option in the Project 
menu must have a check mark by it. 

• Check where the debugger is. The debugger must be in the same 
folder as TI-IINK C. 

• Make sure there's debugger information for main ( ) . Make sure 
that there is a gray diamond next to the file that contains 
main () and any file you want to debug. 

• Turn off the "Use second screen" option. The debugger may be 
displayed on a second monitor that doesn't exist or is turned off. 
Turn off the "Use second screen" option in the Debugging page 
of the Options .•. dialog. 

• Use a smaller partition for your program. If you don't have 
enough memory for TI-IINK C, the debugger, and your project, 
you may be able to use a smaller partition for your project. 
Choose Set Project Type .•• to see if your partition is too big. 

• Use a precompiled header. Using a precompiled header helps 
make the debugger tables smaller. If you already use the 
MacHeaders file, you can put more header files in it. 

• Check your INITs. Some INITs, like MacroMaker, Automac, and 
MasterStrokes, interfere with the debugger's display. Remove 
them, reboot your Macintosh, and try again. See "Check for INIT 
conflicts" on page 468. 

• Turn off debugging for some files. If there's not enough memory 
for the debugger, turn off debugging for some files. 
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When All Else Fails ... • 
When All Else Fails ... 
If none of the solutions in this appendix solve your problem, you may need 
to call Symantec Technical Support. Before you do, be sure you do the fol­
lowing: 

• Isolate your problem. Finding a bug in a large program is diffi­
cult. If you think you've found the code causing your problem, 
write a small program that uses that code. 

• Know the System version. To find it, go to the Finder and choose 
About the Finder in the Apple menu. 

• Know the THINK C version. To find it, launch THINK C and 
choose About TIIINK. C in the Apple menu. 

• Call from a phone near the computer. The support analyst may 
need to ask you about the program. 

• Have the problem in front of you. Be ready to re-create your 
problem for the support analyst. Have THINK C running and 
your project open. 

• Be patient. 

To find the phone number for Technical Support: 

• If you're in North America, look at the Customer Seroice Plan 
booklet included in your THINK C package. 

• If you're outside North America, ask your local Symantec office 
or distributer. 

Note 
Other Symantec products (like MORE, SAM, and Norton 
Utilities) have different Technical Support numbers. Read 
the Customer Seroice Plan booklet carefully for the right 
number. 
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Error Messages + 
C 

This appendix is a guide to the error messages TI-IINK C generates.The error 
messages are in alphabetical order. Error descriptions marked "Assembly" 
are generated by the inline assembler. Error messages marked "Debugger" 
are generated by the TI-IINK C Debugger. 

8-bit reference to label 'symbol' out of range 
(Assembly) You've used a symbol that's out of range for an assembly lan­
guage instruction that expects an 8-bit operand. You get this error if you try 
to do a short branch to a label that's over 127 bytes away from the branch in­
struction, or use such a label in a PC-relative with index addressing mode. 
Because the inline assembler optimizes branches to got os, you'll also get 
this error if the final destination of the branch is over 127 bytes away. Exam­
ple: 

asm 
bra.s @foo 
jrnp @foo(dO.w) 

/* over 127 bytes */ 
foo: 

kansas: bra.s @cLabel 
} 

cLabel: goto Oz 
/* over 127 bytes from kansas */ 

Oz: printf("We're not in kansas anymore!"); 

Keep in mind that return, continue, and break are treated just like 
goto in the inline assembler. 

'symbol' has not been declared 
You used the identifier symbol before you declared it. 
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c Error Messages • 

For more information on ac­
cess control, see Object-Ori­
ented Programming, 
Chapter 4, "Using Objects 
with THINK C. " 

'symbol'ls not an argument 
You declared symbol as if it was an argument in a function definition; but it is 
not in the parameter list. Example: 

void function(void) 
short left_out_of-parameter_list; /* Illegal */ 
{ 
} 

'symbol' was not placed in a register 
(Assembly) 11IINK C couldn't place a variable in a register and you tried to 
use it as a register in an inline assembly language section. Example: 

void function(void) 
{ 

register short a, b, c, d, e, f; 

asm { 
moveq =ltl0,f ; f isn't in a register 

"filename" Is not a text file 
There are three ways to get this error: 

• You tried to include more than one precompiled header. 
• A file name in an =ltinclude statement refers to a file that is not a 

text file. 
• You Option-double-clicked on a symbol to find its definition, and 

the symbol is defined in a library. 

access to 'symbol'denied 
The member symbol of a class is pri vate or protected, or was inherited 
pri vate, and it is not accessible. Remember, if you declare a class with the 
class keyword, its members and inheritance are pri vate by default. Ex­
ample: 

class A { 
short i; 
void foo(void); 

} ; 

class B : A { 
pUblic: 

short j; 
void bar(void); 

} ; 
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For more information on ac­
cess control, see Object-Ori­
ented Programming, 
Chapter 4, "Using Objects 
with THINK C. " 

class C : B { 
pUblic: 

short k; 
void xyzzy(void); 

} ; 

class D : public B { 
public: 

short k; 
void xyzzy(void); 

} ; 

void function (void) 
{ 

A *p new A; 
B *q new B; 
C *r new C; 
D *s new D; 

p->i 0; II NO: 
q->j 0; II OK: 
r->j 0; II NO: 
s->j 0; II OK: 

access to 'delete' denied 

access to 'delete'denied • 

i is private. 
j is public. 
j is inherited private. 
j is inherited public. 

You tried to delete an object, and its class defines its destructor as private 
or protected. Note that all members of a class declared with the class key­
word are pri vate if no access specifier is provided. You might declare 
constructors and destructors pri v a te to control allocation and deallocation 
through static member functions. Example: 

class ClassC { 
public: 

static void destroy (ClassC *); 
private: 

ClassB *b; 
-ClassC(void); 

} ; 

void ClassC::-ClassC(void) 
{ 

delete b; 

void ClassC::destroy(ClassC *c) 
{ 

delete C; II OK. 
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c Error Messages • 

For more information on ac­
cess control, see Object-Ori­
ented Programming, 
Chapter 4, "Using Objects 
with THINK C. " 

void function(void) 
{ 

register C *p; 

delete p; II NO: Destructor is private. 
C::destroy(p); II OK. 

access to 'new' denied 
You tried to create an object with new, and its class defines its constructor as 
private orprotected. Note that all members ofa class declared with the 
class keyword are pri vate if no access-specifier is provided. You can 
declare constructors and destructors private to control allocation and 
deallocation through static member functions. Example: 

class ClassC { 
public: 

static ClassC *make(void); 
private: 

ClassB *b 
ClassC(); 

} ; 

ClassC::ClassC(void) 
{ 

b = new ClassB 

ClassC *ClassC::make(void) 
{ 

return(new ClassC); II 

void function (void) 
{ 

register ClassC *p; 

p new ClassC; II 
II 

p ClassC: : make () ; II 

OK. 

NO: 

OK. 

Constructor is 
private. 
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addressing mode requires 68020 • 
addressing mode requires 68020 

For more information on us- (Assembly) You're trying to use an Mc68020 addressing mode, but Mc68020 
ing the inline assembler, see inline assembly is not enabled. Example: 
Chapter 13, "Assembly Lan­
guage." 

For more information on 
type checking and proto­
types, see "Type Checking" 
on page 188. 

asm { 
clr.w (100000,aO) NO 
clr.w (10000,aO) OK: Optimized to 

10000(aO) 
clr.w (1000,aO,dO.w) NO 
clr.w (100,aO,dO.w) OK: Optimized to 

100(aO,dO.w) 
clr.w 100(aO,dO.w*2) NO: Scale factor 

must be 1. 

argument list is inappropriate here 
You declared a function with an old-style argument list but did not provide a 
function body. Usually, you specified a prototype for a function which uses 
a type name that is undefined. Example: 

short foo(Str255)i 

iinclude <Types.h> 
short foo(Str255)i 

II NO: If Str255 isn't 
II defined. 

II OK 

argument to function does not match prototype 
argument to function 'symbol'does not match prototype 
The sole argument to a function does not match the prototype. The proto­
type may be explicit or inferred. Example: 

void print (char *)i 
void function(void) 
{ 

char *msg 
Str255 s; 

"hello, world\n"; 

print(s)i II NO: Str255 is 'unsigned char' 
print (msg) i II OK. 
error(s)i II OK: Infers 

II int error(unsigned char *) 
error(msg)i II NO: Doesn't match inferred 

II prototype. 

THINK C User Manual 483 



c Error Messages • 
For more information on 
type checking and proto­
types, see "Type Checking" 
on page 188. 

argument #n to function does not match prototype 
argument #n to function 'symbol'does not match prototype 
The given argument to a function does not match the prototype. The proto­
type may be explicit or inferred. 

'break' not in loop or switch 
The break statement must be inside a loop (while, do-while, for) or a 
switch. Example: 

void function(void) 
{ 

short i; 
break; II NO 

while(l) 
break; II OK 

do { break;} II OK 
while(l); 

switch(i) { 
case 1: 

break; II OK 

call of non-function 
An expression in the function call position does not evaluate to a function or 
a pointer to a function. Example: 

void function(short (*f-ptr) ()) 

short i, j, k, result; 
result = i (j+k) ; 

result (*f-ptr) (i, j); 
result f-ptr(i, j) ; 

can't allocate stack temporary 

II f-ptr is a pointer 
II to a function. 

II NO: May be missing 
II something 
II after i. 
II OK 
II OK: Same as above 

The compiler tried to allocate a temporary variable beyond the ftrst 32K of 
the local stack frame. mINK C uses temporary variables to store intermedi­
ate values in SANE floating-point operation and the return values of func­
tions returning structs. You should reduce the size of the local stack frame 
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can 't assign to array • 
(by making large arrays s ta tic, for example) or move the calculations into 
another function. Example: 

void function(void) 
{ 

char a[32762]; 
float x = 2.0; 

x = x * x + 3.0; II NO: Needs temp 
II beyond -32768(a6) 

can't assign to array 
You cannot assign, increment, or decrement arrays. Example: 

void function(void) 
{ 

char al[4]; 
char a2[4]i 
char a3[4]i 

if (al == a2)11 OK: Compares arrays' addresses 
al++i II NO: Can't increment arrays 

al 0; II NO: Can't assign to an array 
al = a2; II NO: Can't assign arrays 

can't assign to function 
You cannot assign, increment, or decrement functions. Example: 

void function(void) 
{ 

short fl(); 
short f2(); 
short f3()i 

if (fl -- f2) I I 
II 

fl++; II 
fl 0; II 
fl = f2i II 

OK: 

NO: 
NO: 
NO: 

compares functions' 
addresses 
can't increment functions 
can't assign to a function 
can't assign functions 
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c • Error Messages 

can't call constructor 'symbol'directly 
You can invoke a class's constructor only by using new. You can't call it like 
a member function. Example, 

class C 
public: 

CO; 
} ; 

void function(void) 
{ 

register C *p, *q; 

p new c; II OK 
q = p->C(); II NO 

can't concatenate normal/wide strings 
You can concatenate only wide strings with wide strings or normal strings 
with normal strings. Example: 

char sl[] 
char s2[] 
char s3 [] 
char s4[] 

"hello," 
"hello," 
L"hello," 
L"hello," 

"world". II OK 
L"world". II NO 
"world". II NO 
L"world". II OK 

can't do that with multi-segment p~oject 
Your project is multi-segment, and what you're doing is allowed only with 
single-segment projects. You see this message when you 

• Use the Build Library ... command on a multi-segment project 
• Use a multi-segment project as a library, 
• Use the Build Device Driver ••• ,Build Desk Accessory ••• , or 

Build Code Resource ... command on a multi-segment project 
when the "Multi-Segment" option is not on. 

can't load STRS In this project 
You're trying to load a library into a project. The library has "Separate STRS" 
option on, and the project has the "Separate STRS" option off. You need to 
rebuild the library with the "Separate STRS" off, or turn the option on in the 
project that's using the library. 
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For more information, see 
"Setting the partition size 
and SIZE resource flags" on 
page 101. 

can't modify 'const' location 

can't modify 'const' location • 
You are trying to assign to a const variable, or to a location referred to by a 
pointer to a const. Example: 

const short x = 0;11 constant short 
const short *p; II pointer to constant short 
short * const q; II constant pointer to short 

void function(void) 
{ 

x = 1; 
p = 0; 
*p = 0; 
q = 0; 
*q = 0; 

II NO 
II 9K 
II NO 
II NO 
II OK 

can't open file "filename" 
THINK C cannot open the file in an # incl ude statement. Its name may be 
misspelled, it may not ~xist, or it may be in the wrong tree. For more infor­
mation, see Chapter 9, "Files & Folders." 

can't run background-only project 
You can't run your project under THINK C if the Background Only bit is set 
in its SIZE resource. You set that bit in the SIZE Flags menu in the Set Proj­
ect Type ••• dialog. 

can't take address of method '~ymbo/' 
You can't take tpe aqdress of a method unless it is static. Unlike C++, 
THINK C does not support pointers to non-static methods. Example: 

class C { 
pUblic: 

void g(void); 
static void f(void); 

} *cp; 

void foo (void) 
{ 

void *p; 

p &Cp->g; II NO. 
p = &C::f; II OK: f is static. 

'case' not in switch 
You used the case keyword outside of a swi tch block. 
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c • Error Messages 

character literal must be 1, 2, or 4 bytes 
A character literal must contain exactly 1, 2, or 4 characters. Example: 

char cl 'A' ; II OK 
char c2 'AB' ; II OK 
char c3 'ABC' ; II NO 
char c3 'ABC ' . II OK , 
char c3 '\n\n\n\n'; II OK 

class declarations must appear outside any function 
You must declare a class globally. You cannot declare it within the body of a 
function. 

class must have a name 
Unlike a struct, union, or enum, a class declaration must have a tag 
name. Example: 

typedef class { 
void foo (void) ; 

} C; 

class C { 
void foo(void); 

} ; 

code overflow 

II NO. 

II OK: Compiler inserts 
II implicit 
II 'typedef class C ct. 

You have more than 32K of code or data in one file. Break your file up into 
smaller files. 
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constant required 

constant required • 
THINK C expected a constant but didn't find one. Example: 

idefine aConstant 12 
void function(void ) 
{ 

short h; 
short x[2]; 
short y[h]; 

enum { 
color = h, 

size = aConstant 
attributes; 

struct { 

II 
II 
II 

II 
II 
II 

OK: 2 is a constant 
NO: h isn't a 

constant 

NO: enum values must 
be constant 

OK 

unsigned illegal bit field : h; 
unsigned legal_bTtfield : size; 

} bits; 

II NO 
II OK 

short z[size]; II OK: Array dimension 
II is a constant 

code segment too big 
See "link failed" on page 506. 

contains a function call 
(Debugger) The expression in the Data window contains a function call. In 
Figure C-l, entering rand () displays an error message, but entering rand 
displays the address of the function. 

Data 0 

I 10~ 
rand() ¢¢ contains a functi on call ¢¢ ~ rand ( ) Ox2387F5 

Q 
~ 

Figure C-1 The "contains a function call" error message 
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'continue' not in loop 
The continue statement must be inside a loop (while, do while, for). 
Example: 

void function(void) 
{ 

short i; 
continue; 

while (1) 
continue; 

do { continue; 
while(l); 

switch (i) { 
case 1: 

continue; 

II NO 

II OK 

II OK 

II OK 

could not evaluate constant expression 
An expression that's in a position where TI-UNK C requires a constant (such 
an enumeration constant or array size) is too large for the compiler to evalu­
ate. Example: 

enum { foo = 1 « 33 }; II NO. 

void function(void) 
{ 

short X; 
X = 1 « 33; 

data segment too big 
See "link failed" on page 506. 

II OK: Yields 0 at 
II runtime. 
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declaration of 'symbol' does not match #pragma parameter • 
declaration of 'symbol'does not match #pragma parameter 
There is a #pragma parameter directive for a function named symbol, 
and the number or types of arguments in the prototype do not match those 
in the pragma. Example: 

ipragma parameter AO myfunc (_DO) 

void myfunc(long); II NO 
short myfunc(long); II NO: Can't return 

II short in AO 
void *myfunc(long, ... ) ; II NO: Can't use 

II 
long myfunc(Rect r); II NO: Can't pass 

II struct in DO 
pascal long myfunc(Rect r) ; I I OK: Passes address 

II of Rect 

declarator too complex 
The declaration statement is too complex. You're unlikely to get this error 
unless you're compiling a computer-generated program. 

'default' not in switch 
You used the default keyword outside ofa switch block. 

displacement too large for this addressing mode 
(Assembly) The displacement portion of an addressing mode is out of range 
for that mode. Usually, you used an indexed addressing mode with a dis­
placement less than -128 or greater than 127. Example: 

asm { 

clr.w 200(aO,dO.w) NO. 
clr.w OxFE(aO,dO.w) NO: Hex numbers are 

unsigned. 
clr.w -Ox02(aO,dO.w) OK. 
clr.w 100000(a2) NO: Displacemnt must 

fit in 16 bits. 
clr.w (100000,a2) OK, If MC68020 is on. 

duplicate 'case' 
Within a swi tch block, there are two or more case expressions with the 
same value. 

duplicate 'default' 
You have more than one default in a switch block. 
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For more information on the 
"enums are always ints" op­
tion, see" enums of any 
size" on page 776. For more 
information on the "4-byte 
ints" option, see "Porting 
code from other compilers" 
on page 7 93. 

duplicate register in argument list 
You used the same register more than once in the argument list of a 
#pragma parameter directive. Example: 

#pragma parameter AD foo( DO, __ DO); II NO 
#pragma parameter AD bar( AD); II OK 

escape sequence doesn't fit in a byte 
The octal or hexadecimal escape sequence specifies a number which is too 
large to fit in a byte. Example: 

short x = '\777'; II NO: octal 777 decimal 511 

'enum symbol' already defined 
There is already an en urn with the tag symbol Example: 

enum Days Monday, Tuesday, Wednesday, 
Thursday, Friday}; 

enum Days Mothers, Fathers, Secretaries, 
Memorial, Labor }; 

'enum symbol' already in use 
The enum tag symbol is already used as a struct or union tag. Example: 

typedef struct X { short x; float y; }; 
typedef enum X { a, b, c, d }; 

enumeration constant too large 
The value of an enumeration constant is too large for a 4-byte into This er­
ror happens only if the "enums are always ints" option is on and "4-byte ints" 
option is off. Values that cannot be represented in 32 bits bring up the error 
"could not evaluate constant expression" on page 490. 

#error directive 
The preprocessor came across an #error directive. You can use the 
#error directive to report on any potential problems that the preprocessor 
can detect. Example: 

#if option (trigraphs) 
#error Can't use trigraphs with File Manager. 

#endif 

#define FILE TYPE I????' 
#define FILE-CREATOR I????' 
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For more information on the 
ipragma options direc­
tive, see "Accessing Option 
Settings in Your Code" on 
page 795. 

For more information on 
type checking and proto­
types, see "Type Checking" 
on page 788. 

expression too complex • 
expression too complex 
An expression is too complex. Usually, there are not enough scratch regis­
ters to evaluate a complex addressing expression. Try splitting the expres­
sion into subexpressions. You can also disable automatic register allocation 
for the function so more registers are available. To disable automatic register 
allocation, use this line: 

ipragma options(!assign_registers) 

first argument to function does not match prototype 
first argument to function 'symbol' does not match prototype 
The first argument to a function does not match the type in the prototype. 
The prototype may be explicit or inferred. 

floating constant too large 
A floating-point constant was too large (or too small) to be represented. For 
various limits of floating-point types, see Standard Libraries Reference, 
Chapter 2, "Using the Standard Libraries. n Example: 

long double x = 1.2e100000; 
II NO: Maximum exponent is 4931. 

has side-effects 
(Debugger only) You entered an expression that has a potential side effect: 
=, ++, or --. In Figure C-2, the debugger won't evaluate i++ and i+=1 be­
cause they have side effects. 

Data t!J 

I 10[8] 
i 0 i£ i+1 1 
i++ QQ has side-effects QQ 

i+=1 QQ has side-effects QQ Q 
rJJ 

Figure C-2 The "has side-effects" error message 
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illegal #elif 
Illegal #else 
Every felse or felif must have a matching fif, fifdef, or fifndef. 
Example: 

fifdef name 
felse 
felse II NO: No matching fifdef 
fendif 
felif condition II NO: No matching fif 

Illegal #endif 
Every·fendif must have a matching fif, fifdef, or fifndef. 

Illegal application of '&' 
The address-of operator was used on an object (such as a register variable or 
a bitfield) that doesn't have an address. It is not an error to take the address 
of an inline function. The compiler generates a reference to a function with 
the same name, and brings up the error "link failed" on page 506. Example: 

pascal void Debugger (void) = OxA9FF; 
void function (void) 
{ 

register short i; 
short *p = &i; 
void *q = &Debugger; 

II NO: i is a register 
II OK: But probably not 
II what you meant. 

illegal application of 'pascal' 
Only functions or function types can be declared pascal. Example: 

pascal short f(void); II OK. 
pascal short i; II NO. 
pascal short *p(void); II OK: 

II 
II 

pascal short (*q) (void) ; I I OK: 

illegal application of ' size of 

II 
II 

pascal function 
returning ptr to 
short. 
pointer to pascal 
function 
returning short. 

You cannot use si zeof with a function or a function type. Example: 

short f (void), (*g) (void) ; 

short a sizeof(f); II NO 
short b sizeof(g); II OK: b sizeof pointer 
short c = sizeof(*g);11 NO 
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illegal array bounds • 
lIIegal array bounds 
The bounds of an array can't be negative or zero. Examples: 

short a[-7]i 
short b[O]i 

II NO: bounds can't be negative 
II NO: bounds can't be zero 

lIIegal array element type 
You can't declare an array of functions, or of void objects. However, you 
can declare an array of pointers to functions or of pointers to void. 
(void *x [] is a C idiom for an array of generic pointers.) Example: 

short array of functions[] ()i 
void abyss[SIZE]i 
void *generic-ptr_array[SIZE]i 
short (*array_of-ptrs_to~funcs[SIZ~]) ()i 

illegal cast 

II NO 
II NO 
II OK 
II OK 

You cannot cast structs or unions to other types. You can cast numerical 
values or pointers to other numerical values or pointers. Example: 

typedef struct {short v, hi} Pointi 
void function(void) 
{ 

Point Pi 
long Ii 
p (Point) Ii II NO 
p = * (Point *) &li II OK 

illegal character 'character' 
A character that's not part of the C character set (such as @ or $) appears in 
your source file outside of a comment or string. If the character isn't a print­
able ASCII character, the error message shows it's hexadecimal value. Exam­
ple: 

asm { 
dc.w $A9FF NO: Use OxA9FF. 
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Illegal floating-point operation 
You cannot use some of the C operators on floating point values. Example: 

void function(void) 
{ 

double dl; 
double d2; 
double d3; 
d3 dl % d2; II NO: Can't do floating modulo 
d3 dl« 3; II NO: Can't do floating shifts 
d3 = 3 « dl; II NO: Can't do floating shifts 

illegal function return type 
A function cannot return an array or a function. However, a function can re­
turn a pointer to an array or a pointer to a function. Example: 

typedef char Str255[256]; 
typedef short (* function-ptr) (); 

Str255 function returning array(); II NO 
Str255 *function returning-ptr to array();11 OK 
short function returning functTon() (); II NO 
function-ptr f_returning-ptr_to_f(); II OK 

Illegal initialization 
If the mINK C project is a code resource, desk accessory, or device driver, 
you cannot initialize an address in global or static memory. Example: 

static short i; 
static short *p = &i; II NO: Not in application 

illegal near reference: 'symbol' 
See "link failed" on page 506. 
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illegal operation on struct 
illegal operation on union 

illegal operation on struct • 
You cannot use many C operators on structs or unions. Example: 

short function (void) 
{ 

struct { 
short x; 

} s1, s2, s3; 
short i; 

if (s1 -- s2) 
s1++; 

s1 0; 

s1 = s2; 

s3 = s1 + s2; 
i = s1 - s2; 
i = (long)s1; 
return (sl) 

illegal pointer arithmetic 

II 
II 
II 
II 
II 
II 
II 
II 
II 
II 
II 

NO: Can't compare structs 
NO: Can't increment structs 
NO: Can't assign short to a 

struct 
OK: struct assignment is 

allowed 
NO: Can't add structs 
NO: Can't add structs 
NO: Can't cast a struct 
NO: return does an implicit 

cast 

You cannot perform some arithmetic operations on pointers. You cannot as­
sign integers to pointers with the exception of the constant zero. In addition, 
you cannot compare pointers to integers, again with the exception of the 
constant zero. In all cases, you can use a cast to force the operation when 
necessary. Example: 

void function(void) 
{ 

short *short-ptr; 
short i; 
char *p1, *p2; 
long result; 

short-ptr Ox220; 
short-ptr = 0; 
short-ptr = (short *) 

result 

result 

p1 + p2; 

p1 I p2; 

II NO 
II OK 

Ox220;11 OK: 
II 
II NO: 
II 
II NO: 
II 
II 

Address of 
MemErr 
Can't add 
pointer 
Can't 
divide 
pointers 
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illegal preprocessing directive 
These are the valid preprocessing directives: 

fif 
felif 
finclude 
fline 

fifdef 
felse 
fdefine 
ferror 

illegal size for bitfield 

fifndef 
fendif 
fundef 
fpragma 

Bitfield sizes must be less than or equal to the number of bits in the type 
specifier. Labeled bitfield sizes must be greater than zero. Unlabeled bitfield 
sizes of 0 force a word alignment. Example: 

struct bit fields { 
char c : 9; 
short i : 17; 
short zero 0; 

II 
II 
II 
II 

short good: 11;1/ 
short: 0; II 
long 1 : 33; I I 
short z : -4; II 

}; II 

illegal type for bitfield 

NO: chars are 8-bits long 
NO: shorts are 16-bits long 
NO: Bitfield size must be 

over O. 
OK 
OK: Forces word alignment 
NO: longs are 32-bits long 
NO: Bitfield size must be 

over O. 

These are the only types allowed for a bitfield: 

char short int 
int long int 
unsigned char unsigned short 
unsigned int unsigned long 

You cannot use any other type for a bitfield. Example: 

struct bitfields{ 
char c : 5; 
unsigned int i 5; 
long 1 : 17; 

} ; 

double d : 10; 
void *p : 8; 

II OK 
II OK 
II OK 
II NO 
II NO 

int 
int 
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For more information on 
4tpragma once, see 
"Once-only Headers" on 
page 154 

illegal type for field • 
illegal type for field 
A field may not be a function, unless it is a field of a class. Example: 

struct S { 
short f(); II NO: S is not a class 

} ; 

struct T : indirect { 
short f(); II OK: T is a class 

} ; 

Illegal use of class type 
You must declare an object as a pointer. Also, you can't use sizeof with a 
class. Exam pIe: 

void function(void) 
{ 

ClassName 
ClassName 
char 

illegal use of void 

badObject; 
*goodObject; 
a[sizeof(ClassName)]i 

II NO 
II OK 
II NO 

You cannot use most of the C operators on void values. You cannot declare 
variables of type void. Example: 

void f (void) 
{ 

short i, j; 
i (void)j + 5; II NO: Can't add a void. 
i = f() - 3; II NO: f() returns void. 

immediate value out of range 
(Assembly) An immediate operand is outside the range of permissible values 
for the instruction. Example: 

asm { 
addq.l#10, dO 
Isr.l #10, dO 
moveq #128, dO 

NO: ADDQ/SUBQ range is 1 .. 8 
NO: LSR/LSL range is 1 .. 8 
NO: MOVEQ range is -128 .. 127 

#include files nested too deeply 
You tried to compile a file that had #include directives nested more than 
50 deep. Usually, one of your header files file includes another header file 
which (eventually) includes the original file again. You can use the 
#pragma once directive to inhibit recursive processing of include files. 
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For more information on 
writing assembly for the 
MC68020 or MC688 7, see 
"Writing processor-specific 
assembly code" on page 
252 

Incomplete macro call 
TInNK C reached the end of file before a macro call completed. Example: 

#define macro(argl, arg2) (argl > arg2) 
macro (x, II NO 

Incorrect base register 
(Assembly) You're probably referencing a global through a register other 
than AS (for applications) or A4 (for desk accessories, device drivers, or 
code resources). You don't need to provide a base register to use a global 
variable in assembly language. Example: 

short theGlobei 

void Off Base (void) 
{ 

asm{ 

II a global 

move theGlobe(a2), dO II NO 
move theGlobe(aS), dO II OK: But 

II unneeded 
move theGlobe, dO II OK: Much better 

instruction requires 68020 
instruction requires 68881 
(Assembly) You're using an Mc68020 or Mc68881 instruction but Mc68020 
or Mc68881 inline assembly is not enabled. Example: 

asm 68000 
extb.l 
ext.w 
ext.l 

dO 
dO 
dO 

NO: EXTB.L requires 68020 

OK: Use EXT.W/EXT.L on 68000 
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integer constant required • 
integer constant required 
An integer constant is required, but isn't there. Example: 

#define aConstant 12 
void function(void) 
{ 

enum { 
shape = -2.4, II NO: enum values 

II must be into 
size = aConstant II OK 

attributes; 

short w [3 .14159] ; II NO: Constant must 
II be an into 

short z[size]; II OK: Array dimension 
II is an into 

integer constant too large 
The absolute value of a decimal integer constant must be less than or equal 
to 4294967295 ( 232 -1 ) . A hexadecimal integer constant must range 
from OxO to Oxffffffff inclusive. Example: 

unsigned long a 

unsigned long c 

4294967296; 
II NO 

Ox100000000; 
II NO: Larger than 32-bits 

invalid 68881 unary operator 'symbol' 
You must declare an Mc68881 unary operator to take an extended-precision 
argument and return an extended precision result. See rna th . h for exam­
ples of Mc68881 unary operators. Example: 

II The "8-byte double" option is on. 

float acos(float) : Ox1C; 
double acos(double) : Ox1C; 
long double acos(long double) 

invalid access specifier 'symbol' 

II NO 
II NO 

Ox1C; II OK 

symbolis not public, private, or protected. 

THINK C User Manual 501 



c • Error Messages 

Invalid addressing mode 
(Assembly) You specified an operand to an assembly language instruction 
which is not a valid Mc68000 or Mc68020 addressing mode. Example: 

asm { 
clr.w 
move.w 
clr.w 
clr.w 

Invalid constructor 

(dO)+ 
(pc) ,dO 
-2(dO,aO) 
-2 (aO,dO) 

NO 
NO 
NO 
OK 

You tried to declare a return type for a constructor, or tried to declare a 
member function with the same name as its class. Example: 

class C 
public: 

void C () ; 

co; 

II NO: Constructor can't 
II have return type 
II OK 

} ; 

Invalid declaration 
A syntax error is in a declaration. Example: 

short i j; II NO: Missing 

Invalid declaration of 'operator delete' 

, , , 

The prototype for operator delete must be like this: 

void operator delete(void *); 

invalid declaration of 'operator new' 
The prototype for operator new must be like this: 

void *operator new(size_t); 

If you are not using stddef . h, you can use long or unsigned long in 
place of size_to 
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invalid destructor 

Invalid destructor 
You tried to declare arguments for a destructor. Example: 

class C { 
public: 

} i 

.... C(long)i 

.... C(void); 

.... C () i 

II NO 
II OK: But void is unneeded . 
II OK: Much better . 

Invalid floating-point literal 

• 

(Assembly) A quoted floating-point literal is not a legal SANE floating-point 
number. Example: 

asm { 
dc.x 
dc.x 

"nanO" 
"nan(O)" 

invalid function prototype 

NO 
OK 

For more information on the You used a bad function prototype. Usually, the prototype contains only 
"Language Extensions" op- ... and the "Language Extensions" option is off. 
tion, see "THINK C Exten-
sions" on page 174 Invalid redeclaration of 'symbol' 

You declared an identifier twice, and the second redeclaration is incompati­
ble with the first. Example: 

extern short Xi 
long Xi II NO: X is redeclared 

II differently 
extern short Yi 
short Yi II OK: y is redeclared as 

II the same type 
short Zi 
short Zi II NO: Can only have one 

II defining instance 
typedef short IsARosei 
IsARose IsARosei II NO 
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Invalid redefinition of macro 'symbol' 
You tried to #-define an already defined macro with a different definition. 
You can always redefine a macro to the same thing. If you want to actually 
change the definition of the macro, you must #-undef it first. Example: 

#define NULL OL 
#-define NULL OL II OK 
#define NULL ( (void *) 0) II NO 
#undef NULL 
#-define NULL ( (void *) 0) II OK 

Invalid number 
You specified an illegal integer or floating-point number. Example: 

short x OxA9FGi II NO 
float f = le*37i II NO: But +37 or -37 

II is OK. 

invalid register 'symbol' 
The name symbol is not one of the permitted register names for a #-pragrna 
parameter directive. You can use only these registers: 

AO 
DO 

invalid register list 

Al 
Dl D2 

(Assembly) The register list contains duplicates, or the list is in the wrong or­
der. Example: 

asm { 
movem aO/aO,-(sp) iNO 
movem d7-dl,-(sp) iNO 
movem dl-d7,-(sp) iOK 

invalid scale factor 
(Assembly) In an Mc68020 indexed addressing mode, you can apply a scale 
of only 1,2,4, or 8 to the index register. Example: 

asm 68020 { 
clr.w 20(aO,dO.w*0) NO 
clr.w 20(aO,dO.w*3) NO 
clr.w 20(aO,dO.w*(3+l» OK 
clr.w ([20,aO],dO.w*8,lO) OK 
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invalid size • 
Invalid size 
(Assembly) In an assembly language instruction, you used a bad size specifi­
er or the wrong size specifier for what you're trying to do. Example: 

asm { 
move.b 

move.q 

aO,al 

aO,al 

Invalid storage class 

II NO: Can't move bytes to 
II address registers. 
II NO: .q is not a legal 
II size. 

You applied incompatible attributes to a data item, implicitly or explicitly. 
Example: 

register short aGlobal; II NO: register global 
extern auto short y; II NO: contradictory 

II storage class 

invalid type specification 
You used an illegal or ambiguous combination of type keywords when de­
claring a data item. Example: 

unsigned double d; 
long struct {short i;} s; 

invalid use of class specifier 

II NO 
II NO 

You tried to declare a member of a class outside of a class declaration. Ex­
ample: 

class C { 
pUblic: 

} ; 

static short i; 
short j; 
void foo (void) ; 

shortC::j=O; 
shortC::i=O; 

void C::foo(void); 
void C: : foo (void) { ... } 

II 
II 
II 
II 
II 

NO 
OK: Initializes class 

variable. 
NO 
OK 
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Invalid use of 'operator delete' 
You tried to declare operator delete outside of a class declaration. 
To define operator delete for a class, you must prefix it with the class 
name and : :. Example: 

class C { 
void operator delete (void *); 

} ; 

void *operator delete (void *p) {. .. } 
void *C::operator delete (void *p) { ... } 

Invalid use of 'operator new' 

II NO 
II OK 

You tried to declare operator new outside ofa class declaration. To de­
fine operator new for a class, you must prefix it with the class name and 
: :. Example: 

class C 
void *operator new(size_t); 

} ; 

void *operator new (size t n) { ... } 
void *C: :operator new(sIze_t n) C .. } 

jump table too big 
See "link failed" on page 506. 

label 'symbol' is already defined 

II NO 
II OK 

The label symbol has been defined twice within the function. 

last argument to function does not match prototype 
last argument to function 'symbol'does not match prototype 
The last argument to a function does not match the type of the atgument in 
the prototype. The prototype may be explicit (it must be explicit if the "Re­
quire Prototypes" option is set) or inferred (if the "Infer Prototypes" option is 
set). 

link failed 
The linker couldn't link your program. Usually, the linker fails due to an un­
defined symbol or to a multiply defined symbol (a symbol defined more 
than once in a project). To find out which files contain the offending sym-
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link failed • 
boIs, use the Check Ilnk command in the Project menu. The Link Errors 
window will display the names of the files in parentheses. 

• code segment too big One or more of your code segments 
has exceeded the 32K limit. See "Segmentation" on page 97. 

• data segment too big You declared more than 32K of global 
and static data in your project. Use memory allocation to create 
large data structures or turn on the "Far DATA" option in Set 
Project Type ••• dialog. See "Using more global data with Far 
DATA" on page 100. 

• illegal near reference: 'symbol' A 16-bit reference was made 
to a variable or function which was not in the first 32K of the data 
area or jump table, probably from a library. Recompile the library 
using the Far Code or Far Data options. See "Mixing Near CODE 
and DATA with Far CODE and DATA" on page 10l. 

• jump table too big If the "Far CODE" option is off, your jump 
table is over 32K. If the "Far CODE" option is on, your jump table 
is over 256K. See "Using a larger jump table with Far CODE" on 
page 100. 

• multiply defined: 'symbol' symbol was defined more than 
once. 

• resource too big For drivers, DRVR + DATA resource is > 32K. 
For multi-segment drivers, DATA + JUMP> 32K. For code re­
sources, CODE + DATA + JUMP> 32K. For multi-segment code 
resources, CODE + DATA + JUMP> 32K for segment containing 
main ( ) , CODE> 32K for other segments. 

• undefined: 'symbol' You referred to symbol without defining 
it. 

• undefined: class:: You didn't define the first method you de­
clared in class. 

• undefined: ?class::method You declared a method in your 
class declaration but didn't define it. You might get this message 
if you defined method, but you didn't define the first method you 
declared in class. 
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Ivalue required 
An lvalue is an expression that refers to an object in memory that you can 
store to and examine. Example: 

short short f(void); 
short *pshort f(void); 
void function(void) 
{ 

short i; 
short *p = &i; 

II Operand of ++ must be an lvalue 
7++; II NO 
short f()++; II NO 
pshort_f()++; II NO 

II Left operand of an assignment 
II must be an lvalue. 
short f() = i; II NO 
pshort f() = i; II NO 
*pshort f() = i;11 OK: Produces an lvalue 
(*p)++;- II OK 
(*pshort_f(»++;IIOK 

macro argument 'symbol' appears more than once 
The formal parameters in a macro definition must appear only once. Exam­
ple: 

#define macro(again,again) (again+7) II NO 

memory critical - proceed at your own risk 
Now would be a really good time to save your files and quit. Before you 
work on your project again, you may want to increase the size ofTIUNK C's 
partition with the Finder's Get Info ..• command. 

missing I;' 
TI-lINK C expected a semicolon, but couldn't find one. Sometimes TIllNK C 
cannot determine that a semicolon is missing, and displays the error "syntax 
error" on page 513. 

missing argument name 
The argument list in a function definition did not name all the arguments. 
Example: 

void foo(short i, short j, float); II Prototype 
void foo (short i, short j, float) { ... } I I NO 
void foo(short i, short j, float f) { ... } II OK 

508 THINK C User Manual 



For more information on the 
ipragma options direc­
tive, see "Accessing Option 
Settings in Your Code" on 
page 195. 

missing #endif 

missing #endif • 
Every iif, iifdef, and iifndef must have a matching iendif. 

multiply defined: 'symbol' 
See "link failed" on page 506. 

no files in project 
Your project must contain at least one file for what you're trying to do. 

no members defined 
You defined a struct or union without members. Example: 

struct memberless struct{ }; 
union memberless_union { }; 

II NO 
II NO 

no methods defined 
A class definition must have at least one method. 

struct BadName : indirect { 
short instanceVar; II NO: No methods 

} ; I I declared 

no such member 'symbol' 
In a . or - > expression, the right operand is not the name of a member of 
the class or struct for the left operand. Example: 

void function(void) 
{ 

struct s1 struct{ 
struct s2-struct{ 
s 1. non _me'ffiber; 

p1 -> non_member; 

no such option 'symbol' 

short member 1; }s1, *p1; 
short member -2; .} s2, *p2; 

II NO: non member is not in 
II s1 struct 
II NO: non member is not in 
II s1 struct 
II NO: me'ffiber 2 is not in 
II s1_struct 

You used the identifier symbol as an argument to ipragma options or 
_option, but it is not one of the valid options. Example: 

#pragma options(!optimize) 
#pragma options(!global_optimizer) 

II NO 
II OK 
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c Error Messages • 
For more information on the 
"Language Extensions" op­
tion, see "THINK C Exten­
sions" on page 774 

Because of the visibility rules 
for dasses and their mem­
bers, there are other situa­
tions where you must use an 
object pointer. For more in­
formation, see Object-Ori­
ented Programming, 
Chapter 4, "Using Objects 
with THINK C. " 

For more information on the 
ipragrna options direc­
tive, see" Accessing Option 
Settings in Your Code" on 
page 795. 

nothing was declared! 
You tried to compile an empty source file. If the "Language Extensions" op­
tion is off, source files must contain at least one declaration. 

object pointer required 
The operand ofa delete or_classof operator has a type which is not a 
pointer to an object. Example: 

void function(void) 
{ 

void *p =.new Ai 
A *q = new A; 

delete !'; 
delete q; 
delete (A*)p; 

II p is a generic pointer 
II q is an object pointer 

II NO 
II OK 
II OK 

object pointer required for 'symbol' 
You are trying to access a non-static member of a class, and you did not 
specify an object pointer. EXample: 

class C { 
public: 

static short i; 
short j; 
static void f(void)i 
void g (void) ; 

} i 

void foo(C *cp) 
{ 

} 

C::i = 0; 
C::j=O; 
cp->j = 0; 

void C: : g (void) 
{ 

C::j=O; 

II OK: Ii' is static. 
II NO 
II OK 

II OK: 'this' is implied. 

option 'symbol' can not be adjusted 
Some of the compiler options can not be set or cleared with the #pragma 
options directive during compilation. Usually these are project-wide op­
tions, such as int_ 4 or a4_globals. You can change these options for 
the entire project from the Options ... and Set Project Type ••• dialogs. 
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option 'symbol' can not be adjusted within a function • 
option 'symbol' can not be adjusted within a function 
With the :Jt:pragma options directive, you cannot set some compiler op­
tions within the body of a function. Move the pragma before the body of the 
function. Example: 

void function(void) 
{ 
:Jt:pragma options(check-ptrs) 

:Jt:pragma options(check-ptrs) 
void function(void) 
{ 

out of memory 

II NO 

II OK 

THINK C ran out of memory. Close open windows to reclaim more memory. 
If you get this message when you try to run the debugger, try making your 
application's partition size smaller. See"Memory Considerations" on page 
246. 

pointer required 
You're using an operator that requires a pointer with an expression that's not 
a pointer. Example: 

void function(void) 
{ 

short x, result: 
result *x: II NO: x isn't a pointer 
result = x->a_member; II NO: x isn't a pointer 

pointer types do not match 
You tried to assign, compare, or subtract incompatible pointers. In TIIINK C, 
pointers are more strictly typed than some other C compilers. In assignments 
and comparisons, the two pointer types must match or be of type void * 
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c Error Messages • 

For more information on the 
Partition box and SIZE flags 
menu, see "Setting the par­
tition size and SIZE resource 
flags" on page 707. 

For more information on the 
"Require prototypes" option, 
see "Type Checking" on 
page 788. 

When subtracting two pointers, the types must match and not be void * 
You can cast pointers to force compatibility. Example: 

void function(void) 
{ 

char *charytr; 
int *intytr; 
void *voidytr; 
int result; 
long difference; 
charytr = intytr; II NO 
charytr = (char *)intytr; II OK 
voidytr = intytr; II OK 
int-ptr = void-ptr; II OK 
result (charytr == intytr); I I NO 
result = ((int *)charytr == intytr); II OK 
result = (charytr == (void *)intytr); II OK 
result = (voidytr == intytr); II OK 
difference charytr - intytr; II NO 
difference = charytr - (char *)intytr; II OK 

project is not 32-bit compatible 
You're trying to run your application under THINK C with System 7.0 in 32-
bit mode, but you didn't set the 32-Bit Compatible flag in your application. 
To set that flag, use the SIZE Flags menu in the Set Project Type ••• dialog. 

project requires a larger memory partition 
You need to increase the project's partition size. To set the partition size, use 
the Partition box in the Set Project Type .•• dialog. 

prototype required 
prototype required for function 'symbol' 
When the "Require prototypes" option is on, you must provide a function 
prototype for each of your functions. You may have defined a prototype, but 
forgot to put a semicolon (;) at the end. Also, in a class declaration a pro­
totype is required for operator new and operator delete, regardless 
of the setting of the "Require prototypes" option. 

resource too big 
See "link failed" on page 506. 

redundant application of 'const' 
redundant application of 'pascal' 
redundant application of 'volatile' 
You repeated one of the qualifiers const, pascal, or volatile in a type 
declaration. 
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For more information on 
type checking and proto­
types, see "Type Checking" 
on page 188. 

For more information on 
type checking and proto­
types, see "Type Checking" 
on page 188. 

second argument to function does not match prototype • 
second argument to function does not match prototype 
second argument to function 'symbol' does not match prototype 
The second argument to a function does not match the prototype. The pro­
totype may be explicit or inferred. 

static function 'symbol' referenced but not defined 
You declared a function s tat i c and referred to it, but you did not define it 
in the same source file. Previous versions ofTI-lINK C treated these as if they 
were declared extern, but now it strictly enforces the declaration. 

'struct symbol' already defined 
There is already a struct with that tag. Example: 

typedef struct X { short x; }; 
typedef struct X { short y; }; 

'struct symbol' already in use 
The struct tag is already used as a struct or union tag. Example: 

typedef struct X { short a, b, Ci }i 
typedef union X { short Xi double Yi }i 

switch value must be integral 
A switch expression must be of type char, int, or long or an unsigned 
variant. Example: 

char *Pi 
float fi 
switch (p) C .. } 
switch (f) { ... } 

II NO: switch of pointer 
II NO: switch of float 

syntax error 
There was a syntax error. These are some common errors: 

• Too many } 's 
• A label wi thou t : 
• Malformed expressions 
• Mismatched parentheses 
• A missing semi-colon. 

third argument to function does not match prototype 
third argument to function 'symbol'does not match prototype 
The third argument to a function does not match the prototype. The proto­
type may be explicit or inferred. 
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c • Error Messages 

too many arguments 
nnNK C allows you to have up to 31 arguments in a function defmition. Ex­
ample: 

f (arg1, arg2, ... , arg31, arg32) 
{ 
} 

too many initializers 

II one too many 
II args 

The number of initialization values exceeds the expected number of data 
items specified in the declaration of the data structure. Example: 

char *directions[4] = {"north", "east", 
"south", "west", "lost" }; 

struct { short a,b,c; } x[2] 
{ 1, 2, {3, 4 } }; 

too many segments 

II NO 

II NO 

Applications can have no more than 254 segments. Multi-Segment desk ac­
cessories, device drivers, and code resources are limited to 30 segments. 

undefined label 'symbol' 
You tried to goto the label symbol, but you haven't defined that label within 
the function. 

undefined 'symbof 
See "link failed" on page 506. 

unexpected end-of-file 
THINK C reached the end of a source file before a C language construct was 
completed. Example: 

main ( 
II End of file encountered 
II before the close parenthesis. 

'union symbol' already defined 
There is already a uni on with that tag. Example: 

typedef union X { short X; double y; }; 
typedef union X { short y; double X; }; 

'union symbol' already in use 
The union tag is already used as a struct or union tag. Example: 

typedef union X { short X; double y; }; 
typedef struct X { short a, b, c; }; 
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For more information on 
writing processor-specific 
code, see "Writing proces­
sor-specific assembly code" 
on page 252. 

unknown class 'symbol' 

unknown class 'symbol' • 
You use the identifier symbol as a class name but it is not defined or is not as 
a class. Example: 

short C; 
void function(void) 
{ 

void *p = new Ai 
C::f(); 

unknown CPU 

II NO: A is not defined. 
II NO: C is not a class. 

(Assembly) You specified a CPU in an a sm statement that was not one of the 
recognized CPUs. Example: 

asm 68010 { 
rtd #8 

NO: Only 68000, 68020, 68030 
68040, 68881, and 68882 
are permitted. 

unknown enumeration 'symbol' 
An enumeration declaration refers to an enumeration tag that you have not 
defined. Example: 

enum unknown colors; II NO 

unknown instruction 
(Assembly) The inline assembler doesn't recognize the mnemonic you used. 
Usually, you forgot the period in a mnemonic. Example: 

asm { 
movew 
move.w 

dO,d1 
dO,d1 

unknown struct 'symbol' 
unknown union 'symbol' 

iNO 
iOK 

You must define a struct or union before declare an instance of it. How­
ever, you can declare a pointer to an undefined struct or union since 
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c • Error Messages 

TInNK C knows the size of a pointer and doesn't need to know the size of 
undefined struct or union is not needed. Example: 

struct not-previously_defined s; 
struct not-previously_defined *p; 
short i = sizeof(p); 
short j = sizeof(*p); 
struct link list element { 

II NO 
II OK 
II OK 
II NO 

struct link list element *next; 
struct link-list-element recursive; 

II OK 
II NO 

}; --

unterminated comment 
TIIINK C reached the end of a source file before it reached the end of a com­
ment. 

unterminated quote 
Either a character constant or a string constant is missing its end quote. Ex­
ample: 

void function(void) 
{ 

long file type; 
function("hello world); II NO: missing " 

file_type 

file_type 

'TEXT; 

'TEXT'; 

value has no members 

II 
II 
II 
II 

after world 
NO: missing , 

after TEXT 
OK 

In a . or -> expression the left operand was not a struct/union. Exam­
ple: 

void function(void) 
{ 

short non_struct, *short-ptr; 
struct sl_struct { short member_I; } sl, *pl; 

short-ptr->member_l; 

II NO: non struct is not 
II a struct *1 
II NO: short-ptr is not 
II a struct pointer 

516 THINK C User Manual 



'void' function must not return a value 

'void' function must not return a value 
A function declared void cannot return a value. Use a return statement 
without a value. Example: 

void in-partners_suit(condition) 
short condition; 
{ 

if (condition) 
return; II OK 

else 
return(l); II NO 

wrong number of arguments to function 
wrong number of arguments to function 'symbol' 

• 

You called a function with an explicit or inferred prototype with the wrong 
number of arguments. To write a function that takes a variable number of ar­
guments, use ... in your prototype. Example: 

typedef void (*actionProc) (char *s); 
(*actionProc) (aString, anlnt); II NO 

void error(char *s); 
error(ninvalid command %s", aString); II NO 

void msg(char *s, ... ); 
msg("invalid command %s", aString); 

wrong number of arguments to macro 'symbol' 

II OK 

You called a macro with the wrong number of arguments. Example: 

#define twice(x) (x+x) 
void function(void) 
{ 

short i; 
i = twice(3,4); II NO: macro called 

II with 2 args. 

wrong number of operands 
(Assembly) You probably forgot something. Example: 

asm { 
add.w 
add.w 

dO 
dO,dO 

NO 
OK 
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c • Error Messages 

wrong type(s) of operand(s) 
(Assembly) Some instructions require operands of a specific type. Example: 

asm { 
movea dI,dO NO: MOVEA can move only 

into address regs 
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Glossary. 
D 

A 
AS The register that points to the application space for the currently run­
ning application. 

ANSI (The American National Standards Institute) An organization that de­
fines standards for everything from the C programming language to scientific 
equipment to the sinks in public rest rooms. The ANSI standard for C speci­
fies the syntax and interpretation of the language and includes a set of func­
tions that a compiler should support. 

ANSI Library Contains the functions in the library defined in the ANSI 
standard. 

APDA (Apple Programmer's and Developer's Association) Apple's in­
house membership organization that distributes technical information and 
products to developers. 

AppleTalk Apple's networking protocol. 

application globals The globals that your application defines. 

application parameters Information that the system stores in the appli­
cation space about a running application. 

application space Memory that's available for dynamic allocation by ap­
plications. 

THINK C User Manual 519 



D Glossary • 
array window In the mINK C Debugger, a window that displays the 
contents of an array. It is similar to a data window. 
IO~II~0~ 

I 10[E] 
o 
1 
2 
3 
4 
~ 

o 
1 
o 
101:12 
2:17:14 
-17408 

Figure 0-1 An array window 

assembler An application that compiles assembly language into machine 
code. See also inIine assembler. 

auto-indenting Describes an editor that indents lines for you automatical­
ly. Whenever you start a new line in the mINK C editor, it's indented by the 
same amount of space as the line above it. 

auto-make The part of mINK C that compiles your program for you. Us­
ing the information in your project file, it compiles only the flIes that have 
been changed since the last compilation. 

auto mode The mode in which the TI-IINK C Debugger pauses at break­
points to update the source and data windows. To enter auto mode, hold 
down the Option or Command key as you press any of the status panel but­
tons (except Stop). To exit auto mode, press the Stop button. See also 
breakpoint and status panel. 

B 
breakpoint A statement at which you tell the mINK C Debugger to stop 
execution when it's running your program. See also simple breakpoint, 
conditional breakpoint, and temporary breakpoint. 

Bundle bit Lets the Finder know that your application has a BNDL re­
source. Set it with the Set Project Type .•• dialog. The BNDL resource maps 
file types to their proper icons. 

c 
c++ A programming language based on C that includes support for object­
oriented programming, operator overloading, and more. TI-IINK C contains 
object-oriented extensions that are compatible with C++. 

call chain See subroutine call chain. 
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c • 
callback routine A routine that you pass as an argument to a Macintosh 
Toolbox routine. 

CODE component One of the four components a project has for each 
source file or library. Contains the executable code generated for the file. 
Compare with DATA component, JUMP component, and STRS compo­
nent. 

code resource A resource that contains a program's code. Applications 
have code resources of type CODE, and device drivers and desk accessories 
have code resources of type DRVR. Some other types of code resources are 
XCMD, cdev, INIT, and WDEF. Compare with code segment. 

code segment An individual CODE resource, which is part of the code of a 
Macintosh application. Segments are loaded in and out of memory by the 
Segment Loader. 

conditional breakpoint A breakpoint at which the TI-IINK C Debugger 
stops only if a condition is true. See also breakpoint. Compare with simple 
breakpoint and temporary breakpoint. 

console A Macintosh window that behaves like a glass TIY or dumb ter­
minal. See also console package. 

Figure D-2 A console 

console package The part of the ANSI library that lets you use simple 
windows, called consoles, for input and output. If your program uses the 
streams STDIN, STDOUT, or STDERR and doesn't directly call Toolbox rou­
tines, this package creates a console and handles the Macintosh interface for 
you. This package lets you port UNIX or MS-DOS programs easily. See also 
console. 
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D Glossary • 
current function In the THINK C Debugger, the function that THINK C is 
executing. It's displayed in the lower left corner of the source window. See 
also source window. 

I!!!!!!!!!!!!!!! !!!!!!!!!!!!!:: ~~ ~.~!! ~!.~ ~ ~ ~~ ~~ ~: ~~::!!!!!!!!!!!!!!!!!!!!!!!! ~ ~ ~! i 
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I. DnvBulln\j. I}CL:~:~::~:.~:~:::.~:~:.~:~~::.~~.:.:.~~.I;J 

Figure 0-3 The name of the current function 

current statement In the THINK C Debugger, the statement that the de­
bugger is about to execute. A black arrow, the current statement arrow, ap­
pears to the left of it. 

current statement arrow In the THINK C Debugger, the arrow that ap­
pears to the left of the current statement 

D 
DA Shell A small program that simulates an environment for your desk ac­
cessory. Useful for debugging your desk accessories. Included with THINK 
C 

DATA component One of the four components a project has for each 
source file or library. Contains the global and static variables for the file. See 
also CODE component, JUMP component, and STRS component. 

data window In the THINK C Debugger, the window you use to display 
and change the values of your variables. 

Figure 0-4 The data window 
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E • 
deselect button The button with an "X" in the mINK C Debugger's data 
window. Press it to erase the contents of the entry field. See also data win­
dow and entry field. 

l iiiiiiiiiiiiii"i:i;~t"'''' iiiiiiiiii;;:i ~"~~~LLI;I;I;LLI;I;I~;I;I;I;~;I;I';I;I;i"'::'~;'I'Fvl 

r 

:;J<~ili",j;ji~,il'JijO~*** ~~ ---
'~;~ilil!Ili~Uilf''''''''''''''''''''''::: 

1.1">,( "'11,1 I: :: : ,~: : I ! ... 

L :;: _______ l!. 

Figure 0-5 The deselect button 

desk accessory A small program that is implemented as a device driver 
and can be used at the same time as an application. Its type is DFIL, and its 
creator is DMOV. 

Desk Manager The part of the Macintosh Toolbox that handles desk ac­
cessories. 

device A part of the Macintosh or a piece of external equipment that trans­
fers information into or out of the Macintosh. The most common ones are 
disk drives, modems, and printers. 

device driver A program that controls the exchange of information be­
tween an application and a device. See also device. 

Device Manager The part of the Macintosh Toolbox that su pports device 
input and output. 

driver See device driver. 

E 
enter button The button with a check mark in the THINK C Debugger's 
data window. Press it to enter the contents of the entry field. See also data 
window and entry field. 
iiiiiiiiiiiiiii"ci;;t'I''''iiiiiiiiii;;:iji 
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Figure 0-6 The enter button 
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• D Glossary 

entry field In the THINK C Debugger, the field in the upper left corner of 
the data window. Here you enter the names of variables you want to view or 
new values for variables you want to change. 

I iii iii iii iii i i:: ~:~ ~:':I:: iii ii! iii i ~~; i Ie 1'~~J[8J 
b:mlilllon!lllllll·······················::· 
I ~'j!;,,(I'~"1 .': :: : ,~: : I!· .... • 

! .. . 
I ,', 
L~ ___ w~_ •• ___ jt 
Figure D-7 The entry field 

F 
Far CODE Code that contains functions that you refer to with 32-bit abso­
lute addresses instead of 16-bit relative addresses. It lets you have a jump ta­
ble as large as 256K 

Far DATA Code that contains global data that you refer to with 32-bit ab­
solute addresses instead of 16-bit relative addresses. It lets you have an un­
limited amount of global variables. 

File Manager The part of the Macintosh Toolbox that handles file input 
and output. 

function prototype A function declaration that describes the types of the 
function's arguments. This is a function prototype: 

int foo (int X, char y); 

G 
global optimizer The part of THINK C that optimizes your code so that 
it's smaller and faster. These are the types of optimizations it performs: in­
duction variable elimination, common sub-expression elimination, code mo­
tion, and register coloring. 

Grep A powerful pattern-searching feature in the THINK C editor. Based 
on the grep command found in many UNIX systems. 

H 
header file A file that contains function prototypes and variable declara­
tions. It does not contain source code to implement functions. You include it 
in files that use what it declares. 

heap The area of memory in which space is dynamically allocated and re­
leased on demand, using the Memory Manager. See also zone size. 
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I • 
#include (v) To put a file in an #include statement. For example, to #in­
clude the file stdio. h in your source file, put this statement in your source 
file: 

iinclude <stdio.h> 

(adD Describes any file you use in an #inc1ude statement. See also header 
file. 

inline assembler The part of THINK C that lets you include assembly lan­
guage for the MC68000, MC68020, and Mc68881 in your C programs. 

inline declaration Declares an inline function that lets you embed ma­
chine code in a C program. The machine code in the declaration is executed 
instead of a call to a function. 

J 
JUMP component One of the four components a project has for each 
source file or library. Contains the jump table for the file. See also jump ta­
ble. Compare with CODE component, DATA component, and STRS 
component. 

jump table A table that contains one entry for every function in an appli­
cation. The Segment Loader uses this to find a function in one segment 
when a function in another segment refers to it. 

l 
library A collection of compiled functions that you can use in many pro­
grams. 

Link Errors window When you compile a program, this window dis­
plays the names of undefined and multiply defined routines. 

List Manager The part of the Macintosh Toolbox that helps you create, 
display and manipulate lists. 

low memory globals G lobals stored at the bottom of the Macintosh 
memory space. They are available to all running applications, but you 
should manipulate them only with Toolbox routines. 
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M 
MacHeaders A precompiled header file containing the most common 
declarations used in Macintosh programs. See also precompiled header 
file. 

Macintosh Programmer's Workshop (MPW) A software development 
environment for the Macintosh made by Apple. A fully configured system 
contains a shell (with a command-line interface much like UNIX), a C com­
piler, a Pascal compiler, and an assembler. 

Macintosh Toolbox The software in the Macintosh ROM that implements 
the Operating System and the User Interface Toolbox. The Operating System 
handles low-level operations like I/O and memory management. The User 
Interface Toolbox helps you implement the standard Macintosh user inter­
face in your application. 

Macsbug A low-level debugger from Apple that uses a command-line in­
terface. It can show exactly what's in memory as your program runs, but it 
can't show you high-level information, like variable names. 

marker A placeholder you can put in a source file. You place it with the 
Mark .•. command, and you go to it by Command-clicking on the title bar of 
the source window and selecting its name from the pop-up menu. 
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Figure D-8 The marker pop-up menu 

Mc6sooo (1) The microprocessor used in the Macintosh Classic, Plus, Por­
table, SE, 12SK, 512K, and 512K enhanced. (2) A generic term for the micro­
processors in the MC6sooo family, including the MC6so00, MC68020, and 
Mc68030. 

MC6s020 The microprocessor used in the Macintosh LC and II. In addi­
tion to what the Mc6sooo provides, this provides faster processing, an ex-
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tended instruction set, and full 32-bit addressing. With the Mc68851 
coprocessor, this lets you use virtual memory. 

o • 
MC68030 The microprocessor used in the Macintosh SE/30, IIci, Hcx, Hfx, 
IIsi, and IIx. In addition to what the Mc68020 provides, this lets you use vir­
tual memory without the MC68851. See also virtual memory. 

MC68851 An coprocessor for the Macintosh II that handles paged memo­
ry management and lets Y0l.l use virtual memory. Sometimes called the 
Paged Memory Management Unit or PMMU. See also virtual memory. 

Mc68881 A coprocessor that provides high-speed support for processing 
scientific computations. Sometimes called the floating-point unit or FPu. 

MPW See Macintosh Programmer's Workshop. 

multi-segment Describes any application, desk accessory, device, or 
code resource that contains more than one code segment. 

o 
.0 flIes The binary files produced by MPW compilers. They can be used as 
THINK C libraries. 

object code The machine language that the THINK C compiler generates 
from your source files. THINK C stores it in your project. 

optimizer See global optimizer. 

p 

partition size The amount of memory an application gets when running 
under MultiFinder. You set it in the Get Info ... dialog in the Finder. Also 
called Application Memory Size. 

Pascal string A string that begins with" \p" or" \p", like this: 
"\pThis is a Pasal string" 

THINK C replaces the \p with a byte containing the length of the string. Use 
with Pascal routines, such as Toolbox routines. 

PMMU See MC68851. 

pointer A variable that contains the address of something in memory, like 
another variable or a function. 
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D Glossary • 
precomplled header file A header file in a format THINK C can use 
readily, making it faster to load than other headers. Must contain only decla­
rations and preprocessor symbols. See also header file. 

Printing Manager The part of the Macintosh Toolbox that lets programs 
print on any kind of printer with the same interface. 

profiler The part of TI-lINK C that collects timing statistics about your 
functions. To use it, turn on the Profile option in the Code Generation sec­
tion of the Options ... dialog. 

program Anything you can compile with TI-lINK C: an application, desk 
accessory, device driver, or code resource. 

prototype See function prototype. 

project A file that keeps track of all the files in your program. It contains 
the object code for your files, maintains the dependencies between them, 
and remembers what needs to be recompiled. This is the heart of the THINK 
C development environment. 

project prefix Text that TI-lINK C includes in all the source files in your 
project. It's as if you put the text at the beginning of all your source files. You 
set in this prefix in the Prefix page of the Options ..• dialog. 

project tree The folder your project is in and all the folders in it. Keep the 
files you use in only one project here. 

project window The window that displays the files in your project. Here 
you can select files to edit and debug. See also project. 

Figure D-9 A project window 

Q 
QuickDraw The part of the Macintosh Toolbox that performs all the 
graphic operations on a Macintosh screen. 
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R • 
R 
ResEdit An application that lets you interactively create and edit resourc­
es. Included with THINK C. 

resource A piece of data stored in the resource fork of a Macintosh file. 
Common resources are windows, menus, fonts, and executable code. See 
also resource fork. 

resource fork One of the two forks in any Macintosh me. It contains re­
sources, such as menus, fonts, icons, and executable code. To access it, use 
the Resource Manager. See also resource. Compare with the data fork. 

resource file (1) A file that contains the resources your project uses. 
When you run a program in the environment, THINK C opens this file so 
you can use its resources. When you build your project, THINK C copies the 
resource file into your finished program. (2) Another name for the resource 
fork of a Macintosh file. 

s 
SANE See Standard Apple Numerics Environment. 

SADeRez An application that decompiles the resources in a file and cre­
ates a resource description file. Included with THINK C. 

SARez An application that compiles a resource description file to create re­
sources. Included with THINK C. 

segment See code segment. 

Segment Loader The part of the Macintosh Toolbox that loads the code 
of an application into memory, either as a single unit or divided into dynam­
ically loaded. See also code segment. 

selected statement In the THINK C Debugger, the statement you selected 
in the source window by clicking on it. It is highlighted. If you don't click on 
a statement, the current statement is the selected statement. Compare with 
current statement See also source window. 

Serial Driver A device driver that controls communication, via serial 
ports, between an application and serial devices. 

simple breakpoint A breakpoint at which the THINK C Debugger always 
stops. See also breakpoint. Compare with conditional breakpoint and 
temporary breakpoint. 
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D Glossary • 
smart linking A technique THINK C uses to remove as much unused 
code from your final program as possible. THINK C removes code for all un­
used functions. 

source files The text files that contain your source code. 

source window In the THINK C Debugger, the window that contains the 
source code being executed and the status panel 

SelPort<bull • ...,eIllndow); 
Era •• Recl(c,c Ircl.Slc:rl); 
IIO,IRecl • clrcl.Slc:rt; 

• DnvBulln". 

Figure 0-10 The source window 

stack (1) Any area of memory that is allocated and deallocated in a last-in 
first-out order, like a stack of trays in a cafeteria. (2) A specific stack in the 
Mc68000 that contains information on each routine in the subroutine call 
chain. Each time you call a routine, a stack frame is added that contains the 
routine's parameters, variables, and return address. When you return from a 
routine, its frame is removed from the stack. 

stack frame A frame in the Mc6sooo stack that contains a routine's pa­
rameters variables, and return address. 

stack size The maximum size of the stack in the Mc6sooo. By default, this 
is 16K. 

Standard Apple Numerics Environment (SANE) A system for perform­
ing floating-point arithmetic that Apple computers use. It meets all require­
ments for extended-precision, floating-point arithmetic as prescribed by 
IEEE Standard 754 and ensures that all floating-point operations are per­
formed consistently and return the most accurate results possible. 

statement marker In the THINK C Debugger, the diamond to the left of a 
line of source code. It shows that the line generates code. 
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s • 
status panel In the THINK C Debugger, the top of the source window. It 
contains six buttons that let you control the execution of your program. 

I: .. ,I. 0 ... "11(4 II l .... ..,.. 

I
,:, +- ~:~~; .. 'I"';'~.':,~:~~~.~II~:~:~::~ r" 
I'~"'" ·i;~:;·i'i·~'~iZ~~~I::~~::~.~~:~~~:::::~:.:.:~~ji;A;r 
Figure 0-11 The status panel 

STRS component One of the four components a project has for each 
source file or library. If you use the Separate STRS option, this contains the 
string literals and floating-point constants for the file. Otherwise, they're in 
the DATA component and this component doesn't exist. See also CODE 
component, DATA component, andJUMP component. 

string literal A sequence of characters enclosed by quotes. 

struct window In the THINK C Debugger, a window that displays the 
contents of a struct. It is similar to a data window. 

liD"""",,,," theEuent ===BJii 

1
0 10~ 

what I 

.... age 19M08 r-........ 7:1358 
IIIheNi ~lrucl OX1D816Ag IIIOdI fl..-. 

I2J 

Figure 0-12 A struct window 

subroutine call chain The list of functions called to get to the current 
function. In the THINK C debugger, click on the current function indicator to 
see this. See also current function. 

Figure 0-13 A subroutine call chain 
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D Glossary • 
T 
temporary breakpoint Lets you set a breakpoint and start execution in 
one step. The next time the mINK C Debugger comes to it, the debugger 
stops and clears it. See also breakpoint. Compare with conditional break­
point and simple breakpoint. 

TIDNK C tree The THINK C Folder and all the folders in it. If you use 
a file in more than one project, keep it in here. 

TMON A low-level debugger that uses a graphical interface. It can show 
exactly what's in memory as your program runs, but it can't show high-level 
information, like variable names. 

Toolbox See Macintosh Toolbox. 

Toolbox routine Any routine in the Macintosh ROM. 

trap intercept routine A routine that executes instead of a trap routine 
that implem~nts a Toolbox routine. 

u 
UNIX A popular operating system for mainframe computers created by 
AT&T's Bell Labs. Bell Labs created C to write UNIX. 

unix library Contains many functions found in C compilers for UNIX that 
aren't in the ANSI standard. 

v 
vertical retrace task A task that executes during the vertical retrace inter­
val, which occurs sixty times a second. 

virtual memory Space on your hard disk that you can use as though it 
were extra RAM. 

z 
zone See heap. 

zone size The size of your application's heap. 
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Index + 

Entries in bold face refer to menu commands. Entries in typewriter 
face refer to functions, methods, variables, keywords, or files. 

Symbols 
() , balancing 133 
/ / comments 177 
@, in assembly labels 256 
[ ] , balancing 133 
, in Toolbox traps 259 

"{}, balancing 133 
16-bit relative addresses, in applications 

100 
32-bit absolute addresses, in applications 

100 
32-bit Compatible flag 103 
"4-byte int" option 172, 193 
68000 identifier 254 

See also MC68000 
68020 identifier 254 

See also MC68020 
68030 identifier 254 

See also MC68020 
68040 identifier 254 

See also MC68020, MC68881 
6 8881 identifier 254 

See also MC68881 
68882 identifier 254 

See also MC68881 
"S-byte double" option 193 

A 
a4 globals option 197 
A4=felative addressing 109, 118, 274 

testing for 197 
absolute addresses, in applications 100 
Accept ChildDiedEvents flag 103 
Accept Remote HighLevelEvents flag 104 
acceptAppDiedEvents flag 103 

acceptSuspendResumeEventsflag 
103 

ADBS resource 116 
Add 89 
Add ••• 273 
adding 

file to project 89 
file to segment 98 
library to project 273 
markers 134 

Address 237, 421 
addresses 

dereferencing in debugger 238 
formatting in debugger 236,421 
inline assembler, in 264 
16-bit relative, in applications 100 
32-bit absolute, in applications 100 
viewing as array 240 

ADSP.h 165 
AIFF.h 165 
aliases 155 
Aliases. h 165 
"Always generate stack frames" option 

244 
inline assembler, and 252 

"Always save session" option 242 
American National Standards Institute 11 

See also ANSI C 
ANSI C 11 

books on 10-13 
compiling compatible code 182 
implementation, in THINK C 425-

441 
ANS I library 

floating-point, and 174 
SANE, and 215 
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Index • 
ANSI Settings button 183 
APDA 14 
APPL file type 100 
Apple iincludes folder 209 
Apple Computer 13 
Apple Extended Keyboard 131 
Apple Programmer's and Developer's As-

sociation 14 
AppleEvents, receiving 103 
AppleEvent s • h 165 
AppleTalk 205, 207 
AppleTalk. h 165 
applications 99-104 

background 103 
building 96, 99-104 
creator 100 
events, receiving 102 
Far CODE and DATA 100-101 
file type 100 
large, writing 100 
limits 95 
link map of 168 
linking 96 
MultiFinder, running under 101-104 
resource files for 96--97 
running 104, 220 
segmenting 97-99 
SIZE resource 101-104 
stationery for 104 
STRS component 101 
System 7.0, running under 101-104 
32-bit clean 103 
updating windows, in debugger 243 
See also projects 

argument promotion 460-462 
"Infer prototypes" option, and 191 
!!Require prototypes" option, and 

190 
arguments 

passing in registers 194 
passing to Pascal routines 205 
pushing on stack 266, 269 
variable number of 268 

arrays, in debugger 
formatting 236, 421 
modifying 239 
viewing 238 

arrow keys 130 
arrow, in debugger 223 
asm keyword 251,253-254 
asm. h 165, 210, 259 
assembler, See inline assembler 
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assembly language 
producing from source 168 
See also inline assembler 

assign_registers option 202 
ASYNC modifier flag 261 
atan () 215 
@, in assembly labels 256 
Attach Condition 230 
Attrs field 117 
auto mode 234 
"Automatic Register Assignment" option 

170 
inline assembler, and 252 

AUTOPOP modifier flag 261 

B 
background applications 103 
Background Null Events flag 103 
Background Only flag 103 
backing up files 138 
Balance 133 
balancing parentheses, brackets, braces 

133 
Balloons. h 165 
BDC.h210 
beginning of file, going to 131 
binary libraries 275 
Binary-Decimal Conversion Package 210 
blocks of text, shifting 132 
Boolean Pascal type 206 
botRight macro 212 
braces, balancing 133 
brackets, balancing 133 
branching, and inline assembler 256 
break, in inline assembler 256 
breakpoints 227-231 

choosing a file for 229 
conditional 230 
saving 242 
setting in code 231 
simple 228 
temporary 229 

Brodie, Jim 11 
bug alert 163 
bug column 219 
Build Application .•• 96, 99-104 
Build Code Resource •.• 96, 115-124 
Build Desk Accessory ••. 96, 104-115 
Build Driver ••• 96,104-115 
building projects 96 
Byte type 206 



c 
Clanguage 

ANSI standard options 182 
books on 10-13 
extensions to 174 
implementation 170-174,425-441 

The C Programming Language, Second 
Edition 10 

C String 237,421 
C Traps and Piifalls 11 
C: A Reference Manual 10 
cacridentifier252 
call chain 224, 244 
callback routines 212 

in drivers 109 
See also Pascal routines, functions 

calling conventions 
for C 266-269 
for Pascal 269-270 

canBackground flag 103 
CASE modifier flag 261 
case, in search 140 
CCOD resources 124 
ccr identifier 252 
CDEF resource 116 
cdev resource 116 
Char 237, 421 
cha r Pascal type 206 
char, representation 172 
char[] 194 
characters, invisible, searching for 141 
characters, multi byte 426 
"Check pointer types" option 188 
ChcckSyntax 163 
checkytrs option 199 
checking types 188-191 
Chernicoff, Stephen 13 
child died events, receiving 103 
choosing a project type 93 
CKI D resource 136 
class definition, searching for 143 
class keyword 175 
Clear All Breakpoints 228 
Clear Breakpoint 228 
CLEAR modifier flag 261 
Close All 138 
Close ••. 138 
closing source files 138 
CntrlParam and drivers 108 
CODE component 94-95 
"Code motion" option 185 

Code Optimization page 184-188 
code resources 115-124 

A4-relative addressing 118 
attributes 117 
building 96, 115-124 
custom headers 121 
global data in 118 
libraries, using in 119, 274 
limits 95 
locking 120 
MacTraps, using in 119 
main ( ) , writing 118, 121 
merging 123 

c • 

object-oriented programming, using 
117 

QuickDraw globals, using in 119 
resource files, for 96-97 
segmenting 97-99, 119, 123-124 
string literals, in 119 
See also projects 

Command-keys 130, 455 
comments 

inline assembler, in 251 
with / / 177 

common sub-expression elimination 185 
CommResources • h 165 
CommToolbox 205 
compatibility, See porting, ANSI C 
Compile 163 
Compiler Settings page 191-194 
compiling 163-164 

See also precompiling, building, run-
ning 

components, of project or library 94-95 
CompuServe 14 
conditional breakpoints 230 
"Confirm saves" option 139 
Connections. h 165, 209 
ConnectionTools.h165 
constants, in inline assembler 265 
context, of debugger expressions 237 
continue, in inline assembler 256 
continuously running programs 234 
Controls.h 164 
Copy 129 
Copy to Data 235 
cos () 215 
creating libraries 274-275 
creating resource files 341-351 
creating source files 127 
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creator, file 93 

application 100 
code resource 117 
drivers 106 

CRMSerialDevices.h165 
"CSE elimination" option 185 
cstr2dec () 214 
CTBUtilities.h165 
CtoPstr () 207 
current function 224 
current statement 223 
CurrentA5111 
custom headers 

for code resources 121 
for drivers 111 

CUt 129 

D 
Darnell, Peter 11 
DATA component 94-95 
Data window 222, 234-240 

context 237 
editing expressions 238 
errors 240 
evaluating expressions 235 
formatting expressions 236 
modifying variables 238 
saving contents 242 
scope 235 
Updating 234 
viewing variables 234-240 

data, global, See global data 
DatabaseAccess.h165 
DC directive 263 
DCOD resource 115 
dCtlDelay feild 111 
dCtlDelay field 112 
dCtlEMask field 111, 112 
dCtlEnable 111, 112 
dCtlFlags field 111, 112 
dCtlMenu field 111, 112 
DCtrlPTr and drivers 108 
debugger 219-247 

breakpoints 227-231 
context 237 
editing expressions 238 
editing files in 226 
errors 240 
evaluating expressions 235 
exiting 246 
files, viewing 226 
formatting expressions 236 
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inline assembler, and 252 
memory, and 246 
modifying values 238 
optimized code, and 242 
options 243-245 
running program from 231-234 
saving settings 242 
scope 235 
searching files 227 
storing names for 245 
turning on 219 
type-casting 236 
updating program's windows 243 
variables, viewing 234-240 
windows 221-223 

Debugger () 231 
debugger, low-level 245-246 

entering from code 231 
storing names for 245 

Debugging page 243-245 
DebugStr () 231,241 
dec2str () 214 
Decimal 237, 421 
decompiling resource files 355-365 
"Defer & combine stack adjusts" option 

in line assembler, and 252, 186 
defer_adjust option 202 
"#define _STDC_" option 183 
definitions, searching for 143 
delete keyword 175 
deleting 

character 131 
markers 136 
segments 99 

dereferencing pointers in debugger 238 
deselect button 222 
desk accessories 

and System 7.0105 
See also drivers 

Desk.h 164 
DeskBus . h 165 
device drivers, See drivers 
device headers 111 
Devices. h 164 
dfc identifier 252 
Dialogs. h 164 
direct identifier 175 
directives, #pragma 194-202 
directives, in inline assembler 263 
Disassemble 168 
disassembling resource files 355-365 
disk layout 159 



disk space 6 
Disks.h 165 
dispatched traps, in inl ine assembler 259-

262 
dNeedGoodbye 111, 112 
dNeedLock 111, 112 
dNeedTime 111, 112 
doesActivateOnFGSwitch flag 102 
double 

changing size 193 
representation 173 
returning from function 267 

double precision floating point 173 
double_8 option 198 
Down-arrow key 131 
dReadEnable 111, 112 
drivers 104-115 

A4-relative addressing 109 
building 96,104-115 
EventRecord, getting 108 
global data in 108 
headers 111 
10, setting 106 
libraries, using in 110,274 
limits 95 
MacTraps, using in 110 
main ( ) , writing 108 
multi-segment 114 
object-oriented programming, using 

in 107 
opening 112 
QuickDraw globals, using in 110 
quitting 113 
resource files, for 9~97 
segmenting 97-99 
string literals in 109 
See also projects 

DRVR resource 115 
dStatEnable 111, 112 
dWritEnable 111, 112 

E 
editing 129-134 

expressions, in debugger 236, 238 
files, in debugger 226 

editing keys 130 
Editions.h 165 
EFNT resource 134 
"S-byte double" option 193 
End key 131 
end of file, going to 131 
ENET.h 165 

enter button 222 
Enter key 130, 235 
entire file, searching 140 
entry field 222 
"enurns are ints" option 176 
enums, size of 176 
EPPC.h 165 
error messages 163, 240 
Errors. h 164 
ETAB resource 134 
EventRecord and drivers 108 
events, receiving 102 
examining variables 234-240 
executing, in debugger 231-234 

continuously 234 
skipping statements 234 
stopping 233 
to statement 233 
See also running 

exiting 
from debugger 246 
from drivers 113 

ExitToShcll 246 
exp () 215 
expanding macros 168 
expressions, in debugger 

context of 237 
editing 236, 238 
evaluating 235 
locking 238 
modifying values 238 
removing 236 
type-casting 236 
updating 234, 237 
See also variables 

extended 215 

E 

extended precision floating-point 173 
extensions, to C 174 
extern labels 258 

F 
fabs () 215 
Factory Settings button 180 
FALSE macro 212 
"Far CODE" option 100-101 

function calling, and 266 
testing for 197 

"Far DATA" option 100-101 
testing for 197 

far_code option 197 
far_data option 197 
fields, in inIine assembler 255 

• 
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file and driver traps, flags for 261 
File Manager, and inline assembler 261 
file type 93 

application 100 
code resource 117 
drivers 106 

files, See source files 
Files. h 164, 209 
FileTransers.h165 
FileTrasferTools.h165 
Find Again 139 
Find in Next File 142 
Find ... 139 
Finder. h 165 
finding in files 139-149 

See also searching 
FixMath. h 165 
FKEY resource 116 
float, representation 173 
Floating Point 237, 421 
floating-point 172,214-216 

changing size 193 
converting formats 215 
extended type 215 
formatting, in debugger 236, 421 
inline assembly, in 255 
MPW C, and 216 
representation 172-174 
returning from function 267 
SANE, and 214-216 

floating-point unit, See MC68881 
folders, hidden 154-155 
Folders. h 165 
font, setting 133 
force_frame option 200 
formatting 

lines, in editor 132-133 
values, in debugger 236 

Forward Delete key 131 
"4-byte int" option 172, 193 
fpcr identifier 252 
fpiar identifier 252 
fpsr identifier 252 
FPU, See MC68881 
freezing expressions 238 
front clicks, receiving 103 
function keys 130, 455 
function pointers, See callback routines, 

functions 
function prototypes, See prototypes 
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G 

called, how 266-269 
current, in debugger 224 
definition, searching for 143 
inline In, 194 
inline assembler, in 254 
large number of 100 
listing in application 168 
multiple entry points 258 
names of 170 
names, storing 245 
registers, for parameters and return 

value 194 
returning from 267 
stepping in and out, in debugger 233 
trap intercept, in drivers 109 
variable number of arguments 268 
See also Pascal routines 

"Generate 68020 instructions" option 
inline assembler, and 253, 192 

"Generate 68881 instructions" option 192, 
174,215 

and function return 268 
"Generate link map" option 168 
Gestalt Manager 205 
GestaltEqu.h 164 
Get FrontClicks flag 103 
Get Info .•• 94 
get/set traps, flags for 261 
global data 

code resources, in 118 
drivers, in 108 
limits 95 
listing in application 168 
over 32K 100 
See also QuickDraw globals, low­

memory globals 
global optimizer 184-186 

See also optimizations 
global scope, in debugger 235 
global variables, See global data, Quick­

Draw globals, low-memory glo­
bals 

global optimizer201 
globals, iOw-memory, See low-memory 

globals 
Go 232 
Go To Line ••• 132 
Go Until Here 233 
gopt_coloring option 201 



gopt _ cse option 201 
gopt_induction option 201 
gopt_loop option 201 
goto, in inline assembler 256 
Graf3D.h 165 
Grep 144-149 

H 
Handle type 206 
Harbison, Samuel P. 10 
header files 

aliases, and 155 
finding 154 
once-only 154 
opening 128 
precompiling 164, 167 
prototypes, and 188 
Toolbox 164-166,208-212 

headers 
code resources 121 
drivers 111 

Hcx 237,421 
hexadecimal constants, in inline assem-

bler 263 
HFS modifier flag 261 
hidden files 154-155 
high level events, receiving 103 
HighLevelEvent-Aware flag 103 
Home key 131 
"Honor 'register' first" option 170 
honor_register option 202 
Horton, Mark R. 11 
How to Write Macintosh Software 13 
Hypercard XCMDs 116, 205 
HyperXCmd. h 165 
HyperXLib 205 

icons, application 100 
Icons.h 165 
ID 

code resource 117 
drivers 106 

identifiers 170 
inline assembler, in 254 
object-oriented programming, and 

175 
IEEE floating-point representation 173 
"Ignore casen option 140 
IMMED modifier flag 261 
immediate constants 265 
immediate-mode operands 255 

#inc1ude files, See header files 
indenting lines 132-133 
indirect identifier 175 
indirect option 199 

H • 
"Induction variable elimination" option 

185 
"Infer prototypesn option 190 
inferyrotos option 199 
infinity, in inline assembler 256 
inherited identifier 175 
INIT resource 116 
inline assembler 251-265 

branching 256 
C constructs 251 
compatibility 262-264 
floating-point literals 255 
header file for 210 
identifiers for 254 
mUltiple entry points 258 
optimizations, using with 252 
options it changes 252 
preprocessor symbols 251 
registers, using in 262 
returning from 258 
Toolbox routines in 259-262 

in line functions 177, 194 
insertion point 

moving 131 
scrolling to 130 

Inside Macintosh 12 

int 
See also Toolbox routines 

changing size 193 
representation 172 
short int compatibility 460 

int _ 4 option 198 
integer Pascal type 206 
integers 

changing size 193 
formatting, in debugger 236, 421 
representation 172 

invisible characters, searching for 141 
is32BitCornpatible flag 103 
isHighLevelEventAware flag 103 
isp identifier 252 
isStationeryAware flag 104 

Jaeschke, Rex 11 
jIODone 113 
JSR, in inline assembler 258 
JUMP component 94-95 
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jump table 94-95, 100 

limits 95 
over 32K 100 
testing for 197 

jump_table option 197 

K 
Kernighan, Brian W. 10 
keys, function 130 
keywords, for object-oriented program-

ming 175 
Knaster, Scott 13 
Koenig, Andrew 11 

l 
labels, in inline assembler 256 
"Language Extensions" option 174 
Language Settings page 182, 188-191 
Language. h 165 
LDEF resource 116 
learning how to program 10-13 
Left-arrow key 131 
.lib files 275 

See also libraries 
libraries 273-276 

adding to projects 273 
binary 275 
code resources, in 119, 274 
components 94-95 
creating 274-275 
drivers, in 110, 274 
Far CODE and DATA in 101 
linking into projects 96 
loading 274 
moving in projects 158 
MPW libraries 275 
projects as 274 
"Separate STRS" option, with 101 
See also projects 

limits, for projects 95 
lines 

going to 132 
selecting 132 
See also statements 

link map 168 
linking projects 96 
Lists.h 164 
literals 

floating-point, in inl ine assembler 
255 

Pascal string 206 
string, in code resources 119 
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string, in drivers 109 
string, in STRS component 94-95, 

101 
Load Library 274 
local scope, in debugger 235 
localAndRemoveHLEventsflag104 
Lock 238 
locking 

code resources 120 
expressions 238 

log () 215 
LoMem.h 165,210 
long double, representation 173 
"Long format" option 245 
long int 

Point compatibility 459 
representation 172 

long_macsbug_names option 201 
longint Pascal type 206 
low memory globals 178, 210-211 

M 
Mac #includes folder 209 
Mac #includes.cl66 
MACDEV 14 
MacHeaders 164-166,453 

prototypes, and 189 
machine instructions 177 

See also assembly language 
Macintosh C Programming Primer 13 
Macintosh header files, SeeMacHeaders 
Macintosh Programming Secrets 13 
Macintosh programming, learning 11-13 
Macintosh Revealed 13 
Macintosh Toolbox routines, SeeToolbox 

routines 
macros 

defining for whole project 181 
expanding 168 
inline assembler, in 251 

Macsbug 245-246 
entering from code 231 

"Macsbug Names" option 245 
macsbug_names option 201 
MacTraps 205, 453 

code resources, in 119 
drivers, in 110 

MacTraps2205 
See also MacTraps 

MacTutor13 



main () 
code resources, for 118, 121 
drivers, for 108 

• map file 168 
Margolis, Philip 11 
Mark, Dave 13 
Mark ••. 134 
markers 134-136 
MARKS modifier flag 261 
match words, in search 140 
matching parentheses, brackets, braces 

133 
MBDF resource 116 
Mc68000 

assembly language, writing 252-254 
compiling for 192 

Mc68020 
assembly language, writing 252-254 
compiling for 192 

mc68020 option 200 
MC68030, See Mc68020 
MC68040, See MC68020, MC68881 
Mc68881 

assembly language, writing 252-254 
compiling for 192, 215 
inline functions 178 
MPW C, and 216 

mc68881 option 200 
MC68882, See Mc68881 
MDEF resource 116 
memory 

debugger, and 246 
setting application partition size 101 
THINK C, for 5 

memory traps, flags for 261 
Memory. h 164 
Menus.h 164 
Merging code resources 123 
methods 

definitions, searching for 143 
large number of, in applications 100 

MF Attrs, See SIZE Flags 
MIDI.h 165 
modified read-only file 136 
Modify Read-only 137 
modifying variables 238 
Monitor 245-246 
monitor, second, and debugger 243 

moving 
file, within 130-132, 134-136 
files in project 157-158 
marker, to 135 
segments 99 

MPW C, See porting, ANSI C 
MPW object files 275 
MPW Projector 136-137 
msp identifier 252 
multibyte characters 426 
multi-file searching 141 
MultiFinder 

N 

applications, building for 101-104 
applications, running under 104 
memory, and 5 

• 

TI-IINK Class Library, using with 103 
MultiFinder-Aware flag 102 
multiple entry points, in function 258 
multi-segment, See segments 

N 
names for variables and functions 170 
names of functions, for debugger 245 
nAppleTalk 205, 207 
"Native floating-point format" option 192, 

215, 174 
native_fp option 198 
New 127 
new keyword 175 
NEWOS modifier flag 261 
NEWTOOL modifier flag 261 
next page, going to 131 
nooptimize pragma directive 195 
[Not in ROM] 205 
Notification.h 164 
null events, in background 103 
Numerical Recipes in C 11 
NumToString() 210 

o 
.0 files 275 

See also libraries 
object code 163 

types of 94-95 
obj ectc option 198 
object-oriented programming 

code resources, using in 117 
drivers, using in 107 
extensions 175 
keywords 175 
large applications, in 100 

oConv 275 
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OFFSET () 255 
offsetof () 255 
old-style defintions 

and prototypes 190 
once pragma directive 154 
once-only headers 154 
Open 127 
Open Selection .•• 129 
opening 

drivers 112 
header files 128 
source files 127-129 

operator identiher 175 
optimizations 96, 170, 184-188 

automatic register assignment 170 
changing in code 195,201-202 
code motiop 185 
common sub-expression elimination 

185 
debugger, usi~g with 242 
defer & combine stack adjusts 186 
global optimizer 184-186 
induction variable elimination 185 
inline assembler, using with 252 
register coloring 186 
smart linking 96 
suppress redundant loads 187 
testing in code 201:....202 

option directive 195-202 
options pragma directive 195-202 
Options ••• 179 

inline assembler, and 252 
testing and changing in code 195-

202 
OSEvents.h 164 
OSTypeO type 206 
OSUtils. h 164 
owned resources 115, 124 
owning resources 115, 124 

P 
""\p" is unsigned char[]" option 194 
"\p" strings, See Pascal strings 
pack _ enums option 199 
packages, in inline assembler 259-262 
Packages. h 165, 209, 210 
packed array [1 •. 4] of char 206 
Page Down key 131 
Page Setup ••• 138 
Page Up key 131 
Palettes.h 165 
panic button 233 
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parameter, pragma directive 194 
parameters, See arguments 
parentheses, balancing 133 
partition size 

ofTIIINK C and debugger 246 
of your application 101 

parts, of project or library 94-95 
pascal keyword 212 
Pascal routines 205, 212-214 

called, how 269-270 
calling indirectly 213 

Pascal Suing 237, 421 
Pascal strings 206 

changing type of 194 
formatting, in debugger 236, 421 
See also strings 

Pascal types 206 
pascal. h 165, 212 
Paste 129 
pathname 153 
patterns, searching for 144-149 
pc identifier 252 
pcrel strings option 197 
Picker.h 165 
PictUtil. h 165 
Plauger, P. J. 11 
Point type 206 
Point, long int compatibility 459 
Pointer 237, 421 
pointer types, checking 188 
pointers, See addresses 
pop-up menu 

header files 128 
markers 135 

Portability and the C Language 11 
Portable C Software 11 
porting 

ANSI C code 182 
assembly code 262-264 
header files, and 208, 453 
low-memory globals, and 210-211 
MPW object files 275 
MPW Projector, and 136-137 
options for 193-194 
project to other Macintosh 158 
SANE, and 216 
TIIINK C projects, old versions 447, 

458-463 
Power.h 165 
PPCToolBox . h 165 



----------------------------------------------------Q • 

:!tpragma directives 194-202 
noopt imi ze 195 
once directive 154 
options 195-202 
parameter 194 

Precompile ••• 164-167 
precompiling 164, 167 

See also header files 
preferences, See Options ••• , Set Tabs & 

Font. .. 
Prefix page 181 
J>i'eproccss 168 
preprocessor output 168 
previous page, going to 131 
PrGlue 20" 208 
Print Manager 208 
Print ••. 138 
printing files 138 
printing from applications 208 
Printing. h 165, 208 
Print Traps. h 165, 208 
private identifier 175 
procedures, See functions, Pascal routines 
Processes. h 164 
processor-specific code 191-192, 252-

254 
See also Mc68020, MC68881 

ProcPtr type 206 
profile option 200 
programming, learning 10-13 
programs, See appl ications, projects 
project prefix 1,81 
project tree 153, ISS, 159 
"Projector-Aware" option 136-137 
projects,91-124 

bug column 219 
building 96 
components 94-95 
damaged 104 
debugger, using with 219 
defining macros for 181 
libraries, adding 273 
limits 95 
link map 168 
moving files 157-158 
moving to other machine 158 
opening files 127-129 
organizing files 156, 159 
renaming files in 138 
resource files, for 96-97 
running 104 

running, with debugger 220, 231-
234 

searching in 141 , 
segmentiQg 97-99 
selecting files 128 
size of94 
source files, adding 89 
types of 93-94 
updating windows, in debugger 243 
See also applications, drivers, code 

resources, libraries 
promotion, argument, See argument pro­

motion 
protected identifier 175 
prototypes 

argument promotion, and 461 
enforcement options 189 
functional arguments, and 462 
return type, and 462 
Toolbox routines, and 458 

PtoCstr () 207 
Ptr type 206 
pub 1 i c identifier 175 

Q 
QDOffScreen.h 164 
QuickDraw globals 205 

code resources, in 119 
drivers, in 110 

Quickdraw. h 164, 209 
quitting 

R 

debugger 246 
drivers 113 
your program 104, 246 

read-only file· 136 
receiving events 102 
receiving events, See. events, receiving 
"Recognize trigraphs," option 176 
records, Pascal, passing as arguments 205 
Rect type 206 
Redo 130 
redundant_loads option 202 
Reed, Cartwright 13 
"Register coloring" option 186 
registers 

inline assembler, in 254, 262 
parameters, putting in 194 
return value, putting in 194 
variables, register 170 

relative addresses, in applications 100 
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RememberA4 () 

in code resources 119, 122 
in drivers 110 

remote AppleEvents, receiving 104 
Remove Marker ••• 136 
removing 

character 131 
expressions in debugger 236 
markers 136 
segments 99 

Replace 140 
Replace All 141 
Replace and Find Again 140 
replacing, in files 140 

See also searching 
"Require prototypes" option 190 
require_protos option 199 
requirements 5-6 
ResEdit 2.1 Reference 13 
resource attributes, setting 117 
resource description files 299-338 
resource files 

creating 341-351 
decompiling 355-365 
description files 299-338 
projects, and 96-97 

resources, code, See code resources 
resources, owned and owning 115, 124 
Resources. h 164 
RestoreA4 () 

in code resources 119, 122 
in drivers 110 

restoring debugger settings 242 
Re s Type type 206 
Resume 104 
Resume events, receiving 103 
Retrace.h 165 
return address 

for C 267 
for Pascal 270 

Return key 132, 235 
return value 

from C function 267 
from Pascal routine 270 
putting in register 194 

ret urn, in inline assembler 256, 258 
returning 

from C function 267 
from drivers 113 
from Pascal routine 270 
within inline assembler 258 

Returns, searching for 141 
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Revert 130 
Right-arrow key 131 
Ritchie, Dennis M. 10 
ROMDefs. h 165 
routines, See Pascal routines, functions 
• rsrc file 96 
Run 104 
running programs 104 

S 

with debugger 220,231-234 
See also executing 

SADeRez 299, 355-365 
SANE 214-216 

extended type 215 
floating-point representation 173 
MPW C, and 216 

SANE. h 165, 209, 214 
SARez 299, 341-351 
Save 138 

in debugger 242 
Save a Copy As ••• 138 
Save All 138 
Save As ••• 138 
saving 

debugger settings 242 
source files 138-139 

scope, in debugger 235 
Scrap.h 164 
screen, second, and debugger 243 
Scr ipt . h 165 
scrolling to selection 130 
SCSI.h 165 
searching 139-149 

debugger, in 227 
definitions of symbols, for 143 
options 140 
patterns, for 144-149 
several files, in 141 

SegLoad.h 164 
segments 97-99 

code resources, in 119, 123-124 
drivers, in 114 
limit, number of 98 
limit, size of 95 
listing in application 168 
size of components 94 
unloading from code resources 123 
unloading from drivers 114 

selected statement 224 
selecting project type 93 



selecting text 129 
scrolling to selection 130 

selection, in editor 129 
"Separate STRS" option 101 

testing for 197 
separate_strs option 197 
Serial. h 165 
Set Breakpoint 228 
Set Context 237 
Set Project Type ••• 

applications 99-104 
code resources 115-124 
drivers 104-115 
testing options in code 197 
See also projects 

Set Tabs & Font .•• 133 
setting variables, in debugger 238 
SetUpA4 () 

in code resources 119, 122 
in drivers 110 

SetUpA4. h 212 
sfc identifier 252 
shielded files 154-155 
Shift Left 132 
Shlfi Right 132 
short double, representation 173 
"Short format" option 245 
short int 

int compatibility 460 
representation 172 

Show Condition 231 
Show Context 237 
showing variables 234-240 
ShutDown. h 165 
signature, file 93, 100 
signedystrs option 199 
simple breakpoints 228 
sin () 215 
single precision floating-point 173 
16-bit relative addresses, in applications 

100 
SIZE flag field 101-104 
SIZE resource 101-104 
sizes 

enums, of 176 
floating-point, of 174 
integers, of 172 
limits on code and data 95 
project components, of 94 
segment components, of 94 

Skip To Here 234 
skipping statements 234 

Slots.h 165 
smart linking 96 
Software Engineering in C 11 
Sound. h 165, 209 
SoundInput • h 165 
source files 163 

adding to projects 89 
breakpoints 227-231 
closing 138 
compiling 163-164 
creating 127 
debugger, in 219 
disassembling 168 
hiding 154-155 
linking 96 
moving to folder 157 

s 

moving within 130-132, 134-136 
naming 138, 153, 156 
opening 127-129 
organizing 156, 159 
preprocessing 168 
printing 138 
saving 138-139 
searching 139-149,227 
segmenting, and 97-99 
selecting, in project window 128 
syntax, checking 163 
viewing in debugger 226 

Source window 221, 223-227 
errors 240 

sp identifier 252 
sqrt () 215 
sr identifier 252 
stack frames, generating 244 
stack, during function call 267 
Standard C 11 
StandardFile.hl65 
start of file, going to 131 
Start.h 165 
starting drivers 112 
statements 

executing 232-233 
in debugger 223 
See also lines 

static functions, and prototypes 190 
Stationery-Aware flag 104 
status panel 232 
stdarg . h 268 
_ STDC _ macro 183 
stdc option 198 
Steele, Guy L., Jr. 10 
Step 232 

• 

THINK C User Manual 545 



Index • 
Step In 233 
Step Out 233 
Stop 233 
Stop Signs, See breakpoints 
stopping program 233 
str2dec () 214 
"Strict Prototype Enforcement" option 

189 
string literals 

code resources, in 119 
drivers, in 109 
STRS component 94-95,101 
See also Pascal strings 

string traps, flags for 261 
String255 type 206 
StringPtr type 206 
strings 

converting 207 
formatting, in debugger 236, 421 

strings, Pascal, See Pascal strings 
strings, Toolbox, See Pascal strings 
StringToNum() 210 
STRS component 94-95,101 
structs 

formatting in debugger 236, 421 
inline assembler, in 255 
modifying in debugger 239 
passing as arguments 205 
returning from function 267 
viewing in debugger 238 

"Suppress redundant loads" option 187 
Suspend & Resume Events flag 103 
syntax, checking 163 
SYS modifier flag 261 
SysEqu. h 165, 210 
System 7.0 

aliases 155 
applications, building for 101-104 
applications, running under 104 
memory, and 5 
THINK Class Library, using with 103 

System software 6 
See also System 7.0 

T 
Tabs 

inserting 132-133 
searching for 141 
size of, setting 133 

tan () 215 
temporary breakpoints 229 
Terminals. h 165 
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TerminalTools.h 165 
text blocks, shifting 132 
text files 

opening 127 
See also source files 

text, selecting 129 
TextEdi t • h 165 
THINK #includes folder 210 
"THINK C + Objects" option 174 
THINK C 5.0 Folder 153 
"THINK C" option 174 
THINK C tree 153, 155, 159 
THINK Class Library 

under System 7.0 or MultiFinder 103 
THINK Reference 12 
THINK.h 165, 212 
THINK C 179 
thinkc option 198 
32-bit Compatible flag 103 
32-bit absolute addresses, in applications 

100 
thi s identifier 175 
Timer.h 165 
titles in editing windows 153 
TMON 245-246 

entering from code 231 
Toolbox header files, See MacHeaders 
Toolbox routines 10, 205-216 

arguments, converting 205 
header files 208-212 
inline assembler,in 259-262 
libraries 205 
prototypes, and 458 
strings, and 206 

Toolbox traps, flags for 261 
ToolUtils. h 165 
topLeft macro 212 
Trace 232 
trap intercept routines, in drivers 109 
traps, in inline assembler 259-262 
Traps.h 165,259 
tree 153, ISS, 159 
trigraphs 176 
trigraphs option 198 
TRUE macro 212 
type checking 188-191 
type, file 93, 100 
type-casting, in debugger 236 
types 

Pascal 206 
representation 172-174 

Types.h 165,209 



u 
underscore, in Toolbox traps 259 
Undo 129 
unions 

formatting in debugger 236, 421 
modifying in debugger 239 
returning from function 267 
viewing in debugger 238 

universal floating-point format 173 
and SANE 216 

UnloadA4Seg () 114, 123 
unsigned char[) 194 
Up-arrow key 131 
"Update program windows" option 243 
updating Data window 234 
Use Debugger 219 
"Use Global Optimizer" option 184 

inline assembler, and 252 
"Use second screen" option 243 
"Use Source Debugger" option 243 
usp identifier 252 

v 
• v files 275 
va arg () 268 
va-end () 268 
va-start () 268 
valli'es of variables, viewing 234-240 
Values. h 165 
var parameters 205 
variable number of arguments 268 
variables 

definition, searching for 143 
inline assembler, in 254 
modifying, in debugger 238 
names of 170 
register 170 
type-casting, in debugger 236 
viewing, in debugger 234-240 
See also expressions, in debugger 

variables, global, See global data 
vbr identifier 252 
Video.h 165 
viewing variables 234-240 
virtual keyword 175 
virtual option 199 
vocabulary files 275 

W 
watch points, See conditional breakpoints 
WDEF resource 116 

"Whole words only" option 140 
wildcard searching 144-149 
window titles 153 
windows 

debugger 221-223 
editing 129-134 
project 98 

Windows.h 165 
word selecting 129 
word wrap 129 
words, searching for 140 
"Wrap around" option 140 

X 
x80tox96 () 216 
x96tox80 () 216 
XCMD resource 116, 205 
XFCN resource 116, 205 

z 
zpc identifier 252 

u • 
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